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1: Welcome to PAC Control

INTRODUCTION

Welcome to PAC Control, Opto 22's visual control language for Opto 22 SNAP PAC control systems and the
input/output (I/0) units that work with them.

PAC Control makes it easy to write control applications with little or no programming experience. If you know
how to design a control application and can draw some flowcharts to describe it, you already know the basics
of PAC Control. At the same time, PAC Control provides a complete and powerful set of commands, as well as
the OptoScriptm programming language, to meet your most demanding industrial control needs.

PAC Control comes in two forms: PAC Control Basic and PAC Control Professional .

«  PACControl Basic is included in the purchase of an Opto 22 SNAP PAC controller and is also available as
a free download from our website, www.opto22.com. PAC Control Basic includes both flowchart and
OptoScript programming, subroutines, a graphical debugger, and about 400 commands.

«  PAC Control Professional is available for purchase either separately or as part of the complete PAC
Project  Professional software suite. The Professional version of PAC Control adds:

- Support for controller redundancy and Ethernet link redundancy to controllers and I/0 units

- Support for Legacy hardware, including serial mistic’1/0 units with a SNAP PAC S-series controller
- Aconversion utility to help you move older OptoControl” strategies to PAC Control

- Additional “Pro version only”PAC Control commands

For information on features supported by a specific controller, see the controller documentation.

FOR DEVELOPERS: SNAP PAC REST API

If you're a developer who'd like to use PAC Control strategy tags in communications with other
devices, the Opto 22 SNAP PAC REST APl is a secure and powerful way to do just that. The APl is
available in SNAP PAC R-series and S-series controllers with PAC firmware R9.5a and higher. To
configure HTTPS access to your PAC's RESTful server and learn how to call the API, visit
developer.opto22.com.

ABOUT THIS GUIDE

This user’s guide not only teaches you how to use PAC Control, but also provides programming instruction and
tips. The separate PAC Control Command Reference, Legacy Edition (form 1711) describes in detail all
PAC Control programming commands and instructions.
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This guide assumes that you are already familiar with Microsoft” Windows on your personal computer, including
how to use a mouse, standard commands, and menu items to open, save, and close files. If you are not familiar
with Windows or your PC, refer to the documentation from Microsoft and your computer manufacturer.

This guide covers both PAC Control Basic and PAC Control Professional.

The Basic icon indicates features or functions that apply only to PAC Control Basic.

The Pro icon indicates features or functions that apply only to PAC Control Professional.

Here's what is in this user’s guide:

1: Welcome to PAC Control—information about the guide and how to reach Opto 22 Product Support.

2: PAC Control Tutorial—a tutorial designed to help you use PAC Control as quickly as possible. The chapter
leads you through a sample strategy that you can manipulate, download, and run in Debug mode.

3:What Is PAC Control?—an introduction to PAC Control, key terminology, and the main windows and toolbars.

4: Designing Your Strategy—programming in PAC Control: how to get from your real-world control problem to
a working strategy.

5: Working with Control Engines—how to configure and communicate with control engines.

6: Working with 1/0—how to configure and communicate with input/output (I/0) units, /0 points, and PID
loops.

7: Working with Strategies—detailed steps for creating, compiling, and running strategies.

8: Working with Flowcharts—detailed steps for creating and working with the flowcharts that make up your
strategy.

9: Using Variables and Commands—steps for configuring the seven types of variables you can use in
programming: communication handle, numeric, string, pointer, numeric table, string table, and pointer table
variables. Also shows how to use the commands that control the I/O and variables you've configured.

10: Programming with Commands—important tips on using PAC Control commands to accomplish what you
wantin your strategy.

11: Using OptoScript—details on the optional scripting language available in PAC Control for complex loops,
string handling, and mathematical expressions.

12: Using Subroutines—how to use subroutines to streamline your strategy development.
A: Troubleshooting—tips for resolving communication problems and other difficulties you may encounter.
B: Errors and Messages—types of errors, where you'll see them, and the causes of common errors.

C: PAC Control Files—a list of all PAC Control files located in the PAC Control directory and in any strategy
directory.

D: Sample Strategy—an illustration and description of the sample “Cookies” strategy used in Chapter 1.

E: OptoScript Language Reference—details about OptoScript code, including comparisons to other
languages, lexical reference, and notes to experienced programmers.

F: Legacy High-Density Digital Module Commands—provides information on the deprecated high-density
module commands used with older high-density modules.

Index—alphabetical list of key words and the pages where they are located.
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CHAPTER 1: WELCOME TO PAC CONTROL

Choosing Documentation

This legacy version of the PAC Control User's Guide contains the latest information you need to use

PAC Control with your SNAP PAC system as well as information for using Opto 22 “legacy” products designed
to work with pre-SNAP PAC systems. For a version designed for a SNAP PAC system that does not include older
legacy products, see the PAC Control User’s Guide (form 1700).

For information on what we mean by “legacy”and how to migrate from an older system to a SNAP PAC
system, see the SNAP PAC System Migration Technical Note (form 1688).

To enable legacy I/0 units and commands in PAC Control, see “Legacy Options”on page 234.

Document Conventions

The following conventions are used in this document:

«  ltalic typeface indicates emphasis and is used for book titles. (Example: “See the PAC Display User’s Guide
for details.”)

«  Names of menus, commands, dialog boxes, fields, and buttons are capitalized as they appear in the
product. (Example: “From the File menu, select Print.")

«  File names appear either in all capital letters or in mixed case, depending on the file name itself.
(Example: “Open the file TEST1 txt.")

«  Key press combinations are indicated by plus signs between two or more key names. For example,
Shift+F1 is the result of holding down the Shift key, then pressing and releasing the F1 key. Similarly,
Ctrl+Alt+Delete is the result of pressing and holding the Ctrl and Alt keys, then pressing and releasing
the Delete key.

o "Click"means press and release the left mouse button on the referenced item. “Right-click”means press
and release the right mouse button on the item.

«  Menu commands are referred to with the Menu > Command convention. For example,
“File > Open Project”means to select the Open Project command from the File menu.

«  Numbered lists indicate procedures to be followed sequentially. Bulleted lists (such as this one) provide
general information.

To simplify the text and make it quicker to read, this document consolidates all the variants of a part name to
one part name. For example, there are three variants of the SNAP-PAC-ST:

«  SNAP-PAC-S1

e« SNAP-PAC-ST-FM [obsolete]

o SNAP-PAC-ST-W [obselete]

When you see "SNAP-PAC-51"in the text, the information also applies to SNAP-PAC-S1-FM (obsolete) and

SNAP-PAC-S1-W (obsolete). If there is a situation where the information does not apply to one of the variants,
it is specifically called out in the text.

Help, Documents, and Opto22.com Resources

To help you learn, understand, and use PAC Control systems, we offer a wide variety of options:

«  Helpis available in PAC Control and in all of the applications in the PAC Project™ Software Suite from
Opto 22.

—  Tosee screen and field-level help, click the Help button on any PAC Control screen. While entering
commands (instructions), click the Command Help button to see details about the command.

— Inthe PAC Control menu bar, click Help to view the list of help topics.

- Click Help > Manuals to open the PDF versions of the documents that are installed when you install
PAC Control, including:
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—  The PAC Control User's Guide (form 1700)—Shows how to install and use PAC Control.
—  The PAC Control Command Reference (form 1701)—Contains detailed information about each
command available in PAC Control.
—  The PAC Control Commands Quick Reference (form 1703)—Lists all PAC Control commands plus
their OptoScript code equivalents and arguments.
Our website at www.opto22.com offers has a broad range of resources—from helpful videos to online
blogs, forums, and news to free online self-training. We even offer free hands-on training at our
headquarters in Temecula, California.

Product Support

If you have any questions about PAC Control, you can call, fax, or email Opto 22 Product Support.

Phone: 800-TEK-OPTO

(800-835-6786 toll-free in the U.S. and Canada)
951-695-3080

Monday through Friday,

7 am.to 5 p.m. Pacific Time

Email: support@opto22.com

Opto 22 website: www.opto22.com

NOTE: Email messages and phone calls to Opto 22 Product Support are grouped together and answered in the order
received.

When calling for technical support, you can help us help you faster if you provide the following information to
the Product Support engineer:

A screen capture of the Help > About dialog box showing software product and version (available by
clicking Help > About in the application’s menu bar).

Opto 22 hardware part numbers or models that you're working with.
Firmware version:

- Forgroov EPIC processors and groov RIO modules: available in groov Manage by clicking Info and
Help > About.

- For SNAP controllers and brains: available in PAC Manager by clicking Tools > Inspect.
Specific error messages you received.
Version of your computer’s operating system.

For PAC Control, PAC Display, OptoOPCServer, or PAC Manager, you may be requested to provide
additional information, such as log or dump files. You can find these files in a support files sub-folder:

a. OnyourWindows Desktop, double-click the PAC Project 10.5 folder.

b. Double-click Support Files.

c.  Double-click on the appropriate shortcut to open the sub-folder containing the requested files.
Note: PAC Control, PAC Display, OptoOPCServer, and PAC Manager create appropriate sub-folders when they

create diagnostic log or dump files. If they have not created these files, the sub-folder may not exist; in this case,
the shortcut will not work.

Installing PAC Control

PAC Control is a component of the PAC Project Software Suite, a comprehensive set of software tools for
industrial automation, remote monitoring, and data acquisition projects in any line of business.
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Installation is easy and quick, and you can download PAC Project directly from the Opto 22 Support >
Downloads webpage.

The PAC Project installer includes both the Basic (free) version of the software suite, and the software for PAC
Project Professional. Click here for a comparison of PAC Project Basic and PAC Project Professional features.

To install PAC Control:
1. Download PAC Project from the Opto 22 Support > Downloads webpage.

2. Navigate to the folder where you downloaded PAC Project, and then double-click the installation file
(PAC_Project_<release number>.exe) to begin installation.

NOTE: You must have an OptoPassword to install the Professional version of PAC Control. For details, see the Opto 22
website, www.opto22.com, Support > Downloads tab, and click the link for OptoPassword (located in the text above
the Search field).

If you have trouble installing PAC Control, contact Opto 22 Product Support at 800-835-6786 (toll-free in the
U.S. and Canada) or 951-695-3080.

System Requirements

Installation Requirements

Here's what you need to install and run PAC Control. If you are using PAC Display, please see its requirements in
the PAC Display User’s Guide (form 1702).

«  Acomputer with at least the minimum processor and memory required for your version of Microsoft®
Windows®, and Ethernet capability. Additional memory and a better CPU may be required for some
configurations. We recommend staying away from low-end CPUs and using one of the following
operating systems:

—  Microsoft® Windows® 10 Professional (32-bit or 64-bit) or Windows 11 Professional

(OptoOPCServer and OptoDatalink) ® must install .NET Framework 4.0 prior to installing PAC Project on
these operating systemsNOTE: PAC Project cannot be installed on Windows XP or older Windows operating
systems. Other versions of Windows operating systems and embedded Windows operating systems are not
supported.

»  Ethernet capability

»  VGA orhigher resolution monitor. Minimum size: 800x600 with small fonts

«  Mouse or other pointing device

«  (Optional) Installed Windows printer

«  Foravailable hard disk requirements, please see the PAC Project Release Notes.
«  Compatible control engine and I/0 unit(s), as shown on page 6.

Important Note on Disk Drives

Opto 22 applications, including PAC Control, perform best when using files from a local hard disk. Network
drives may be used, but performance may suffer and depends upon the speed and reliability of the network.
While it may be possible to use other drive types, such as key chain USB drives and memory cards, their use is
not recommended. They are better suited for transferring files rather than directly accessing them.
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Using this
controller

Compatible Controllers and 1/0 Units

The following controller and 1/0 unit combinations are compatible with PAC Control Basic and PAC Control

Professional as shown.

PAC Control Basic supports these I/0 units

PAC Control Professional supports these 1/0

units

groov EPIC PR-series

SNAP PAC S-series

SNAP PAC R-series*

SoftPAC*

GRV-EPIC-PR1
SNAP-PAC-RT
SNAP-PAC-R1-B
SNAP-PAC-R1-W!
SNAP-PAC-R2
SNAP-PAC-R2-W!
SNAP-PAC-EB1
SNAP-PAC-EB1-W'
SNAP-PAC-EB2
SNAP-PAC-EB2-W'

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W!
SNAP-PAC-R2
SNAP-PAC-R2-W!
SNAP-PAC-EB1
SNAP-PAC-EB1-W'
SNAP-PAC-EB2
SNAP-PAC-EB2-W'
SNAP-PAC-SB1
SNAP-PAC-SB2

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W!
SNAP-PAC-R2
SNAP-PAC-R2-W!
SNAP-PAC-EB1
SNAP-PAC-EB1-W'
SNAP-PAC-EB2
SNAP-PAC-EB2-W'

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W!
SNAP-PAC-R2
SNAP-PAC-R2-W!
SNAP-PAC-EB1
SNAP-PAC-EB1-W'
SNAP-PAC-EB2
SNAP-PAC-EB2-W'

Generic OptoMMP device?
G4EB2

G4D32EB2
G4D32EB2-UPG

SNAP Ultimate I/0

SNAP Ethernet I/0

SNAP Simple I/0

E1and E23

Generic OptoMMP device?
G4EB2

G4D32EB2
G4D32EB2-UPG

SNAP Ultimate 1/0

SNAP Ethernet I/0

SNAP Simple I/O

E1and E23

Generic OptoMMP device?
G4EB2

G4D32EB2
G4D32EB2-UPG

SNAP Ultimate I/0

SNAP Ethernet I/0

SNAP Simple I/0

E1and E23

Generic OptoMMP device?
G4EB2

G4D32EB2
G4D32EB2-UPG

SNAP Ultimate I/O

SNAP Ethernet I/0

SNAP Simple I/O
E1andE23
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GRV-EPIC-PR1
SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W!
SNAP-PAC-R2
SNAP-PAC-R2-W'
SNAP-PAC-EB1
SNAP-PAC-EB1-W'
SNAP-PAC-EB2
SNAP-PAC-EB2-W'

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W!
SNAP-PAC-R2
SNAP-PAC-R2-W'
SNAP-PAC-EB1
SNAP-PAC-EB1-W'
SNAP-PAC-EB2
SNAP-PAC-EB2-W'
SNAP-PAC-SB1
SNAP-PAC-SB2

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W!
SNAP-PAC-R2
SNAP-PAC-R2-W'
SNAP-PAC-EB1
SNAP-PAC-EB1-W'
SNAP-PAC-EB2
SNAP-PAC-EB2-W'

SNAP-PAC-R1
SNAP-PAC-R1-B
SNAP-PAC-R1-W!
SNAP-PAC-R2
SNAP-PAC-R2-W'
SNAP-PAC-EB1
SNAP-PAC-EB1-W'
SNAP-PAC-EB2
SNAP-PAC-EB2-W'

Generic OptoMMP device?
G4EB2

G4D32EB2
G4D32EB2-UPG

SNAP Ultimate I/0

SNAP Ethernet I/0

SNAP Simple I/O

E1and E23

B3000 serial

SNAP-BRS

G4D16R, G4D32RS, G4A8R
B100 and B200

Generic OptoMMP device?
G4EB2

G4D32EB2
G4D32EB2-UPG

SNAP Ultimate I/0

SNAP Ethernet I/O

SNAP Simple I/0

E1and E23

B3000 serial

SNAP-BRS

G4D16R, G4D32RS, G4A8R
B100 and B200

Generic OptoMMP device?
G4EB2

G4D32EB2
G4D32EB2-UPG

SNAP Ultimate I/0

SNAP Ethernet I/0

SNAP Simple I/O

E1and E23

Generic OptoMMP device?
G4EB2

G4D32EB2
G4D32EB2-UPG

SNAP Ultimate I/O

SNAP Ethernet I/0

SNAP Simple I/O

E1and E23

B3000 serial

SNAP-BRS

G4D16R, G4D32RS, G4A8R
B100 and B200
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Using this PAC Control Professional supports these 1/0

controller PAC Control Basic supports these I/0 units units

1 Wired+Wireless PACs and 1/0 can be used on a wired Ethernet network or on a wireless LAN.

2 An Ethernet device with an OptoMMP memory map.
3 E1 and E2 I/O units are supported for the features available under the OptoMMP protocol only, not for all Optomunx features. For

details, see the ET and E2 User’s Guide (form 1563).
“# Note that R-series controllers and SoftPAC do not support SB-series 1/O units.
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2: PAC Control Tutorial

INTRODUCTION

In this chapter, we'll start with a sample strategy: a control application for a simple cookie factory. You'll learn
how to work with strategies, open and manipulate flowcharts, work with variables and 1/0 points, configure a
control engine, compile and download a strategy, run it in Debug mode, make an online change, and more.
The tutorial can be used with either PAC Control Basic or PAC Control Professional. (The images in the tutorial
show PAC Control Basic.)

The best way to use the tutorial is to sit down at your computer and follow it through. To start, all you need is
PAC Control, which allows you to do everything up to the point of downloading your strategy. To do the
complete tutorial you will need the controller and I/0 included in a SNAP PAC Learning Center. For more
information, go to www.opto22.com, and search for the part number SNAP-PACLC.

In This Chapter

Opening the Strategy page 9
SAVING the STFATEQY .o eeeeveseve s s sssssssssssss s page 11
Examining the Strategy page 12
Opening a Chart page 15
Opening a BlOcK ... page 17
AddING @ COMMANG ....ooorevrrreers s sssssss s sssssesssssee s page 20
Configuring @ CoNtrol ENGINE ..o page 25
Compiling the Strategy page 28
RUNNING the STrAteQY ...ooveeeveeeereevesses s sssssssns page 29
Compiling and Downloading the Change ... page 36
Using a Watch Window ..........ccccceoseeennen page 38
Closing the Strategy and Exiting page 43
WRAT'S NEXT? ..o sessssses s s ssss s page 43

OPENING THE STRATEGY

A strategy is a complete control program developed in PAC Control. Our sample strategy controls a cookie
factory. The sample strategy is described in detail on page 435, but for now, let’s just open and explore it. In
this tutorial, we'll use PAC Control Basic.
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OPENING THE STRATEGY

1. Start PAC Control.!
The PAC Control main window opens.

& PAC Control Basic - [} *
File Edit Confi Chart Subroutine Tools View Help Menu bar

D E M| ¥ @XM h e eet F|Pd

!

PAC Control: Ready MUM

2.  Onthe PAC Control toolbar, click the Open Strategy button @ .

3. Inthe Open Strategy dialog box, browse to
C\Users\Public\Public Documents\Opto 22\PAC Project\Control Basic Examples\ioCookies.

(If you're using PAC Control Pro, substitute “Control Pro Examples”for “Control Basic Examples”in the
folder location.)

4. Click Cookies.idb to select it, and then click Open to open the strategy in PAC Control.
If a File Format Change warning message is displayed, click Yes to continue.

File Format Change | ClickYes to continue.

You are about to open a strategy saved using the R%.5a
version of the PAC Control database.

If you continue, the file will be saved in the new B10.0a
version of the PAC Control database and you will not be
able to open the strategy in earlier PAC Control versions,

Do you want to continue?

The Cookies strategy opens and the PAC Control window now shows the Cookies strategy in the Strategy
Tree window. (Yours may look somewhat different.)

" In Windows, click the Windows Start button, and then click Opto 22 > PAC Control Basic 10.5 (or PAC Control
Pro 10.5).
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ﬁ PAC Control Basic - Cockies * - [Powerup]
File Edit Configure Chart Subroutine Compile

[4i Config

MBS H| % al X | A% FRImeées @ | P&

Mode Tools View Window Help

[C3) Control Engines
[C5) Subroutines Included
[ charts
= I£5) Variables
IC5) Mumeric Variables
IC5) String Variables

[C5) Pointer Variables

[E5) Communication Handles

IE5) Mumeric Tables

[C5) String Tables

[C5) Pointer Tables
[ 1/0 Units

V| IL Next 4 Prev

[od

PAC Control: Ready

Configure NUM

SAVING THE STRATEGY

Now let's save the strategy to a new name, so we can change it while leaving the original intact.
1. Inthe PAC Control menu bar, click File > Save Strategy As.

‘] Save Strategy As

Organize » MNew folder
| | Control Basic Examples ~ #
DJ FTP and Data Logging
|| InitVariables
| | 10_Enabler for Enet & PA
~ ioCookies
|___‘|J Archives
DJ OptoScript Examples
DJ Powerup Message

DJ Control Pro Examples
v

[ BT P R

+~ u <« Control Basic Examples » ioCookies

Du Archives
& Cookies.idb

*
P
@

Search ioCo..

v 0
BE -

File name:

Save as type: | PAC Control Strategy Files (*.idb)

» Hide Folders

[ save Cancel |

2.

Since each PAC Control strategy must be located in its own directory, you can't save the strategy in its

current location: you need to create a new folder for the new strategy.

a.
Basic Examples directory.

b.
The new folder appears in the list.

In the Save Strategy As dialog box, click the Up One Level button (¥ to move up to the Control

Right-click the mouse anywhere in the subfolders pane. In the pop-up menu, click New > Folder.
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o, Save Strategy As

£ v « PAC Project... » Controd Basic Examples v O
Organize = Mew folder IE ~
Hypery & FTP and Data Logging
Opto 22 InitVariables
PAC Proj 10_Enabler for Enet & PAC Brains
PAC Proj ioCookies

OptoSeript Examples

Cont
= Powerup Message
FTPa
o
File pame:
Save as type: | PAC Control Strategy Files (.idb)
A Hide Folders Cancel

c. Type My Cookies to replace rename the folder.
d. Double-click the folder to open it.

e. Inthe File name field, type Cookies.

The dialog box now looks like this:

4, Seve Strategy A x
= * 4 [ w Control Basi. » My Coolies v @ Search My Cookies )
Organize »  Mew folder G

PAC Project ™ Narme Date modified Type
Centrol Ba
FTPand |
InitVarish
10_Ensbl

wlookie

My Cook

v < 3

File pame: | Coakoed v
Save as type: | PAC Control Strateqgy Files ("idk) w

A Hide Folders Cancel

f.  Click Save.
Your new strategy is saved in the My Cookies directory.

EXAMINING THE STRATEGY

Briefly, our cookie factory consists of:

«  Atankof pre-mixed cookie dough

«  Atankof chocolate chips

+ Anoven

«  Avisual inspection station

«  Aconveyor belt

«  Compressed air to blow rejected cookies off the belt

12 PAC Control User’s Guide, Legacy Edition
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Conveyor
belt  _—push To Start

START I

Oven Inspection station

The process starts when a ball of dough drops from the dough tank onto the belt. The conveyor belt moves
the dough ball under the chip tank to receive some chips, and then it moves the dough into the oven to bake.
The next stop is an inspection, where rejected cookies are blown off the belt and good cookies move along to
shipping. Should anything go wrong, we also have some built-in alarms to stop the process.

The best way to see all the components of the strategy is to look at the Strategy Tree.

The Strategy Tree Window

To configure and run a strategy, you must leave the Strategy Tree window open—if you close the Strategy
Tree window, the strategy closes, too.

To expand a folder in the Strategy Tree, click the plus sign; click the minus sign to collapse the folder.

To move the Strategy Tree window, click and drag title bar. To minimize, maximize, or dock it, click the buttons
in title bar. To resize the window, drag any edge.

Title bar —————— |Cookies < n
] Cookies The Strategy Tree window
[C3) Control Engines
Clickthe minus sign I Subroutines Induded

to collapse a foldet = () Char
= l?o Alarms
l?o Dough_Chip_Control T This Strategy has five
2] l?o Dough_Vessel_Pressure_Control charts
(2] l?o Oven_Inspection_Control
2] l?o Powerup
= 5 Variables
@ [E3) Mumeric Variables
IC5) String Variables
[C5) Painter Variables
[ Communication Handles
[E5) Mumeric Tables

. . [C5) String Tables
Click the plus sign & i

to expand a folder 3 1/0 Units

] one o

Expanding the folders in the Strategy Tree reveals that the strategy includes five flowcharts (in the Charts
folder), eight Numeric Variables, and one Mixed I/0 Unit (with both analog and digital points). The Strategy
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Tree not only shows you all components of the strategy but it also provides shortcuts to many common PAC
Control activities, such as opening flowcharts, adding new variables, and configuring points.

Docking the Strategy Tree

Since the Strategy Tree is so useful, you'll probably want to keep it visible while you create and debug your
strategy. To keep the Strategy Tree window visible, you can dock it in a separate frame.

1. Clickthe docking button [ in the upper-right corner of the Strategy Tree window.
The Strategy Tree moves into its own frame at the left side of the main window.

# PAC Control Basic - Cookies - a x
File Edit Configure Chart Subroutine Compile Mode Tooks View Window Help

T © o W el X AR v me e e P

# Ty Dough_Vessel_Pressure_Control
@ By Oven_tnspecton_Control
2, Powenp
& 3 Veriables
@ I3 Numeric Vaniables
) String Variables
() Pointer Variables
I3 Commurscation Handies
I Numeric Tables
£ String Tables
[ Ponter Tables
& £ ounits

[ ] BNt GPw

C:\Users\Public\Documents\Opto 22\PAC Project 9.68\Control Basic Examples\My Cookies\Cookies.idb Configure NUM

2. Tochange the width of the Strategy Tree's frame, move your mouse over the right side of the frame.
When the pointer changes to the Windows Splitter icon >, click and then drag the side to make the
frame wider or narrower.

Using Quick Find

The quick find tool at the bottom of the Strategy Tree helps you to find items quickly in the tree.
Use the Next and Prev buttons (or F3 and Shift+F3) to find multiple matches. Any partial match will work.
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P Cookics O [= [ )
- o

I3) Centrol Engines

|5 Subroutines Induded
1) Charts
I Variables
Quick find tool [ 1/o nits Use the Next and Previous buttons to
1 find the next or previous instance of
your Quick Find search

D ] Oned g Fre

For example, if you enter the word, “setpoint,”when you click Next, the first match is found.

¥ cookies © [ [ & [nSnl

7 [ Numeric Variables A
[1g] bStartFlag

Iz

ﬁ%& dtCookieMotionTimer

Match 228 oughPressureSetpoint

FLT

@ fRampValue
@ fSetpointMinusDeadband
@ nChartstatus

(& nonakieMationPreset

£ >
Em T

L

When you click Next again, the next match is found.

OPENING A CHART

Every control process can be planned and mapped out using one or several PAC Control flowcharts, or charts.

Because flowcharts are easy to follow, PAC Control strategies are easy to understand.

For an example, let's take a look at the Dough_Chip_Control chart.

1. With the Charts folder expanded, double-click the Dough_Chip_Control chart name on the Strategy
Tree. (You can also open a chart by clicking Chart > Open in the PAC Control menu bar, and then
double-clicking the chart name.)

The chart appears somewhere in the large frame of the main window.
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4 PAC Control Basic - Cookies - m} X
File Edit Config Chart  Sut i Compile Mode Tools View Window Help [;Aaélmlze
= — _ _ utton
M © W an X (A 0B00es als s
Cookies < n
= &) Cookies ~
@ ) Control Engines
(3 Subroutines Induded = 2
& Charts This chart drops the dough and chips on the conveyor belt.
B e The belt must be running between 50% and 65% of max rpm.
@ T Deugh_Chip_Control The Powerup chart starts
® Ty Dough_Vessel_Press this chart.
[ % Oven_Inspection_Cc
= ) Variables
= ) Numeric Variables
HEl bstartrlag
o )
% RG] This chart runs
Fir fDoughPressure continuously once the
54 fRampvalue program has been started.
B3 fsetpointMinusD
2] nchartstatus
£ nCooldeMoton A AT [P\ chart /
H&l nLoopCounter v
< >
ot Gre |8 ownowow |
PAC Control: Ready Config NUM

2. (lickand drag the title bar of the chart window if necessary to see the Maximize button at the upper
right. Click the Maximize button to make the chart fully fit the frame.
Note the tabs at the bottom of the main window; the white tab tells you you're viewing a chart, and the
gray tab shows the chart’s name.

‘: PAC Control Basic - Cookies - [Dough_Chip_Control] — (] X
ﬂ File Edit Config Chart  Subrouti Compile Mode Tools View Window Help - & x
T © 5 4 X (a0 0e il
Cookies o3 x | A~
B &) Cookies ~ This chart drops the dough and chips on the conveyor belt.
& (&) Control Engines The belt must be running between 50% and 65% of max rpm.
G Subroutes Th hart starts ]
- e Powerup chart s
W Certs this chart.
® ?@ Alarms
@ T Dough_Chip_Control
@ T, Dough_vessel_Press
@ T Oven_Inspection_Cc
® T Powerup
& [ Variables
= ) Numeric Variables This chart runs
[ bstartFlag continuously once the
34 ¢ -l program has been started.
ﬁ fDoughPressure
54 fRampvalue Drop the dough.
. ] intMinusD
White tab shows iy fse“"';hm | 5
thisisachart.  — —n 03 o | < >
H&l nLoopCounter ¥ (shortauts | 85%
< > 44T >N chart /
Gray tab shows T ETRIETR
& g
chart name. ————~—S-Net—G-Prv—HE—  Dough Chp_Corirl
PAC Control: Ready Config NUM
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PAC Control Blocks and Connections

Let's take a closer look at what this chart does. Even without its descriptive comments, it's easy to see that this
program segment begins by starting a conveyor belt. If the belt isn't running at the correct speed, the process
goes into a loop until the speed is correct. When it is correct, dough is dropped on the belt, and then chips are
dropped on the dough. The process then loops back to re-evaluate the conveyor speed, waiting if it's
incorrect, and dropping more dough and chips if it's correct.

The rectangular-shaped blocks are called action blocks. They do things.
The diamond-shaped blocks are condition blocks. They decide things.

Charts may also contain other blocks, including oval-shaped continue blocks, which route the program logic
back to another block in the same chart, and hexagon-shaped script blocks, which contain instructions and
logic written in PAC Control's built-in OptoScript programming language.

Connections link the blocks together and show how the program logic flows. Action blocks exit through just
one connection, since they always go in one direction. Condition blocks exit through two connections, one for
a true evaluation and the other for a false evaluation.

Action Block tool

OptoScript Block tool
Tind tool iondition Block tool
84 a7 = Compile View £ Compile All
| 2 | § i'lr? ? T 1J | & comp p
£ Pan tool | Text tool
J elect tool Connect tool
ind and replace tool  Continue Block tool

This chart drops the dough and chips on the conveyor belt.
The belt must be running between 50% and 65% of max rpm.

The Powerup chart starts Start
this chart.

Action Block

Connections OptoScript Block

7
Start
eyor
This chart runs

continuously once the
program has been started.

Condition Block

Text Drop the dough.
op Dough
x Drop the chips.
Drop Chips

OPENING A BLOCK

Let's see what's in a block.
1. Double-click the Drop Dough block.
The Instructions dialog box appears.
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18

i Instructions - Dough_Chip_Control - Drop Dough - Block 3 *

For animaticn in ioDisplay

Move

From nCookieMotionPreset | Modify...
To dtCookieMotionTimer
Delete

Open the dough valve.
Turn On Mext Block
doDoughDispenseValve
Previous Block
Keep the dough valve open for 2 seconds. '
Delay (Sec)
2.0

Close the dough valve.
Turn Off
doDoughDispenseValve

Close Help Command Help

This block contains four instructions: Move, Turn On, Delay (Sec), and Turn Off. Each one has a description
above it.

Double-click the Turn On instruction to see more about it. (You could also click it once and click Modify).
The Edit Instruction dialog box for the Turn On command appears.

& Edit Instruction *

Instruction:
v| | Select..

Comment:

| Open the dough valve.

Type Mame

Digital Output w | | doDoughDispenseValve v |

. Cancel Help | Command Help

Here we see the details of the command: it turns on doDoughDispenseValve (the digital output point for
the dough dispensing valve). In other words, it opens the valve.

Close the Edit Instruction dialog box by clicking OK or Cancel.
Close the Instructions dialog box by clicking Close or by pressing Esc (the Escape key).

Add a New Block and a New Connection

Before we leave the Dough_Chip_Control chart, let's make a cosmetic change. We noted earlier that we didn't
have any continue blocks in this chart. Let's add one to replace the long connection that loops from the Drop
Chips block up to the Speed OK? block.

1.
2,

Delete the existing long connection line by clicking it to select it, and then pressing the Delete key.
Now click the Continue Block tool '@ ' in the toolbar.

When you bring the mouse back into the chart area, an oval outline appears, representing the new
continue block.

Position the oval below the Drop Chips block, and then click the mouse.
A continue block appears with the default name Block (and the block number).
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4. If you move the mouse pointer again, a new oval outline follows. Deactivate the Continue Block tool by
right-clicking the mouse, or by pressing Esc.

Your screen should now look something like this:

{J
The Powerup chart starts Start
this chart.
1w
Start
( Conveyar >
g
This chart runs
continuously once the Speed OK?
program has been started.
T
d Drop the dough.
Drop Dough
i Drop the chips.
Drop Chips
18
v
< ¥
(i) Shortcuts | B4% w
[AT- TR chart £

5. Connect the Drop Chips block to the continue block:
a. C(lickthe Connecttool t .
b. Clickonce in the Drop Chips block.

NOTE: When using connections, always click first in the block that the connection is coming from.

6. If you move your pointer around the screen, you see a connection following the pointer. Click the top of
the continue block to complete the connection. Deactivate the Connect tool by right-clicking the mouse
button or by pressing Esc.

Rename a Block

Let's rename the continue block.

1. Click the continue block to select it.

2. Right-click the continue block and select Name from its pop-up menu.
The Name Block dialog box appears.

& Name Block *
| oK |

Cancel

Help

3. Type Back to ‘Speed OK?’ overthe selected text,and then click OK.
The chart now looks something like this:
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& Dough_Chip_Control* El

This chart drops the dough and chips on the conveyor belt.
The belt must be running between 50% and 65% of max rpm.

g
The Powerup chart starts
“"s cnan.

7
/7 sa L
| Conveyor |

This chart runs
continuously once the
program has been started.

Drop the dough.

Drop the chips.

v
< >

(i)Shortcuts | 84% v

4[4[ TR\ Chart /

Select a Continue Block’'s Destination

Now let's give the continue block its instructions.
1. Double-click the continue block to see a list of all the blocks in the chart.

ﬁ Select Continue Block Destination *
S
Block Id: Mame Type
7 Drop Chips Action
5 Drop Dough Action
2 Speed OK? Condition
a Start Action
17 Start Conveyor OptoScript

Cancel telp

2. (lickthe Speed OK? block to select it, and then click OK.

When the program reaches the continue block, it returns to the Speed OK? block. We haven't changed
the way the program works; we've just done the same thing in a different way.

Continue blocks are useful in a complex chart to avoid crossing connection lines.

ADDING A COMMAND

Now we're going to add a command (also called an “instruction”) to a block in the Dough_Chip_Control chart.
This command will keep track of the number of cookies we produce.

NOTE: To enable legacy commands in PAC Control for a specific strategy, see "L egacy Options”on page 234.

1. Double-click the Drop Dough block.

20 PAC Control User’s Guide, Legacy Edition



CHAPTER 2: PAC CONTROL TUTORIAL

i Instructions - Dough_Chip_Control - Drop Dough - Block 3 *

For animaticn in ioDisplay

Move

From nCookieMotionPreset | Modify...
To dtCookieMotionTimer
Delete

Open the dough valve.
Turn On Mext Block
doDoughDispenseValve
Previous Block
Keep the dough valve open for 2 seconds. '
Delay (Sec)
2.0

Close the dough valve.
Turn Off

doDoughDispenseValve

Close Help Command Help

2.  We'll add the new instruction (command) between the Turn On and Delay (Sec) commands.
a. (lickanywhere on Delay (Sec) to highlight this command.

TIP: The highlighted area indicates the position where the next command is added,

b. Click Add to open the Add Instruction dialog box.

& Add Instruction X
Instruction:
solute Value w Select...
Comment:
~
Type Mame
of | All valid Types v| | bChipDispenseValve v|
Put Resultin | All valid Types - | | bChipDispenseValve w |

. Cancel Help | Command Help

Finding Commands in the Instructions Dialog Box. There are several ways to find commands.

«  If you know the exact name of the command you want, you can start typing it as soon as you open the
Instructions dialog box. (Don't worry about typing over the Absolute Value command—it
appears in the Instruction field only because it's the first command in the alphabetical list of commands).
As you type, the first command matching the letters you have typed is filled in automatically. As you
continue typing, PAC Control displays the next matching command. When you see the command you
want, press Enter or click the Add button to add it to the block.

For example, if you want to create a Move command:

m Make Integer 64
mo Modulo
mov Move
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«  Oneway to add a command is to click the Instruction drop-down list, and then scroll through the list of
commands to find the one you want.

Athird way to add a command is the one we'll use now.
3. Inthe Add Instruction dialog box, click Select.

4 Select Instruction *
Groups: Instructions:

Anialog Point ~ "
Chart Add

Communication Arccosine

Control Engine Arcsine

Deprecated Arctangent

Digital Point Clamp Float Table Element

Error Handling Clamp Float Variable

IO Unit Clamp Integer 32 Table Element

IO Unit - Event Message Clamp Integer 32 Variable

IO Unit - Memory Map Complement

IO Unit - Scratch Pad Cosine

Logical Decrement Variable

Divide

Miscellaneous Generate Random Mumber

PID - Ethernet Hyperbuolic Cosine

Pointers - Hyperbaolic Sine v
Siru datinn Hunarhnlic Tannant

Cancel Help Command Help

Command groups are listed on the left, and commands in the highlighted group are listed on the right.
4. The command we want will increase a counter. Counting sounds like math, so let’s try the Mathematical
group.

Click Mathematical on the left to highlight it, then scroll through the list on the right until you find the
Increment Variable command.Clickitonce.

4 Select Instruction *
Groups: Instructions:

Analog Point | | Absolute Value -
Chart Add

Communication Arccosine

Control Engine Arcsine

Deprecated Arctangent

Digital Point Clamp Float Table Element

Error Handling Clamp Float Variable

IO Unit Clamp Integer 32 Table Element

IO Unit - Event Message Clamp Integer 32 Variable

IO Unit - Memory Map Complement

IO Unit - Scratch Pad Cosine

Logical Decrement Variable

ﬁm— Divide

Miscellaneous Generate Random Mumber

PID - Ethernet Hyperbuolic Cosine

Pointers Hyperbuolic Sine

Simulation Hyperbolic Tangent

Strng T
Time/Date o Maximum 1,
Timinn Miniirmu irm

Cancel Help Command Help

NOTE: If you need information about a command, click the Command Help button.

5. Click OK, and this command is displayed in Instruction filed of the Add Instruction dialog box.

The cursor is automatically moved to the next field, which is Comment. Comments are optional but very
useful; they can help someone else understand the purpose of the instruction.

6. Inthe Commentfield, type Increment a counter of cookies produced.
7. Next, click the Type drop-down list (the field that currently reads “All Valid Types”).

This list shows what those valid types are: a float variable, an integer 32 variable, and an integer 64
variable.
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Counters are integers, so select Integer 32 Variable.
Now we're going to create the integer 32 variable to increment, which will be called nCookie_Counter.
a. Clickthe Name down-down list (the field that currently reads “bStartFlag”).

The drop-down list shows all variables currently configured as integer 32 variables:

& Add Instruction *

Instruction:
| Increment Variable w Select...

Comment:

| Increment a counter of cookies produced

Type Mame
Integer 32 Variable w |
nChartStatus
nCoockieMotionPreset
nLoopCounter

Cancel Help Command Help

nCookie_Counter is not in the list, because we haven't created it. We'll create it now using what we
call “on-the-fly configuration.”

b. C(lick bstartFlag toselectit, and then type the new variable name right over it:
nCookie Counter

c. Click OKto close the dialog box, and the following message appears.

PAC Control Basic *

The object you have specified does not exist,
Do you wish to add it now?

Yes Mo Cancel

d. ClickYesto create the new nCookie_Counter variable.
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Notice that the name and type have already been filled in.

Add Variable
MName: Cookie Counter:
Description:
Type: Integer 32 e
Initialization

(O Initialize on strategy download
(® Initialize on strategy run
O Persistent

Initial Value: | 0

Public Access (Optional)

# Public Access Attribute Representations

Add
Modify

Remove

Cancel Help

e. Add adescription, if you wish. Leave the initial value at zero, which is the default, and don't make
any changes in the Public Access pane. (If you're curious, Public Access makes your tags accessible to
other programs, such as Inductive Automation’s® Ignition® SCADA software.)

f.  Click OK to save your changes and close the dialog box.

In the Add Instruction dialog box, click OK to close it.
The new instruction appears in the Drop Dough Instructions dialog box.

‘ Instructions - Dough_Chip_Control - Drop Dough - Block 3

For animatien in icDisplay

Move
From nCookieMotionPreset
To dtCookieMotionTimer

Open the dough valve.
Turn On
doDoughDispenseValve

Increment a counter of cookies produced
Increment Variable

nCookie_Counter
Keep the dough valve open for 2 seconds.
Delay (Sec)

2.0

Close the dough valve.

Close Help Command Help

*

Add...

Delete

Mext Block

| Previous Blodk

But maybe it makes more sense to start the counter at the beginning of the process, rather than in the

middle, after some dough has already been dropped. Let's change it.
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10. With the Increment Variable command highlighted, right-click to display the pop-up menu, and then
click Cut. (You can also use Ctrl+X to cut.) Cutting puts the instruction in the Windows Clipboard.

11. Now click Turn On to highlight it. Right-click to display the pop-up menu, and then click Paste.
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You can also use Ctrl+V to paste. The Increment Variable command is pasted above the highlighted
instruction, like this:

ﬁ Instructions - Dough_Chip_Control - Drop Dough - Block 3 *
For animation in ioDisplay - Add...
Move

From nCookieMotionPreset | Modify...
To dtCookieMotionTimer

Delete

Increment a counter of cookies produced

Increment Variable Mext Block
nCookie_Counter
| Previous Blodk

Open the dough valve.
Turn On
doDoughDispenseValve

Keep the dough valve open for 2 seconds.

Delay (Sec)
2.0
Close the dough valve. w
Close Help Command Help

12. Click Close to return to the chart.
13. To save the changes you've made, click the Save Strategy button [gl on the toolbar, and then click OK.
14. Take a look at your new variable in the Strategy Tree:

- Ifthe Variables folder is collapsed, click plus sign to expand it.

- If the Numeric Variables folder is collapsed, click the minus sign to expand it.

Your new nCookie_Counter variable should be in the list in alphabetical order.

Congratulations! You've just added a cookie counter variable. Now we're ready to download the strategy to a
control engine. But first we have to tell PAC Control that about our control engine.

CONFIGURING A CONTROL ENGINE

Up to this point, we've been able to play around in PAC Control without hardware. Now it's time to configure a
control engine (a controller).

1. If you have a PAC Control-compatible controller and /O unit that you can use for this tutorial, make sure
they are on the same network as your PC, and make sure you have loaded the most recent firmware.

For a list of compatible controllers and I/0 units, see page 6. For instructions to load firmware, see the
PAC Manager User’s Guide (form 1704).

2. Double-click the Control Engines folder on the Strategy Tree, or select Configure > Control Engines.
The Configure Control Engines dialog box appears.

Configure Control Engines X
Active Engine:
Engines Assodated with Strategy:
Set Active
Add...
Modify...
Delete
Download Cptions...
Concel | [ rio
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CONFIGURING A CONTROL ENGINE

Since we haven't configured a control engine yet, there are no control engines in the list.
3. (lick Add.

If PAC Control is on a network that has configured controllers, you'll see them in the list. Otherwise, the
list will be empty.

Select Control Engine

Configured Control Engines:

~ Add...
Modify...

Delete

4. C(lick Add again to add a control engine.
The Control Engine Configuration dialog box appears.

Control Engine Configuration x

Configure Ethemet Connection

Configure control engine name and parameters:

Control Engine Name: ||

System Type
(®) Standard
(O Redundant Networks (PRO enly)
(O Redundant Controllers (PRO only)

Settings
IP Address/Hostname: [0.0.0.0
Controller Port: | 22001
Software Retries: l:l

Software Timeout: mSEc

Cancel

5. Enter Cookie Controller as the control engine name.

The name can contain letters, numbers, spaces, and most other characters except colons and square
brackets. Spaces cannot be used as first or last characters.

6. Under System Type, make sure Standard is selected.
7. Enterthe control engine’s IP address.

On hardware such as a SNAP PAC R-series controller, the IP address is usually written on a sticker on the
side of the unit. If an IP address has not been assigned to the control engine, see the PAC Manager User’s
Guide (form 1704), for configuration instructions.

If you're using a SoftPAC™ computer-based controller:
a. Use the loopback IP address—127.0.0.1—if PAC Control and SoftPAC are on the same PC.

26 PAC Control User’s Guide, Legacy Edition


http://www.opto22.com/site/documents/drilldown.aspx?aid=3161
http://www.opto22.com/site/documents/drilldown.aspx?aid=3161

CHAPTER 2: PAC CONTROL TUTORIAL

b. If SoftPAC is not on the same computer as PAC Control, use the IP address of the NIC card on the PC
running SoftPAC. NOTE: The SoftPAC PC’s NIC must be configured with a static IP address.

NOTE: In PAC Control Professional, a second IP address field is available, so you can designate a secondary
communication path to the control engine should the primary one fail. For more information, see “Creating
Redundant Ethernet Links in PAC Control” on page 104.

Make sure that you have not changed the values in the Port, Retries, and Timeout fields, and then click
OK.

The newly configured control engine appears in the Select Control Engine dialog box.

Select Control Engine

Configured Control Engines:

Cookie Controller

oK Cancel

9. Make sure the new Cookie Controller control engine is selected (highlighted), and then click OK.

The new control engine appears in the Configure Control Engines dialog box.

Configure Control Engines x

Active Engine:
Cookie Controller

Engines Assodated with Strategy:

okie Controller Set Active

Modify...
Delete

Download Options...

OK Cancel Help

If you have only one configured control engine at this point, it is automatically set as the active control
engine (that is, the control engine that will run the strategy). If there were more than one control engine
associated with your strategy, you would select the control engine you want, and then click Set Active to
load it into the Active Engine field.

10. Click OK to close the Configure Control Engines dialog box.

In the Strategy Tree, the new control engine appears as the first entry in the Control Engines folder.
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COMPILING THE STRATEGY

The simplest way to compile a strategy is to enter Debug mode. The strategy is saved and compiled before
changing modes.

NOTE: The remainder of the tutorial is designed to work with the controller and I/O on a SNAP PAC Learning Center.
For more information, go to www.opto22.com and search for the part number, SNAP-PACLC.

1. Click the Debug mode button on the toolbar (or in the menu bar, click Mode > Debug).
In the Save Strategy dialog box, click Yes to save the strategy.

& save Strategy - *

Changes have been made to the strategy. Do you
want to save the strategy before starting the

debugger?
Yes Click "Yes” to save the strategy
and start the debugger.
c | Click "Cancel” to dose this
kit window and not start the
debugger.

2. Yesor OKfor any other message you may see, for example:

Download Warning

I'\ Strategy Mismatch
-l

The strategy to be downloaded does not match the strategy already in the control engine.
Strategy To Download
" Name: Cookies

¥ Checksum: BD2D3CCCOCESBD176B26971C99730CCD
Timestamp: 05/11/18 16:55:27

Strategy in the Controller —

MName: Cookies
Checksum: B1F43943C2D68495410EASOBEC42D537
Timestamp: 05/09/18 10:19:07

If you choose to continue, the strategy that is in the control engine will be replaced by this strategy.

Do you want to continue the download?

PAC Control Basic *

o Powerup Clear Expected returned from control engine.

PAC Control Basic

o The control engine’s memory has been cleared,

Do you wish to continue downloading this strategy?
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Two additional dialog boxes appear. The first dialog displays the progress as the strategy is compiled. The
second dialog shows progress as the strategy is downloaded to the control engine.

4 Strategy Download *

-&. Downloading your strategy
v

Cancel

Assuming the strategy was compiled and downloaded successfully, you are now in Debug mode. (Note
that the strategy isn't running quite yet.)

In the PAC Control window, you'll notice that the Debug toolbar is now available. The mode is shown at
the bottom of the main window. The open chart window shows that the strategy is stopped, as shown in
the following figure:

Debug toolbar

butt ﬁ PAC Control Basic - Cockies [DEBUG] - [Dough_Chip_Control] — O *
uttons E—

WHgine Debug Chart Subroutine Mode Tools View Watch Window Help -8 %
i coniig =1 0evus - o (Y IR

- This chart drops the dough and chips on the conveyor belt.
o O Cookies The belt must be running between 50% and 65% of max rpm.
[C3) Control Engines
[C Subroutines Induded The Powerup chart starts . S
& [ Charts this chart.
= IC5) Variables
[C5) Mumeric Variables
[C3) String Variables 2 Start
IC5) Painter Variables Conveyor

[C5) Communication Handles
[C5) Mumeric Tables
[C5) String Tables
[C5) Pointer Tables
[ 1/0 Urits

This chart runs
continuously once the
program has been started.

Drop the dough.
Drop Dough
7 Drop the chips.
Drop Chips
Strategy status -_  . . z
] T I — Oorars [ ]
AL E ] #I, Chart / Mode
ONet @Pev Mgy poun cip Conl |
PAC Control: Ready Debug NUM

RUNNING THE STRATEGY

In Debug mode, we're going to run our strategy and examine it to see how running a strategy affects variables,
command blocks, and so on. The first chart to run in any strategy is the Powerup chart, so we'll ook at it first.

1. Inthe Strategy Tree, expand the Charts folder and then double-click Powerup. When the Powerup chart
opens, notice that the PAC Control window shows its status as Stopped.

2. Clickthe Run Strategy button p .°
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You may briefly see a progress window. In the strategy Status area (at the bottom of the chart window),
the word Stopped changes to Running. Let's try pausing the program to see where we are.

Click the Pause Chart button [1 . (If the Pause Chart button is grayed out, click anywhere in the Powerup
chart to activate the Debug toolbar, and then click the button.)

4 PAC Control Basic - Cookies [DEBUG] - [Powerup] - m] X
%File Edit Control Engine Debug Chart Subroutine Mode Tools View Watch Window Help - ||
51 Config =8 Debug 1 0o [RETSIESN AN TRNUIN AU RIS
: °@m «
= 2 Cookies

@# () Control Engines
(3) Subroutines Induded
# ) Charts
= =) Variables
@ () Numeric Variables This chart starts the program and all other charts.
[ String Variables
(= Pointer Variables
() Communication Handles

) Numeric Tables

) String Tables ) ) )

) Pointer Tables Wait until start flag is set
& () 1/0 Units true (non-zero).

O Start the alarm monitoring,
StartCharts | dough/chip control, pressure
control, and ovenlinspection

charts.
v
>
/—
vl & &
T Nett  Prev & o |
PAC Control: Ready Debug NUM

The hatch marks on the Start? block indicate that this command block was about to be executed when
we clicked Pause. Apparently the program isn't getting past this block. Notice that the False exit routes
right back to the top of the Start? block, while the True exit moves on to Start Charts. We can see that if
the start flag had been true (non-zero), the program would have gone right into the Start Charts block.
Since we didn't get that far, the start flag must be zero.

And infact it is. We planned it that way because we wanted someone (for example, a factory operator) to
start the process intentionally. We can simulate this ourselves in PAC Control by manually setting the flag
to a non-zero value.

In the Strategy Tree, expand the Numeric Variables folder, and then double-click the bStartFlag variable.
The View Variable dialog box appears.

*'2 "hStartFlag” (scanning) *

value: [0 | @@ -—Maximize button

In this box, you can view the variable’s value, but you can't change it until you maximize the dialog box.
Click the Maximize button. This dialog box displays current information about bStartFlag. You can see

that the variable has a value of 0 (zero), and you would be correct to think its value is initialized to 0 on
strategy download.

2If “Error"is displayed in the status bar (and the bottom of the PAC Control window), click it to open the PAC Message
Viewer. Then, use the messages to figure out and resolve the problem. Remember: This part of the tutorial assumes
you have a SNAP PAC Learning Center (or that you've configured a controller and I/O unit that can run the example strat-
egy).
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't "bStartFlag” (scanning) e

Mame: bStartFlag

Value: | [v]

Apply Watch DEC » {i1More Info (=l

Highlight 0 in the dialog box, and then type 1 to replace it. The field turns purple, indicating a change has
been made but not implemented.

\& "bStartFlag" (NOT SCANNING) X

Mame: bStartFlag

Watch DEC » {F)More Info = ——Minimize button

Click Apply to implement the change. Then, minimize the View Variable dialog box and move it out of
the way.

Inspecting Messages

The status bar in the main PAC Control window tells you when an information, warning, or error message has
been placed in the message queue. Messages can help in troubleshooting your strategy.

1.

2.

Click the light-blue [TMFR box in the status bar at the bottom of the window. If you don't see the
INFD  box, click Control Engine > Messages to view the View Message Queue dialog box.

In this example, the message tells you that the I/O unit has powered up.

& View Message Queue for Cookie Controller at 10.20.30.40 - O *
2 Refresh | 53 Copy All | = * Pop Top Message | < Clear All Messages

# Code Severity Description Chart Block Line  Object Time Date

o -4 Info Device has powered up (Po... =system_.. N/A MiA Mixed ... 1313 05/11H18

Close the dialog box to return to the Powerup chart.

Stepping Through the Chart

Now let's step through the chart to control when instructions are executed and see what happens.

1.

Click inside the Powerup chart to activate the Debug toolbar, and then click the Step Over button T .
The hatch marks move from Start? to Start Charts. We've just moved (stepped) to the next block.
Click the Step Over button again.

PAC Control executes the Start Charts block and steps to the next command block. Since there are no
more blocks in this chart, we are actually exiting this chart and moving on to new instructions in another
chart. The Powerup chart has stopped, and you can see the word Stopped at the bottom left of the chart.
In the View Variable dialog box, the bStartFlag value reverts to zero, because the Start Charts block set the
flag back to zero.

Close the bStartFlag View Variable dialog box. Click the Powerup chart window to activate the Debug
toolbar, and then click the Pause Chart button to turn stepping off. (Note that the Strategy Status
indicators show “Step Off.")
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Now, close the Powerup chart (Chart > Close), and then double-click the Charts folder on the Strategy
Tree.

The View Chart Status dialog box appears. This dialog box shows us all the charts in our strategy. As you
can see, four of the charts are running, and one (Powerup) is stopped.

*' View Chart Status - *
Mame Status Mode Breakpoint Status Paused At

Alarms Running Step Off Break Off

Dough_Chip_Control  Running Step Off Break Off

Dough_Vessel_Pre... Running Step Off Break Off

Oven_Inspection_,.. Running Step OFf Break Off

Powerup Stopped Step Off Break Off

Powerup is stopped because it has already done its job. Let's check the running charts.

Close the View Chart Status dialog box and click inside the Dough_Chip_Control chart again.

If your mouse has a wheel, hold down the Ctrl key and move the mouse wheel up or down to change the
zoom.

If your mouse doesn't have a wheel, there are several other ways to zoom out, too. You can right-click the
chart and select Zoom from the pop-up menu. You can select Zoom Out from the View menu. You can
press the + or - keys on the keyboard. After zooming out, the chart looks something like this:

Tl ohartdrop & 18 dough and ahilp & on s conveyor belt
The beltmu ctbe running betwesn 50% and 85% ofmax rpm.

The Fowerup ohart shrts
#ilcohart

TG ohartruns
sonfnuou dy onoe e
program hac besn shried.

Drop s dough.

Drop s ohip &

v
>

£
|_funning | Step OFf fBreak Ot O
[T T2 Chart /

—|3?:F| Dough_Chip_Contral |

You can zoom back in if you wish by holding down the Ctrl key and moving the mouse wheel down or
one of the other methods.

The chart’s status bar indicates that it is running, but we can’t see much happening.
Click the Pause Chart button 11 .

One of the command blocks appears with hatch marks.

Now click the Step Over button [F .

The next command block is hatched.
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Continue clicking and watch how the program proceeds from Speed OK? to Drop Dough to Drop Chips
to Back to ‘Speed OK?"and back up to Speed OK?

A pulsating green border appears around a block when the commands inside the block are being
executed. While you are stepping through, and anytime the Pause Chart button is clicked, the chart
status indicates Step On.

Click the Pause Chart button again to run the strategy at full speed.
Step Off now appears in the chart status bar.

Auto Stepping

The final stepping option is auto stepping. You can select this option whether or not the chart is currently
paused.

1.

3.

Click the Auto Step Chart button & and watch the program move from block to block.
At one time or another, your chart looks like this:

this chart. STrt ~

Start
Conveyor

This chart runs
continuously once the
program has been started.

Drop the dough.

Tesanlosios:  Drop the chips.

"Speed OK?"

v
< ¥
[Furning [5tc0 Ao | Break 01 |_2.005 5ec_] Oshoteus [1000 9

[A[- TR chart £
—|ﬁ’l Dough_Chip_Contral |

Notice that in the PAC Control toolbar, the Run and Auto Step Chart buttons are depressed. The chart
status bar shows us the chart is running and in Step Auto mode. The time indicator to the right of Break
Off shows the time it took for the most recent block to execute.

Click the Auto Step Chart button again to end auto stepping.

Step Off appears, indicating the program is again running without interruption.
Now let's see how many cookies we've produced to this point.

On the Strategy Tree, double-click the numeric variable nCookie_Counter.

1« "nCoockie_Counter” (scanning) *

Value: |42 | =
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6.

The Value field should increase every time a cookie is produced, adding to the total number of cookies
produced since the strategy run began. The nCookie_Counter above shows this figure as 42. (Yours may
be different)

But nCookie_Counter tells us the total number of cookies put on the conveyor belt, without considering
that some of them may be rejected by the inspection station. We need to subtract the number of bad
cookies so that nCookie_Counter keeps track of the number of cookies sent out the door, not just sent to
the oven.

Close the nCookie_Counter View Variable window and click the Configure mode button on the toolbar.
Double-click the Oven_Inspection_Control chart on the Strategy Tree to open it.

The chart window looks something like this:

This chart maintains the oven temperature and rejects
cookies that do not pass visual inspection.

The Powerup chart starts St
this chart.
L 4
E = While conveyor speed
Speed Oven is out of spec, set oven
Standby »
= temperature to 200
degrees.
=
7 Set oven temperature to

450 degrees.

If inspection station sees
a bad cookie, open reject
valve for 0.5 second.

v
>

Sstorcars

€
I T T

Near the bottom of the chart, the Reject Cookie? block determines whether a bad cookie has been found.
If one has, the strategy moves to the next block, Blow Off, which is where the bad cookie gets blown off
the conveyor. When that happens, we want to decrement the nCookie_Counter variable.

Double-click the Blow Off block to open its instructions window:

ﬂ Instructions - Oven_Inspection_Control - Blow Off - Block 15 *
Reset the on-latch after it has been triggered. Step Into
Clear On-Latch

On Point dilnspectionPassFail Switch Step Over
Turn on reject valve to blow away bad cookie. Step Out
Turn On

doRejectValve Mext Block

Leave reject valve on for 2 seconds.
Delay (Sec)

Previous Blodk

20

Turn off reject valve.
Turn Off
doRejectValve

Close Help Command Help
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This command block is executed only when a bad cookie has been found. This block first resets the
on-latch triggered by the bad cookie, so that the next cookie won't be marked bad, too. The block then
turns on the reject valve. The valve stays on for two seconds before being shut off. Let's decrement the
counter after the cookie is gone and the valve is shut.

Scroll down and click the open spot below the other instructions.

The highlighted line marks the position of the next command to be added.

Click Add.
& Add Instruction X
Instruction:
Absolute Value ~ Select...
Comment:
~
Type Mame
of | All valid Types v| | aiDoughVesselPressure v|
Put Resultin | All valid Types v| | aoConveyorSpeedControl v|
v
Cancel Help Command Help

You can use PAC Control without a mouse, and to demonstrate how, we'll use only the keyboard to enter
data in this dialog box.

Type dec in the Instruction field.

The Decrement Variable command appears, since it's the first command that starts with that text pattern.
This is the command we want to use.

Press Tab twice to move to the Comment field, and (if you want to) type a comment.

Press Tab again to move to the Type field. Press the down arrow on your keyboard twice to select Integer
32 Variable.

Press Tab again to advance to the Name field, and then press the down arrow until you see
nCookie_Counter.

Press Tab again and notice that an outline appears on the OK button.
An outlined button means that pressing the space bar or Enter is equivalent to clicking the button.
Now the dialog box looks like this:

& Add Instruction *

Instruction:

| Decrement Variable ~ Select...

Comment:

| Decreases cookie count by one to account for a rejected cookie

Type Mame

Integer 32 Variable w | | nCookie_Counter ~ |

Cancel Help Command Help

Press OK.
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The dialog box closes and the new command appears in the Instructions window.

ﬁ Instructions - Oven_Inspection_Control - Blow Off - Block 15 *
Turn on reject valve to blow away bad cookie. - Add...
Turn On

doRejectValve Modify...
Leave reject valve on for 2 seconds. Delete
Delay (Sec)

20 Mext Block

Turn off reject valve. Previous Block
New command Turn Off
doRejectValve

nCookie_Counter

Close Help Command Help

15. Click Close to return to the Oven_Inspection_Control chart.

COMPILING AND DOWNLOADING THE CHANGE

Now we'll compile and download the modified strategy.

1.

Click the Debug mode button on the toolbar.
At each warning message, click Yes or OK to continue.
On the toolbar, click the Run Strategy button b .

In the Strategy Tree, double-click the bStartFlag variable. Maximize the dialog box, change the value to 1,
and then click Apply. Close the dialog box.

Click inside the Oven_Inspection_Control chart to make it the active chart, and then click the Auto Step
Chart button.

You see three blocks being processed: Speed OK?, Oven On, and Reject Cookie? The strategy doesn't
move into the Blow Off block. That's because an inspector has to flag bad cookies, but we don't have an
inspector right now. So we'll simulate what would happen by tripping the digital input that flags a bad
cookie.

In the Oven_Inspection_Control chart, click the Auto Step Chart button again to stop auto stepping.
Step Auto changes to Step Off in the status bar.

Click the Pause Chart button.

Step Off changes to Step On.

Click the Breakpoint tool &% and click once on the Blow Off block.

A red box appears around the Blow Off block, and Break On now appears in the chart status bar.
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~
The Powerup chart starts
this chart. S
v
2 ; While conveyor speed
Speed F is out of spec, set oven
0K? OvenStandby | . 1 perature to 200
degrees.
e
7 Set oven temperature to
Oven On 450 degrees.

If inspection station sees
a bad cookie, open reject
valve for 0.5 second.

Break On < I
 — Blow Off
v
< ¥
[ Funning [ Step Off J[Break 0n] ] (shoteuts 1007 v
Oven_Inspection_Control \_A_I\LM
ﬁ’l Dough_Ehip_EoW Oven_|nzpection_Control |

chart status bar.

The chart appears.
10. Click the Pause Chart button to pause the chart.

Click the right mouse button or press ESC to release the tool. Notice that Break On now appears in the

Click the Dough_Chip_Control tab at the bottom of the PAC Control main window.

-
7
Start
Conveyor
This chart runs
continuously once the
Speed OK?
program has been started. (=B
§ Drop the dough.
Drop Dough
v Drop the chips.
Drop Chips
w*w
@ack to %é
"Speed OK?™
RN NN
v
£ >
| Running || Step On [{ Break Off [  2.003 Sec. (i) Shortcuts [ 100% v
[ 122/ Chart /
—|ﬁ’l Dough_Chip_Contral ﬁ’l Oven_|nzpection_Control
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USING A WATCH WINDOW

To see clearly what we're doing, we'll create a watch window to monitor cookie production.
1. Inthe Strategy Tree, double-click nCookie_Counter.

%< "nCookieCounter” (scanning)

Walue: | 74 | =

The value is frozen at some number, such as the 74 shown above. Since the counter is no longer
increasing, we can see that cookie production has temporarily stopped.

2. (lick the Maximize icon [&] (in the lower right corner) to display the scanning options.

% NCookie_Counter” (scanning)

Mame: nCookie_Counter

Walue: | 74 |

3. (lick Watch.
The Add Watch dialog box opens.

1 Add Watch Entry

Mame: | nCookie_Counter

Select Portions To 'watch:

Walue Select &l

LClear

Select W atch Window

[ QK H Cancel ][ Help ]

4. Since there is no watch window available to select, we'll create one.
Click New.

Create New Watch Window:

Loaok in: | 125 My Cookies v| @ ? # ,
File name: | | [ Open ]
Files of bype: | PALC Contral ' atch YWindow Files [7.wth] w | [ Cancel ]
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Make sure the My Cookies directory appears in the Look in field. Type a name for the watch window in

the File name field. Then click Open.

The watch window name appears in the Add Watch dialog box, and the new watch window appears

behind it.

In the Add Watch Entry dialog box, click OK. Close the nCookie_Counter view variable dialog box.

The new watch window looks something like this:

Watch window

#1 PAC Control Professional - [nCookie_Counter]

[ | (B |

¢ File Edit ControlEngine Debug Chart Subroutine Mode Tools Wiew ‘Wabtch Window Help

Docking button

of
1

g X

Cookies

= I5) Cookies
I5) Control Engines
15 Subroutines Included
= I5) Charts
l?o Alarmz
l?o [ough_Chip_Contral
l?o Dough_Yeszel_Pressu

l?o Intermupt
l?o Oven_|nzpection_Conl
l?o Powerup
= £ Wariables
= I£5) Mumeric Yariables
2] bStartFlag

Izz

a4 diCookietotionTir—

THR

] [DoughPressureSe

FLT

] R ampialue

FLT

B 5 etpointtinusDe:

FLT

g nChartStatus
[12] 1% 1
IZZ

g nCookieCounter  w

| > 3

e o e

arne Type
nCoockie_ Counter Integer 32 Wariasbhle

IVAL
74

|w

< )
-

ﬂ’l Dough_Chip_Contral

ﬂ’l Oven_lnspection_Control | &®

nCookie_Counter

IPAC Control: Ready

Debug

UM

Since we want to be able to see chart windows as well as the watch window, let's dock the watch

window at the bottom.

In the watch window, click the docking button f&] in the upper-right corner.

The watch window moves to the bottom of the main window.

PAC Control User’s Guide, Legacy Edition



USING A WATCH WINDOW

A PAC Control Professional - [Dough_Chip_Control] |._||E|r>__<|
ﬁFile Edit Control Engine Debug Chart  Subroutine Mode Tools Wiew Watch  Window Help - | &8 x

# > mn ¥a]

This chart runs : -
= [ Cookies /1| |continuously once the ed oK?
I5) Control Engines program has been started.
15 Subroutines Included
= I5) Charts
&
Ty dlams . Do Bt Drop the dough.
EL'O [ough_Chip_Contral n
EL'O Dough_esszel_Pressu *
ELIO Itermupt v Drop the chips.
EL'O Oven_|nzpection_Conl Drop Chips
EL'O Powerup
= £ Wariables *
= gmeric\u"ariables - | ) e
12| hStartFlag
24 acscemtoronri ! || | I KN R EXEETUGTTR I 5o
< | > [\ Chart /

-

—|ﬁ| Dough_Chip_Contral |ﬁ| Oven_|nzpection_Control |

Docked watch 0 0L ot i
window Hame Type IVAL HVAL
nCoockie_ Counter Integer 32 Warishle 74
PAC Control: Ready Debug MM

Now we'll trip the latch that signals a bad cookie.

8. Onthe Strategy Tree, under the 1/0 Units folder at the bottom of the window, expand Mixed_IO_Unit by
clicking the plus sign at the left of the name.

You see a folder named Points.
9. Expand the Points folder to display the digital I/O points configured for this I/0 unit.

:« Cookies

15 Wariables ~
= £ 140 Units
= 28 Mived_I0_Unit
= [ Point Points folder

LU 4D oughLevelSwich
L diChipLevelSwitch
I“'%“_' dilrspectionPassFail3wi
L diEStop
B"’—_“,' doD oughPressureContro

B"’—_“,' doD oughDispensel alve
B"’—_“,' doChipDispenzetalve
B"’—_“,' doRejectyalve

OM_, aolvenT emperatureCol
OM_, aolonveyorSpeedContr
IM,_ aillvenT emperature
IM,_ aiD oughvesselPressure

= PiDs =

< |
-

10. Double-click dilnspectionPassFailSwitch.
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16.
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%.& "dilns pectionPassFailSwit. .. rg|

VAL XVAL: = Maximize button

In the minimized dialog box, click the Maximize button.

3% "dilns pectionPassFailSwitch® |... rg|

Mame:  dilnzpectionPassF ailSwitch

Tupe:  Digital Input (i1 More Irfo

IVl Al
State: s
On-Lateh: S
Off Latch: E

Communication

Pairit:

140 Unit: _ =1 Open Parent
5

NOTE: Don't worry if the red error message “l/O unit not configured” or XVAL values appear in this dialog box.
This occurs because the strategy is configured for sample hardware that probably doesn’t correspond to your
actual I/0 units and modules. PAC Control can't locate this hardware. That's okay for this example.

When an inspection finds a bad cookie, the on-latch attached to the 1/0 point dilnspectionPassFail Switch
is supposed to go on. We're going to trip it manually.

Click one of the arrows in the On-Latch IVAL field to change it to On. Also make sure that the Enable
comm field says No.

The dialog box should look like this:

%.& "dilnspectionPassFailSwitch™ (... rg|

Mame:  dilnzpectionPassF ailSwitch
Tupe:  Digital Input (i1 More Irfo
IWaL: HAL

On-latch On | On-Latch: S S

Communication

140 Unit: _ =1 Open Parent

[ Apply ] [ Watch ] [ Flat > ] =l
Click Apply.

The On-Latch IVAL field turns green after a second or two, indicating the latch is on.
Click Watch.
We'll add the variable to our watch window, so we can see what happens.

In the Add Watch dialog box, leave all portions checked. Click OK to add the variable to the Cookie Watch
window. Close the view point dialog box.

In the Cookie Watch window, click the plus sign next to (02) dilnspectionPassFailSwitch. (Your screen may
show only part of the words.)

Move your cursor over the right side of the Name column until the cursor changes shape. Then click and
drag the column to make it wider, until you can see all the words.
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v« Watch Window: < |:||§|rz|
Name Type
nCoockie_ Counter Integer 32 Warishle

} diInspectionPassFail... [Digital Input

Jtate
On-Latch
COff-Latch

18. Clickin the Oven_Inspection_Control chart to make it active, and move the scroll bars until you can see
the Blow Off block at the bottom.

Your window now looks something like this:

A PAC Control Professional - [Oven_Inspection_Control]
ﬁFile Edit Control Engine Debug Chart  Subroutine Mode Tools Wiew Watch  Window Help

#horm
Cookies T degrees. 7]
15 Paints \\I//
== EJHs Set oven temperature to
El Event_01 450 degrees.
%‘S‘ Mixed 0_Unit
= ) Points
LU 4D oughLevelSwitch -
L diChipLevelSwitch If inspection station sees
ar a bad cookie, open reject
10 GEStap valve for 0.5 second.
B"’—_“,' doD oughPressureControly':
B"’—_“,' doDoughDispensel alve
B"’—_“,' doChipDispenzetfalve -
B"’—_“,' doRejecty alve " < | a3 =
|
SOOI I -~ T oco 0~ Jorcok o Joos7io o1 IR
< s ||FEpp e
Ab Mext 4 Prev ﬂ’l Dough_Chip_Contral ﬂ’l Oven_lnspection_Control |

A 0 00 siotiseioiioooioioisotioosottiosditisntiisoisidioinsotintsossiistsissitosisbtaisiseisiiohisisisissobiissabiabistssabai

Type
Integer 32 Warishle 472
. [Pigital Input

Name
nCookie_ Counter

On-Latch
COff-Latch OFF OFF

C:\Program Files\Opko22\PAC Praject 8, 1%Contral Pro ExamplesiioCookies\Cookies.idb Debug L

19. Click the Step Over button as many times as it takes to get the hatch marks to the Blow Off block. Now
watch the nCookie_Counter IVAL value in the watch window as you click the button again.

A bad cookie was found, so the counter was decreased by one. At the same time, the on-latch was reset
to Off, as you can also see in the watch window.
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A PAC Control Professional - [Oven_Inspection_Control]
ﬁFile Edit Control Engine Debug Chart  Subroutine Mode Tools Wiew Watch  Window Help - 8 x

[ coniig =Y pebug 0 1< IS IETIACIN TR R

Oven Standby TS OUToTSpec, Set 0
& Port = temperature to 20'
=y E?:SS u degrees.
1
fig Event 01 7 Set oven temperature to

2 Mived_|O_Urit e
= 15 Paints
LU 4D oughLevelSwitch
L diChipLevelSwitch
I“'%“_' dilnzpectionP azsF ailSwitch
L diEStop
B"’—_“,' doD oughPressureControly':
B"’—_“,' doDoughDispensel alve
B"’—_“,' doChipDispenzetfalve
B"’—_“,' doRejecty alve "

< - | 3
= aolvenTemperatureContre
T e =
A anlnrweunineedtantinl ¥ l:l Break D [#39719 813 Sec EREIEERS
< | T I 3 3 N
Ab Mext 4 Prev ﬂ’l Dough_Chip_Contral |ﬁ| Oven_lnspection_Control

450 degrees.

If inspection station sees
a bad cookie, open reject
valve for 0.5 second.

<

Name Type IVAL VAL
Integer 32 Warishle

. [Pigital Input

.. OFF
....... OFF
....... — =
PAC Control: Ready Debug MM
On-latch reset to Off Counter decreased by one

20. Click the Auto Step Chart button to go back to auto stepping.

The counter does not decrease again, because the on-latch is no longer set. But the counter won't
increase until we start the Dough_Chip_Control chart again.

21. Click the Dough_Chip_Control chart tab. Click the Pause Chart button to unpause the chart. Verify that
Step On changes to Step Off in the chart status bar.

The watch window shows the nCookie_Counter value going up again.

CLOSING THE STRATEGY AND EXITING

Before we finish this tutorial, you may want to explore the sample strategy on your own. You can double-click
items in the Strategy Tree or open up other charts to see what they do. You can also double-click command
blocks to see what they contain.

1.  When you're ready to stop, click the Stop Strategy button in the toolbar.
This action prevents the strategy from running continuously unattended on the control engine.
A dialog box asks if you are sure you want to stop the strategy.

2. (lick Stop Strategy.

3. Toclose the strategy, select File > Close Strategy; or select File > Exit to quit PAC Control. If dialog boxes
ask whether you want to remove breakpoints and take charts out of stepping mode, click Yes.

WHAT'S NEXT?

Your introduction to PAC Control is now complete. Using the sample Cookies strategy, you learned how to:
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44

Open, save, and close a strategy

Work with the Strategy Tree

Work with charts and add commands in blocks

Configure a control engine

Compile, run, step through, and add breakpoints to a strategy
Make an online change

Use a watch window to monitor variables and I/0 points.

The rest of this book expands on the knowledge you've just acquired. Now may be a good time to look at the
table of contents or thumb through the book and familiarize yourself with its contents. Some sections you
may want to read; others you'll probably just refer to as needed.
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3: What Is PAC Control?

INTRODUCTION

The tutorial in Chapter 2 introduced you to PAC Control without explaining much about it. In this chapter we'll
learn more about PAC Control and see its main windows and toolbars.

In This Chapter

About PAC Control
General Control Concepts
PAC Control TermMiNOIOGY ... veeessssssses s sssssesssssssssssessssssssssneon
PAC Control Main Window

Windows and Dialog Boxes in PAC CONtrOl....weveveeeeesesrevere s page 57

Customization Features page 63

ONINE HEID oo s ssssssss e s page 75
ABOUT PAC CONTROL

PAC Control is a programming language based on flowcharts. Whether you have PAC Control Basic or PAC
Control Professional, you use PAC Control to develop software that monitors and controls all kinds of
equipment and sensors, from a simple heating system to a complex factory. The software you develop
controls the Opto 22 hardware that runs your heating system or factory.

The diagram below shows how PAC Control on your PC can work with the hardware in your control system.
This example shows a small system; yours may be even smaller or considerably larger and more complex. The
diagram uses a SNAP-PAC-S1 as the control engine. Input/output (I/0) points on the subordinate SNAP PAC
/0 units monitor and control the analog, digital, and serial devices connected to them. All these terms are
defined in the following pages.
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Control System Example

PAC Display

Viewing, Trending, PAC Control

Alarming Programming,
Debugging

1 SNAP PAC S-series
0= | controller

| Runs strategy;
controls all I/0

SNAP PAC
1/0 unit

Fuel Pump
(Analog output)

SNAP PAC
1/0 unit

(Thermocouple)
(Analog input)

Pump (On or Off)
(Digital output)

Tank Level
(Analog input)

SNAP PAC
1/0 unit

Barcode Reader
(Serial device)

Q

\{A\;“

Conveyor
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GENERAL CONTROL CONCEPTS

Automation

Automation is a way of adding intelligence to an industrial process. When you automate a process, you are
less dependent on human action to carry out the process. The process generally becomes faster, more
accurate, and more reliable. For example, take a look at the tank level and pump combination in the diagram
on the previous page. Instead of having a person watch the level in the tank and turn the pump on or off
when the level gets too low or too high, you can automate the process by installing a processor and I/0. The
processor and /0 respond in milliseconds and are on the job 24 hours a day.

Control Engines

In an Opto 22 PAC Control system, the control engine is the programmable component in Opto 22 controllers
that provides the intelligence required for automation.

Using PAC Control, you create a software program (a strategy) that tells the control engine how every aspect of
a process should work. You download the strategy to an Opto 22 control engine which runs it as a stand-alone
application. On a SNAP PAC controller, the strategy is stored in the controller’s electronic memory; the
development PC can be turned off or used for other operations while the control engine runs the program.
Whenever necessary you can modify the strategy and download it again to the control engine.

In the diagram on the previous page, one SNAP PAC S-series controller runs the program that controls the
three areas of automation.

Digital and Analog Inputs and Outputs

An industrial process can include many different hardware components: switches, pumps, tanks, valves,
furnaces, conveyors, photo sensors, thermocouples, and so on. All the components communicate with the
control engine in the controller by way of input/output (I/0) points.

Input points are wired to hardware that brings information into the control engine from the process.
Examples of devices that can be wired to input points are thermocouples, switches, and sensors. The control
engine takes the information from the input points—such as whether a switch is on or what temperature is
registered on a sensor—processes it using the software instruction set, and returns information to the process
through output points.

Output points are wired to hardware that receives information from the control engine and uses this
information to control components of the process. For example, lights, motors, and valves are all devices that
can be wired to output points. Using an output point, the control engine might turn on a light or open a valve.

There are two types of /0 points, digital and analog:

«  Digital points can be either on or off (True or False). Push buttons and LEDs are examples of digital
devices. An LED is either on or off; it has no other possible state.

In the Control System Example on page 46, the photo sensor is an example of a digital input device. The
photo sensor is either on or off. When it turns off as the sheet passes through its beam, the digital I/0
module tells the control engine it is off, and the control engine responds as programmed to stamp the
sheet.

The pump is an example of a digital output device. Based on information from the tank level input, the
control engine turns the pump on or off as programmed.

«  Analog points have a range of possible values. Temperature and pressure are examples of analog
information. Temperature might be any number in a range, -2 or 31.65 or 70.1 or many other possible
numbers.
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In the Control System Example on page 46, the tank level sensor is an analog input device. It registers the
changing level of water in the tank and reports the level to the control engine, which responds by
turning the pump on or off.

The fuel pump is an example of an analog output device. Based on information about the temperature in
the furnace, the control engine adjusts the pressure of fuel through the pump as programmed.

SNAP Serial Communication Modules

In the PAC Control system, some I/0 modules do not contain standard analog or digital input/output points,
but are used for communication over a serial network.

SNAP serial communication modules provide one or two channels for sending data to or receiving data from a
serial device (RS-232 or RS-485/422) or a protocol like PROFIBUS or Controller Area Network (CAN) that can
communicate over a serial network. In the Control System Example on page 46, the barcode reader is an
example of a serial device.

KEY FEATURES

“Copying SNAP 1/0 Configurations”on page 121

Using a configuration file, you can copy an I/0O configuration from one strategy to another. Or, using PAC
Manager, you can send the configuration to multiple I/O units at the same time.

“Segmenting Networks In PAC Control”on page 103

You can leverage the two independent Ethernet network interfaces on a SNAP PAC controller to segment
the control network from the company network.

“Creating Redundant Ethernet Links in PAC Control”on page 104

(Pro only) If you are using SNAP PAC controllers and PAC Control Professional, you can use Ethernet link
redundancy to set up alternate network links.

“Configuring Event/Reactions” on page 166

(Pro only) For serial-based mistic I/O units you can configure specific reactions to events when they
occur.

“Persistent Data”on page 258

You can configure the data in most variables to be persistent. The variable’s value is saved in the
controller's memory; the value is retained and not reinitialized when the strategy is run, stopped, or
started—or even if the strategy is modified and re-downloaded.

“Pointer Commands” on page 359

For advanced programming, you can create pointers that store the memory address of a variable or
some other PAC Control item, such as a chart, an I/0 point, or a PID loop. You can perform any operation
on the pointer that you could perform on the object the pointer points to.

“Setting Initial Values in Variables and Tables During Strategy Download”on page 266

When you are adding table variables in PAC Control, you can set all table elements to one initial value. Or
you can set each individual table element to its own value by creating an initialization file to download
with your PAC Control strategy.

“Using Subroutines”on page 408“12: Using Subroutines” on page 401

You can use subroutines that are independent from strategies, but that can be called from any chart or
other subroutine in your strategy. Subroutines offer two ways to work with variables and other logical
elements: they can be passed in or they can be local to the subroutine.

“Configuring PID Loops”on page 156

A proportional integral derivative (PID) control loop (often referred to as a PID loop) monitors a process
variable, compares the variable’s current value to a desired value (a setpoint), and calculates an output to
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correct error between the setpoint and the variable. Because the calculation is comple, it is done by a
mathematical formula, or algorithm, that you can then adjust (tune) for each PID loop.

PAC CONTROL TERMINOLOGY

action block  Action blocks are rectangular blocks in a flowchart that contain one or more instructions
(actions) that do the work of the strategy, such as turning things on or off, setting variables, and so on. Several
instructions can be placed in one action block. Action blocks can have many entrances, but only one exit.

analog point  Analog points have a range of possible values. Temperature and pressure are examples of
analog information. Temperature might be any number in a range, -2 or 31.65 or 70.1 or many other possible
numbers. Analog points can be either inputs (such as a tank level sensor) or outputs (such as a fuel pump).

blocks A chart is made up QfacUon i B
blocks, condition blocks, continue blocks,

and OptoScript blocks connected by arrows, |

which show how the process flows. A chart ~ Action block —— [
used with redundant controllers also has o
sync blocks.

Condition block

sync block The sync block tool is visible

only when controller redundancy support is

enabled. A sync block is used to synchronize  OptoScript block
redundant controllers at strategic locations

in a transactional chart (a chart that contains

sync blocks). For more information, see the Sync block
SNAP PAC Redundancy Option User's Guide

(form 1831).

Process A

4
Checkpoint

Continue block

condition block Condition blocksare | v
dmmqnd—shaped blocks‘m a flowchart that o I
contain questions (conditions) that control (A5 Chart/
the logical flow of a strategy. Condition
blocks can have many entrances, but only
two exits: True and False. The block can contain more than one condition, and you can use AND or OR to
indicate whether all conditions must be true to exit True, or whether any one condition must be true to exit
True.

continue block Continue blocks are oval-shaped blocks in a flowchart that route the flow of execution to
an action, condition, or OptoScript block. They do not contain any instructions, but store only the name of the
next block to execute. Continue blocks can have many entrances, but no exits, since the exit is defined within
the block. Continue blocks avoid awkward connections between two blocks that are far apart.

digital point Digital points can be either on or off (true or false). Push buttons and LEDs are examples of
digital devices: an LED is either on or off; it has no other possible state. Digital points can be eitherinputs (such
as a photo sensor) or outputs (such as a pump).

external value The external value (XVAL) is the real-world value measured or set by an 1/O point. The PAC

Control strategy reads and writes only to internal values, and transfers internal values to external values if
communication to the associated I/0 unit is enabled.
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PAC CONTROL TERMINOLOGY

flowcharts  Since most control applications are complex, the strategy typically consists of a series of process
flowcharts, or charts, that all work together. Each chart controls one aspect of the strategy—one piece of the
automated process. Together, all the charts constitute the strategy. The total number of charts in a strategy is

limited only by the amount of memory available in the control engine.

A chart can be running, suspended, or stopped. A running chart is actively performing its assigned task. A
suspended chart is temporarily paused. A stopped chart is inactive. Every chart in a PAC Control strategy can
change the status of any other chart in the strategy, yet every chart is independent of every other chart. Any
combination of charts can be running simultaneously, up to the maximum limit allowed on the control
engine. (See also, multitasking.)

Every strategy automatically contains a Powerup chart. The Powerup chart is automatically started when the
strategy begins running, so it starts other charts. All other charts you create, based on the needs of your
process.

input point  Input points are wired to hardware that brings information into the brain from the process.
Examples of devices that can be wired to input points are thermocouples, switches, and sensors. The control
engine in the brain takes the information from the input points—such as whether a switch is on or what
temperature is registered—processes it using commands in the strategy, and returns information to the
process through output points.

instructions (commands) PAC Control commands, or instructions, tell the control engine what to do at
each step in the flowchart to control the process. Each block in a chart contains one or more instructions, such
as Convert Number to String or Start Counter or Chart Running?

Commands are in two forms: Actions and Conditions.

«  Action commands do something in the process; for example, Convert Number to String and Start Counter
are both action commands. On the flowchart they appear as instructions in action blocks, which are
rectangular in shape. They may also appear in hexagonal OptoScript blocks.

«  Condition commands check a condition and are in the form of a question. Chart Running? and Variable
False? are examples of condition commands. They appear as instructions in condition blocks, which are
diamond-shaped, or in hexagonal OptoScript blocks. Condition commands are questions that always
have two possible answers, either yes or no (true or false). The answer determines the flow of logic and
what happens next in the chart.

The instruction shown below is for the condition block, Button D3 On?This block contains only one instruction.
As you look at the chart, you can see that the answer to the question in the instruction determines whether
the process flows to Turn LED D7 On or to Turn LED D7 Off.
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Instruction for the block
named Button D3 On?

Mext Block b
4y 0
FPrevious Block.

Operator
() AND
CI0R

[ Cloze ] [ Help ] [ Command Help ]

internal value The internal value (IVAL) is the value read or written by the PAC Control strategy. Internal
values are transferred to external values only when communication to the I/0 unit is enabled.

multitasking The control engine can run several charts seemingly at once, each performing a different task
through a time-slicing technique called multitasking (also called multicharting). Opto 22SNAP Ultimate I/0
control engines can run up to eight charts plus one host task simultaneously; SNAP PAC R-series and
SNAP-LCE controllers can run up to 16 charts plus one host task simultaneously; SNAP-PAC S-series controllers
can run up to 32 charts plus one host task simultaneously; a SoftPAC controller can run up to 64 charts plus
one host task simultaneously. The host task is an invisible chart used to communicate to a PC, which may be
running PAC Control in Debug mode or PAC Display.

Each chartin a running or suspended state counts toward the total that can run simultaneously. Charts that
are stopped do not. When the Powerup chart is running, it also counts.

The actual order and timing for running tasks is not deterministic—that is, it is not always the same, but
depends on priorities at any given time. For example, communication may sometimes take a higher priority
than a running chart.

OptoScript block  OptoScript blocks are hexagonal blocks in a flowchart that contain OptoScript code.
OptoScript is a procedural language that can simplify tasks such as math computations, string handling, and
complex loops and conditions. OptoScript blocks can have more than one entrance but only one exit.

output point  Output points are wired to hardware that receives information from the brain and uses this
information to control components of the process. For example, lights, motors, and valves are all devices that
can be wired to output points. Using an output point, the control engine in the brain might turn on a light or
open a valve.

pointer A pointer does not store the value of a variable; instead, it stores the memory address of a variable
or some other PAC Control item, such as a chart, an 1/0 point, or a PID loop. You can perform any operation on
the pointer that you could perform on the object the pointer points to. Pointers are an advanced
programming feature and are very powerful, but they also complicate programming and debugging.
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Because pointers can point to any data type, pointer tables can store an assortment of data types in a single
table.

Pointers allow one level of indirection within PAC Control; a pointer cannot point to another pointer. After you
add a pointer through the “Add Variable Dialog Box"on page 259, you can use it wherever the object itself
would be used.

strategy The software program you create using PAC Control Basic or PAC Control Professional. The strategy
includes all the definitions and instructions (commands) necessary to control the process that one Opto 22
controller handles. Since most control processes are complex, the strategy typically consists of a series of
process flowcharts that all work together, with each chart controlling one piece of the automated process. You
may have several PAC Control systems, each controlling a different process and therefore running different
strategies. Or you may have two or more PAC Control systems controlling identical processes in different areas
and running the same strategy.

variables A variable is a holding place that represents a piece of information in a strategy, such as the
parameters for communication, temperature reported by a thermocouple, the name of a chart, or a group of
words and numbers to be sent to a display. The information a variable represents is called the value of the
variable. As a strategy runs, the variable’s name remains the same, but its value may change. For example, the
value of a variable named Oven_Temperature may change several times while its strategy is running, but its
name remains Oven_Temperature.

A variable stores one of six types of data: floating point, integer, timer, string, point, or communication handle.

When you create the variable, you designate the type of data it contains.

«  Afloating point (or float) is a numeric value that contains a decimal point, such as 3.14159, 1.0, or
1234.2. A good example of a float variable is one that stores readings from an analog input, such as a
thermocouple.

« Aninteger is a whole number with no fractional part. Examples of integer values are -1, 0, 1,999, or -456.
The state of a switch, for example, could be stored in an integer variable as 1 (on) or 0 (off).

«  Atimer stores elapsed time in units of seconds with resolution in milliseconds. Up timers count up from
zero, and down timers start from a value you set and count down to zero. For example, you could set a
down timer to make sure a value is updated at precise intervals.

«  Astring stores text and any combination of ASCIl characters, including control codes and extended
characters. For instance, a string variable might be used to send information to a display for an operator
to see.

A string variable can contain numeric characters, but they no longer act as numbers. To use them in
calculations, you must convert them into floating point or integer numbers. And a numeric value to be
displayed on a screen must be converted into a string first.

« A pointer does not store the value of a variable; instead, it stores the memory address of a variable or
some other PAC Control item, such as a chart or an I/0 point.

«  Communication handles store parameters needed for communication with other devices.

You can use variables that are individual pieces of information, and you can also use table variables, which are
groups of related information in the form of a table.

PAC CONTROL MAIN WINDOW

With a strategy open, the main window in PAC Control Basic and PAC Control Pro look similar to this:
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PAC Control title bar
Menu bar

Toolbar

4, PAC Control Basic - Cookies — a X
- File Edit Configure Chart Subroutine Compile Mode Tools View Window Help
5 DS E| Yl X A A0

EE=) cooes|
B (&) Control Engines
@ () Subroutines Included
& Charts
= () Variables
@ () Numeric Variables
@ () String Variables
() Pointer Variables
(&) Communication Handles
() Numeric Tables
() String Tables
() Pointer Tables
® (& o units

Strategy Tree  ———

Shes o

]; Coolaes | Mode

Status bar ——pac controk: Ready Configure NUM

Since PAC Control uses standard Microsoft Windows conventions, you'll recognize the title bar and menu bar
and already be familiar with some of the menus, such as File, Edit, View, Window, and Help. This section
discusses some things that may not be familiar.

Status Bar

The status bar at the bottom of the window shows you information about PAC Control. When you move your
mouse over the toolbar, a description of the button you're pointing to appears in the status bar. The status bar
indicates the mode PAC Control is in and indicates messages or errors helpful in debugging.

To hide or show the status bar, choose View > Status Bar. A check mark next to the menu item means the
status bar will show; no check mark means it is hidden.
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Mode

You can run PAC Control in three modes: Configure, Debug, or Online. The current mode is shown in the status
bar, on the right. Toolbars and menus change depending on the mode.

«  Configure mode is used to create, modify, save, and compile strategies, flowcharts, and subroutines;
and to configure control engines, I/0, and variables.

«  Debug mode is used to download, run, and debug strategies and to view control engine and
communication status and errors while the strategy is running.

«  Online mode is a scaled-down version of Configure mode, used to change a strategy while it is running.
You cannot add variables and I/0 in Online mode, but you can change ones that already exist.

NOTE: When you change a chart in Online mode, a new copy of that chart is downloaded to the control engine,
but the old one is not deleted. After you have made a few online changes, the additional chart copies begin to
take up memory. To avoid memory problems, be sure you stop the strategy after making several online changes
and completely compile and download it to clear out old chart copies.

NOTE: Depending on the extent of the changes you want to make to the strategy, Background Downloading
may be a more appropriate alternative to Online mode. To understand the difference, see the table on page 210.

To change modes, choose the mode you want from the Mode menu, or click its button in the toolbar.

Toolbars

Toolbars give you shortcuts for doing many things that also appear on menus. Toolbars in PAC Control include
standard Windows buttons like New and Save as well as special buttons for PAC Control functions. The tools
that you can use depend on which mode you're in. Tools not currently available are grayed out.

The following toolbars are standard in PAC Control.
«  Mode Selection Toolbar

«  Configure Mode and Online Mode Toolbar

«  Debug Mode Toolbar

Mode Selection Toolbar

The mode selection tools are always available.

Tool Description

Configuration Mode
Debug Mode
Online Mode

Configure Mode and Online Mode Toolbar

The following toolbars appear in configure mode and online mode.

O 3 # sa@m x &4 Lo o ¢ @ D Y5 B 2 conpleview 5 Compile Al

In a smaller window, the toolbar looks like this.

AEH ¥R X A hITmoCce S E 2 8
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0 New Strategy 4™ Pan Tool

=3 Open Strategy (| Action Block Tool

(= Save Strategy = OptoScript Block Tool
% Cut L 3 Condition Block Tool
By Copy - Continue Block Tool
[Fey Paste | Checkpoint Block Tool
x Delete ty Connect Tool

- Find e=| Text Tool

% Find and Replace & Compile Active View
[y Select Tool Compile All

Debug Mode Toolbar

The following toolbar appears in debug mode.
B Run Strategy [l Stop Strateqy | [ Pause Chart [PlInto [ Over [P out <% Autostep <l Breakpoint
In a smaller window, the debug toolbar looks like this.

> B 0l MiFIP F O

[~ Run Strategy ir Over

| Stop Strategy 7 Out

11 Pause Chart & Auto Step

| Into I Breakpoint
Strategy Tree

The Strategy Tree opens when you open a strategy, and closing it is equivalent to closing the strategy. The
Strategy Tree shows you all the elements of your strategy: control engines, flowcharts, subroutines, variables,
/0 units and points, and PIDs.
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The Strategy Tree works just like Windows Explorer: you can expand or collapse folders to view or hide what is
in them. You can easily see what is in your strategy, open elements to change them by double-clicking them,
or open a pop-up menu by right-clicking on an element.

Each element in the strategy is represented by a button, shown just to the left of its name. The table below
shows the buttons and what they represent.

Button Description Button Description

#; Control Engine ﬂ Integer 32 Table
% Chart = Integer 64 Table
IE4
&, Subroutine ===z ] String Table
STR
(2] Integer 32 Variable = Pointer Table
I=z FTF
= Integer 64 Variable ial Digital 1/0 Unit
IEY 1]
A4 Float Variable iy | Mixed 1/0 Unit
FLT RSO
3 Down Timer Variable | Analog Input Point
L = 9inp
ot Up Timer Variable o Digital Input Point
THE I+
H B . . .
% String Variable EID = Analog Output Point
E=7 Communication Handle Digital Output Point
cH O—= 9 P
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Button Description Button Description
Float Tabl = pDL
%I_E_IE_I oat Table =T oop

|E|R Pointer Variable

WINDOWS AND DIALOG BOXES IN PAC CONTROL

Windows and dialog boxes in PAC Control follow Microsoft Windows standards. You can minimize, maximize,
move, resize, and tile them as needed. See your Microsoft Windows documentation for information on how to

perform these functions.

Using Tabs to View Open Windows

When multiple windows are open—especially if they are maximized—it can be difficult to know where you
are, and windows can become lost behind each other. However, you can click the tabs at the bottom of the
main PAC Control window to move among chart windows, subroutine windows, watch windows, and blocks

you may be stepping through for debugging.

ﬁ PAC Control Basic - Cookies * - [Dough_Chip_Centrol] — O e
ﬂ’, File Edit Configure Chart Subroutine Compile Mode Tools View Window Help - [ =
[4i Config M EH X #a%||ihoec ¢es B
Cookies ¢ | || [belt must be running between 50% and 65% of max rpm. ~
N L]
= [ Cookies Powerup chart starts S

[E3) Control Engines chart.

IC5) Subroutines Induded

=5 Charts =

= I£5) Variables Start

Conveyor

[C5) Mumeric Variables
|5 String Variables

[C5) Painter Variables w
[E5) Communication Handles chart runs
[E5) Mumeric Tables |inuously once the Speed OK?
[ String Tables ram has been started.
[C5) Pointer Tables T
© 1/0 Unis £ Drop the dough.
Drop Dough
£ Drop the chips.
Drop Chips &
< >

(i)shortouts | 91% v

|ﬁ| Dough_yessel_Pressure_Contml |

>

<
] &nee o

Ch\Users\Public\Documents\Opto ZZ\PAt I;roj;(é.ft\l.’_ontrol Basic Examples\}&gkies\c Okies.idb  Configure MUM

White tabs show where you are Gray tabs show open windows. Click a tab
when stepping through a chart or to bring its window into view.
subroutine.

The upper layer of tabs appears when you are stepping through your strategy in Debug mode. It acts as a kind
of call stack to let you see how you got to the current block or command.
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e E|I,|’0Units T T R T * .
AiD M'XEd—.IO—U”'t T T AT SUpdate Holding
+ [ Peints T T AT Variable @ w ww
=) PIDs
< | >
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A JA[AT M), Chart A fetion Block - Incrernent Counter” - 1d #7 Subrowtine "Yariable_Increase_Motification”
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IPAC Control: Ready Debug MM
Click the arrow buttons to see This white tab shows you are stepping inside the Variable_Increase_
tabs that are not visible or are Notification subroutine, which was called by the Increment Counter
only partly visible. action block on the gray tab at left. The gray Chart tab farther left shows

the chart this action block is in. Click any tab to see how you got to
where you are.

Docking Windows

You can place the strategy Tree and watch windows where you want them (dock them) in the PAC Control
main window. Docked windows do not have tabs but are contained in their own frames. PAC Control
remembers their position the next time you open that strategy.

«  Todocka window, click the docking button & in the window's title bar.

The window moves to its own frame. (Compare the following figure with the one on page 52 to see the
difference in the Strategy Tree window.)
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1PAC Control Professional
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To change the docked position, click and drag the window's title bar to any edge of the main window.

To change the docked window's width or height, click and drag the edge of its frame in the direction you
want.

To free the window from its docked position, click the docking button [ in its title bar.

Zooming in a Chart or Subroutine Window

You can change the scale of any chart or subroutine window by using the zoom feature. There are several
ways to zoom:

Hold down the Ctrl key and move the mouse wheel up and down.
Press the + or - keys on the keyboard.

Right-click anywhere on a chart or subroutine window to display a pop-up menu. Select Zoom and
choose In, Out, or Reset (to return the zoom to 100 percent).

From the View menu, choose Zoom In, Zoom Out, or Zoom Reset.

To pick the zoom percentage you want, click the zoom field at the bottom right of the window and
choose one of the preset zoom levels. The “Zoom to fit" option resizes the chart to fit in the window.

NOTE: Zooming always takes place with reference to the center point of the window.

Here is a window at 50 percent zoom:
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The same window at 200 percent zoom looks like this:
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| A
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pee
OK? Oven Standby
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Oven On 350 degrees.
< l 3 5
(1) Shortcuts ’m
[T [T chart /

Panning a Chart

The pan tool allows you to easily pan around a flowchart.
1. Using the pan tool &% , click and hold to grab a portion of a chart.

You can access the pan tool either from the toolbar or by holding down the space bar and clicking the
left mouse button.
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Ek WHITE ConvVeyor speed A
Speed is out of spec, set oven
Oven Stan| :
OK? JRELE L temperature to 200
Pan tool — TI degrees.
7 Set oven temperature to
Oven On 450 degrees.

If inspection station sees
a bad cookie, open reject
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2. Move the pan tool to a new position and release.
The chart moves to a new position.

This chart maintains the oven temperature and re
cookies that do not pass visual inspection.

The Powerup chart starts
this chart. Start

Redrawing a Chart or Subroutine Window

If you want to move quickly to a particular block, you can redraw a chart or subroutine window with any block
atits center.

1. With a chart or subroutine open in the active window, select View > Center On Block, or right-click in the

chart or subroutine window and choose Center On Block from the pop-up menu.
The Center On Block dialog box appears, listing all blocks in the chart.

#1 Center On Block E|

Block Id: - MHame [ Type

Continue

7 Drop Chips Action

5 Drop Dough  Action

2 Speed OK?  Condition
0 Start Action

17 Start Corv...  OptoScript

OK. l[ Cancel ][ Help

PAC Control User’s Guide, Legacy Edition 61



WINDOWS AND DIALOG BOXES IN PAC CONTROL

2. Double-click the block you want, or click it once and click OK.
The chart or subroutine is redrawn with the selected block in the center of the window.

Changing Column Width in a Dialog Box

Many dialog boxes include several columns of information. To see all the data in some columns, you may need
to make columns wider.

«  Towiden or narrow a column, click the right edge of the column label and drag it horizontally.

A Configure 170 Units X

Mame Type Port Address Aa Enabled FRefC.. Descri.. Add...
Dizabled  Enabled

Mired [... SHAP-.. 127.0...

Etherr...

Modify...

[— Clickand drag

1/0 Paints...
FID Loops...

Ewvent/Reactions...

[ Cloze ] [ Help ]

«  Toresize a column to the exact width of its longest entry, double-click the line that separates the column
from the one on its right.
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Sorting Data in a Dialog Box

In some dialog boxes with columns of data, you can sort the information in the way you want to see it. The
Center On Block dialog box provides an example.

The blocks in this dialog box normally appear in alphabetical order by the block name.

# Center On Block rz|
Block 1d: Mame Type
. Continue
7 Drop Chips Action
5 Drop Dough  Action
2 Speed OK?  Condition
] Start Action
17 Start Conv...  OptoScript
[ QK ] [ Cancel ] [ Help ]

«  Tosort by block number instead, click the Block Id column label.

# Center On Block rz|
Bla... Mame Type
2 Speed OK?  Condition
5 Drop Dough  Action
7 Drop Chips Action
17 Start Conv...  OptoScript
13 Backto ... Continue
[ QK ] [ Cancel ] [ Help ]

« Tosortinthe opposite order (descending numbers instead of ascending numbers), click the Block Id
column label again.

Some dialog boxes don't allow custom sorting. If you click a column label in these dialog boxes, nothing
happens.

CUSTOMIZATION FEATURES

This section describes PAC Control special features for displaying numeric data, launching other applications
from PAC Control, and modifying strategies using PAC Control's Command-Line Interface tool.

Setting Decimal, Binary, or Hex Display Mode

You can set up PAC Control to show the values of all integers and integer tables in decimal (the default),
binary, or hexadecimal (hex) format. Binary and hex formats help you use masks. Hex format is particularly
useful for entering integer literals and initial values for a digital-only Ethernet brain. Hex view is available in all
modes: Configure, Debug, and Online.

The default view is in decimal notation, as shown in the following figure.
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%< "nCookie_Counter™ (scanning)

Mame: hCookie_Counter
Value: [314 H— Decimal view

OMoein 7

To view integers and integer tables in binary view, choose View > Binary Integer Display, or click the DEC
button and choose Binary. The integers appear as shown below.

Al

=% "nCookie_Counter” (scanning)

Mame: nCookie_Counter

Binary view. All the bits

Walue: |DDDDDDDD goooooog 00001110 oooolio0o0o
cannot be shown at once.

OMoein 7

To view integers and integer tables in hex view, click BIN in the dialog box, and then select Hexadecimal. Here's
how the integers appear in hex:

%, “nCookie_Counter* (scanning)

Mame: nCookie_Counter

Hex view. The Ox before the number
indicates that the number is in hex.

Yalue [0x00000EZ0 i

OMoein 7

To return to decimal view, click HEX and then select Decimal.

Setting Hex String View

You can also set strings to appear in hex notation. Here is the View Variable window showing a string in
regular notation:

%, “String Variable™ (scanning)

Mame: Sting_‘ariable
whidth: 10 max width 0 current width

Walue: |ITtem price =

Bytes: 0o: 73 11s 101 109 Item
4: 32 112 114 105 price =
§: 599 101 3z 61
iz: 32

Epply 2

(i1 More Irfo =l

To change to hex notation, click the ASCII button on the dialog box.

Here's how the string appears in hex:
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%% String_Variable™ (scanning)

Mame: Sting_‘ariable
whidth: 10 max width 0 current width

Walue: |49 74 65 6D 20 70 72 69 63 65 20 3D

Bytes: 0: 73 11s 101 109 Item
4: 32 112 114 105 price =
§: 599 101 3z 61
iz: 32

OMoeio 7

Setting Up Applications to Launch from PAC Control

You may find it useful to launch other software applications directly from PAC Control. For example, you may
want to launch PAC Display, Notepad, or the Calculator from PAC Control. You can set up PAC Control so that
these applications appear in the Tools menu.

NOTE: If you launch an application from within PAC Control when that application is already running, a second
instance of the application may open. It depends on the application; some check to see whether the application is
already running, and some do not.

1. With PAC Control open, choose Tools > Customize.
The Customize dialog box appears.

Menu Cantents o ]

Add

2. (lick Add.In the Menu Text field, type the name of the application as you want it to appear in the Tools
menu.

3. Inthe Command field, type the path for the application’s executable file, or click the Browse button [-..]
and then navigate to the file.

(Optional) In the Arguments field, type any necessary command line parameters.

5. (Optional) In the Initial Directory field, type the directory the application should default to when it runs.
For example, this is the directory the application would show when you open or save files.

6. Repeatthe steps to add other applications. To change an application’s position in the menu list, highlight
it and click the Move Up or Move Down keys.

7.  When you have finished adding applications, click OK. The PAC Control main window is displayed, and
the applications you've added now appear in the Tools menu.
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Using PAC Control's Command-Line Interface Tool

PAC Control's Command-Line Interface (CLI) tool was built for customers who want a fast and easy way to
modify existing strategies without using the PAC Control graphical user interface.

CLl'is a command-line program that runs in Microsoft's Command Prompt window. It can:

«  Move a configured I/O module or I/0 point to an empty position on the same or different I/O unit

«  Add new variables

«  Create a control engine download (.cdf) file

You can perform operations one at a time, or you can run multiple commands in a batch.

Responses to commands (and error codes) are logged to a file. For details, see “Checking CLI Command
Output.”

CLI Commands and Syntax

CLI commands are not case-sensitive. You can run them from either a normal or an Admin (“elevated
privilege”) Command Prompt window.

The syntax for a CLI command is:

<CLI executable program> <strategy filename> /<operation>
<arguments>

where:
+ <CLI executable program> isyour PAC Control filename and extension:
- For PAC Control Basic, the program is control .basic.exe
- For PAC Control Professional, it is control . pro.exe
« <strategy filename> isthe strategy to modify; for example: cookies.idb
Note that you can perform operations on only one strategy at a time.
+ /<operation> <arguments> isthe operation to perform and its required arguments (see “CLI
Operations and Arguments”on page 67). Multiple arguments are separated by semicolons.
IMPORTANT: Paths, filenames, and arguments that contain a space must be enclosed in straight quotes (" ).

Depending on the folder you run CLI from, you may need to enter the path and filename for the CLI
executable program, the strategy, or both.

For example, if PAC Control Basic is installed on your C:\ drive, the path and filename for the CLI executable
programis:

"C:\Program Files (x86)\0Opto22\PAC Project 10.5\control.basic.exe"

Because the path contains spaces, the path and filename have been enclosed in straight quotes.

Command Prompt — = &

Example of a CLI command and response.
Paths, filenames, and arguments that include spaces must be enclosed in straight quotes.
Note that the response is a new prompt.

When typing CLI commands:
«  Type aspace after:
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- The ClLl executable program name.
- The strategy filename.
- The operator.
«  Typeasemicolon (;) between arguments. Don't put spaces before or after the semicolons.
« Ifyour path, filename, or arguments include spaces, you must enclose them with straight quotes (" ").

Saving the Strategy
After performing a command, the CLI saves the strategy used in the command.

When you use the /cdf option with a strategy from a previous version of PAC Control, the strategy will be
updated to the current version of PAC Control. When this happens, there is no warmning message (like the one
displayed when you open an older strategy in PAC Control).

CLI Operations and Arguments

The following table describes the CLI operations and arguments. Required characters are shown in bold, red
color to make them easier to see.

...use this

To do this: .
operation:

...with these arguments:

Move a configured 1/0

. <source /0 unit>;<source module position>,<target I/O
module to an empty posi- |/mm urce l/O unit>;<sou ule position><target I/

unit>; <target module position>

tion

where:

e <source I/O unit> is the name of the I/0 unit that contains the
module? you want to move.

< <source module position> is the current position number? of
the module to move.

«  <target /O unit> is the name of the I/O unit you want to move
the module to.

«  <target module position> is the position number? where you
want to move the module. Note that the position must be
empty (that is, not configured with another module).

Example:

C:\>control.pro.exe cookies.idb /mm Mixed IO Unit;8;Sprinkler Control;4

Move a configured /0
point to an empty position

<source I/0O unit>;<source point name>,<target I/O unit>;
<target module position>,<target point position>

/mp

where:
« <source I/O unit> is the name of the I/O unit that contains the
point you want to move.

«  <source point name> is the name of the point to move.

«  <target /O unit> is the name of the I/O unit you want to move
the point to.

. <target module position> is the position number? of the
module where you want to move the point.

o <target point position> is the point number on the module?
where you want to move the point. Note that the position must
be empty (that is, not configured with another point).

Example:
C:\>control.pro.exe cookies.idb /mp Mixed IO Unit;doRejectValve;
Valve Unit;2;0
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...use this

To do this: .
operation:

...with these arguments: (Continued)

<variable type>,;<variable name>,;<description>,<initializa-

Add a variable /av

NOTE: This operation does tion type>;<initial value>[;<string width>][;<table length>]
not support pointer vari- where:

ables or pointer table vari- «  <variable type> indicates the type of variable.

ables. Enter one of the following values.

Type this: ...if the variable is a:

INT32_VAR 32-bit integer variable
INT64_VAR 64-bit integer variable
FLOAT_VAR Float variable

STR_VAR String variable

DNTMR_VAR Downtimer variable
UPTMR_VAR Uptimer variable

CMHDL_VAR | Communication handle variable
INT32_TBL 32-bit table variable

INT64_TBL 64-bit table variable
FLOAT_TBL Float table variable
STR_TBL String table variable

«  <variable name> is the name of the variable. The name must
follow PAC Control conventions (for example, it cannot start with or
contain spaces, it cannot start with a number, and so forth).
Maximum length is 50 characters.

«  <description> is a brief description of the variable (in straight
quotes, if it contains spaces). To leave the description field
blank, enter a space in straight quotes (like this:" " ). Maximum
length for the description is 127 characters.

« <initialization type> indicates how to initialize the variable.
Enter one of the following values.

Type this: ...to:
ON_DOWN- Initialize the variable on strategy down-
LOAD load.

Initialize the variable when the strategy

ON_RUN
runs.

(Not applicable to timer variables.) This
argument makes the variable per-
PERSISTENT sistent. For more information about
persistent variables, see “Persistent
Data” on page 258.

«  <initial value> is the variable’s initial value.
NOTE: Not applicable to timer variables. For timers, enter a space for
this argument.
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...use this

To do this: .
operation:

...with these arguments: (Continued)

* [;<string width>][;<table length>] Applicable only to
strings and table variables.
- Strings: The string width. Example: 15
The maximum width you can give a string is 1024
characters.

- String tables: The string width and table length.
Example: 15; 99 Note the semicolon between the
numbers.

The maximum width you can give a string is 1024
characters. The maximum table length is 1,000,000
elements.

- Integer and float tables: The table length. Example:
99

Example:
C:\>control.pro.exe cookies.idb /av INT32 VAR;nFlavor;"Cookie Flavor";
ON_RUN; 0

<filename of a text file that contains CLI commands>

This operation lets you issue one command to perform all
the commands in a text file. This is the preferred method if
several or more CLI commands are to be performed on the
same strategy. This is also the fastest option when many
operations are performed on the same strategy.

Perform a series of /f « Each command must follow CLI command syntax:
commands <operation> <arguments>
« Each command must be on a separate line. (Don't use
word wrapping in the file.)
» Each command is processed in order.
 Responses (and, if applicable, errors) are logged to a file.
For details, see “Checking CLI Command Output.”
Example:

C:\>control.pro.exe cookies.idb /f "C:\Documents\my batch commands.txt"
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...use this

To do this: .
operation:

...with these arguments: (Continued)

This operation has no arguments.
The output is saved in the folder where PAC Control is
installed.

Compile a strategy into a
cdf fileP Jedf

Example:C:\>control.pro.exe cookies.idb /cdf

Set or clear the public attri- | Set <variable type>;<variable name>
bute setting (read+write or | operations: | where:
read) on a variable /pasvrw |. <variable type> indicates the data type of the variable.
/pasvr Enter one of the following values.
Type this: ...if the variable is a:
Clear
operations: INT32_VAR 32-bit integer variable
/pacvrw INT64_VAR 64-bit integer variable
/pacvw
FLOAT_VAR Float variable
STR_VAR String variable

DNTMR_VAR | Downtimer variable
UPTMR_VAR Uptimer variable

CMHDL_VAR Communication handle variable
INT32_TBL 32-bit table variable

INT64_TBL 64-bit table variable

FLOAT_TBL Float table variable

STR_TBL String table variable

« <variable name> is the name of the variable. The name
must follow PAC Control conventions (for example, it can-
not start with or contain spaces, it cannot start with a
number, and so forth). Maximum length is 50 characters.

Example:
C:\>control.pro.exe cookies.idb /pasvr INT32 VAR;nCookieMotionPreset

Set or clear the public attri- | set <channel type>;<channel name>
bute setting (read+write or where:

d h : operations: o )
read) on a channel /pascrw «  <channel type> |nd|cat.es the type of signal.
Enter one of the following values.
/pascr - - - -
Type this: ...if the signal type is:
Clear ANA_IN Analog input
operations: ANA_OUT Analog output
/paccrw DIG_IN Digital input
/paccw

DIG_OUT Digital output

« <channel name> is the name of the channel. The name
must follow PAC Control conventions.

Example:C: \>control.pro.exe cookies.idb /paccrw DIG_IN;diDoughLevelSwitch

@ Remember that module numbers and point numbers are zero-based; the first position is number 0 (not 1).
b See “Saving the Strategy”on page 67.

The syntax to load a strategy in PAC Control's graphical user interface is:

<CLI executable program> <strategy filename>
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Example: C:\>control.pro.exe cookies.idb

Checking CLI Command Output

For each CLI command you enter, the system logs a record in a Control.Output.csv file. (If the file already exists,

new messages are appended to the file.) You can view the Control.Output.csv file to see whether or not a CLI

command was successful. The file’s .csv format lets you open the file in text editors (like Notepad), as well as in

spreadsheet programs (like Excel).

«  When acommand is successful, CLI logs “Succeeded,” and the name of the operation you performed.

«  When a command fails, the message shows “Failed,” followed by an error code (described on page 71),
the name of the operation, and the arguments entered with the operation.

Control.Output.csv files are located in the same folder as the strategy used in the CLI command.
For example, if the strategy in your command is located in the C:\MyStrategies folder, the Control.Output.csv is
saved in C\MyStrategies.

Example of a Control.Output.csv file opened in Microsoft Excel®.
In this example, Excel has parsed the data into columns.

@ Control.Qutput.csv - Microsoft Excel i O b4

Home Insert Page Layout Formulas Data Review  View Developer  Acrobat  Team @29 e = @ ER

A -de Qi HEER Y =

A5 - Jx | Succeeded 2
A B C D

1 |Failed (Error4) Create Controller Download File No controller in strategy

2

3 |Failed (Error4) Create Controller Download File  No controller in strategy

4

5 |Succeeded _I Create Controller Download File

6

7 |Failed (Error 11) Add Variable INT32_VAR

8

9 Failed (Error 12) Add Variable INT32_VAR;

10

11 |Succeeded Add Variable INT32_VAR;nRogersint32;"Test Variable";ON_RUN;0
WWH-M_

Error Codes
This table explains the error codes you might see in the Control.Ouput.csv log file.

Error

Operation code Meaning
all 1 No operation was entered. Please enter an operation.
/f (Command file) 2 The text file containing CLI commands could not be opened.
all 3 CLI could not open the strategy.
all 4 The strategy does not have a configured controller
5 CLI could not create the .cdffile.
6 CLI could not re-open the .cdf file.
/cdf (Compile to 7 CLI could not create the .crn file
.CDF file) ’ ’
8 CLI could not open the intermediate file.
9 CLI could not append to the .crn file.
70 CLI could not open the strategy because it was previously saved in

PAC Control Basic.
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72

Error

Operation code

71
72
73

10

11

12
13

/av (Add Variable) 14

15

16

17
18
19

PAC Control User’s Guide, Legacy Edition

Meaning (Continued)
CLI could not find the path to a file you want to download after the
strategy.

CLI could not save the strategy because it is currently open in
PAC Control Basic or Professional.

CLI could not save the strategy because the CLI does not have permis-
sion to access the specified folder.

The variable type argument is missing.

The variable name argument is missing, or too long (maximum length
is 50 characters), or is formatted incorrectly, or already in use, or is a
programming “reserved word.” (Reserved words cannot be used as
variable names.)

The description argument is missing or too long. The maximum size for
a description is 127 characters.

The initialization kind argument is missing.
The initial value argument is missing.

(Applicable only to string and string table variables.) The string width
argument is missing or too long. The maximum size you can give a
string is 1024 characters.

(Applicable only to table variables.) The table length argument is miss-
ing or too long. (Maximum table length is 1,000,000 elements.)

Cannot create the variable.
Cannot get an ID for the new variable.

Cannot add the variable to the strategy.



Operation

/mm (Move Module)

20

21

22

23

24

25

26

27

29

30

32
33

34

35

36
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Meaning (Continued)

The source I/0 unit is missing. Please enter the name of the source I/O
unit.

The source module position is missing. Please enter a source module
position number. Remember that module positions are zero-based
(count up from 0 instead of from 1).

The target 1/0 unit is missing. Please enter the name of the target I/0
unit.

The target module position is missing. Please enter a target module
position number. Remember that module positions are zero-based
(count up from 0 instead of from 1).

The source I/0 unit is not in the strategy. Check the name and re-enter.

The source module position is out-of-range. Check the number and
re-enter. Remember that module positions are zero-based (count up
from 0 instead of from 1).

The target I/0 unit is not in the strategy. Check the name and re-enter.

The target module position is out-of-range. Check the number and
re-enter. Remember that module positions are zero-based (count up
from 0 instead of from 1).

A module already exists at the target module position. Enter an empty
module position.

No module is defined at the source module position. Check the num-
ber and re-enter.

One or more points on the source module are referenced by a PID loop,
and the target I/0 unit is not the source I/0 unit. To move the module,

remove the PID loops, or make sure the source module and the target

module are the same.

The target module cannot be used because it’s not compatible with
the source module.

The source I/0 unit cannot be verified.
The target 1/0 unit cannot be verified.

The source module position is out-of-range. Check the number and
re-enter. Remember that module positions are zero-based (count up
from 0 instead of from 1)

The target module position is out-of-range. Check the number and
re-enter. Remember that module positions are zero-based (count up
from 0 instead of from 1)

The points on the source module are not allowed on the target I/O unit.
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Error

Operation code

40

41

42

43

44

45
46

47

48

49
/mp (Move Point)

50

51

52

53
54
55

56

57

58
59

60
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Meaning (Continued)

The source I/0 unit is missing. Please enter the name of the source I/O
unit.

The source point name is missing. Please enter the name of the source
point.

The target I/0 unit is missing. Please enter the name of the target I/0
unit.

The target module position is missing. Please enter a target module
position number. Remember that module positions are zero-based
(count up from 0 instead of from 1).

The target point position is missing. Please enter a target position
number. Remember that point positions are zero-based (count up from
0 instead of from 1) and are the position on the module (not the abso-
lute point

position).

The source I/0 unit is not in the strategy. Check the name and re-enter.

The source point name is not in the strategy. Check the name and
re-enter.

The target I/0 unit is not in the strategy. Check the name and re-enter.

The target module position is out-of-range. Check the number and
re-enter. Remember that module positions are zero-based (count up
from O instead of from 1).

The target point position is out-of-range. Check the number and
re-enter. Remember that point positions are zero-based (count up from
0 instead of from 1) and are the position on the module (not the abso-
lute point position).

A point already exists at the target point position. Enter an empty point
position.

The point on the source module is referenced by a PID loop, and the
target 1/0 unit is not the source I/0 unit. To move the point, remove the
PID loop, or make sure the source module and the target module are
the same.

The target point cannot be used because it's not compatible with the
source point.

The source I/0 unit cannot be verified.
The target 1/0 unit cannot be verified.
The source point name cannot be verified.

The target module position is out-of-range. Check the number and
re-enter. Remember that module positions are zero-based (count up
from 0 instead of from 1).

The target point position is out-of-range. Check the number and
re-enter. Remember that point positions are zero-based (count up from
0 instead of from 1) and are the position on the module (not the abso-
lute point

position).

The point on the source module is not allowed on the target I/0O unit.
Quadrature modules must be moved to an even numbered channel.

Quadrature modules require two adjacent channels. The second chan-
nel is occupied by another point.
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. Error . .
Operation code Meaning (Continued)
80 The variable could not be found in the strategy.
81 The data type of the variable does not match the data type of the vari-
able in the strategy.

/pasvrw . . . .
/pasvr 82 Cannot set a write attribute on Down Timers or Up Timers.
/pacvrw 83 The variable cannot be updated.
/pacvw . . ) )

84 Cannot clear a write attribute on Down Timers or Up Timers.
/pascrw
/pascr 85 Public access setting does not apply to pointers or communication
/paccrw handles.
/pacew . 20 The channel was not found.
(Set or clear public
access setting on 91 The signal type of the channel does not match the signal type of the
variables or chan- channel in the strategy.
nels) 92 Cannot set a write attribute on input channels.

93 The channel cannot be updated.

94 Cannot clear a write attribute on input channels.

KEYBOARD AND MOUSE SHORTCUTS

Use the following keyboard and mouse shortcuts to view and navigate a chart.

Action Shortcut Action Shortcut

ONLINE HELP

Center on Block0 | 0 or Numeric Keypad 0 Move to Bottom Left Numeric Keypad 1

Center on Block... [J Move to Bottom Numeric Keypad 2

Block Preview Middle-click on a block Move to Bottom Right | Numeric Keypad 3

Move to Top Left Numeric Keypad 7 Zoom In +

Move to Top Numeric Keypad 8 Zoom Out -

Move to Top Right | Numeric Keypad 9 Zoom to Fitand Center |F

Move to Left Numeric Keypad 4 Zoom to 100% Z

Move to Center Numeric Keypad 5 Pan Space + Left Mouse Button
Move to Right Numeric Keypad 6

To open Help within PAC Control, click Help > Help Topics in the PAC Control menu bar, or click the Help
button in any dialog box. Help buttons in dialog boxes are context-sensitive and provide help specifically on
that dialog box. Buttons labeled “Command Help” give specific information on the command (instruction) you
are currently using. (The command must be highlighted to open Command Help.)

For brief explanations of buttons, move your mouse over the button and look in the status bar.

In Action and Condition Instructions dialog boxes, let your mouse rest for a second on a command, and you'l
see a list of the variable types used in that command. (To show or hide the variable types list, in Configure
mode, click PAC Control Options > Show/Hide Instruction Type Information.)
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To open copies of PAC Control manuals and quick reference cards, click Help > Manuals. You willneed Adobe
Acrobat Reader to open these files. You can also find information, documents, and support on the Opto 22
website.
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4: Designing Your Strategy

INTRODUCTION

This chapter introduces you to PAC Control programming—how to design a PAC Control strategy to control
your automated process. For additional important information on using PAC Control commands (instructions)
to program your strategy effectively, see page 285 and the individual command information in the PAC Control
Command Reference.

NOTE: Because our focus in PAC Project is on the SNAP PAC System, PAC Control initially shows only SNAP PAC1/O units
and the commands used with them. When you're using the SNAP PAC system only, hiding legacy 1/0 units and
commands makes it simpler and less confusing to build your strategy. However, the legacy capabilities are still there
and can be made visible in a specific strategy as needed. For information, see “Legacy Options” on page 234.

In This Chapter

STEPS 1O DESIGN covvvrrevvvvrrssisssrnssesssssssesssssssesss s ssssssssssssssessssssssssssseese page 77
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STEPS TO DESIGN

How do you get from your real-world control problem to a working PAC Control strategy that solves it?
Here's an outline of the basic approach; we'll fill in the details on the following pages.

First, solve the problem.
«  Define the problem.
- Whatam I trying to do?
- What inputs and data do | have to work with?
—  What do the outputs have to be?
- How many times does the process have to be repeated?
«  Design alogical sequence of steps to solve the problem.
—  Break down the larger process task into sub-process tasks.
- Break down the sub-process tasks into detailed steps.
«  Testthe steps.

Next, build the strategy.
«  Configure hardware.
- Control Engines
- 1/Ounits
- 1/Opoints
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«  Determine necessary variables and configure them.

«  Create charts, one for each sub-process, and add instructions.
«  Compile and debug each chart.

«  Compile and debug the whole strategy.

Finally, use and improve the strategy.

Now let's take a look at each of these steps in order.

Solving the Problem

You can avoid a lot of extra time and rework if you define and solve your problem before you ever start
building a flowchart in PAC Control.

Defining the Problem

Suppose, for example, you want to automate a simple lawn sprinkler system. Start by asking yourself (or
others) questions about the control process you're trying to do.

What are you trying to do? Start with the big picture and work down to the smaller details.
»  Big picture: I'm trying to control this sprinkler system.
»  Smaller details:

- The sprinklers should turn on every Sunday and every Wednesday.

—  They should not turn on if it's raining.

—  They should start at six o'clock in the morning.

- Theyneedto run for 15 minutes.

What inputs and data do you have to work with? List all the inputs. Describe the data they provide. Check
for any inputs or data you need but don't have.

Input Data the input provides

Hygrometer Humidity (percentage from 0-100%)

Day Day of the week (Sunday through Saturday)

Time Hour of the day (24-hour clock)

Sprinkler status Whether sprinklers are currently running (on or off)
Input from timer Length of time sprinklers have been on (in minutes)

What do the outputs need to be? List all the outputs. Describe the results that are needed. Check for any
outputs you need but don't have.

Output What it does
Sprinkler switch Turns sprinklers on or off
Timer control Sets timer

How many times does the process have to be repeated? Our example is a simple sprinkler system in
which the process happens twice a week on certain days. In a more complex system, however, you might
have one section of the sprinklers turn on, followed by other sections, repeating the process several times in
different areas and then repeating the whole pattern on certain days.

78 PAC Control User’s Guide, Legacy Edition



CHAPTER 4: DESIGNING YOUR STRATEGY

Designing a Logical Sequence of Steps to Solve the Problem

Now that you've determined what you're trying to do and what your inputs, data, and outputs look like, you're
ready to outline the steps needed to solve the control problem. Think about how you would do the job if you
were doing it by hand. Again, work from the top down, starting with big steps and then breaking those big
steps into smaller steps.

Sprinkler Control System
Every day at 6:00 a.m.:

1. Check the day and the weather.

2. Ifit's raining, leave the
sprinklers off.

3.Ifit's the right day and it's dry,
turn them on.

1. Check the day and the weather.

Read the day of the week.
If it's Sunday or Wednesday, read the
hygrometer.

2.If it’'s raining, leave them off.
If the hygrometer says 100%,
check to make sure sprinklers

are off.

3.Ifit’s the right day and

it's dry, turn them on.

If it's Sunday or Wednesday and if
the hygrometer says 99% or below,

turn sprinklers on.

Start the timer.

When they've been on for 15
minutes, turn them off.

If they're on, turn them off.

If a human being were doing this job, this level of instruction would probably be just fine. With a computer,
however, the instructions need more detail. For example, the first instruction, “Every day at 6:00 a.m.,” would
have to be expanded more like this:

a. Read the hour.
b. If the hour equals six, go on to the next step.

¢. If the hour does not equal six, go back to step a.

Testing the Steps

Now that you have your steps in place, run through each sub-process in your mind to see if anything is
missing. Is there an answer for every “if"? Are all the possibilities taken into account?

It may help you to draw out your control process as a flowchart. Often it is easier to see decision points and
responses to decisions in a flowchart. You're still working at the human level at this point; just be aware that
the computer may require more details.

Here's a possible flowchart for the simple sprinkler control problem.
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Simple Sprinkler System Process Flowchart

At 6:00 a.m., read the
day of the week <

Is it Sunday or
Wednesday?

Wait 24 hours |«

Read the hygrometer |

Yes

Is humidity less
than 1009%?

Sprinklers off?

Turn sprinklers on Turn sprinklers off |_
and set timer for | P

15 minutes

| Turn sprinklers off |

Building the Strategy

Once you have the control problem solved in detail, you can begin building the strategy in PAC Control. Now
you'll add all the logical details the computer needs.

Configuring Hardware

The first step in building your strategy is to configure your control engine, /O units, and /O points. (For details
and step-by-step procedures, see Chapter 5: Working with Control Engines and Chapter 6: Working with 1/0.)
You can add more I/0 units and points later if needed, but it saves time to configure them now.

When you solved this control problem, some of the inputs and outputs you defined were physical I/0, such as
the hygrometer and the switch to turn on the sprinklers. You configure these physical inputs and outputs as
the 1/0 points.

Here are the I/0 points you might configure for the simple sprinkler system:

Physical 1/0 Type 1/0 Point Name
Hygrometer Analog Input Hygrometer

Sprinkler status Digital Input Sprinkler_Status
Sprinkler switch Digital Output Sprinkler_Switch
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Determining and Configuring Variables

Some of the inputs and outputs you defined when you solved the problem were not physical /0, but
information. For example, the day of the week is not a physical input; it's a piece of information you can get
using a command in PAC Control. These inputs and outputs become variables.

You also need variables to store the information that input points give you. And you may need variables for
manipulating information.

To determine the variables you need, think about the pieces of information your process requires. Then look at
the PAC Control commands in the PAC Control Command Reference. Find the commands you need and check
them to see what types of variables each command requires.

For example, you need to know what day of the week it is. Will the control engine give you this information as
a string (for example, “Wednesday”) or in some other format? When you check the command Get Day of
Week, you discover that the day is returned as a number

(Wednesday = 3), so you set up this variable as a numeric integer.

Here are some variables you may need. (See Chapter 9: Using Variables and Commands for more information
and step-by-step procedures to add variables.) You can change them or add other variables later if necessary.

Variable Needed Type Name in PAC Control
Hour of the day Numeric (32-bit integer) Time_of_Day

Day of the week Numeric (32-bit integer) Day_of_the_Week
Humidity Numeric (float) Humidity

Down timer Timer Timer

Creating PAC Control Charts and Adding Instructions

If you have already drawn the process in a flowchart, this step will go faster. PAC Control is based on flowcharts
because they are a natural way to show a control process. And the block names and instructions you add to
charts—ijust like the names of variables—are in normal, everyday language. (For details and step-by-step
procedures, see Chapter 8: Working with Flowcharts and Chapter 9: Using Variables and Commands.)

The difference between the flowchart you drew before and the chart you create in PAC Control is that the
flowchart was designed for human beings, but the PAC Control chart must be more detailed so the computer
can follow it.

Because the chart is more detailed—and because most control processes are far more complex than our
sprinkler system—you will usually create multiple charts for a PAC Control strategy. Break the process down
into logical chunks, or modules, and then create a chart for each module. A modular design makes it easier to
test and to update your strategy.

Even for a simple process like our sprinkler control, there is no single “correct” way to solve the control
problem and build the strategy. Instead, there are many possible ways.

The following chart shows one example:
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AT Chart

One difference between this chart and the human-level chart on page 80 is that several delays have been
added to the chart. There is one before rechecking the hour of the day, one before rechecking the day of the
week, one before rechecking whether the timer has expired, and finally one before starting the flowchart over
again.

This sprinkler system is not time-critical. If the sprinklers turn on at a little past 6:00 a.m. or the grass is watered
an extra few seconds, it doesn't matter. Delays give the control engine time to do other things. (For more
information on delays and using control engine time effectively, see page 98)

Each block in the chart contains the PAC Control commands (instructions) that do the work in the system. For
example, here are the instructions for the block “Turn on sprinklers, set timer”:

# Instructions - Dough_Chip_Control - Start

Turn On Add...
Sprinkler_Switch

Set Down Timer Preset Value

Target Value 900.0

Down Timer Timer

Mewt Block

Start Timer

Timer Timer Previous Block

[ Cloze ] [ Help ]

As you create charts and enter instructions, keep referring to the PAC Control Command Reference. The
Command Reference describes the “arguments”for each command, which are pieces of information you must
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enter in the instruction. You can also press F1 to open online help for commands, which gives you the same
information as in the printed Command Reference.

For example, one of the commands shown above, Set Down Timer Preset Value, has two arguments. The
Command Reference and online help tell you that the first argument—the target value, or the value from
which the timer counts down—can be a float variable or a float literal (entered in either decimal or
hexadecimal form), and that the second argument is the name of the down timer variable. You need this
information when you enter the instruction in the Add Instruction dialog box.

#1 Add Instruction

Instruction:

|SetD0wnTimerPresetVaIue v| [ Select... ]
LComment:
Tupe Marme
Targst Value Float Literal v| [a000 v|
Arguments < _
Down Timer D ovar Tirmer Y ariables v| |Timer v|

[ QK ] [ Cancel ] [ Help ] [ Command Help ]

The sample flowchart we've shown uses standard PAC Control commands only. If you have a programming
background, you may wish to incorporate OptoScript blocks in your flowchart. OptoScript is a procedural
language that can simplify some programming tasks, including string handling, math calculations, and
complex loops and conditions. See Chapter 11: Using OptoScript for more information.

Compiling and Debugging the Strategy

When all charts are completed and their instructions added, the next step is to compile and debug the
strategy. But first, check your hardware. Check cabling and connections, and make sure the actual I/O matches
the configured I/0 in the strategy.

Now compile and debug the strategy. (For details and step-by-step procedures, see Chapter 7: Working with
Strategies. If you have problems, see Appendix A: Troubleshooting.)

If you have multiple charts, debug each one separately and then debug the strategy as a whole. It is easier to
find errors in one flowchart than in a group of interrelated ones.

Make sure the connections between charts are accurate. For example, is a chart started at the correct block in
another chart?

Use the debugging tools discussed in Chapter 6 to find errors by stepping through a chart and setting
breakpoints to discover which block or line contains the problem. And if you've tried everything and it still
doesn't work, contact Opto 22 Product Support at 800-835-6786 (toll-free in the U.S. and Canada) or email
support@opto22.com.

Using and Improving the Strategy

Any strategy is one of several possible ways to solve a control problem. One way may be more efficient under
some circumstances; another way may be better for others. As you use the strategy over time, as control needs
change, and as you become more knowledgeable about PAC Control, you'll find ways to make the strategy
better.
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BASIC RULES

The sprinkler strategy we just created is a simple example. This section gives basic rules to keep in mind when
you're solving more complex control problems.

When you create a new PAC Control strategy, a Powerup chart is automatically included. You add all the other
charts you need, and the total number of charts in the strategy is limited only by the control engine’s memory.
Be aware, however, that the maximum number of charts that can be running at any one time is based on the
control engine you are using:

« 16 chartson a SNAP PAC R-series or SNAP-LCE controller
o 32chartson a SNAP PAC S-series controller

o 64 chartson a SoftPAC controller

o 8charts on SNAP Ultimate I/0

Program logic moves through a flowchart in one of two ways: flow-through or loop.

«  Achart with flow-through logic performs a set of specific commands and then stops. It has a beginning
and an end, and at the end is a condition or action block that has no exit.

Subroutines, the Powerup chart, and any other chart that does not need to run continuously (such as an
interrupt chart) should always have flow-through logic. In complex strategies, be careful when using
delays and condition looping (waiting for something to occur) in charts with flow-through logic.

«  Achartwith loop logic has no end. It loops through a set of actions and conditions continuously. A
loop-logic chart can have several paths through which the direction of the logic may flow, depending on
certain criteria. Use loop logic for a chart that needs to run continuously. (The simple sprinkler chart has
loop logic; it runs continuously.)

Chart Guidelines

As you design your strategy, put each sub-process of your overall control problem into a separate chart within
the strategy. As noted above, on a SNAP Ultimate brain, you can have a maximum of eight charts (plus one
host task) running at once. On a SNAP PAC R-series or SNAP-LCE controller, a maximum of 16 charts (plus one
host task) can run at once. On a SNAP PAC S-series controller, 32 charts (plus one host task) can run at once. On
a SoftPAC controller, 64 charts (plus one host task) can run at once. (For more information, see “Optimizing
Throughput”on page 98.)

In general, follow these chart guidelines:

«  Use the Powerup chart just to set initial values for variables, perform setup commands, and start the main
charts. Use flow-through logic so the Powerup chart will stop as soon as the other charts begin.

«  Create a few charts to monitor essential or time-critical pieces of your process, such as emergency stops
on dangerous equipment or I/0 that must be monitored continuously. These charts should use loop
logic so they are constantly running.

«  Create an Interrupt chart only for critical event/reactions that send interrupts through direct lines from an
/0 unit to the controller. See “Using an Interrupt Chart for Event/Reactions (mistic only)”on page 87 and
“Using an Interrupt Chart with the Generating Interrupt? Command (mistic Only)” on page 338.

« Ifasetof operations is used multiple times in your strategy or is used in more than one strategy, you can
put that logic in a subroutine and call the subroutine when needed. Calling a subroutine doesn't require
as much time as calling a chart or starting a new chart. In addition, a subroutine starts as soon as it is
called in the context of the chart that is calling the subroutine. A Start Chart command is simply placed in
the task queue and started in turn. See Chapter 12: Using Subroutines for more information.

«  Use the text tool to type a descriptive title in each chart and add any necessary explanations. Keep blocks
far enough apart to easily see the flow, and if possible, design the chart so its entire flow can be seen
within one window. If a chart becomes too complex, split it into smaller charts.
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«  When you use OptoScript code, remember that it is not self-documenting. Be sure to add comments so
that you or others can easily see what the code is doing. (Similar comments are also useful in other PAC
Control flowchart blocks.) Use OptoScript blocks within a flowchart for operations they make easier, such
as string handling and math calculations, but keep the logic and purpose of the strategy clear in the
flowchart.

«  Within a chart, leave Block 0 empty. This makes it easy to insert logic at the beginning of the chart by
adding a block between Block 0 and the next block. If a block contains more instructions than can be
easily traced and debugged, break it down into two or more sequential blocks. Never place another block
in the flowchart before Block 0. Charts always start with Block 0, which cannot be deleted.

Naming Conventions

To save trouble in the long run, it's wise to establish naming conventions for charts, blocks, variables, I/0 units
and points, control engines, subroutines, and so on. If you name these elements in a consistent way from the
beginning, it is easier to find them in lists, to see related elements, and to know their functions without
opening them.

Since PAC Control automatically alphabetizes these names, you can plan naming schemes to place similar
items together in the way you expect to use them.

Names have a maximum length of 50 characters. They can be all upper-case characters, or they can be mixed
case.

In chart names, for example, you might include a few letters indicating whether the chart monitors critical
tasks, is a master chart calling others, or is periodically called:

«  Mntr_Tank_Leak (constantly running chart that monitors a critical situation)
o Mstr_Conveyor_Process (master chart that calls others for a sub-process)
«  (Call_Message_Display (chart called by a master chart for a specific purpose)

Block names should tell what the block does, so you can understand a chart without needing additional
explanations. Block names should describe the purpose of the instructions within them. Use a question for the
name of a condition block, with a true exit reflecting the answer yes.

«  Read Thermometer (action block)

«  Temperature Too High? (condition block)

o Turn OnPump 1 or Pump 1 On (action block)
«  Pump On? (condition block)

Variable names can include Hungarian notation to indicate the type of variable, since the variable type is not
always apparent in its name. For example a variable named Month might be either a string or an integer.
However, using Hungarian notation, sMonth indicates a string, and nMonth indicates an integer.

Another good practice is to identify variables used in a single chart differently than variables used by more
than one chart or process, especially if you have a large chart and want to separate these types of variables. For
variables used only in a table, you can include the table name in the variable name. For example, you might
use the name Fail_Count_in_Config_Values for a variable to be used in a table named Config_Values.
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The following table shows suggested notation for use in PAC Control:

Variable type Letter Variable type Letter

integer 32 variable n pointer variable p
integer 32 variable used as Boolean | b pointer table pt
integer 32 table nt digital /0 unit dio
integer 64 variable nn mixed I/0 unit mio
integer 64 table nnt analog input point ai
float variable f analog output point ao
float table ft digital input point di
down timer dt digital output point do
up timer ut chart cht
string variable s communication handle cmh
string table st

In 1/0 point names, you may want to indicate the point’s function, the state of the device when the point is
active, its location, or a schematic reference. You can abbreviate names of familiar devices and write out less
familiar names. Include the information you need in the order in which it will be most useful to you:

«  Heater_Switch (You have only one heater.)

o Htr6_Switch_SW23B (You have many heaters, and the schematic reference is needed.)
«  Cnvyr_Speed_Encoder_BIdgA (You want all conveyors to appear together.)

«  BldgA_Cnvyr_Speed_Encoder (You want all points in Building A to appear together.)

INSTRUCTION EXAMPLES

This section includes examples of common instructions you may want to use. See Chapter 10: Programming
with Commands for more information on programming with PAC Control. If you need to use math
calculations, strings, or complex loops and conditions in your strategy, also see Chapter 11: Using OptoScript
for examples of OptoScript. OptoScript is a procedural language within PAC Control that can make
programming easier, especially if you are an experienced programmer.

Creating Messages to Display On Screen

You may need to create messages to display on screen, for example to give data to operators. Typically these
messages consist of some specific, literal words and symbols followed by a variable value and maybe some
additional literal words or symbols.

Current temperature=|86.3F.
A A »
T T\
Literal words Variable  Literal words
& symbols value & symbols

Average price=5/4.86

You can create the message in a single block in your PAC Control chart, like this:
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1. To enter the literal text, use the
command Move String. Remember
to include spaces where you want T .
ove String
them to appear, such as after the ™ __From “Current temperature = *

equal sign. To Current_Temp_Message

1 Instructions - Message Display - Create Message

Convert Float to String

2. Add the variable value by converting E::;f: ;:”"e"‘—”“"l’
it to a string and appending it to the e Hext Block
i - ecimals 1
string you just created. Put Result in Current_Temp_String Previous Black

ppend String to String
Append Current_Temp_5Siring
To Current_Temp_Message

Append String to String

Append "F.
3. If needed, append another To Current_Temp_Message
literal string.
.|
’ Cloze ] ’ Help ]

Alternatively, you can create the message by placing the following OptoScript code within a single OptoScript
block:

FloatToString (Current Temp, 5, 1, Current Temp String);

Current Temp Message = "Current temperatu;e =g Current Temp String +
"F . n ,.

OptoScript can be more efficient for string handling than standard PAC Control commands. See Chapter 11:
Using OptoScript for more information.

Using an Interrupt Chart for Event/Reactions (mistic only)

An Interrupt chart is primarily intended to be used with mistic serial brains and event/reactions. The purpose
of an Interrupt chart is to handle interrupts from mistic serial brains specially wired to a SNAP PAC S-series
controller. These interrupts are generally used for critical events requiring immediate action. If you create a
chart named Interrupt, PAC Control will compile the chart so that it is used correctly.

If an interrupt chart exists in the strategy, it will be started and suspended automatically when the strategy is
run. When a mistic interrupt is received by the controller, the Interrupt chart will execute.

To create an Interrupt chart:

1. With your strategy open and in Configure mode, select Chart > New, or right-click the Charts folder on
the Strategy Tree and select New from the pop-up menu.

The Add New Chart dialog box appears.
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#1 Add New Chart

X

Mame:

Drescription:

[ ak. H Cancel ][ Help ]

2. Enter the name Interrupt (which is not case sensitive), then enter a description if you want and click OK.
A message appears saying that an Interrupt chart has a special meaning and behavior.

PAC Control Professional

A chart named "Interrupt” has special meaning and behaves differently than reqular charts.,
\t/ 1t is primarily intended ko be used with miskic serial brains and Event/Reactions,

Do you wank bo continue using the "Interrupt” name for this chart?

[ s |[ Mo ]

3. ClickYes.
A chart named Interrupt is created.

Adding Logic to an Interrupt Chart

To use the new Interrupt chart for event/reactions, you need to create three basic blocks:
»  Condition blocks that determine which I/O unit and event/reaction generated the interrupt
«  Action block(s) to clear latches and interrupts, so the Interrupt chart won't keep on running

«  Action block(s) to take whatever action is necessary when the event/reaction occurs, for example to start
an alarm chart or stop a process.

Here's how a simple interrupt chart might look:
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D L]
o
n
Black 0
Condition block determines S R
whetheran I/O unit has C e Foo o E
generated an interrupt. Unit 1 p” Unit2 »
Gen Int? .
T
Action block clears [’ Clear Latch *Add similar logic for
latches and interrupts. T Jandntermupt | - - o - RO Uit
. 64 004001005 11 i B €
i : r 5
ER 1 T Suspend | Start Alarm
! atch On? o Charts ) Handler
Condition blocks =
determine whether an .. . . F
event has occurred. )
ER2 > T _f Suspend " |¥ Start Alarm
! atch On? o Charts ) Handler
F
o
Action blocks take | Emd
necessary action o e
when event occurs. < 5
(1) Shortcuts
LD T chart £

Notice that the Interrupt chart uses flow-through logic. When it finishes (and there are no interrupts), the
interrupt chart goes back to Block 0, becomes suspended, and waits for the next interrupt.

See also:
«  Forinformation on using interrupt commands, see “Using an Interrupt Chart with the Generating
Interrupt? Command (mistic Only)”on page 338.

«  Formore information about time in the task queue, see “Optimizing Throughput”on page 98.
»  For more information about event/reactions, see “Event/Reaction Commands”on page 337.

Error Handling

Every strategy should have a way to handle errors. It's important to check values and errors that are returned
from the commands in your strategy. Communication to an I/0 unit, for example, will be automatically
disabled if a command sends it variable values that are clearly wrong, such as a memory map address in an
incorrect format.

Counting

Most standard digital inputs can be used as counters to count the number of times the input changes from off
to on. The availability of counters depends on the brain’s capabilities, and the speed of counters depends on
the module.
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For information on brain capabilities, see the SNAP PAC Brains Data Sheet (form 1689).

For more information on module counting speed, see the module’s specifications on the Opto 22 website,
www.opto22.com. On the website, select Products > SNAP PAC System > Brains and I/0 > Digital I/0.

NOTE: You can use counters on high-density modules with SNAP-PAC-RT and SNAP-PAC-R1-B controllers, and
SNAP-PAC-EBT and SNAP-PAC-SBT brains with firmware R8.1 or higher.

Before using a counter, you must configure the point as a counter. (See “Adding /O Points” on page 130, or
use PAC Manager.) Counters on Ethernet and SNAP PAC I/0 units do not need to be started, and they cannot
be stopped. Therefore, do not use the Start Counter and Stop Counter commands with SNAP PAC /0 units.
However, you can use Get Counter and Get & Clear Counter.

Counters on mistic I/0 units must first be started using the Start Counter command. In addition to Start
Counter, you can use the following commands on mistic 1/0 units: Stop Counter, Get Counter, Get & Clear
Counter, and Clear Counter.

Using a Count Variable for Repetitive Actions

A numeric variable for counting is useful when the same action needs to be repeated a specific number of
times. For example, suppose your process includes filling a packing box with a dozen bags of cookies. You can
use a count variable to track how many bags are dropped into the box.

Here's part of a chart showing how you would use a count variable in this way:

— Shipping_Area

A Instructions - Shipping_Area - Count = 122

Is Bag_Count Add...
Equal?
To 12
Next Block
Previous Block
Operator
(& AND
[ Close ] [ Help ] ammand Help OO0R

If you are an experienced programmer, you'll notice that this example isa for loop. You can use the following
OptoScript code within a single OptoScript block to accomplish the same result:

for Bag Count
Bag_ Dropper
next

1 to 12 step 1 //Count 12 items dropped into box
1; //Turn on bag dropper
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See Chapter 11: Using OptoScript for more information on using code to streamline control structures in your
strategy.

Programming Case Statements

Afrequent need in programming is to create case statements, also called “switch” statements, “if/then/else”
statements, or "nested if” statements. These statements create multiple decision points: if the condition is A,
then X will happen; if the condition is B, then Y will happen, and so on. (This example uses regular PAC Control
commands; see Chapter 11: Using OptoScript for another option that takes up less space in your flowchart.)

For example, suppose you have a conveyor with three speeds: high (3), low (2), and stopped (1). Sometimes it
runs at high speed, sometimes at low speed; but before a box can be put on the conveyor, the conveyor must
be stopped. And it can be stopped only from low speed, not from high speed. Here's a portion of a chart
showing the case statements that control this process:

Conveyor speed is checked
and moved (copied) into a
variable.

A Instructions - Conveyer_Operation - Get conveyor s... E]

= Conveyer_Operation

’ ' 1 v
. Box ready? . .

Add...

From Conveyor_Speed_Sensor
Conveyor_Speed

Modify...

Delete

A Instructions - Conveyer_Operation - Speed high?

Each condition block checks

e Is Conveyor_Speed Add.. foraparticular speed. This one
.o Lo P Equal? i
............ S To 3 Modify... checks for high speed (3).
]
................. A Instructions - Conveyer_Operation - Shift to low
..... . = i If speed is too high, it is
From 2 shifted down to the next

4 i Conveyor_Speed lodf 2 level, until the conveyor is
............... ] Delete finally stopped and the box
................ can be puton.

Shift to low

(i) Shortcuts | 1003 w

[ Cloze ] [ Help ] Command Help

The example above shows three cases, because there are three possible speeds and each speed demands a
different action.
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If you had only two possibilities (for
example, if the box could also be put
on the conveyor at low speed), you
could handle both possibilities within
one condition block. For example, you
could put two Equal? commands in
the same condition block, and check
the Or operator, as shown at right.

Using a Timer

Atimer stores elapsed time in units of
seconds (with a resolution in
milliseconds). Timers can range from
0.001 t0 4.611686 x 10'° seconds.

Timers come in two forms:

A Instructions - Conyveyer_Operation - Conveyor stopped? [z|
Is Conveyor_Speed Add...
Equal?
To 1 Modify...
Is Conveyor_Speed Delete
Equal?
e 2 Mewst Block
Previous Block
Operataor
() AND
Cloze ] [ Help Command Help CoR
Or operator

«  Up timers count up from zero. They're typically used to measure how long something takes.
«  Down timers start from a value you set, and then count down to zero. They're used to determine when a

event should begin.

Here's an example of a down timer. In this example, the process starts every 1.5 seconds.

The starting value for the
timer is set in Block 0.

The condition block checks Block 0
whether the timer has reached
zero. If it hasn't, the chart loops™
until it has.

rocess Timer
Expired?
N\

]

\

When the timer has expired, L
itis restarted and the process
begins. ~

“nstructions - Timer_Example_Chart - Block O

Set Down Timer Preset Value Add...
Target Value 1.5 =
Down Timer Process_Timer Madify
Start Timer Dele
Timer Process_Timer
Next Block
revious Block

Down Timer
Down Timer Expired?

“lnstructions - Timer_Example_Chart - Start Process Ti... @

Process_Timer

Next Block

When the process ends, the e End Process Start Timer

logic loops back to check __— Timer Process_Timer
whether the timer has expired < [ tnon oot rellel iy el
again.
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For more information, see "Using Timers”on page 370.

Using a Flag Lock

The Flag Lock and Flag Unlock commands allow you to give a task exclusive access to one or more objects—
such as tables, integers, or 1/0 units—until the task is complete. For example, if you want two different charts
to change the values in the same table, it is important for one chart to complete its task before allowing the
second chart to access the table.

To demonstrate, the following charts show how to construct two charts in a strategy so that each chart can
access the same table without interference from the other chart.

Chart 1 and Chart 2 are very similar. The main difference is that one block (D) in Chart 1 adds 2 to each table
element, while in Chart 2 it adds 3.

0
- - - | GetTable | - - - | GetTable |_- - - - -
A+— T _-— Am—— Lock e |
Br——y Decrement . s B —5 Pecrement
: -7 Table Index | - - . roe o . -7 Table Index
' Release Table| | ' Release Table| |
c j Lock E C Lock E
Tl
¥ o . . L J
D Add 2 10 Table| - Ce D+t |Add 3 to Table
. Element . Por e TR Element
Chart 1 Chart 2

Here's what each block accomplishes:

A—Get Table Lock. Uses the following instructions to wait until Chart 2 unlocks the flag before it locks the
flag on the table. It also tracks the number of times Chart modifies the table, and it gets the length of the table.
The Timeout value of -1 makes the chart wait the other chart has successfully unlocked the flag on the table.
See also, “Flag Lock Timeout Values” on page 94.
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o4

Flag lock will wait until
Chart 2 unlocks the flag on
the table. See also, “Flag

x]

# Instructions - Chart1 - Get Table Lock

Lock Timeout Values”on -1 Timeout = "Wiait until lock succeeds" -~
page 94. Flag Lock

Flag Int_Table_Flag

Timeout -1

Put Result in Int_Table_Flag_Result

Tracks the number of times

the t{ip|e has been Increment Variable et Black
modified by Chart1 Modified_by_Chart1
PBrevious Block

Get Length of Table

Gets the length of the Table Int_Table
table and puts it in Put in Int_Table_Index —
w
Int_Table_Index
Cloze ] [ Help

Using the numeric variables Modified_by_Chart1 and Modified_by_Chart2 (from Chart 2), a watch window
can track the number of times the table has been modified by each chart. For details, see “Using Watch
Windows for Monitoring” on page 196.

Natne Type IVAL

Modified by Chartl Integer 32 Variable 91
Modified by ChartZ Integer 32 Variable 49
Int_Table Index Integer 3Z Variahle 17

B—Decrement Table Index. The table has 100 elements, numbered from 0 to 99. This instruction block
starts at element 99 and on each loop decrements by 1 to go to the next element. This continues until it
reaches index 0.

C—Index >=0. If the index is greater or equal to zero, the chart proceeds to D. If the index equals -1, the
chart goes to E.

D—Add 2 (or 3) to Table Element. Adds two (or three) to the value of the current table index.

E—Release Table Lock. This block uses a Force unlock of zero, which means it will unlock only for the chart
that locked the flag. In this case, if Chart 1 locked the flag, only Chart 1 can unlock the flag.

Flag Lock Timeout Values

The following chart shows the effect of different Timeout values used with the Flag Lock command:

Timeout Effect

1 Wait until success. The application will wait (block) as long as it takes to lock the
flag. Since it never gives up, the only value that can be returned is 0.

Don’t wait at all. Succeeds only if the flag is available to be locked immediately.
0 Makes this a non-blocking call. If the flag is not already locked, a return of 0 (Suc-
cess) is returned. If the flag is locked, a -17 (Already Locked) error is returned.

Wait maximum of value milliseconds to lock the flag. If it succeeds within the spec-

Val h o s . . . .
alue greater than 0 ified time, 0 is returned; otherwise, a -37 (Timeout on Lock) error is returned.

Value less than 0 Produces a-8 (Invalid Data) error
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Pointers and Indexing
The following examples show three possible ways to control 16 fans based on setpoints.

Without Pointers

The first way, shown below, uses individual fan outputs and setpoint variables to determine whether to turn
off or on the appropriate fan. It's a simple way to solve the problem but takes a long time to program and
produces a large, repetitive section in the flowchart. It also consumes more control engine memory, due to
the large number of conditional and action blocks.
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Is Temp01
Greater?

Than SPO1

Each fan output (Motor01-Motor16) uses a
separate temperature input (Temp01-
Temp16) and a separate setpoint variable
(SP01-SP16). The flowchart cycles through
them all to control the fans.
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With Pointers and Indexing

The second way uses pointers and indexing to accomplish the same result in a smaller space, using less
control engine memory and fewer programming steps. The fan outputs and the temperature inputs are
referred to by pointers. The setpoints, instead of requiring individual variables, are simply numbers in a table.

FasCirl - Load Paknbers

1 It e Vi

Bl T Podier Tabile Elenieat

Irvidex FaniCaylovdex
0 Talske PRt &
Tor Podnten A=

Mlssee Toam Poimel Table Blerment
Inaden FarrCinlinviden
T ampa
Y-

1 Imstrwctions - FanCirl - Too Warm?

pTemg
G eafler Than Hurseric Table EBlement F
Al ez FanCllindex
of Tabls ESetpoints

1 Inwtructions - FamCirl - Tupn Fan (in

Cooe || Heb || Commandiise |

The flowchart sets initial values for the pointers, and
then cycles through the pointer tables to control the

N Instructions - FanCtrl - Load Pointers

fans. (Tables have already been initialized in the Move fsom Loler Tenio Hlement A Add..
Index FanCtrlindex
Powerup chart) 0f Table pthotors
To Pointer pMotor
Move from Pointer Table Element
""" S ] Index FanCtrlindex B Next Block
""" C |8 SN Of Table ptTemps _
Load Pointers To Pointer pTemp Previous Block
" Instructions - FanCtrl - Too Warm?

3 Is pTemp
Turn Fan On B B Greater Than Numeric Table Element?
" S At Index FanCtrlindex
T B Of Table ftSetpoints

[ MeytRiock |

o a| 1 Instructions - FanCtrl - Turn Fan On
~~~~~~ o]
NE pMotor
Setindex=1— -
Next Block

Previous Block

[ Close ] [ Help ] [ Command Help ]
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Using OptoScript

The third way also uses pointers and indexing, but places all the action in an OptoScript block. See Chapter 11:
Using OptoScript for more information on using OptoScript.

9 ) i | OptoScript - Alarms - Stop Conveyor %
< ﬁp date Fan } y 2
States ) »3 Actions  +€> Conditions ) Wariables 428 Test Compile dh 4/
EIRTRTE = & as OptoScript Code:
\W//loop through elements 1-16 of the table=s.
for FanCtrlIndex = 1 to 16 =tep 1

ssmove the AT and DO to the pointers
pHotor=ptMotors[FanCtrlIndex]:
pTenp=ptTemnp=[FanCtrlIndex]:
ssocompare the walues and act.
if (*pTemp:ftSetpoints[FanCtrlIndex]ithen
*pHotor=1: ~~Turn on motor
else
*pHotor=0; ~»Turn off mnotor
endif

next

OPTIMIZING THROUGHPUT

For tips on how to design your PAC Project system and program your PAC Control strategy to ensure optimum
system performance see the Optimizing PAC Project System Performance technical note (form 1776). For
additional information, see the PAC Display User's Guide (form 1702).
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5: Working with Control Engines

INTRODUCTION

This chapter shows you how to configure and work with control engines. For the list of compatible hardware
and software, see page 6.

In This Chapter

Configuring Control Engines page 99
Segmenting Networks In PAC Control page 103
Creating Redundant Ethernet Links in PAC Control page 104
Using Redundant CONtrollers ... page 108
Changing or Deleting a Control ENGINE .....cccovevvsesvevnsssserssrnn page 108
Inspecting Control Engines and the Message Queue....... page 110
Archiving Strategies on the Control ENgine........ovvvecienns page 114
Restoring Archived Strategies from the Control Engine........... page 115
Downloading Files Using PACTerminal.........o.oveeecoosessones page 118

CONFIGURING CONTROL ENGINES

Before you can use a control engine to run a strategy, you must first define the control engine on your PC and

then associate the control engine with your PAC Control strategy.

«  See "Defining a Control Engine on Your PC" below to identify the connection through which the PC and
the control engine communicate. Because this process writes to the Windows Registry on your PC, you
must define control engines for each computer that uses your strategy. (If your computer can boot to
two operating systems, you must configure control engines for each operating system.) You can define
control engines in PAC Control or in the software utility, PAC Terminal.

«  See "Associating the Control Engine with Your Strategy” on page 102 to identify which defined control
engine is the active control engine. Although you can associate several control engines with the same
strategy if necessary, the strategy can be downloaded to only one at a time. The control engine set to
receive the download is called the active engine. You must use PAC Control for associating the control
engine with your strategy.

Defining a Control Engine on Your PC

You can use either PAC Terminal or PAC Control to define a control engine on your PC. Follow these steps to
define a control engine using the PAC tool of your choice.

1. Start either PAC Terminal or PAC Control, and then open the Select Control Engine dialog box:
Using PAC Terminal:
- InWindows, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.5.
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From PACTerminal’'s menu bar, click Configure > Control Engines. When the Select Control Engine dialog
box opens, go to step 2.

Using PAC Control:
a. Start PAC Control. (For instructions, see the footnote for “Start PAC Control.”on page 10.)
b. Open a strategy in either Configure mode or Online mode.

c.  From PAC Control's menu bar, click Configure > Control Engines. The Configure Control Engines
dialog box appears.

Configure Control Engines *

Active Engine:

Cookie Controller

Engines Assodated with Strategy:
okie Controller

Set Active

Add...
Modify...
Delete

Download Options...

Cancel Help

d. ClickAdd.
The Select Control Engine dialog box appears.

Select Control Engine
Configured Control Engines:
Cookie Controller - Add...
Modify...
Delete
v
Cancel

2. The Select Control Engine dialog box lists all the control engines configured on your system, whether or
not they are associated with your strategy.

- Ifthe control engine you want appears in the list, it has already been defined on this PC, click to
highlight the control engine’s name and then click OK. Then skip to “Associating the Control Engine
with Your Strategy”on page 102.

- Ifthe control engine you want is not in the list, click Add.
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The Control Engine Configuration dialog box appears.

Contral Engine Configuration *

Configure Ethemet Connection

Configure cortral engine name and parameters:

Control Engine Name: || I A
System Type
(®) Standard
B

(7 Redundant Networks (PRO only)
(7)) Redundant Controllers (PRO anly)

Settings
IP Address/Hostriame: [0.0.0.0 1

Controller Port: | 22001

Software Retries: |0

Software Timeout: | 5000 msec

MmO O

Cancel

3. Complete the fields as described in “Control Engine Configuration Dialog Box" below.
4. (lick OK.
The Select Control Engines dialog box appears, displaying your new control engine in the list.

Select Control Engine

Configured Control Engines:
Cookie Controller
R 1 Controller

Add...

Modify...

Delete

Cancel

5. Inthe Select Control Engine dialog box, highlight the control engine you want to associate with the
strategy, and then click OK. Continue with “Associating the Control Engine with Your Strategy”on
page 102.

Control Engine Configuration Dialog Box

A—Control Engine Name. Enter a descriptive name for the control engine. Valid characters are letters,
numbers, spaces, and most other characters except colons and square brackets. Spaces cannot be used as first
orlast characters.

B—System Type. Select the system type:
«  Standard: A normal system not using redundant networks or redundant controllers.
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102

&
&

6 6

«  Redundant Networks (Pro only): A system that has redundant networks (also known as link redundancy).
When selected, two IP address boxes are available under Settings for the primary and secondary
networks. See “Creating Redundant Ethernet Links in PAC Control”on page 104 for more information.

«  Redundant Controllers (Pro only): Use with a system configured with the SNAP PAC Redundancy Option.
When selected, three IP address boxes are available under Settings for Controller 1, Controller 2, and
Arbiter. For more information on setting up the Redundancy Option, see the SNAP PAC Redundancy
Option User’s Guide (form 1831).

C—IP Address/Hostname. The IP Address/Hostname text boxes available depend on your System Type.
Each IP address is entered in decimal notation (for example, 192.9.200.24).

Hostnames are supported only in standard configurations, not redundant ones. In order to use a hostname,
your network must have a domain name server (DNS) and the hostname must already have been entered in
your DNS either by you or someone in your IT department.

«  For Standard: Enter the IP address or hostname of the control engine.

«  ForRedundant Networks (Pro only): Enter the Primary and Secondary IP addresses on a SNAP PAC
controller: the Primary IP address is ETHERNET 1, the Secondary IP address is ETHERNET 2. Both IP
addresses use the same port number. See “Creating Redundant Ethernet Links in PAC Control”on
page 104 for more information.

«  ForRedundant Controllers (Pro only): For the SNAP PAC Redundancy Option. Enter addresses for
Controller 1, Controller 2, and Arbiter. For more information on setting up the Redundancy Option, see
the SNAP PAC Redundancy Option User’s Guide (form 1831).

D—Port. Enter the control engine’s IP port number. The default of 22001 is the port of the host task on the
control engine; this default normally should not be changed.

E—Retries. Retries indicate the number of times PAC Control will reattempt communications with the
control engine. Since retries are automatically handled by the protocol (TCP/IP), enter zero here.

F—Timeout. Enter the timeout value in milliseconds. Timeout value is the length of time PAC Control tries
to establish communication through the port. If it fails, it tries again as many times as specified in D. Any
positive integer is valid. For Ethernet, 3-5 seconds (3000-5000 milliseconds) is a good starting point.

Associating the Control Engine with Your Strategy

After you have defined the control engine on your PC (see page 99), it can be associated with your strategy.

1. Ifyouarein PAC Terminal, close PAC Terminal. Open the strategy in PAC Control (Configure mode or
Online mode) and from the menu bar, click Configure > Control Engines.
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In the Configure Control Engines dialog box, the engine’s name appears in the list.

Configure Control Engines *

Active Engine:
Active engine ———[R1 Contraller |

Engines Associated with Strategy:

@I 1 Controller I Set Active

Cookie Controller

List of control engines Add...
Maodify...
Delete

Download Options. ..

OK Cancel Help

2. Checkto make sure the correct control engine appears in the Active Engine field. If not, highlight the one
you want and click Set Active.
Only one control engine can be active. If only one control engine is listed, it automatically becomes the
Active Engine.

Your control engine configuration is complete. To configure I/0 units and points, see Chapter 6: Working with
/0.

SEGMENTING NETWORKS IN PAC CONTROL

You can take advantage of the two independent Ethernet network interfaces on a groov EPIC processor or a
SNAP PAC controller to segment the control network from the company network. Because the two network
interfaces are completely independent and have separate IP addresses, they can be set up on two separate
networks. Host traffic can communicate on one, while the controller communicates with the I/O units on the
other. (If you need help understanding how the two Ethernet network interfaces on a SNAP PAC controller
differ from the two Ethernet network interfaces on a SNAP PAC brain, see OptoNews Tip: Two Ethernet
interfaces - different on PACs & brains on our website, www.opto22.com. There is a similar explanation in the
groov EPIC and groov RIO user guides for their respective products.)

To segment networks, start by assigning a secondary IP address:

«  tothe Ethemnet 2 interface on a SNAP PAC controller with PAC Manager, following instructions in the
PAC Manager User’s Guide (form 1704).

«  tothe ETH1 interface on a groov EPIC processor with groov Manage, following instructions in the
groov EPIC User’s Guide (form 2267).

Remember that this network interface must be on a completely separate network segment.

You don't need to do anything special in PAC Control. Configure only one control engine, using the IP address
of the Ethernet interface to be used for host communication. The control engine will direct communication to
I/0 units through the other interface, based upon the I/0 unit's IP address. The IP addresses of the 1/0 units
must be compatible with the secondary IP address of the controller.

NOTE: PAC Display Basic and other hosts on the company network cannot communicate with 1/0 units when they
are on a separate network. To solve this problem, you can purchase PAC Project Professional, or PAC Display
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CREATING REDUNDANT ETHERNET LINKS IN PAC CONTROL

Professional and OptoOPCServer (version R7.0 and higher) separately; these applications support network
segmenting by communicating with I/0 units through the controller. Also, you can add a second network interface
card (NIC) and assign it an IP address compatible with the I/O unit network.

CREATING REDUNDANT ETHERNET LINKS IN PAC CONTROL

(Pro only) Create redundant Ethernet links to provide a backup network connection in case the primary
connection route becomes unavailable. If that happens, the controller switches to the secondary
communication route.

There are a few ways to create redundant links in PAC Project, which you can combine:

«  Controller to I/0: When you create a redundant link from the controller to 1/0, if communication to the
primary I/0 unit IP address fails, communication switches automatically to the secondary 1/0 unit IP
address, which usually is the second Ethernet network interface on a SNAP PAC R-series controller. See
“Commands for Ethernet Link Redundancy”on page 341 for more information on primary and secondary

I/0 units.
Eggg!ggg

SNAP PAC R-series

SNAP PAC S-series

NOTE: If your system has redundant controllers, in order
touse link redundancy from the controller to the I/0, you
must connect ETHERNET 2 on the controllers and on the
1/0 units to the same switch. No other devices can be
connected to that switch.

100 |

L

«  PACDisplay Pro to controller: When a PAC Display Professional project is installed on a PC with two
network interface cards (NICs), the project can be configured to use the primary and secondary IP
addresses to access data from the PAC Control strategy running on the control engine. One address is
always active. If the primary address is unavailable, then the secondary address becomes the active
address, and the PAC Display scanner automatically shifts to the secondary address. If the secondary
address fails, then the primary address becomes the active address and automatically tries the primary
address again. For details, see the PAC Display User’s Guide (form 1702).

| = ——| PCuwithtwo NICs
Ly E E running OptoOPCServer

1L [ ... L

SNAP PAC S-series

PC with two NICs
running PAC Display Pro

NOTE: If your system has redundant controllers, you cannot use link redundancy between PAC Display Pro and
the controller. For more information on using redundant controllers, see the SNAP PAC Redundancy Option
User's Guide (form 1831).
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System Architecture for Ethernet Link Redundancy

As shown in the examples below, you can set up your system in several ways to take advantage of the link
redundancy capability in PAC Control. For additional information, see the SNAP PAC controllers’user’s guides.
For details on how PAC Display works with link redundancy, see the PAC Display User’s Guide (form 1702).

Using a SoftPAC Controller. In examples 1 and 2 below, the PAC S-series controller can be replaced by a
SoftPAC controller. The PC running SoftPAC must have two network interface cards (NICs) configured with
static primary and secondary IP addresses on different subnets.

Example 1: Ethernet Link Redundancy

In this example, the primary concern is that the Ethernet network may need maintenance or may fail, leaving
the computer running PAC Display Professional, the computer running the OptoOPCServer (as the PAC Display
scanner), the controller, and the I/O units unable to communicate.

The solution is to connect all these devices on two networks; if one network goes down, devices can
communicate on the other. Note that each computer has two network interface cards (NICs). I/0 units are
controlled by the controller. Each /O unit is connected to its own group of sensors and actuators, but all are
connected to the same two networks.

If one network needs maintenance, for example to replace a switch, you can safely shut it down using the Set
Target Address commands in PAC Control and options in PAC Display Professional.

PC with two NICs running PAC Display Pro PC with two NICs running PAC Display Pro

] =
E!Il!l_! EEI!E'! i |
PAC Display PAC Display L—
Ll
Opto 22 Redundant Network
Yy N

-| PC with two NICs running
OptoOPCServer (as PAC
Display scanner)

Ethernet switch,
network #2

Ethernet switch,
network #1

.| SNAP PAC S-series controller
- controls all /0 units

SNAP PAC R-series

Sensors and actuators,
location #1

Sensors and actuators,
location #2

PAC Control User’s Guide, Legacy Edition 105


http://www.opto22.com/site/documents/drilldown.aspx?aid=3163
http://www.opto22.com/site/documents/drilldown.aspx?aid=3163" target="_blank

CREATING REDUNDANT ETHERNET LINKS IN PAC CONTROL

106

e

Example 2: Ethernet Link, Computer, and Software Redundancy

The second example of link redundancy illustrates concern not only about the stability of the Ethernet
network, but also about the computers and the software that run on them. Any of these things—the network,
a computer, or the OptoOPCServer or PAC Display Professional software running on the computer—may need
maintenance or may fail.

The solution here is to provide duplicate computers and software, and connect all devices on two networks.
Each computer has two NICs. /O units are all controlled by the controller. Each I/0 unit is connected to its own
group of sensors and actuators, but both are connected to the same two networks.

For more information on using Ethernet link redundancy with PAC Display, see the PAC Display User’s Guide
(form 1702).

Two PCs, each with two NICs running PAC Display Pro

— e
e
— B = :
= | = =
iy s
EEEE | EEEE
PAC Display = PAC Display =
= ==,
= L

= »

L It

Opto 22 Redundant Network

Two PCs, each with two NICs running
OptoOPCServer (as PAC Display scanner)

" E

=

Fthernet switch,
SNAP PAC S-series controller hetwork #2

controls all I/0 units

arrozz

Ethernet switch,
network #1

SNAP PAC R-series

Sensors and actuators,
location #1

SNAP PAC R-series

ensors and actuators,
location #2
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@ Example 3: Ethernet Link Redundancy with Serial |/0 Units

This third example of link redundancy shows a SNAP PAC S-series controller with serial I/0 units. The
redundancy is in the Ethernet networks between the controller and computers running PAC Display
Professional and OptoOPCServer. This example provides link redundancy for the Ethernet network. Again,
note that the computers all have two NICs.

Opto 22 Redundant Network
PC with two NICs running PAC Display Pro PC with two NICs running PAC Display Pro

~—

== T
<[ <>] ] <[ <[>]>]
PAC Display PAC Display

Ethernet switch, network #2

Ethernet switch, network #1 @

3 o

SNAP PAC S-series controller controls all I/0 units

Sensorsandactuators,
location #2

Sensorsandactuators,
location #1

L Sensorsandactuators, >J
w/
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Configuring Ethernet Link Redundancy

(Pro only) Ethernet link redundancy from PAC Display Pro to a control engine is easy to configure. First, make
sure the secondary IP address has been assigned to the controller in PAC Manager. Then in PAC Control, just
enter both the primary and secondary IP addresses when you configure the control engine (see page 99).
Once you have set up link redundancy for the control engine you are using in your PAC Control strategy, it
works automatically in PAC Display.

To configure link redundancy from the control engine to I/0 units, enter both the primary and secondary IP
addresses when you configure the I/0 unit (see “Adding an I/0 Unit"on page 125).

Using Strategies with Link Redundancy

(Pro only) Although PAC Display and OptoOPCServer (as the PAC Display Pro scanner) automatically shift to
the secondary address when the primary address is not available, the PAC Control debugger does not. In PAC
Control, you control which address receives communication, so you know exactly how communication is
occurring during debugging. To change between primary and secondary control engine addresses, follow the
steps in “Changing the Control Engine that Receives the Downloaded Strategy”on page 109.

Once you have changed the address, when you enter Debug mode, you are communicating through the
address you chose. Downloading the strategy to a SNAP PAC controller through one of its Ethernet interfaces
replaces any strategy that was downloaded earlier through its other interface.

USING REDUNDANT CONTROLLERS

The SNAP PAC Redundancy Option allows you to configure two redundant SNAP-PAC-S controllers that use
the same PAC Control strategy. By utilizing sync blocks in the strategy and persistent/redundant variables, critical
data is synchronized in both controllers so that the inactive controller can take over at any time and become
the active controller. To learn more about the SNAP PAC Redundancy Option and how to set up a strategy
using sync blocks and persistent/redundant variables, see the SNAP PAC Redundancy Option User’s Guide
(form 1831).

NOTE: If your system has redundant controllers, you cannot use link redundancy between PAC Display Pro and the
controller.

CHANGING OR DELETING A CONTROL ENGINE

108

See the following topics to change or delete a control engine:

«  “Changing a Control Engine’s Definition” (below)

»  “Changing the Control Engine that Receives the Downloaded Strategy”on page 109
«  "Removing a Control Engine’s Association with a Strategy”on page 109

«  “Deleting a Control Engine from Your PC"on page 109

Changing a Control Engine’s Definition

Whenever necessary, you can change a control engine’s definition on your PC—its name, the port the PC uses
to communicate with it, or the PC port setup (such as timeouts and retries). These changes can be made
either in PAC Control or in PAC Terminal.

1. Choose one of the following:

- In PAC Control: With the strategy open in Configure mode or Online mode, right-click the control
engine name on the Strategy Tree and choose Modify from the pop-up menu.

—  InPACTerminal: From the PAC Terminal menu bar, click Configure > Control Engine.
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The Select Control Engine dialog box appears.
2. Inthe Select Control Engine dialog box, click the control engine you want to change and click Modify.

3. Make the necessary changes, following the same steps you would for configuring the control engine
initially. (For help, see “Defining a Control Engine on Your PC" on page 99.)

Changing the Control Engine that Receives the Downloaded Strategy

You can configure several control engines for a strategy, but only one at a time can receive the downloaded
strategy. The control engine that receives the strategy is called the active engine.

NOTE: In PAC Control Professional, you can also configure a control engine for Ethernet link redundancy (see “Creating
Redundant Ethernet Links in PAC Control” on page 104 for more information). In this case, you can also choose
whether the primary or secondary IP address will receive the strategy.

To change the control engine that receives the downloaded strategy, follow these steps:

1. Make sure the strategy is open and in Configure or Online mode.

2. Onthe Strategy Tree, right-click the name of the control engine you want to set as the active engine.
If its name does not appear in the Strategy Tree, follow the steps in “Configuring Control Engines”on
page 99.

3. From the pop-up menu, choose Set Active.

The active engine moves to the top of the list in the Strategy Tree.

4. (Pro only) If the control engine is configured for Ethernet link redundancy, right-click the name of the
control engine on the Strategy Tree again. From the pop-up menu, choose Use Primary IP Address or Use
Secondary IP Address.

Removing a Control Engine’s Association with a Strategy

If you no longer want to use a control engine with a strategy, you can remove its association with the strategy.
This action does not delete the control engine’s definition on your PC.

CAUTION: Do not delete the control engine from within the Select Control Engine dialog box. Doing so will delete
it from the PC as well as the strategy.

Make sure the strategy is open in Configure mode or Online mode.

2. Onthe Strategy Tree, right-click the name of the control engine you want to remove. From the pop-up
menu, choose Delete.

The control engine is no longer associated with your strategy.

Deleting a Control Engine from Your PC

If you are sure that a control engine will no longer be used with your PC, you can delete it using PAC Terminal.
Deleting the control engine removes its definition only on the PC you are using.

1. Start PACTerminal:
- InWindows, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.5.
2. Right-click the name of the control engine in the list.

CAUTION: Make sure you are highlighting the right one. You cannot undo a deletion.

3. From the pop-up menu, choose Delete.
The control engine is no longer defined on the PC.
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INSPECTING CONTROL ENGINES AND THE MESSAGE QUEUE

110

You may want to inspect or change control engines while you are running the strategy in Debug mode.
See the following topics to view control engine information and the engine’s message queue, either from
PAC Control in Debug mode or from PAC Terminal:

“Inspecting Control Engines in Debug Mode” (below)
“Viewing the Message Queue”on page 112
“Inspecting Control Engines from PAC Terminal”on page 114

Inspecting Control Engines in Debug Mode

With the strategy running in Debug mode, choose Control Engine > Inspect.

You can also double-click the active engine (the first one under the Control Engines folder) on the Strategy
Tree, or right-click the control engine and choose Inspect from the pop-up menu.

The Inspecting dialog box opens.

Inspecting: Cookie Controller - *
A—i Control Engine: SMAP-PAC-R1 at 10.20.30.40
B— Firmware Version: R9.5¢ (11:38:56 July 11, 2017)
C—————— volatile RAM: 4,98 ME free
Battery-backed RAM: 1013.75KE free
File Storage RAM: 1.88 ME free
D Up Time: 18 days, 15 hours, 50 minutes, 51 seconds
E—— Device Time: 08:58:56 May 12, 2018 Sync time to PC — F
G_— Message Queue: 0 messages
H Strateqgy information
Active: Cookies  {07:24:55 May 12, 2018 )
0 chart(s) running Archive: No |
J—— | Run W Stop E StoretoFlash /K
L — T Alternate: Mot Enabled /
N Stored in Flash: A strategy is stored in flash memory
0__5u:tnrun: ()Enabled (@) Disabled
Communication
P Loop Time: 4.17 msec
Q — | Comm Errors: None

Here you see data relating to the control engine. If you are using Ethernet link redundancy in PAC Control
Professional, remember that the information shown is for the IP address you chose before entering Debug
mode. (See “Using Strategies with Link Redundancy”on page 108 for more information.)

A—Control Engine. Type of device the control engine is running on and the device’s IP address.

PAC Control User’s Guide, Legacy Edition



CHAPTER 5: WORKING WITH CONTROL ENGINES

B—Firmware Version. \ersion number of the firmware (kernel) loaded on the device, and the date the
firmware was released.

C—Memory Available. Amount of memory (RAM) available on the control engine. For example, a SNAP
R-series controller has a total of 16 MB of RAM on the control side, 2 MB of which is battery-backed. Volatile
RAM shows the amount of total RAM available for use. Battery-backed RAM shows the amount available in
battery-backed RAM, where persistent variables, variables initialized on download, the autorun flag, and the
strategy archive are stored. File Storage RAM shows the space available in the control engine’s file system See
the PAC Manager User’s Guide (form 1704) for more information about the file system. See also the SNAP PAC
Memory Usage Technical Note (form 1646).

D—Up Time. Total time that the control engine has been running since powerup.
E—Device Time. Current date and time recorded on the control engine.

F—Sync time to PC. Click to synchronize the control engine’s time and date to that of the PC running PAC
Control.

G—Message Queue. Number of messages (information, warning, and error messages) encountered when
attempting to run the strategy on the control engine (up to a maximum of 1000 messages). (See “Viewing the
Message Queue”below.) Click to open the View Messages dialog box, listing the details of any information,
warning, or error messages.

H—Active. Name of the strategy currently running on the control engine, the date and time it was
downloaded, and the number of charts currently running.

I—Archive. Information about the strategy currently archived on the control engine.
J—Run/Stop. Start or stop the active strategy.

K—Store to Flash. Click to store either the active or alternate strategy to flash memory. Only one strategy at
a time can be stored in flash memory. This button is enabled if there is a strategy stored in RAM, even if the
strategy is currently stored in flash. See Burned in flash (N) on this dialog box.

L—Alternate. Name of the alternate strategy, and the date and time it was downloaded.

M—Switch and Run/Switch. Click Switch and Run to make the alternate strategy the active strategy and
run it in the control engine. Click Switch to make the alternate strategy the active strategy without running it.

N—Stored in flash. Shows whether a strategy is currently stored in flash memory.

O—Autorun. Click to indicate whether the strategy should automatically run when the control engine is
restarted. The strategy must be stored to flash to autorun. See Store to Flash (above) and “Saving a Strategy to
Flash”on page 204.

P—Loop Time. Time required to gather the inspection data from the control engine (the average time
taken for a single transaction).

Q—Comm Errors. Any communication errors.
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Viewing the Message Queue

The message queue holds error, information, and warning messages. All may be helpful in troubleshooting.
When a message is placed in the queue, a blue INFO, yellow WARNING, or red ERROR box appears in the PAC
Control status bar, as shown in the following diagram.

#1 PAC Control Professional - [Counter] |’._||’E|P5__<|
ﬁFile Edit Control Engine Debug Chart  Subroutine Mode Tools Wiew Watch  Window Help - 8 x
=} Debug #4 L[| AR
@ Previous_Count L 4
2] status L Block 0
@ Takal_Count
+ | String Yariables
IC5) Painter Yariables
IC5) Communication Handles
IE5) Mumeric Tables
[C5) String Tables ?
IC5) Painter Tables T 1
= [ IO Units . _
3
= G RLA 4 “Production '
=1 ) Paints : Details -
L po_switch : :
I“'%“_' Sprinkler _Switch
= plarm 2
E— - - - - Counter
o= FID_Output P
OM_, Refrigeration < | ¥
= F'IE:I Input T =
IR iR ] Fiurino || Step Off fBreak 0rf || [EETETS T
< | ¥ ' Chart /
| v| @ Mext ﬁ} Prev —|ﬁ| Counter ﬂ’l Meszages ﬂ’l Powerup |
IC:'l,Program Files\OptoZ2\PAC Project 8, 14Control Pro ExamplestioCookies\Cookies (INFO WaARNING  [SGIsEN ) Debug MM
—

Messages have been placed in the queue.

To see the message queue:
1. Click the INFO, WARNING, or ERROR box.

# View Message Queue for “Cookie Controller™

“ZpRefresh _—gCDDy all ETF‘op Top Message X Clear all Messages

# | Code  Sewverty | Deszcription Chart Block Line | Object | Time Date ~
o -4 Info Device has powered up. [Powerup clear e <spstern: _IMIT_.. MAA Met Miked | 15:02:03  09/05/07

1 35 wharning /0 paint mizmatch: a configured point doe.. <systerm: _INIT_. Mia Mst aolwen.. 15:02:03  09/05/07

2 -3h wharning /0 paint mizmatch: a configured point doe. . <system: _IMIT_. Mia Mst aoConw.. 15:02:03  09/05/07

3 -3h wharning /0 paint mizmatch: a configured point doe.. <system: _IMIT_. Mia Mst ailven.. 150203 09/05/07 D
4 700 Warming  PID Loop 0 has been configured outside of._. <spstern: _IMIT_.. M/A Met Miked | 15:02:03  09/05/07

5 13 Errar Owerflow errar. Dough_Chip_Co... 17 Msg [null] 18:02:21  09/05/07

E 13 Errar Overflow errar. Dough_Chip_Co... 17 Msg [null] 18:02:21  09/05/07 bt
Mumber of messages: 12

2. Tosee all the information in the column, drag the edge of a column heading.
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3. Tosee all of the information for one message, double-click the message.

# View Message Queue for “Cookie Controller™

=sRefresh =3 Copy Al Eanp Top Message | ¢ Clear All Messages
# | Code | Severty | Description Block Line Db|ec:t Time Date
1 700 ‘wWaming  PID Loop O has been configured i M MHAa anal l.. 1E 20 25 09325.1"0?
2 B3 Info 10 ermar; pe i
3 63 Info 1/Oenonpe 4) Message Details
4 -R3 Error Mo data recy
5 B34 Info Atternpt(s] tol CODE: -4
B 93 Info 170 Unit rot SEVERITY: Info
DESCRIPTION: Dewvice has powered up. [ 'Powerup clear expected' message
received. )
Mumber of messages: 7 CHART: <system: _INIT IO0>
BLOCK: M/ L
LINE: N/&

OBJECT: Local IO TI/0 Unit [127.0.0.1]
TIME: l6:Z0:Z6
DATE: 09/25/07

h. =

To refresh the display with the latest messages, click Refresh.

To copy all messages in table format for transfer to another program such as Excel, click Copy All.
To delete the top (oldest) message on the list, click Pop Top Message.

To delete all messages, click Clear Messages.

Close the dialog box to return to the Inspect Control Engine dialog box.

Any changes you have made to the queue are reflected there.

© N w s

Message Queue Information

Each message in the View Messages dialog box includes the following information:

Code. The message or error code number. For details, see “List of Common Messages” on page 425 (or see
User, if the message was placed in the queue using the command Add Message to Queue).

Severity. Information, Warning, or Error.

Chart and Block. The chart and block being executed when the error occurred. If the error occurred
someplace outside the strategy, for example when trying to connect to an I/0 unit, Chart shows <system>. If
the error occurred in a subroutine, Chart shows the chart that called the subroutine, and Block indicates the
name of the subroutine plus the block number in the format <sub name>.<block number>.For
example, error #4 above (“Cannot divide by zero") occurred in block 1 of the subroutine
Variable_Increase_Notification, which was called by the Temperature_Control chart.

Line. If you are in Full Debug mode, the line being executed when the error occurred.

Object. The table, /0 unit, or other object affected by the message. In errors #1 and #2 above, the control
engine was unable to communicate with I/O unit EIO_C. The unit’s IP address is shown for easy reference.

Time and Date. \When the error occurred.
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Inspecting Control Engines from PAC Terminal

You can also inspect control engines from PAC Terminal.

1. Start PAC Terminal:
- InWindows, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.5.
The PAC Terminal window appears.

File Tools Configure View Help

Control Engines:
Controller ﬁane System Type Address 1 Address 2

$§¥Cookie Controller ~ Standard v127.0.0.1 »
$¥R1 Controller Standard v10.195.55.111 #§

2. Double-click the control engine you want to see (or right-click it and choose Status from the pop-up
menu).

The Inspect Control Engine dialog box appears. The dialog box is explained on page 110.

ARCHIVING STRATEGIES ON THE CONTROL ENGINE

"a

Archiving strategies on the control engine provides a backup in case original strategy files on the computer
are lost. When you archive a strategy to the control engine on an Opto 22 controller, a zipped file is saved in
battery-backed RAM. On a SoftPAC controller, a zipped file is saved on the PC's hard drive. In either case, if
power to the control engine is lost, the archive is still there.

We recommend you archive to the computer (during strategy development); you can also archive to the
control engine (when the strategy is completed). Archiving to the control engine as well as the computer
makes sure that an older strategy can always be found and updated, even after personnel changes occur and
years pass. See also, “Archiving Strategies on the Computer”on page 205.

Archive files are date and time stamped, and zipped for compact storage. The archive file name on the control
engine is in one of the following formats:

. Path\Filename.Download.D02282000.T114351.zip
. Path\Filename.Online.D02282000.T7114351.zip

The date stamp (D) is in the format mm/dd/yyyy. In the examples above, the date is February 28, 2000. The
time stamp (T) is in the format hh/mm/ss. In the examples above, the time is 51 seconds past 11:43 AM.

Make sure the control engine has sufficient memory available to store the archive file. Since only one strategy
at a time can be on the control engine, only the latest archive for that strategy is on the control engine. Other
archives are erased during strategy download.

To archive a strategy to the control engine:
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In PAC Control, choose File > Strategy Options.

Strategy Options @

Archive | Download | Legacy | Serial 140 Ports|

[[] Archive strategy to disk when strategy is downloaded

I 0K ][ Cancel ][ Help

]

In the Strategy Options dialog box > Archive tab, select “Archive strategy to disk when strategy is
downloaded"” Also select “During download, save archive to the control engine and save strategy to flash

memory.”

Strategy Options E]

Auchive | Download | Legacy | Serial 1/0 Ports

[] &rchive strategy to disk when strategy is closed
Archive strategy to disk when strategy is downloaded

[¥]:During download, save archive ta the contral engine and save strategy to flash memory

0K ][ Cancel ][ Help

J

Click OK.

The strategy will be archived to the computer and to the control engine when it is downloaded. Any
archive already on the control engine will be replaced by the new archive. In addition, the strategy will be
saved to flash memory, so it will still be available if power to the controller or SNAP Ultimate brain is

turned off.

RESTORING ARCHIVED STRATEGIES FROM THE CONTROL ENGINE

If original strategy files are lost or damaged, you can use PAC Terminal to restore the strategy archive from the
control engine to a computer.

1.

Start PAC Terminal:

- InWindows, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.5.
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MOVING CONTROL ENGINES FROM ONE PC TO ANOTHER

The PAC Terminal window appears.

File Tools Configure View Help

Control Engines:
Controller ﬁame System Type Address 1 Address 2

$¥ Cookie Controller ~ Standard v127.0.0.1
$¥R1 Controller Standard v10.195.55.111

2. Right-click the control engine and choose Upload > Strategy Archive from the pop-up menu.

3. Inthe Save PAC Control Strategy Archive As dialog box, navigate to the folder where you want to save the
archive file. Keep the file name as it is, so you can see the date and time it was originally downloaded to
the control engine. Click Save.

A dialog box shows progress as the archive file is uploaded to the computer.

4. Navigate to the zipped archive file. Assuming you are using WinZip, double-click the file name. Highlight
all files and click Extract. Extract them to the location you want.

5. When allfiles are extracted, double-click the .idb file to open the strategy. If necessary, re-link subroutines
and files run before or after a strategy.

Re-linking may be necessary because the directory structure in the zip file may not match what was
originally on the computer. The zip file structure is as follows:
Root (.idb, chart files, .inf)
Subroutines
Control engine files
Control_Engine_Name_1
Before run file
After run file
Control_Engine_Name_2

MOVING CONTROL ENGINES FROM ONE PC TO ANOTHER

16

Sometimes it's necessary to transfer a strategy to another computer, such as when the computer has to be
replaced, or when another PC will be used to run the control application. Instead of typing in each control
engine on the new computer, you can open the ControllerNames.ini text file and merge the control engine
names from a source PC with those on a target PC.

NOTE 1: Use this procedure only if you have PAC Control version R9.4a or higher. For versions prior to R9.4a, see the
OptoKnowledgeBase article KB80603 on the Opto 22 website, http://opto22.com. However, the best method is to
install the newest software and use the method described here.
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NOTE 2: When PAC Control version R9.4a or higher is first used, it automatically migrates the control engine
definitions from older versions. If you then use an older version of PAC Control to add another control engine, the new
control engine will not automatically be available in the R9.4a or higher version, because it checks the older versions
of control engine definitions only the first time it is run.

To move all the control engines from a source PC to a target PC:

1.

On the source PC, locate the Controller.ini file. This file can be found in the following location:
C\ProgramData\Opto 22\PAC Project\ControllerNames.ini
Send the file by email or other means so that it can be opened on the target PC.

On the target PC, open the ControllerNames.ini files for the source and target PCs with a text editor such
Notepad.

Source

File Edit Format View Help
R2 Control Engine 9.0.0.0 10.195.55.112

R1 Control Engine 9.0.0.0 10.195.55.111
Cookie Controller 9.0.0.0 127.0.0.1

Target

File Edit Format View Help

S2-M Control Engine 9.0.0.0 10.195.56.102
S1-M Control Engine 9.0.0.0 10.195.56.101

4. Copy thelist of control engines from the source PC file and paste them to the end of the list of control

5.

engines in the target PCfile.
Target and Source merged on target PC

File Edit Format View Help

S2-M Control Engine 9.0.0.02 10.195.56.102 2.0.0.0 0
S1-M Control Engine 9.0.0.02 10.195.56.101 20.0.0.90 0

R2 Control Engine 9.0.0.0 1©.195.55.112 9.0.0.0 0
R1 Control Engine 9.0.0.0 1©.195.55.111 9.0.0.0 0
Cookie Controller 9.0.0.0 127.0.0.1 0.0.0.0 0 _

< >

Save the target ControllerNames.ini file on the target PC before closing it.
All of the control engines in the merged file will now be available in PAC Control.
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DOWNLOADING FILES USING PAC TERMINAL

Using PAC Terminal, you can download PAC Control strategies or Forth files related to the strategy, such as
library or initialization files, directly to a control engine, without having to open each program.

For information on using the brain’s file system to store data and manipulate it within your strategy, see
“Managing and Accessing Files in the Control Engine’s File System” on page 305.

NOTE: If you are downloading a PAC Control strategy that requires other files, be sure to download the files in the
correct order (for example, library file, then strategy file, then initialization file). If you need to set initial values for
individual table elements on strategy download only, see “Setting Initial Values in Variables and Tables During
Strategy Download” on page 266.

1. Start PACTerminal:
- InWindows, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.5.

The PAC Terminal window appears.

File Tools Configure View Help

Control Engines:

Controller ﬁane System Type Address 1 Address 2

$¥'Cookie Controller ~ Standard v127.0.0.1 ®
$¥R1 Controller Standard v10.195.55.111 ¥

2. Right-click the control engine and choose Download > Forth File from the pop-up menu.

3. Inthe Download File dialog box, click Browse.

4. Inthe Open dialog box, locate the file you want to download. When the full path appears,
click OK.
If necessary to find the file, choose All Files from the Files of Type drop-down menu.
The download begins, and a dialog box shows its progress.
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6: Working with 1/0

INTRODUCTION

In addition to configuring a control engine to run your strategy, you also need to configure input/output
hardware to do the work: turning things on, setting temperatures, monitoring controls, and so on.
This chapter shows you how to configure and work with 1/0 units, I/0 points, and PID loops.

In This Chapter

Choosing a Configuration TOO........eovveeoeeeeseeeseee s page 119
ADOUL /O UNIES e ssssssss s s s ssssssss s page 121
Adding an 1/0 Unit page 125
AQAING 1/O POINES v sssesese s s ssssssessssssess s page 130
The Configure I/0O Modules and Points Dialog BoX .........ccc........ page 150
The Configure Power Monitoring Module Dialog Box.......... page 154
CoNnfiIGUING PID LOOPS ..oovvvvesevevsssvessvssssesssssssssssssssssssessssesssssssoe page 156
Inspecting, Monitoring, and Changing I/0 in Debug Mode ... page 176
Inspecting and Tuning PID Loops page 184
Using Watch Windows for Monitoring page 196

CHOOSING A CONFIGURATION TOOL

Configuring 1/Q is one of your major planning steps in developing a PAC Control strategy. Generally it's best to
configure all I/0 units, channels/points, and PID loops at once, before you start building flowcharts.

«  Forgroov1/O modules and groov RIOs, there are several tools to configure 1/O; however, for PAC Control
strategies, use only PAC Control.

»  For SNAP PAC Controllers and I/0, you can use either PAC Control or PAC Manager.

Configuring groov 1/0 with PAC Control

You can configure groov 1/0 with PAC Control, but not with PAC Manager.

NOTE: You may have read that you can configure groov I/0 with groov Manage. However, any configuration you do
in groov Manage cannot be exported to PAC Control. (groov Manage doesn't export its I/O configuration. You can use
PAC Control to scan for groov I/0O modules; however, it doesn’t bring in existing channel names, channel types,
offset/gain configuration, and so forth.)

For more information about groov Manage, see the groov EPIC User’s Guide, form 2267.
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CHOOSING A CONFIGURATION TOOL

Choosing a Configuration Tool for SNAP 1/0
IMPORTANT: For mistic /O units, PAC Manager cannot be used for configuration. Instead, use PAC Control.

About ETand E2 brain boards: You can configure E1s and E2s like any other /O unitif you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s),
see /O Configuration for E1 an E2 Brain Boards (form 1576).

For most I/0 units, if you are already in PAC Control, configuration is easier there and you can use the loopback
IP address for SNAP PAC R-series or SNAP Ultimate /0 units controlling themselves. However, some functions
for 1/0 units cannot be configured in PAC Control.

If you use PAC Manager, you can save your configuration to a file, load it to multiple 1/0 units at once, and use
it for referencing points in OPC. However, you cannot use the loopback address in PAC Manager and you
cannot use PAC Manager for mistic 1/0 units.

Choose your configuration tool based on what you need to do:

Use PAC Manager for SNAP 1/0
configuration if

Use PAC Control for I/0 configuration if

* You have only one I/O unit or I/O unit * You have multiple I/0O units whose
configurations are different. configurations are exactly the same or similar.
* You are configuring mistic I/O units. * You are using a modem connection (PPP) or

+ The strategy will run on SNAP PAC R-series or SNMP.

SNAP Ultimate I/O units that are controlling You are using event messages or email.
themselves using the loopback IP address, You are configuring events and reactions on the
127.0.0.1 I/0 unit in addition to strategy logic.

* You are using an Ethernet network for * You are not using PAC Control.
communications (or using a SNAP PAC
controller with an SB brain).

* The strategy handles all logic; you are not also
configuring events and reactions on 1/O units.

Whichever tool you use for configuring 1/0, be aware of the impact if you later change configuration. For
example, if you configure 1/0 in PAC Manager, download the configuration file to I/O units, and then later add
a point in PAC Control, remember that your configuration file doesn't contain that point.

If you use PAC Manager, follow instructions in the PAC Manager User's Guide (form 1704). When you have
finished configuration and saved the configuration file, you can import it into PAC Control following the steps
in “Importing PAC Manager 1/0 Configuration into PAC Control” below.

If you use PAC Control, follow the steps beginning with “Adding an 1/0 Unit"on page 125.

Importing PAC Manager I/0 Configuration into PAC Control

If you have configured all /O units, points, and PID loops in PAC Manager, follow these steps to import the
configuration file into a PAC Control strategy.

1. Open the strategy in PAC Control. In the Strategy Tree, right-click the folder named “I/O Units,”and from
the pop-up menu, choose Import.

2. Navigate to the configuration file you created and saved in PAC Manager. Double-click it to open it.

The configuration information is imported. You can expand the 1/0 Units folder to see the imported units
and their points.

If you need to configure additional I/0 units from within PAC Control, see “Adding an I/0 Unit"on
page 125.To tune PID loops, see “Inspecting and Tuning PID Loops”on page 184.
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Copying SNAP 1/0 Configurations

Note: These instructions apply only Ethernet-based I/0 units. Remember, you cannot use PAC Manager for groov RIO,
groov EPIC, or serial-based I/0 units.

If you have two strategies that use similar I/O units and points, you can export an I/0O configuration from one
strategy into a file, and then import it into the other strategy.

If you need similar configurations for several Ethernet-based I/0 units, you can use PAC Manager to send it to
multiple 1/0 units at once. For more information about PAC Manager, see the PAC Manager User’s Guide
(form 1704).

Creating the Configuration Export File

1. Open the strategy you are copying from in PAC Control. In the Strategy Tree, right-click the folder named
“I/0 Units” (not the icon representing a specific I/0 unit), and then choose Export from the pop-up menu.

The Export I/0 Units to an Opto Tag Database dialog box appears.

2. Navigate to the location where you want to place the export file. Type the file name, and click Save.
The export file is created. It is a comma-delimited ASClI file and its file extension is .otg.
Because it is an ASClI file, you can open it in applications like Notepad and Excel.

Importing the Configuration File

When you import the I/0 configuration file, it does not delete any I/0 units or points that are already there. If
the import file contains I/0 units with the same names as those already in the strategy, you can choose
whether to update them. Updating changes points that have the same name and adds new points, but does
not delete points.

1. Open the strategy into which you want to import the I/0 configuration.
2. Inthe Strategy Tree, right-click I/0 Units and then choose Import from the pop-up menu.
3. Navigate to the location of the export file you created. Highlight its name and click Open.

The I/0 units and points are updated from the configuration file. To see them, click the plus sign next to
the 1/0 Units folder on the Strategy Tree.

ABOUT I/0 UNITS

In PAC Control, the term 1/0 unit usually refers to I/O modules attached to a chassis and processor or (in the
case of SNAP PAC hardware) a mounting rack with a controller, brain, or brain board. The following table
shows processors, racks, and I/0 modules that can be used in PAC Control:

Max #
Modules

Processor
Part Number

Compatible Racks/Chassis

Module types

The following I/0 units are supported in PAC Control Basic and PAC Control Professional

groov RIO N/A (.groov RIO modulgs do not N/A groov analog and digital
require a rack or chassis)
GRV-EPIC-CHS4 4
GRV-EPIC-PR1 GRV-EPIC-CHS8 8 groov analog and digital
GRV-EPIC-CHS16 16
SNAP-PAC-R1 SNAP-PAC-RCK4 (SNAP-M16) 4 . .
SNAP-PAC-EBT SNAP-PAC-RCK8 (SNAP-M32) g |°NAPanalog, digital and serial
SNAP-PAC-RCK12 (SNAP-M48) 12
SNAP-PAC-SB1 SNAP-PAC-RCK16 (SNAP-M64) 16 SNAP analog or digital (no serial)
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Processor . . Max #
Part Number Compatible Racks/Chassis Modules [\ oo [V] [ 4¥/ o113

SNAP-PAC-R2

SNAP-PAC-EB2 SNAP-PAC-RCK4 (SNAP-M16) 4 SNAP analog, digital, and serial (no

SNAP-UP1-Mé64 SNAP-PAC-RCK8 (SNAP-M32) 8 high-speed digital)

SNAP-ENET-564 SNAP-PAC-RCK16 (SNAP-M64) 16

SNAP-PAC-SB2 SNAP analog and digital (no serial)
G4PB32H G4 simple digital

G4EB2 PB32HQ 32 Quad Pak simple digital

G4D32EB2 (Rack included) 32 G4 simple digital

G4D32EB2-UPG G4D32RS 32 G4 simple digital
SNAP-B4M 4
SNAP-B8M SNAP analog, digital, and serial
SNAP-B8MC 8

SNAP-PAC-R1-B SNAP-B8MC-P

SNAP-UP1-ADS SNAP-B12M

222&5;22?;2'51— SNAP-B12MC 12 SNAP analog, digital, and serial
SNAP-B12MC-P (standard digital in positions 0-7
SNAP-B16M only; high-density digital in any
SNAP-B16MC 16 | Pposition)
SNAP-B16MC-P

SNAP-UP1-D64 SNAP-D64RS 16 SNAP digital (limited digital func-

SNAP-ENET-D64

tions; no high-density digital)

The following I/O units are supported only in PAC Control Professional
SNAP-B4M 4
SNAP-BSM SNAP analog and standard digital
SNAP-BSMC 8 (no high-density digital; no serial)
SNAP-B8MC-P
B3000 (serial) SNAP-B12M
B3000-B (serial SNAP-B12MC 12 SNAP analog and standard digital
SNAP-B12MC-P (no high-density digital; no serial;
SNAP-B16M standard digital in positions 0-7
SNAP-B16MC 16 [only)
SNAP-B16MC-P
SNAP-B8M SNAP standard digital only (no serial
SNAP-BRS SNAP-B8MC 8 or high-density digital. Max. 32
SNAP-B8MC-P points)
G4D16R Brick 16 G4 digital (max. 16 points)
G4D32RS Brick 32 G4 digital (max. 32 points)
G4A8R Brick 8 G4 analog (max 8 points
PB16 G1, G4, or Quad Pak digital (max. 16
BT G4PB16 1® points)
B200 PB16A 16 G1 analog (max 16 points)

CAUTION: Make certain you use a rack shown as compatible for the processor. Using any other rack will severely
damage the brain or controller.
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groov RIO Units

A groov RIO unit is a remote I/0 unit that supports a variable number of channels (points) per unit. It does not
require a rack or chassis nor a separate processor, controller, or brain. GRV-R7-MM1001-10 (which is the first
unit in the groov RIO family) has 10 channels; three of the channels are configurable for either input or output,
digital or analog. Two channels are form C electromechanical relays, configurable as either normally open or
normally closed.

groov 1/0 Units

A groov I/0 unit consists of up to 16 groov /0 modules mounted on a groov EPIC chassis with a groov EPIC
processor. groov 1/0 modules support 8, 12, or 24 channels (points) per module.

SNAP 1/0 Units

For most serial-based brain boards, racks are limited to 16 points of either analog or digital 1/0, so each I/0 unit
is either digital or analog.

E1 and E2 1/0 units hold up to 16 points of digital (E1) or analog (E2) 1/0.

G4EB2 1/0 units are always 32 points of digital I/0. If used with G4 modules, inputs and outputs can be mixed
anywhere on the rack; if used with Quad Pak modules, points are in groups of four inputs or four outputs.

Racks for most Ethernet-based brains, however, hold up to 64 points and can be either digital only or both
analog and digital. If the rack attached to a SNAP Ethernet-based brain accommodates both analog and
digital modules, the I/0O unit includes both analog and digital modules.

In most cases the “I/0 unit”you configure in PAC Control is the same as the physical I/O unit (I/O modules
together with a chassis and processor or rack and brain). The entire rack of points is configured as one I/0 unit,
because that's how the points are addressed by the brain.

(PAC Control Pro) In two cases, however, the “I/O unit”in PAC Control does not exactly correspond to the
physical I/0 unit, because these brains address their I/O modules in a different way:

« A B3000 or B3000-B serial addresses up to four groups of 16 points on the largest rack. Each group of
16 points must be configured as a separate I/0 unit, either analog or digital. For more information, see
“SNAP Serial-Based (mistic) I/O Units”on page 123. Note that some PAC Control commands communicate
with all the points on one I/0 unit at once. For more information about these commands, see the
Optimizing PAC Project System Performance technical note (form 1776).

« A G4D32RS brick contains the equivalent of two 16-module units, and the brain board addresses them
separately. When you configure it in PAC Control, notice that it is called a G4D16RS. Configure two
G4D16RS I/0 units for each brick. For more information, see “Non-SNAP Serial-Based (mistic) I/0 Units” on
page 125. NOTE: The Ethernet-based G4D32EB2 I/O unit is not treated this way; it is called a G4EB2 and
configured as a single 32-module unit.

SNAP Serial-Based (mistic) I/0 Units

B3000 or B300-B (serial) SNAP-B series
SNAP-BRS (SNAP-BRS is limited to 8-module racks)

(Pro only) SNAP B-series mounting racks can hold either 4, 8, 12, or 16 Opto 22 SNAP I/O modules. The serial
B3000 or B3000-B brain can use any size B-series rack and both analog and digital modules. It cannot use serial
or high-density digital modules. The SNAP-BRS uses 4-point SNAP digital modules only (no high-density
digital) and only on an 8-module rack.
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Analog modules can be placed in any position on these racks. For the larger racks, 4-point SNAP digital
modules can be placed in positions 0—7 only. Each SNAP digital module contains four input or four output
points. SNAP analog modules supported by the B3000 or B3000-B contain either one or two points.

Each point on the rack is numbered; when you configure the point or read or write to it, you reference it by its
number. Each SNAP brain is really up to four logical brains in one: two digital 16-channel multifunctional
brains plus (for a B3000 or B3000-B) up to two analog 16-channel multifunctional brains.

Jumpers on the SNAP brain set the base address, which must be zero, four, or a multiple of four. The base
address is the first digital address, digital channels 0—15. The second digital address, digital channels 16-31, is
the base address plus one. On a B3000 or B3000-B, the first analog address, analog channels 0—15, is the base
address plus two; the second analog address, analog channels 16-31, is the base address plus three.

The following diagram shows the largest rack as an example. Note that two numbers are shown for each
analog module. If you are using analog modules that contain only one point, ignore the upper point number.

This diagram applies to:
B3000 (serial mistic)
B3000-B (serial mistic)
SNAP-BRS

N

N

Module position ) ———»

DIGITAL ADDRESS 16684

B3000 BASE + 0
110 9 8

N

DIGITAL ADDRESS T 6654
BASE + 1
n 109 8

NOTE: On the B3000 or B3000-B,
analog modules can be placed in any
position; standard digital modules can
be placed in positions 0—7 only.

4

The SNAP-BRS brain uses digital modules
only on an 8-module rack.

SNAP serial and high-density digital Note

modules cannot be used with these Ease Addiess sel by
brains jumpers on brain board
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@ Non-SNAP Serial-Based (mistic) 1/0 Units

Brain boards Racks

G4D16R
G4D32RS Bricks (brain is built into rack)
G4A8R

PB16
G4PB16
PB16A

B100
B200

(Pro only) Because non-SNAP serial-based brain boards generally have a maximum of 16 modules on the
rack, and each module has only one point, addressing points is simple. Point numbers correspond to module
positions on the rack, 0—15, except for the following:

If you are using Quad Pak modules, each module contains four points: module position zero contains
points 0—-3, module position one contains points 4-7, and so on.

A G4D32RS brick contains the equivalent of two 16-module units, and the brain board addresses them
separately. When you configure it in PAC Control, notice that it is called a G4D16RS. Configure two
G4D16RS 1/0 units for each brick.

NOTE: The Ethernet-based G4D32EB2 I/O unit is treated differently; it is called a G4EB2 and configured as a
single 32-module unit. If you upgrade a G4D32RS rack with a G4D32EB2-UPG brain and cover, you will need to
add it as a new G4EB2 I/0 unit and then either move each point over from the old I/0 units to the new one, or
reconfigure points.

ADDING AN I/O UNIT

In PAC Control, the term //O unit usually refers to:

a chassis or rack with an I/0 processor (a processor, controller, brain, or brain board mounted on the
chassis or rack) and up to 16 /0 modules attached.

a groov RIO module

Some important things to consider before you start:

If you already configured groov /O modules or groov RIOs in groov Manage, those configurations will be
overwritten by any configurations you set in PAC Control. For an explanation, see “Configuring groov /0
with PAC Control”on page 119.

If you already configured SNAP 1/0 in PAC Manager, you can still add I/0 units and points from within PAC
Control.

If you need to enable legacy I/0 units in PAC Control for a specific strategy, review the information in
“Legacy Options”on page 234 before continuing.

To add an I/0 unit:

1.

Make sure the strategy is open and in Configure mode. On the Strategy Tree, double-click the 1/0 Units
folder. (You can also select Configure > 1/0 from the menu bar)

PAC Control displays the Configure /0 Units dialog box, showing all configured 1/O units.

PAC Control User’s Guide, Legacy Edition 125



ADDING AN I/0 UNIT

126

You configure most of the data in these columns when you add or modify an I/0 unit.

The Ref Count (Reference Count) is a field that you don't configure. It
represents the number of I/0 points configured on the I/0 unit plus the
number of times the /0 unit is referenced in the strategy.

4 Configure /0 Units *
Mame Type Port Address Watchdog  Enabled RefCount Description Add...
SMAP-PACR1 Ethernet 2001 127.0.0.1 Disabled Enabled 14 Modify...
Delete
1/O Points...
PID Loops...
Close Help Event/Reactions. ..

2. To configure a new I/O unit, click Add or double-click anywhere in the box below any listed units.
PAC Control displays the Add I/0 Unit dialog box.

3. Complete the fields as described in “Add I/O Unit Dialog Box".

4. (lick OK. PAC Control creates a folder under the I/0 Units folder in the Strategy Tree.

groov 1/0 unit only—When you click OK, PAC Control prompts you to automatically add groov /0
modules and channels. For an explanation on how this works and what you need to do, see
“Automatically Adding groov I/O Modules and Channels” on page 131.

Add I/0 Unit Dialog Box

Use this dialog box to add a new I/0 unit to the strategy or edit an existing unit.

& Add 170 Unit

| GRYV-EPICPR1 o |

| [Local {loopbadk)

Information
A— Mame: |
B — Description: |
Type
C——Type:
Addressing
D— Primary Address: | |
E— Secondary Address:
F __ | EthernetPort: 2001

Communication from control engine

G | [A|Enable communications from control engine

H | Timeout and disable communications after tries of second(s) each.

Device Options

I 1 For temperature points, use degrees (_) Fahrenheit (®) Celdus
J Watchdog timeout after 0.5 second(s) of no communications
| [ e

For details on saving the 1/0 Unit Configuration, see “Inspecting I/0 Units”on page 176.
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A—Name. Enter a name for the /0 unit. The name must start with a letter and may contain letters, numbers,
and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the unit.

C—Type. When adding an 1/0 unit, select the type of 1/0 unit from the drop-down list. When upgrading an
older I/0 unit to a SNAP PAC device, applicable upgrades are shown in the drop-down list. (You cannot
upgrade older I/O units to a groov |/0 unit or groov RIO unit.)

D—Primary Address. For Ethernet I/0 units, type the IP address or hostname of the groov RIO unit,
processor, controller, or brain attached to the I/0 unit. If the unit s local (for example, the same SNAP PAC brain
on which the strategy will run), select Local (loopback). This sets the address to a loopback address,
127.0.0.1.This tells the unit to talk to itself, so if you change the unit's IP address or hostname, you don't
have to change the address for the I/0 unit.

For serial units, type the unit’s address (valid range is 0-255).

E—Secondary Address. (Optional; Pro only; Ethernet-based /0 units only, except groov RIO units) To
designate a secondary I/0 unit for communication if this /0 unit is unavailable, enter the secondary unit's IP
address or hostname. Note that both I/O units use the same port number.

F—Port. For Ethemet-based I/0 units, communication with the control engine is Ethernet, and the default
port number is 2001. If you have changed this port for security purposes, also change it here. (See the
controller’s user guide for details.)

For serial-based 1/0 units, the communication port and parameters are shown for you. The Serial Address
drop-down menu shows which addresses are currently being used. The port must be configured on the
Strategy Options dialog box. Also, binary/CRC settings on your hardware are required. For more information,
see “Changing the Baud Rate for SNAP Serial I/0 Units” below.

G—Enable Communications. Select whether you want communication to the 1/0 unit enabled or
disabled on startup. Enabled is the default. Disabling communication to an I/O unit is the same as disabling
communication to all points on the unit.

H—Timeout. Enter the number of times the control engine should try to communicate with the 1/0 untt,
and enter the length of time the control engine should wait for a response when communicating with this I/0
unit. If after the first communication attempt there is no response within the timeout period, the control
engine retransmits. If there is no response within the timeout period, it transmits again. This repeats according
to the number of tries specified. If no response is received within the final timeout period, communication to
the 1/0 unit is disabled. The default number of tries is 3. The default timeout period is 1 second.

In most cases, it is a good idea to start with the default values and only make changes if your system has
problems using the defaults.

CAUTION: If the timeout is long and the I/0 unit is turned off or unreachable, the control engine could take quite
a while to execute a command that talks to I/0. See also, “Tuning the I/0 Unit Timeout Value for SNAP Ethernet I/O
Units”on page 129.

I—Fahrenheit/Celsius. (Analog and Mixed units only) Choose whether temperatures will be handled in
Fahrenheit or Celsius.

J—Watchdog. Select whether you want a Watchdog on the unit (not available on remote simple I/0 units).
The default is No (disabled). If you select Yes, a new field appears; enter the Watchdog timeout value (in
seconds). The default timeout is 0.5 seconds.

With a Watchdog, the I/0 unit monitors activity on the port. If no communication is received for the specified
interval, the unit assumes a Watchdog state. All selected outputs will then immediately go to a specified value,
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as configured in the Watchdog field of the Add Analog Point or Add Digital Point dialog boxes. (See “Manually
Adding groov I/O Modules & Channels or SNAP /0 Modules & Points” on page 132.)

@ Changing the Baud Rate for SNAP Serial I/0 Units

NOTE: This section is for PAC Control Basic users. If you have the Pro version, see “Changing the Baud Rate and Mode
for SNAP Serial I/0 Units” on page 128.

If the default baud rate shown in the Add I/0 Unit dialog box is not correct, you can change it. This baud rate is
for communication through the RS-485 port to serial I/0 units. It does not affect other serial ports on the
controller or communication handles using these ports.

NOTE: Once you have configured a serial port for use with an I/0 unit, do not configure a communication handle on
the same port.

1. Make sure the strategy is open and in Configure mode.

2. (mistic only) Make sure that the mistic /0 units and commands are enabled. If not, see “Enable mistic I/0
Units and Commands” on page 235.

3. Choose File > Strategy Options, then click the Serial I/0 Ports tab.

Strategy Options %
Archive Download Senial 1/0 Ports  Legacy
The SMAP-PAC-51 and SNAP-PAC-52 controllers may use serial /0 units such as the SNAP-PAC-SB1.

The port type must first be set to R5-485, either by using default ports or by PAC Manager.

You must also corfigure which ports will be used for /0 within this strategy:

[ Port Dfor 140 with 115,200 baud (SNAP-PAC-52 only)
[ Port 1 for 140 with 115,200 baud (SNAP-PAC-52 only)
[ Port 2 for 140 with 115,200 baud (SNAP-PAC-52 or -51)
[ Port 3for 140 with 115,200 baud (SNAP-PAC-52 only)

Serial ports may also be used for communicating with other devices by using PAC Control
communication handles.

Cancel Help

4. Selectthe correct port for the controller. Choose the correct baud rate from the drop-down list, and then
click OK.

NOTE: If you are configuring a SNAP-PAC-ST controller you must use port 2. If you are using a SNAP-PAC-S2, see
the PAC Manager User’s Guide (form 1704), for the default serial port assignments or to change a serial port
assignment.

@ Changing the Baud Rate and Mode for SNAP Serial /0 Units

This section is for PAC Control Professional users. If you have the Basic version, see “Changing the Baud Rate for
SNAP Serial I/0 Units”on page 128.

NOTE: Once you have configured a serial port for use with an I/0 unit, do not configure a communication handle on
the same port.

If the default baud rate shown in the Add I/0 Unit dialog box is not correct, you can change it. This baud rate is
for communication through the RS-485 port to serial I/0 units. It does not affect other serial ports on the
controller or communication handles using these ports.
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In addition you can also choose Binary or ASCIl mode. The controller will talk to all I/O units on that port in the
same mode.

NOTE: There is no ASCll version of OptoMMP protocol (which is used on SNAP PAC SB brains), soif a port is set to ASCII,
you won't be able to mix mistic and SNAP PAC SB brains as you can in Binary mode.

1. Make sure the strategy is open and in Configure mode.

2. (mistic only) Make sure that the mistic I/0 units and commands are enabled. If not, see “Enable mistic [/O
Units and Commands” on page 235.

3. Choose File > Strategy Options, then click the Serial I/0O Ports tab.

| Strategy Options *
Archive Download Serial I/O Pots  Redundancy Legacy

The SMAP-PAC-51 and SNAP-PAC-52 controllers may use serial /0 units such as the B3000
or SNAP-PAC-5B1.

The port type must first be set to R5-485, either by using default ports or by PAC Manager.

You must also corfigure which ports will be used for /0 within this strategy:

[ Port Dfor 140 with 230,400 baud and  Binary mode (SMAP-PAC-52 only)
[ Port 1 for 140 with 230,400 baud and | Binary mode (SMAP-PAC-52 only)
[ Port 2for 140 with 230,400 baud and  Binary mode (SMAP-PAC-52 or-51)
[ Port 3for 140 with 230,400 baud and  Binary mode (SMAP-PAC-52 only)

Serial ports may also be used for communicating with other devices by using PAC Control
communication handles.

Cancel Help

4. Selectthe correct ports for the controller, and then choose the correct baud rate and mode from the
drop-down lists and click OK.

If you are configuring a SNAP-PAC-S1 controller, you must use port 2 for serial I/0 units. If you are using a
SNAP-PAC-S2, see the PAC Manager User’s Guide (form 1704), for the default serial port assignments or to
change a serial port assignment.

In addition, make sure to jumper the non-SNAP PAC brain for the correct setting, either Binary CRC (cyclic
redundancy check) or ASCII CRC. Although at the brain level you can choose Binary/ASCll and
CRC/Checksum independently, the Opto 22 drivers support only binary CRC or ASCII CRC.

ASCII CRC is only for mistic brains. If a port is set for ASCIl but has a SNAP-PAC-SB1/2 on it, the compiler
will generate a wamning.

Tuning the 1/0 Unit Timeout Value for SNAP Ethernet 1/0 Units

NOTE: This section applies to SNAP Ethernet I/O only. groov I/0 modules constantly monitor quality. For details, see
the groov EPIC User's Guide, form 2267.

The default I/0 Unit timeout value is T second. However, for best overall performance you can tune the value
for your system.

A SNAP PAC controller automatically retries 2 times before disabling communication to an I/0 unit that is
unresponsive, and it uses the same timeout value for the first attempt and the 2 retries. So, with a 1 second
timeout value and 2 retries, it takes 3 seconds before an unresponsive unit is taken offline. This means the
chart or command that is trying to read or write to that I/0 unit will be delayed by 3 seconds.

When using SNAP PAC Ethernet brains (SNAP-PAC-R1, SNAP-PAC-R1-B, SNAP-PAC-R2, SNAP-PAC-EBT, or
SNAP-PAC-EB2) on a wired LAN (local area network), a timeout value of 0.1 seconds may be fine. When using a
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WAN (wide area network), a wireless network, the Internet, or you are not sure what the networking
technology is, it may be best to use the default value of 1 second. However, if the controller's message queue
shows loss of communication with Ethernet 1/0 units, it may be necessary to increase the timeout value.

For Advanced Users:

If you are an advanced user with a lot of Ethernet experience, you may want to determine normal response
times from a brain using an Ethernet capture utility such as Wireshark® (www.wireshark.org). Look for the
fastest response time, the normal or typical response time, and the longest response time.

Adjust the timeout value to be larger than the maximum observed response time. It is best not to use a
timeout value that is too short because this will cause unnecessary communication retries and timeouts. We
recommend making the timeout be at least 50% to 100% longer than the maximum observed response time.
In addition, we recommend not using a timeout value that is less than 0.1 seconds. For example, if the value is
0.1 seconds, then communication to an unresponsive /O unit will be disabled within 0.3 seconds. If the
network connectivity is very slow, you may need to use a significantly longer timeout value such as 3to 5
seconds or longer.

Changing Configured 1/0 Units

1. Tochange a configured I/0 unit, make sure the strategy is open and in Configure mode.

2. Find the I/0 unit's name on the Strategy Tree. Double-click it to open the Edit I/O Unit dialog box. See
“Add 170 Unit Dialog Box" on page 126.

3. Make the necessary changes and click OK.

You can also change an I/0 unit from the Configure I/0 Units dialog box by double-clicking the unit's name or
highlighting it and clicking Modify.

Deleting Configured 1/0 Units
CAUTION: Be careful when deleting 1/0 units. You cannot undo a deletion.

You cannot delete an /O unit that has I/O points configured, or if it is referenced in a PAC Control command.

1. Todelete a configured I/O unit, make sure the strategy is open and in Configure mode.

2. Findthe I/0 unit's name on the Strategy Tree. Right-click it and choose Delete from the pop-up menu.
The I/0 unit is deleted from the strategy.

You can also delete an 1/0 unit from the Configure 1/0 Units dialog box by highlighting the unit’s name and
clicking Delete.

ADDING I/0 POINTS

After you add an I/0 unit, you can then add its I/O modules and points (or channels, as they are called in groov
I/0 modules and groov RIO units). There are two ways to do this in PAC Control: manually or (for groov 1/0
modules only) automatically.

Making 1/0 Values Publicly Accessible

You can make the value of an I/0 point or channel publicly accessible to third-party applications like Inductive
Automation’s® Ignition® SCADA software. The default setting is not to allow public access.

«  Whenyouadd an I/0 point or channel manually, enable the Make Public (Readable) checkbox.

« Ifyou instruct PAC Control to automatically add groov I/O channels to your strategy, you will need to
manually edit the channels to grant public access.
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For instructions on manually editing the points or channels, see “Add/Edit Digital Point Dialog Box"on
page 135 and "Add/Edit Analog Point Dialog Box”on page 138.

Automatically Adding groov 1/0 Modules and Channels

To manually add groov I/0 modules and channels or to edit the channels after automatically adding them, see
“Manually Adding groov I/0 Modules & Channels or SNAP I/O Modules & Points” on page 132.

When a groov I/0 unit and the computer running PAC Control are on the same network (and their IP addresses
and subnet masks are compatible), PAC Control can automatically detect and add groov I/0 modules and
channels to a strategy. If you use the Add 1/0 Unit dialog box to add a groov I/0 unit, when you click OK,

PAC Control prompts you:

ﬁ Automatically Add Modules and Channels X

A GRY-EPIC analog and digital 10 modules can be automatically detected and added to your newly created
10 unit. The IfQ unit must be online for this to occur, Would you like to automatically add modules?

Automatically detect and add modules

—
\ Automatically create channels within the new modules
——————— Mame Format: | %1_%2_%3%4 | .@j Format information D
Yes Mo Cancel

A—Automatically detect and add modules. Click the checkbox to instruct PAC Control to
automatically add the 1/0 modules.

B—Automatically create channels. Click the checkbox to instruct PAC Control to also create the
channels.

C—Name Format. Use the “Name format”text field to create a format for the point names. Enter any
combination of text and the following format codes:

«  %1—Point type (for example, ai or do).

* %2—I/0 unit name.

*  %3—Module position.

«  %4—Channel position.

«  %5—A unique identifier that is generated automatically

Example: %1_%2_%3%4 would expand to something like di_MyloUnit_0801.
Example: %1ABC_%5 would expand to something like aoABC_473

Click Format information (D) to view the syntax help.

PAC Control remembers the options you select and displays them the next time you configure another groov
/0 unit.

When you finish making changes, click one of the buttons:

Yes. PAC Control dispalys a confirmation message when it finishes scanning the chassis, identifying the
modules, and adding them and their channels to the I/0 unit.
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In this example, PAC Control identified 7 modules, with | pac Control Basic X
a combined total of 100 channels.

7 modules were automatically detected
and added to I/O Unit groov_EPIC_PR1,

—

100 channels were created and added.

No. The I/0 unit is added to the strategy but modules and channels aren't automatically created. You can
manually configure them by following the steps in “Manually Adding groov /O Modules & Channels or SNAP 1/O
Modules & Points” on page 132.

Cancel. The dialog box closes, but the Add /0 Unit dialog box remains open for you to make changes.

NOTE: To make automatically-created channels publicly accessible to third-party systems, you must manually edit
their Public Access setting. For details, see the Public Access setting in “Add/Edit Digital Point Dialog Box” on page 135
and "Add/Edit Analog Point Dialog Box” on page 138.

Manually Adding groov 1/0 Modules & Channels or SNAP |/0 Modules & Points

Before you add an individual I/O point or channel, such as a sensor or a switch, you must add the I/O unit the

pointis on. See "Adding an I/0 Unit"on page 125.

«  Ifyou are working with groov I/0 modules, you can automatically add channels at the same time you are
adding the module by following the directions in “Automatically Adding groov I/O Modules and Channels”
onpage 131.

« Toadd a “placeholder”for a SNAP serial communication module, see “Configuring a SNAP Serial Module”
on page 146.

Adding a Digital I/0 Point

NOTE: If you need to add several similar points, you can save some time by following the directions in “Copying a
Configured I/0 Point” on page 152 after you have added the first point.

1. With the strategy open and in Configure mode, double-click the I/O Units folder (not the individual unit’s
icon) on the Strategy Tree.

The Configure I/0 Units dialog box appears.

&% Configure /0 Units *

Mame Type Port Address Watch... Enabled RefCount Description Add...
Test_Staton_1 GRV-EPIC-... Etherne... 127.0.0.1 Disabled Enabled 0 Modify...

Delete

;
1/0 Modules and Points. ..

PID Loops...

Event/Reactions. ..
Close Help

2. Highlight the I/O unit the points are on, and click I/O Modules and Points.

The Configure I/0O Modules and Points dialog box appears. (See also “The Configure I/0 Modules and
Points Dialog Box"on page 150.)
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- If you are using G1 or G4 single-point modules (for example with a G4EB2 or E1 brain),
double-click the point you want to use. Skip tostep 9 step 9.

— Ifyou are using groov 1/0 or SNAP I/0 modules, notice the module icons in the dialog box. (The
following example shows a SNAP PAC I/0 unit, so both digital and analog modules can be
configured on the same rack.)

4 Configure /0 Points — O X
1/0 Urit: | R1 | Type: | sNAP-PACRL |
Modules and Points Type Features / Subty... | ~ Add...
Module icons 5
™~ "1 [0} Not Used Modify...
[02] Mot Used Delete
[03] Mot Used
[04] Not Used Maove To...
[05] Mot Used
[06] Not Used CopyTo b
[07] Mot Used : :
(0] Not Used | Expand Al |
[09] Nat Used j Collapse All |
[10] Mot Used - .
1111 Not Used v
£ >
C1-:;se E Hel-p

3. Highlight the number that represents the module’s position on the rack, then click Add.
Alist of available modules appears.

&% Add Module X
Part Channels  Type(s) A
g 4
[jSNAP—IDCE-FﬂST 4 2.5-16VDC
[ﬂSNﬁP-IDCE-FIRST-ﬁ 4 18 -32VDC
[jSNAP-IDCSD 4 2.5-28VDC
ﬂSNAP—IDCSMA 4 10 - 32 VDC/VAC Man/fAuto Switch
[ﬂSNAP-IDCE-SW 4 Dry Contact Switch
[jSNAP-IDCSQ 2 4-24\DC
[jSNAP—IDCEG 4 35-75 VAC/NDC
EﬂSNAP-IDCE-HT 4 15-32VDC
ESN&P-IDCE-SW-NC 4 Dry Contact Switch
ﬂSNﬂP—IDCSFM 4 10 -32VDC
EﬂSNAP-IDCSDFM 4 2,5-23VDC
[3 SMAP-IDC-32 32 10-32VDC
ESNAP—IDC—_“»ZDN 32 -2.5--12\VDC
EﬂSNAP-IDC-EnzD 32 2.5-12vDC
[jSNAP-IDC-Enm 32 -10 - 32VDC
EﬂSNAP-IDC-lﬁ 16 10-32VDC
[ﬂSNAP-IDC-HT-].G 16 15 - 28 VDC/VAC
ESNAP-IACE 4 90 - 140 VDC/VAC
ﬂSNAP-IACEIR 4 180 - 280 VDCVAC ™
[ Automatically create points within the new module
Namne format: | %1_%2_%3%4 t) Format information
[ ok || Gl || hep
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4. (Choose the module type and then the exact module from the lists.
5. Toadd points automatically, select “Automatically create points within the new module.”

Use the “Name format”text field to create a format for the point names. Enter any combination of text and the
following format codes:

*  %1—Point type (for example, ai or do).

e %2—I/0 unit name.

«  %3—Module position.

«  %4—Channel position.

*  %5—A unique identifier that is generated automatically

Example: %1_%2_%39%4 would expand to something like di_MyloUnit_0801.
Example: %1ABC_%5 would expand to something like aoABC_473

6. ClickOK.
7. Inthe Configure I/0O Modules and Points dialog box, click the plus sign next to the new module to
expand it.

Notice that the module icon is color-coded to reflect the type of module being configured: white for
digital DC input, red for digital DC output, yellow for digital AC input, and black for digital AC output.

& Configure 170 Points — O =
. I/O Unit: | Sprinkler_Control T : | SNAPPACR1
Moduleicon ~__ s e [pe=: | |
N Modules and Points | Features / Subty... | ~ Add...
! BENS] [00] SNAP-IDCS: 10 - 32 VDC/VAC Digital Input
Expand or collapse points on_—1 e
the module by clicking the + Mot Usad I
Lo = Delete
or - sign in the box. Mot Used
Not Used Move To...
Points [01] Mot Used
02] Not Used CopyTo b
[03] Not Used
[04] Not Used BT
[05] Net Used | collapse Al
[D6] Mot Used }
1071 Not Used v
£ >
Close Help

134

8. Highlight the point you want to configure and click Add.

9. Complete the fields as described in "Add/Edit Digital Point Dialog Box"below.
10. When you have completed the fields, click OK. The new point appears in the list.

Here is an example of how it might look on a SNAP I/0 unit:
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& Configure 1/0 Paints — O .
1/0 Unit: | Sprinkler_Control | Type: | snap-pach1 |
Modules and Points | Type | Features / Subty... | ~ Add...
=[] [00] SNAP-IDCS: 10 - 32 VDCAVAC Digital Input _
450 S uach 00 I [
2 1 Not Used [T cae=
19 2 Not Used -
T 3 Not Used e
[01] Mot Used ; :
[02] Mot Used (HEdR AR
[03] Mot Used
04] Not Used | Eiii |
05] Mot Used Collapse All |
[06] Mot Used '
1071 Mot Used v
£ >
Cl-ose Hel.|:|

Add/Edit Digital Point Dialog Box

NOTE: The fields are the same in the Add Digital Point and Edit Digital Point dialog boxes.

Add Digital Point Ed
A———— Mame: | Panel_Switch |
B — | Description: | |
C | Type: Input

™~ Module: GRV-IDCI-12: 10 - 30 VDC Isolated
D — | Features: | Naone it
E ———F—Default  @®No  (OYes
F ————— watcthdog: @ No Yes
G ——+— [+*| Enable Communication Enable Quality Indicator —H
| | Public Access (Optional)
[IMake Public (Readable) Allow Write Capability
G| [ v

A—Name. Enter a name for the point. The name must start with a letter and may contain letters, numbers,
and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the point.

C—Type/Module. For non-SNAP 1/0 units, choose the module type and the exact module from the
drop-down lists. For a G4EB2, all 32 digital points are addressed as a single I/0 unit; if you are using the G4EB2
with Quad Pak modules, make sure you configure each group of four points as either all inputs or all outputs.

For SNAP 1/0 units: Type and module are already filled in for you, as shown in the example above.
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D—Features. To use a feature of the module, choose it from the drop-down list. You can configure some
input modules with a counter, totalizer, or other feature. (Inputs automatically have both on-latches and
off-latches.)

E—Default. To set a default state for the point when the strategy is run, click Yes and choose the state (Off or
On).To leave the point in the state it was before, click No.

F—Watchdog. (Output modules only) To set a Watchdog, click Yes and choose On or Off from the
drop-down list.

G—Enable Communication. Select whether you want communication to this I/0 point enabled or
disabled on startup. Enabled is the default.

H—Enable Quality Indicator. (Available on some groov /0 channels only) Select this option to display
the channel's data quality in applicable PAC Control dialog boxes. By default, this option is enabled. groov /0
modules that report quality continuously poll their channels for current data values and identify deviations
between reported and expected values. For more information and a list of applicable groov I/0 modules, see
“1/0 Quality Commands”on page 338.

|—Public Access (Optional). Select Make Public (Readable) to allow the point to be read by certain
third-party applications. To allow these applications to write to the point, select Allow Write Capability. By
default, public access is disabled. For details, see “Public Access”on page 265.

Adding an Analog 1/0 Point
1. Make sure the strategy is open and in Configure mode. In the Strategy Tree, double-click the folder
named “I/0 Units” (not the icon representing a specific I/0 unit).
2. Inthe Configure I/0 Units dialog box, highlight the I/0 unit the points are on, and click I/0 Points.
The Configure I/O Modules and Points dialog box appears.
- (Pro only) If you are using a non-SNAP I/0 unit (not including the B3000 or B3000-B),
double-click the channel you want to use. Skip to step 6.
- If you are using a SNAP 1/0 unit (including the B3000 or B3000-B), notice the module icons in
the Configure I/O Modules and Points dialog box.

& Configure I/0 Points — O =
1/O Unit: | Sprinkler_Control | Type: [ snap-PacRL |
Modules and Poirts Type | Features / Subty... | ~ Add...
ESla] (001 SNAP-IDCS: 10 - 32 VDCAVAC _
[071] Not Used
02] Mot Used L
[03] Mot Used
[04] Met Used Move To...
[05] Mot Used
[06] Not Used CopyTo
[07] Net Used
[08] Not Used Siil
03] Not Used Collapse Al
[10] Mot Used
1111 Not Used h
< >
Close Help

NOTE: In this example, a digital module has already been added in position zero. This example shows a SNAP
PACI/Q unit, so both digital and analog modules can be configured on the same rack.

3. Highlight the number of the analog module’s position on the rack, then click Add.
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4. Choose the module type (Analog Input or Analog Output).

5.

&% Add Module

X

Type: (O Digital Input () Digital Output () Analog Input (@) Analog Output () Serial

Module:

Part Channels ~ Type(s)

¥ SNAP-AOA-3 1

[sNAP-AOA-3-16 1 4-20mA

[lSNAP-AOY-5 1 0-10VDC

[l SNAP-ACY-7 1 -10 - +10VDC

[l ShAP-A0A-23 2 4-20mA

[AlSNAP-AOA-23H 2 4-20mA

[ISNAP-AOA-Z35RC 2 4-20mA

[l SNAP-AQV-25 2 0-10¥DC

[alSNAP-AOV-27 3 -10- +10VDC

[lSNAP-AOA-28 2 0-20mA

[ shaP-A0D-23 3 5-60VDCTPO

[AlSNAP-ACD-29+HF 2 2.5-24VDCTPO

[lSNAP-ACVA-3 8 0-5VDC, 0 - 10VDC, 5 - +5VDC, -10 - +10VDC, 4 -
L4 >

lame Format: | %d1_%2_%3%4

el

[ automatically create points within the new module

f}n Format information

Help

CHAPTER 6: WORKING WITH 1/0

To add points automatically, select “Automatically create points within the new module.”

Use the “Name format”text field to create a format for the point names. Enter any combination of text and the
following format codes:

%1—Point type (for example, ai or do).

%?2—I/0 unit name.
%3—Module position.
%4—Channel position.

%5—A unique identifier that is generated automatically

Example: %1_%2_%3%4 would expand to something like di_MyloUnit_0801.

Example: %1ABC_%5 would expand to something like aoABC_473
6.

In the Configure 1/0 Modules and Points dialog box, click the plus sign next to the new module to
expand it. Notice that the module icon is color-coded to reflect the type of module being configured:
blue for analog input, green for analog output.
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138

| Type: | sNAP-PACRL

| Features / Subty... | ~

i Configure |/0 Points
1O Unit: | Sprinkler_Control
Module icon
Madules and Points
[ [00] SNAP-IDCS: 10 - 32 VDC/AVAC
Expand or collapse points on SN | [01] SNAP-AOV-27
the module by clicking the + 221 0 Not Used
or- sign in the box. % 1 Mot Used
2 "] [02] Not Used
Points / [03] Nt Used
[04] Mot Used
[05] Mot Used
[0] Mot Used
[07] Mot Used
[08] Mot Used
1031 Not Used
£
I Close i | Help i

Analog Output _l

O X

Add...

| Delete |

Mowve To... |

Copy Td™ b

Expand Al |

[ Colapse all |

7. Highlight the point you want to configure and click Add.
8. Complete the fields as described in “Add/Edit Analog Point Dialog Box”below.

9. When you have completed the fields, click OK.
The new point is added.

NOTE: If you need to add several similar points, see “Copying a Configured I/0 Point”on page 152.

Add/Edit Analog Point Dialog Box

NOTE: The fields are the same in the Add Analog Point and Edit Analog Point dialog boxes.

PAC Control User’s Guide, Legacy Edition




CHAPTER 6: WORKING WITH 1/0

Add Analog Point *
A — T Mame: | aiVoltage |
B | Description: | |

C i— In/Out Input

™ Channel Type: |GRY-IV-24: £160 Y P

| : Scaling N
D —————rul Range Actual; Scaled: F

| [
Lower: [-10 | [-160

Upper: | 160 | 160 || 160 |
Clear Default
N
G —[sendvalue
0

H ——[Jsend values

i 1 Default
| ——pDefault:  @®no OYes
J ——— watchdoa: (®)No Yes
K — 1 || Enable communication Enable Quality Indicator ————— L

Public Access (Optional)
M — [_]Make Public (Readable) Alloww Write Capability

Cancel Help

A—Name. Enter a name for the point. The name must start with a letter and may contain letters, numbers,
and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the point.

C—In/Out, Channel Type. In/Out and Channel type are usually already filled in for you. In/Out indicates
whether the point or channel is an input or output. If the point or channel of the module offers a range, the
Channel Type field is a drop-down list from which you choose a range.

D—Full Range. Full range and units for this module.

E—Clamping. (Outputs only—optional) To limit output to the device attached to the point, enter and
upper and lower clamp value. (If these fields are left blank, no clamp is applied.) To delete clamp values, click
Clear.

F—Scaling. (You won't see Scaling if you selected a groov module with thermistor range or a
SNAP-AIR400K-8 with temperature channel type). Assign custom units and values to the module. For example,
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you could scale the readings of a -10 to +10VDC input point to measure its input as zero liters per second
when the real-world reading is zero VDC, and 1000 liters per second when the real-world reading is 5 VDC.

This example would look like this:

| Add Analog Point P
Marmne: | Input_1 |
o In this example, units are changed to
Description: | | liters/second and lower and upper
values are changed. Although the
Type: Input module has an output of -10 to +10
volts, the device attached to the point
Module: | SNAP-AIMA-32: -20 - +20 mA e outputs only 0-5 volts. Scaling reflects
the device’s range.
4 e A In this case Clamping protects the
Full Range Actual: Scaled: device by ensuring that out-of-range
Units: | mA | % | voltage will never be sent to it.
-
o [0 ERn| a—
Clear Default
et e e o . paroseasbe et et ]

Custom scaled values are floating point values.

«  Analog input points: Analog inputs typically have under-range and over-range capability, which
means you want to take the under-range and over-rage values into account when you specify the scaling
values. For example, for a GRV-IMAI-8 module, if you select 4 to 20 mA as the input range, the
specification table indicates that it has an under-range limit of 1.8 mA and an over-range limit of 22 mA.
That means that the module could read a value as low as 1.8 mA; anything below that would be flagged
as under-range. Check the specification table for your selected module to determine if there are
under-range and over-range capabilities.

Also note that with firmware R8.0a and higher, you can use regular or inverted scaling. Inverted scaling
means the lower value is greater than the upper value; inverted scaling can accommodate a sensor, for
example, that is wired to the SNAP module in a way that produces a negative current or voltage.

«  Analog output points: Analog outputs do not have under-range or over-range capability. Also, you
cannot use inverted scaling. The upper value must be greater than the lower value.

Thermocouple values are not linear and cannot be scaled.

To return the units and upper/lower values to the defaults for the module, click Default.

F—Steinhart-Hart Coefficients. You will see this only if you selected a groov module with thermistor
range or a SNAP-AIR400K-8 module with temperature channel type. If you selected one of the thermistor or
temperature ranges with specific curve values, the fields display the value for each coefficient and you can't
edit those values. If you selected the thermistor or temperature range with a custom curve, enter each of the
coefficient values.

G—Send Value (Filter Weight). (Inputs only—optional) To set the average filter weight for an analog
input point, check this box and enter the value. A filter weight smooths analog input signals that are erratic or
change suddenly. The formula used for filtering is Y = (X - Y )/W +Y, where Y is the filtered value, X is the new
unfiltered value, and W is the filter weight. The larger the filter weight you enter, the smoother the analog
signal. Filtering is applied to values in engineering units, including minimum and maximum values. It does not
apply to values in counts.
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H—Send Values (Offset and Gain). (Inputs only—optional) To set offset and gain for the analog input
point, check this box and enter values. If you don't know what values to enter, you can use PAC Manager to
calibrate offset and gain for the point. For details, see the PAC Manager User’s Guide (form 1704).

I—Default. To set the initial state of the controller's interval value (IVAL) for this I/O point when the strategy
is run, click Yes and define the value. To leave the IVAL at its last state, click No.

If communication to the point is disabled, only the internal values (IVALs) are accessed or updated by the
control engine. The real-world external values (XVALs) for inputs don’t change because they are controlled by
external devices. The IVALs for inputs are set and will be overwritten by the XVALs unless communication to
the 1/0 unit or point is disabled.

The default (value) is available for both inputs and outputs. It sets the VAL for the point in the strategy in the
controller when the strategy is run. This can be useful when the 1/0 unit is not accessible or communication to
the 1/0 unit is intentionally disabled when the strategy first starts. When communication to an I/O unit is
disabled, any 1/0-related commands in the strategy will act only on the 1/0 point IVALs because the controller
is not able to access the XVALs at the I/0O unit when communication to that I/0 unit is disabled.

Once communication to the I/O unit is enabled and the 1/0 unit is accessible, then the first command to
access that point will update the IVAL. For example, if you use the Move command to write a different value to
an output, both the IVAL and XVAL are updated with the new value. If you use a Move command to read an
input, the XVAL is moved to the IVAL as part of reading the input point.

J—Watchdog. (Outputs only) To set a Watchdog on this point, click Yes, and define the value to be
assigned to the output if the Watchdog is triggered. A Watchdog is triggered if no communication activity is
detected on the bus for the amount of time specified in the Watchdog field of this point’s I/0 unit. For no
Watchdog, click No.

K—Enable. Select whether you want communication to this I/0 point enabled or disabled on startup.
Enabled is the default.

L—Enable Quality Indicator. (Available on some groov 1/0 channels only) This option allows the
channel's data quality to be displayed in applicable PAC Control dialog boxes. By default, this option is
enabled. groov I/0 modules that report quality continuously poll their channels for current data values and
identify deviations between reported and expected values. For more information and a list of applicable
groov /0O modules, see “I/O Quality Commands” on page 338.

M~—Public Access (Optional). Select Make Public (Readable) to allow the point to be read by certain
third-party applications. To allow these applications to write to the point, select Allow Write Capability. By
default, public access is disabled. For details, see “Public Access”on page 265.

Manually Adding groov RIO Channels

Before you add an individual groov RIO channel, you must add the groov RIO unit as an I/0 unit. See “"Adding
an I/0 Unit"on page 125.

Adding a Digital or Analog /0 Channel

1. With the strategy open and in Configure mode, double-click the I/0 Units folder (not the individual unit's
icon) on the Strategy Tree. PAC Control displays the Configure 1/0 Units dialog box.

PAC Control User’s Guide, Legacy Edition 141


http://www.opto22.com/site/documents/drilldown.aspx?aid=3161

ADDING I/0 POINTS

&% Configure /0 Units *
Mame Type Port Address Watch... Enabled RefCount Description Add...
Floor_1_RIO GRV-R7-M... Etherme... 10.192.... Disabled Enabled Modify
Test_Staton_1 GRV-EPIC-... Etherne... 127.0.0.1 Disabled Enabled 0

Delete

1/0 Modules and Points. ..

PID Loops...

Event/Reactions. ..
Close Help

2. Highlight the groov RIO unit the channels are on, and click I/O Modules and Points. PAC Control displays
the Configure RIO Channels dialog box.

&% Configure RIO Channels — [m| *

RIO Unit: |Floor_1_RIO ~ | Type: | GRV-R7-MM1001-10

# Channel Type MName RefCount Details...

o

Unconfigured
Unconfigured
Unconfigured
Unconfigured
Unconfigured
Unconfigured
Unconfigured
Unconfigured
Unconfigured
Unconfigured

PR T A R SR

w0

Concel || reln

3. Toadd adigital oranalog channel, click Unconfigured next to the channel number. PAC Control displays a
drop-down list with all the available functions and signal types. The following example shows the
functions and signal types available for channel 0 on GRV-R7-MM1001-10.

&% Configure RIO Channels - m} X

RIO Unit: | Floor_1_RIO ~ | Type: | GRV-R7MM1001-10

# Channel Type Mame Ref Count  Details. ..

Unconfigured
DI: 5-30 VDC L
DI: Switch Input, Powered
DO: 5-30VDC
AL 0-10V
AL 0-20 mA
AL ICTD Temperature Probe
Al Type B Thermocouple (°C)
AT: Type E Thermocouple (°C)
8 AL Type 1 Thermocouple {°C)
AL Type K Thermocouple (°C)
AL Type M Thermocouple (5C)

AL Type R Thermocouple (°C)
Al Type S Thermocouple (°C)
| AL Type T Thermocouple (°C)

AL Thermistor: 2252 Curve (*C)
AL Thermistor: 3K Curve (°C)
AL: Thermistor: 10K Type 2 Curve (°C)
AL Thermistor: 10K Type 3 Curve (°C)
AL Thermistor: Custom Curve (°C)
AL £150mV
AL £75mV
AL £25mV
AT: 0-400k Ohms

o

=R, N SOV X

The first two characters indicate the function (DI indicates digital input, DO indicates digital output, Al
indicates analog input, AO indicates analog output). The text after the colon describes the signal type.
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4. Select the function and signal type. PAC Control fills in the Ref Count and Details column with default
values.

5. Click Details to review and change default values for the signal type. For example:
- Ifyou selected Al: + 150 mV, you may want to change the default scaling.

- Ifyouselected a signal type that supports quality indication, you may want to disable Enable Quality
Indicator.

- Ifyou want to make the channel public, you can enable Make Public (Readable).
6. Repeat steps 3 through 5 for each additional 1/0 channel you want to add. If you are done, Click OK.

Configure RIO Channels Dialog Box

Because channels on a groov RIO can be configured as an input or an output, as well as different signal types,
the dialog box looks and behaves different from the other point/channel configuration dialog boxes.

&% Configure RIO Channels - O *

RIO Unit: |Floor_1_RIO ~ | Type: | GRVR7-MM1001-10

# Channel Type Mame RefCount  Details. ..

Unconfigured
Unconfigured
Unconfigured
Unconfigured
4 Unconfigured
5 Unconfigured
[ Unconfigured
Unconfigured
Unconfigured
Uncolnﬁgured

]

A—B
D

Cancel Help

h—
o
m

A—Channel Number. Refers to the channel number assigned to the RIO unit. You cannot change this
number.

B—Channel Type. A drop-down list that shows you which function and signal type you can assign to this
channel. Each groov RIO offers a different set of signal types, so what's available on this list depends on the
model you selected. After you select a function and signal type, PAC Control fills in the Ref Count and Details
column with more information about the signal type.

C—Name. Enter a name for the channel. The name must start with a letter and may contain letters,
numbers, and underscores. (Spaces are converted to underscores.)

D—Ref Count. The Ref Count (Reference Count) represents the number of 1/0 channels configured on the
/0 unit plus the number of times the I/0 unit is referenced in the strategy. You can't change this number.

E—Details. Shows more information about the signal type you selected. When you first select a signal type,
PAC Control fills this field with default values for any features available for the signal type. You can change
these values by clicking on the box, which opens the corresponding editing dialog box:

"Add/Edit Digital Point Dialog Box"on page 135
“Add/Edit Analog Point Dialog Box”on page 138

Manually Adding a groov Serial Communications Channel

A groov communications channel is an 1/0 channel that connects to a groov serial module, like GRV-CSERI-4.
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1. With the strategy open and in Configure mode, double-click the 1/0 Units folder (not the individual unit's

icon) on the Strategy Tree. PAC Control displays the Configure I/0 Units dialog box.

X

&% Configure 1/0 Units
Name Type Port Address Watch Enabled RefCount Description
GRV-EPIC- Etherne... 127.0.0.1 Disabled Enabled
S E =

add.. |

Mody...

Delete

I;ID Loops...

Event/Reactions...

2. Highlight the I/O unit that contains the serial communications module, and click /O Points. PAC Control

displays the Configure I/0 Modules and Points dialog box. (For a description of the Configure I/0

Modules and Points dialog box, see “The Configure I/0 Modules and Points Dialog Box"on page 150.)
NOTE: groov serial modules can be added only to the first four slots (00, 01, 02, or 03).

&% Configure /0 Modules and Points = [m] X
1/O Unit: [PR1 | Type: [Grv-EPICPR1 |
. Modules and Points Type Features / Subty | Units Enablec A | Add...
groov serial
modules can be g [01]Not Used Bty
og) [02] Not Used
added only to the % T ReLE
first four slots. e [04] Not Used Moye To...
0 105] Not Used
B0l 106] Not Used CopyTo
0 [07] Not Used
o 108 Not Used Exped
0l [09] Not Used [ Collapse Al |

00 [10] Not Used
00 [11] Not Used

<
Close Help

3. Highlight the number that represents the module’s position on the rack, then click Add. PAC Control

displays the Add Module dialog box.

&% Add Module

Type: @ Digital Input (O Digital Output (O Analog Input (O Analog Output (O Communication

X

Module:
Part Channels  Type(s)
il GRV-IDC-24 24 15-30 VDC
[SJerv-DCI-12 2 10 - 30 VDC Isolated
[Serv-Dcs-24 24 15 - 30 VDC on/off
[Serv-IDCIs-12 2 10 - 30 VDC Isolated on/off
[Herv-1ac-24 24 85 - 140 VAC
[Servact-12 2 85 - 140 VAC Isolated
[lerv-1AcHv-24 24 180 - 280 VAC

180 - 280 VAC Isolated

85 - 140 VAC on/off

85 - 140 VAC Isolated on/foff
180 - 280 VAC onjoff

180 - 280 VAC Isolated on/off
2- 16 VACNDC

2 - 16 VAC/VDC on/off

[Serv-1actHY-12 12
[Serv-1acs-24 24
[SJerv-1acis-12 2
[JervaacHvs-24 24
[JerviacHvs-12 12
[Serv-iacocTii-24 24
[Serv-IacDCTTLS-24 24

[[J Automatically create points within the new module

Name format:

Lo 1]

%1_%2_%3%4

Cancel Help.

42 Format information
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For Type, click Communication. The GRV-CSERI-4 serial module is already highlighted.

&% Add Module

Type: () Digital Tnput () Digital Output () Analog Tnput () Analog Output  (®) Communication
Module:

Part Channels  Type(s)

232/485 Serial Communication Module

Cancel Help
Click OK.
In the Configure 1/0 Modules and Points dialog box, click the plus sign next to the new module to
expand it.
Module icon &% Configure I/0 Modules and Points = m] X
1/ Unit: [PR1 | Type: [Grv-EPICPR1 |
Expand or collapse Enablec ~ | Add.
channels on the
. [Codfy.. ]
module by clicking
. . Delete
the +or-signinthe
bOX‘ Move To...
CopyTo »
Expand All
Channels Colopee AL
V| Scan for New
< > Modules
Close Help

Highlight the channel you want to configure and click Add. PAC Control displays the Add Serial Channel

dialog box. Complete the fields as described below.

Add Serial Channel
A —_  MName: | | |
B ———— Description: | |
1 | Twpe: 2-wire, R5-485, Mo Termination, Mo Bias o
| Cancel [ Help

A-Name. Enter a name for the channel. The name must start with a letter and may contain letters,
numbers, and underscores (Spaces are converted to underscores.)

B-Description. (Optional) Enter a description of the point.

C-Type. Select the configuration you want.

Click OK. The new channel appears in the list.

Here is an example of how it might look on a groov I/0 unit:
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&% Configure /0 Modules and Points

1/ Unit: [PR1

| Type: [Grv-EPICPR1

Modules and Points

| Type | Features / Subty l Units

| Enablec A

= g [00] GRV-CSERI4
230 Watt_Meter
10 { Not Used
LU 2 Not Used
19 3 Not Used
) [101] Not Used
100 02] Not Used
0 03] Not Used
g [04] Not Used
0l [05] Not Used
100 [06] Not Used
00 [07] Not Used

<

Close Help

Serial Module

I I3 ) N

Add...
Modify...

Delete

Move To...
CopyTo »

Expand All
Collapse All

Scan for New
Modules

Configuring a SNAP Serial Module

To configure a placeholder for a SNAP serial module:
With the strategy open and in Configure mode, double-click the I/O Units folder (not the individual unit’s

Use PAC Manager to configure SNAP serial communication modules (part numbers starting with
“SNAP-SCM"), including the SNAP-SCM-PROFIBUS-DP and SNAP-SCM-CAN2B modules. Serial modules can be
used with SNAP Ethernet-based I/0 units only. For more information, see the PAC Manager User’s Guide
(form 1704).

However, you can configure “placeholders”for SNAP serial modules in an I/0 unit so that you can more easily
identify their location in a rack.

icon) on the Strategy Tree. PAC Control displays the Configure 1/0 Units dialog box.

&% Configure /0 Units

Mame Type

Test Station_1 GRV-EPIC-...

Port Address Watch...
Etherne... 127.0.0.1 Disabled

Enabled
Enabled

Ref Count
a

Description

Close Help

Add...
Modify...

Delete

;
1/0 Modules and Points. ..

PID Loops...

Event/Reactions. ..

Highlight the I/0 unit that contains the serial communications module, and click I/0 Points.
PAC Control displays the Configure I/0 Modules and Points dialog box. Notice the module icons in the

dialog box.
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Module icons

&% Configure /0 Modules and Points = [m] X
1/O Unit: | Mixed_IO_units | Type: [ snap-pacR1 |
Modules and Points Type Features / Subty | Units Enablec A | Add...
[01] Not Used Modfy...
™"} [02] Not Used Delete
[03] Not Used
[04] Not Used Move To...
[05] Not Used
[06] Not Used SopyTont)
[07] Not Used
[08] Not Used Exped
09] Not Used [ Coﬂ;pseu 1
[10] Not Used
[11] Not Used v
< >
Close Help

Highlight the number that represents the module’s position on the rack, then click Add.

Alist of available modules appears.

&% Add Module

Type: @ Digital Input (O Digital Output (O Analog Input (O Analog Output (O Communication

X

[Serv-1actHY-12 12
[Serv-1acs-24 24
[SJerv-1acis-12 2
[JervaacHvs-24 24
[JerviacHvs-12 12
[Serv-iacocTii-24 24
[Serv-IacDCTTLS-24 24

Module:

Part Channels  Type(s)

il GRV-IDC-24 24 15-30 VDC
[SJerv-DCI-12 2 10 - 30 VDC Isolated
[Serv-Dcs-24 24 15 - 30 VDC on/off
[Serv-IDCIs-12 2 10 - 30 VDC Isolated on/off
[Herv-1ac-24 24 85 - 140 VAC
[Servact-12 2 85 - 140 VAC Isolated
[lerv-1AcHv-24 24 180 - 280 VAC

180 - 280 VAC Isolated

85 - 140 VAC on/off

85 - 140 VAC Isolated on/foff
180 - 280 VAC on/off

180 - 280 VAC Isolated on/off
2- 16 VACNDC

2 - 16 VAC/VDC on/off

Name format:

Lo 1]

Cancel

[[J Automatically create points within the new module

%1_%2_%3%4

42 Format information

Help

For Type, click Communication. The SNAP-SCM-232 serial module is already highlighted.

2% Add Module

Module:

Type: () Digital Input () Digital Qutput () Analog Input  (C) Analog Output  (®) Communication

*

[JsNAP-SCM-485-422 2
[JsNapscM-232-1 1
[sNAP-SCM-PROFT 1
[JsNAP-SCM-MCHIE 16
[JsNaP-sCM-w2 2
[JsNaP-sCM-SST 2
[JsNap-scM-5T2 2
[SNAP-SCM-CANZE 1

Channels

Type(s)

2 Channel
2 Channel R5-485/422 (2-wire or 4-wire)
1 Channel RS-232
PROFIBUS Module
Motion Control Host Communication Module
2 Channel Wiegand Interface
Serial Synchronous Interface Module
2 Channel Pulse & Direction Digital Qutput
1 Channel Controller Area Network

[ ]/

Cancel

Help

Select the module to configure, and then click OK.
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The Configure I/0O Modules and Points dialog box is displayed.

&% Configure /0 Medules and Points - O X
L/ Unit: | Mixed_IO_units | Type: [ snaPPACRL |
| Modules and Pairts Features / Subty Enablet » Add...
zrial Module
Delete
[03] Not Used
[04] Mot Used Move To...
[05] Net Used
[06] Not Used CopyTa ¥
[07] Net Used
[08] Not Used e
[09] Mot Used Collapse Al
[10] Net Used
[11] Net Used v
< >
Close Help

6. Click Close to save the configuration and close the dialog box. The new module appears in the list.

Changing SNAP I/0 Unit and Point Configuration

If you want to upgrade your current SNAP PAC brain or controller to a different model, you can change

configured 1/0 units and points as follows:

«  Ifyou replace a SNAP brain or rack-mounted controller, you can often change the entire /O unit at once.
This feature does not apply to serial B3000 or B3000-B brains. See the list of allowed replacements in
“Replace a SNAP Brain or Rack-mounted Controller”on page 148.

«  Youcan move a SNAP I/O point or an entire SNAP 1/0 module to a different position on the same or a
different SNAP I/0 unit. See “Moving a Configured /O Module or Point”on page 151.

«  Youcanfillinempty points on a SNAP /0 module or a SNAP I/O unit, or copy a point to another position.
See “Copying a Configured I/0 Point”on page 152.

«  You can also change a SNAP point you've configured (page 153) or delete it (page 154).

Replace a SNAP Brain or Rack-mounted Controller

In most cases you can change the entire I/0 unit type when you replace any of the following brains or
rack-mounted controllers as shown in the table below, and you won't need to reconfigure existing /0O points.

However, if you're replacing an R1 or EBT with an R2 or EB2, and any points on the 1/0 unit have the digital
features Counter, On Pulse, Off Pulse, Frequency, or Period, you'll need to change those /0 points. You'll see a
warning about this when you try to change the I/0 unit type.

0ld 1/0 unit type New 1/0 unit type 0ld 1/0 unit type New I/0 unit type

_ _ *
SNAP-PAC-R2 SNAP-PAC-R1

_ _ *
SNAP-PAC-EB1 zmﬁg_gﬁg_sé N
SNAP-PAC-EB2

SNAP-PAC-EB2*
SNAP-PAC-R1-B
SNAP-PAC-R1*

SNAP-PAC-EB1*

SNAP-PAC-R1 SNAP-UP1-D64

SNAP-PAC-R1-B SNAP-PAC-R1* SNAP-B3000-ENET

148

SNAP-PAC-R2

SNAP-PAC-R1
SNAP-PAC-EB1
SNAP-PAC-EB2
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0ld 1/0 unit type New 1/0 unit type

SNAP-PAC-R1
SNAP-PAC-R2
SNAP-PAC-EB2

SNAP-PAC-EB1

SNAP-PAC-R1
SNAP-PAC-R2
SNAP-PAC-EB1

SNAP-PAC-EB2

SNAP-PAC-R1

SNAP-PAC-SB1 SNAP-PAC-EB1

SNAP-PAC-R1
SNAP-PAC-R2
SNAP-PAC-EB1
SNAP-PAC-EB2
SNAP-PAC-SB1

SNAP-PAC-R1*
SNAP-PAC-R2*
SNAP-PAC-EB1*
SNAP-PAC-EB2*

SNAP-PAC-SB2

SNAP-ENET-D64

CHAPTER 6: WORKING WITH 1/0

0ld 1/0 unit type New 1/0 unit type

SNAP-PAC-R1-B
SNAP-PAC-R1*
SNAP-PAC-EB1*

SNAP-PAC-R1
SNAP-PAC-R2
SNAP-PAC-EB1
SNAP-PAC-EB2

SNAP-PAC-R1
SNAP-PAC-R2
SNAP-PAC-EB1
SNAP-PAC-EB2

SNAP-UP1-ADS

SNAP-ENET-S64

SNAP-UP1-M64

SNAP-PAC-R1
GENERIC OPTOMMP SNAP-PAC-R2
DEVICE SNAP-PAC-EB1

SNAP-PAC-EB2

*This change requires a mounting rack change.

To change a SNAP I/0 unit type:

1. With the strategy open in Configure mode, double-click the I/O Units folder in the Strategy Tree.
2. SelecttheI/O unit you want to change and click Modify.

3. (lickthe Type dropdown list to see the possible types you can change it to.

& Edit1/0 Unit

Information

*

Mame: | Sprinkler_Control

Communication from control

Enable communications from control engine

Device Options —
For temperature points, use degree: (_) Fahrenheit (@) Celsius

[watchdog timeout after | 0.5

Cancel Help

Description: | |
Type: =
Type: SNAP-PACR1 |~ﬁ[
Current Type b
Addressing SMAP-PACR Ethernet, SNAP Analog and Digital points
/Other F ible Types
IP Address: [|snAp-PAC-RZ Ethernet, SNAP Analog and Simple Digital
SMAP-PACEBL Ethernet, SNAP Analog and Digital points
MNAP-PACEB2 Ethernet, SMAP Analog and Simple Digi
Ethernet Port: 2001

Timeout and disable communications after tries of second(s) each.

second(s) of no communications

Other I/0 unit types you can
change this one to

4. Choose the new type, make any other necessary changes, and click OK.
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THE CONFIGURE 1/0 MODULES AND POINTS DIALOG BOX

The Configure I/0 Modules and Points dialog box allows you to make a variety of changes to 1/0 modules and
points.
To open the dialog box:

1. Make sure the strategy is open and in Configure mode. In the Strategy Tree, double-click the folder
named “I/O Units”" (not the icon representing a specific 1/0 unit).

2. Inthe Configure I/O Unit dialog box, highlight the unit and then click I/O Points.
The Configure I/0 Modules and Points dialog box opens.
For a SNAP I/0 unit, it looks something like this:

& Configure 170 Points — a Pt
/O Unit: | Sprinkler_Control | Type: | SNAP-PACRL |
Modules and Points | Type I Features / Subty... & Add...
[ [00] SNAP-IDC5: 10 - 32 VDC/VAC Digital Input :
%Y (011 SNAP-AOV-27 T ]
[0Z] Mot Used | Delete |
[03] Not Used -
04] Not Used Move To... |
[05] Not Used — :
[D6] Not Used CopyTo b
| [07] Not Used e
( g Expand All |
| e r— |
| Clese || Hep | | Colapse Al |

For a groov I/0 unit, the dialog box also has a Scan for New Modules button:

& Configure /0 Points — O *
/O Unit: | groov_EPIC_PR1 | Type: | GRV-EPIC-PRL |
Modules and Points Type Features / Subty h Add...
™ § 1001 GRV-ODCI-12: 5 - 60 VDC Isolsted | Digital Output :
ﬁ [01] GRV-OVMALC-8 Analog Output
[} [021GRV-IDCI-12: 10-30 VOC lsolated  Digital Input Delete
Ml [031GRV-V-24 Analog Input
gl [041GRVATMIS Analog Input MoveTo... |
- [05] GRV-OAC-12: 12 - 250 VAC Digital Qutput =
gl (061 GRV-MA-24 Analog Input CopyTo b

[07] Not Used =
[08] Not Used Expand All |

ﬁi} :3 Esej Collapse All_i
0] s I

Scan for New
Modules

i Close ! i Help !
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Scanning for New Modules (groov 1/0 only)

Clickthe Scan for New Modules button to open the Automatically Add Modules and Channels dialog box. This
dialog box lets PAC Control detect and automatically add 1/0 modules and channels in groov /0 units. For
details, see “"Automatically Adding groov I/O Modules and Channels”on page 131.

Moving a Configured |I/0 Module or Point

You can move a configured I/0 module or I/O point to an empty position on the same I/0 unit or a different
/0 unit.
«  Tomove a module, select it and click Move To.

ﬂ Move Module - SMAP-IDCS: 10 - 32 VDC/VAC *
Select a target 1O Unit: Select an available module position:
b3000enet Module [0Z] Not Used ~
Back_Sprinklers Module [03] Not Used
Mixed_IO_Unit

Module [04] Not Used
Module [05] Not Used
Module [08] Not Used
Module [07] Not Used
Module [08] Not Used
Module [09] Not Used
Module [10] Not Used
Module [11] Not Used W

Sprinkler Control

«  Tomove a point, expand an individual module by clicking its plus sign , or expand all modules by
clicking Expand All. Select the point you want to move and click Move To.

ﬁ Move Peint - Senser_3 (Digital Input) *
Select a target IO Unit: Select an available point position:
b3000enet Module [00] SNAP-IDCS: 10 - 32 VDC/VAC -~
Back_Sprinklers Point 3 : Not Used
Lzifoenl g Module [01] SNAP-ODCSH: 5 - 60 VOC Isolated

Module [02] SNAP-IDCSD: 2.5 - 28 VDC
Paint 2 : Not Used
Paint 3 : Not Used
Module [03] SNAP-OACS: 12 - 250 VAC
Module [04] SNAP-ATARMS
Module [05] SNAP-AQA-23
Module [08] W

1. Inthe left column, select the I/O unit you want to move the module or point to. (The I/0 unit it's on now
is selected by default.) In the right column, select the position you are moving the module or point to.
Then click OK.

You return to the Configure 1/0 Modules and Points dialog box, and the point has been moved.
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Copying a Configured I/0 Point

If you have several points on an I/0O module that are the same, you can copy a configured point:

To fill empty points on the same module.
Tofill all empty points on the I/0 unit.
To another point on the same or a different /O unit.

1. With the strategy open in Configure mode, double-click the I/O Units folder on the Strategy Tree to open
the Configure I/0 Units dialog box.
2. Select the I/0 unit whose points you want to copy, and then click the I/0 Points button. The Configure
I/0 Modules and Points dialog box is displayed. Click Expand All so you can see the points.
& Configure I/O Points - O *
1/O Unit: | Sprinkler_Control | Type: | SNAP-PACRI |
Modules and Points | Type | Features / Subty... » Add...
=[] [00] SNAP-IDCS: 10 - 32 VDC/VAC Digital Input _
I8 Switch_DO Courter
L 1 Not Used Delete
T 2 Not Used '
T 3 Not Used Move To...
= pill [01] SNAP-ODC5SRC: 5- 60 VOC Source  Digital Output -
o dam 1 [ [none  [EENECZALE
100 1 Not Used &
0=+
2 5 Expand Al |
Close Help Collapse All !
3. Highlight the point you want to copy and click the Copy To button. From the pop-up menu, choose one
of the following:
To copy the point to fill empty points on the module, choose Fill In Module.
The point is copied to the other empty points on the same module.
& Configure 170 Points - O *
1/O Unit: | Sprinkler_Control | Type: | sNAP-PACRL |
Modules and Points | Type | Features / Subty... & Add...
= [} [00] SNAP-IDCS: 10 - 32 VDC/AVAC Digital Input _ :
Original point pal| iteh_ S | Modify...
' ' =1 1 Switch_DO_0001 Counter Delote
Copied points LW 2 Switch_DO_000 Courter '
I8 3 Switch_DO_000 Counter Mave To...
= gl [011SNAP-ODCSSRC: 5 - 60 VDT Source  Digital Output
o g Aam_t Naone
T 4 Nt Used
- Expand All
e L e ST . S LA S

To copy the point to fill all empty points on the I/0 unit, choose Fill In 1/0 Unit.

The point is copied to all empty points on similar modules (for example, to all empty points on digital
input modules, whether they are the same or a different part number), and the module and point are

copied to all compatible slots without configured modules.
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4 Configure /0 Points — O *
/O Unit: | Sprinkler_Control | Type: | sMAP-PACR1 |
Igsigzjos(;lnet\%/ﬁ;;lil;]eaaﬂyefsgggsgiis-rhe Modules and Poirts I Type I Features / Subty... l - Add...
s ' » [ (03] SNAP-IDC5D: 2.5- 28 VOC Digtal Input _
e\;‘fpggfn%g; the module s a different ©H [ Switch_D0_0300 Counter
P : = 1 Switch_DD_0301 Courtter Ddete |
U 2 Swich_DO_0302 Courtter
U 3 Swich_DO_0303 Courtter Maove To...
No module existed in this slot. Both # [T [04] SNAP-IDCS: 10 - 32 VDC/VAC Digital Input
the points and the module were 1§ Switch_DO_0400 Counter CopyTo P
copied from the original. & 1 Switch_D0_0401 Counter
19 3 Switch_DO_0402 Counter |
Lt - RS T— —_— AL | e mn IR S AN oy

To copy the point to one other point (either on the same or a different 1/0 unit), choose To Specific.
The Copy To dialog box opens.

i Move Point - Alarm_1 (Digital Cutput) x
Select a target IO Unit: Select an available point position;
b3000enet Module [00] SNAP-IDCS: 10 - 32 VDC/VAC -
Eﬂ?*aSIDSHSE_ftS Module [01] SNAP-ODCSSRC: 5 - 60 VDT Source
e ni 2 7
Sipie v

Paoint 2 : Not Used
Point 3 : Not Used
Module [02] SNAP-AQW-27
Module [03] SNAP-IDCSD: 2.5 - 28 VDC
Module [04] SNAP-IDCS: 10 - 32 VDC/VAC
Module [05] SNAP-IDCS: 10 - 32 VDC/VAC i
£ >

Cancel Help

In the left column, choose the same or another I/O unit. In the right column, choose the location of the
point to copy to.

Available points are shown in black. Already configured points, points on a different type of module
(digital output instead of digital input, for example), and point numbers not on the rack (such as point 40
on an 8-module rack) are grayed out.

If the point is copied to an empty module slot, the module part number from the copied point is added,
too.

4. Afteryou copy a point, change the new point as needed by double-clicking its point name. In the Edit
Digital Point dialog box, type the new name and make any other changes. For details, see "Add/Edit
Digital Point Dialog Box"on page 135.

Changing a Configured 1/0 Point

1. With the strategy open in Configure mode, expand the |/O Units folder on the Strategy Tree until you can
see the I/0 point you want to change. Double-click the I/0O point name.

2. Inthe Edit Analog Point or Edit Digital Point dialog box, make the necessary changes. (For more
information, see “Add/Edit Digital Point Dialog Box"on page 135 and “Add/Edit Analog Point Dialog Box”
on page 138.)

3. (lick OKto save the settings and close the dialog box.
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Deleting a Configured 1/0 Point

You cannot delete an I/O point that is referred to in the strategy.

CAUTION: Be careful when deleting I/0 points. You cannot undo a deletion.

1. With the strategy open in Configure mode, expand the I/0 Units folder on the Strategy Tree until you can
see the I/0 point you want to delete.

2. Right-click the I/0 point's name and choose Delete from the pop-up menu.

You can also delete an 1/0 point from the Configure I/0 Modules and Points dialog box by highlighting its
name and clicking Delete.

THE CONFIGURE POWER MONITORING MODULE DIALOG BOX

154

The Configure Power Monitoring Module dialog box helps you configure a GRV-IVAPM-3 or a

GRV-R7-1TVAPM-3 module, which measures AC voltage and AC current for up to 3 phases and provides 64

analog input points with values derived from those measurements. The input points are organized into

groups:

«  One group for each phase (Phase A, Phase B, and Phase C). Each of these groups contains values
derived from the measurements on the associated phase.

«  ATotals group that contains total values from all 3 phases.

To open the dialog box:

1. Make sure the strategy is open and in Configure mode. In the Strategy Tree, double-click the folder
named “I/0 Units” (not the icon representing a specific I/0 unit).

2. In the Configure I/0 Unit dialog box:

- For GRV-IVAPM-3 modules, highlight the groov I/0 unit that contains the module and then click I/0
Modules and Points.

- For GRV-R7-1TVPAM-3, highlight the module and then click I/O Modules and Points. Skip to step 4.

3. (GRV-IVAPM-3 modules only) Click the plus sign (“+") to expand its tree, then double-click on the row
that displays the message “Double-click to Configure”.

4. PAC Control displays the Configure Power Monitoring Module dialog box.

5

3- Test_RIO_P - O
Master Name: | Rio02_Pwr | | Apply Master Name
Description: |
Voltage Type For All Phases: | 0-400 vrms Wye | MeasurementMode: | Standard v
(i) To force phase measurements to zero, set the Minimum Voltage Threshold Ratio = 1 for that phase.
Phase A PhaseB  PhaseC  Totals
Current Configuration: Voltage Configuration:
Current Transformer Type 0SAmsCT Potential Transformer Turns Ratio 1
Full Scale Current 1 Minimum Voltage Threshold Ratio 0
Minimum Current Threshold (8) 0 Power Creep Adjustment (%) 0
Transformer Phase Compensation 0
CT Reverse Polarity No =
Channel Configuration:
ch  channel Name Comms Quality [ Public "~
0 ta Rio02_Pwr_00_PhsA_Voltage ]
Rio02_Pwr_01_PhsA_CT O
Rio02_Pwr_02_PhsA_TruPwr ]
Rio02_Pwr_03_PhsA_ReacPwr O
Rio02_Pur_04_PhsA_AppPur ]
Rio02_Pwr_05_PhsA_PwrFac O
RioD2_Pwr_06_PhsA_Peaky ]
Rio02_Pwr_07_PhsA_PeakC O
Rio02_Pwr_08_PhsA_Freq ]
.. Rio02_Pwr_09_PhsA_TruePwrAlF... O
Rio02_Pwr_10_PhsA_HarTrusPwr (] v

oK Cancel Help
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5. Fill out the following fields, which apply to all three phases and the totals:

- Master Name—PAC Control provides a generic master name, which is a set of characters prefixed
to each channel name that can help you more quickly assign names to each channel. You can
change the generic master name to any other name that may be more useful to your application.
Type inthe new name in the Master Name field, then click Apply Master Name. PAC Control changes
the prefix of all the channels with the new master name.

- Description—Type in a description for this module. The maximum number of characters is 127.

- Voltage Type For All Phases—The maximum RMS voltage (V,,s) and configuration of the
3-phase circuit. For a Delta circuit, choose a Delta option with the smallest Vs range that is greater
than the nominal line-to-line V,,,; on the circuit. For a Wye circuit, choose a Wye option with the
smallest Vs range that is greater than the nominal line-to-neutral V,,,s on the circuit. For example,
if the module is connected to a three-phase three-wire 480 VAC Delta circuit, choose the 0-520 Vs
Delta option.

- Measurement Mode—Choose from one of the following measurement modes:

- Standard—Measuring up to 3 phases, with each phase connected to one current transformer.
— 2 Current Transformers—Measuring with one of the following configurations:

—3-phase Delta configurations with 2 current transformers: one connected to phase A, the
other connected to phase B. In this configuration, channel values are modified as follows:

—Phase A: Channels 6, 7, 9-12 return values of 0.0.

—Phase B: Channels 24, 25, 27-30 return values of 0.0

—Phase C: Channels 37-48 return values of 0.0, energy channels 49-53 do not accumulate
energy.

—2-phase Wye configuration with 2 current transformers: one connected to phase A, the other
connected to phase B. In this configuration, the channels of phase C are modified as
follows:

—Channels 37-48 return values of 0.0.
—Energy channels 49-53 do not accumulate energy.
6. Fill out the following for each phase that you'll be using. (To switch between phases, click the tabs.)

Current Transformer Type—The type of secondary for the current transformer (CT) used to measure
current on the associated phase. For example, when using a 0-200 A current transformer with 0-5 A secondary
on Phase A, choose the "0-5 A CT" option for phase A.

Full scale current—The primary current in the associated phase when the current transformer secondary is
at maximum scale. For example, if using a 0-200 A current transformer with a 0-5 A secondary, when the
secondary is at 5 A, the primary is measuring 200 A,... Enter 200.

Minimum Current Threshold (A,,)—The minimum current below which all input values for this phase
(except voltage and energy totals) are set to 0. This value is specified in units of RMS amps (A,,o). When set to
the default 0.0, the module will use a default Minimum Current Threshold value. This configuration can not be
used to set a threshold value lower than the default value implemented by the module.

- Transformer Phase Compensation—The number of degrees (°) to add to the phase difference
between the measured voltage signal and current signal for this phase. Valid values include any
floating-point number between -8.0 and 8.0. The default value is 0.0°.

CT Reverse Polarity—Whether to reverse the polarity of the current transformer.

Potential Transformer Turns Ratio—The number of turns in the potential transformer primary winding
divided by the number of turns in the secondary winding. If no potential transformer is used for the associated
phase, set this value to 1.0.

Minimum Voltage Threshold Ratio—The minimum voltage below which all input values for this phase
(except energy totals) are set to 0. Specify this value as a fraction of the full-scale voltage in the "Voltage Type
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for All Phases" option. For example, if "Voltage Type for All Phases" is set to "0-520V,,, Delta" and Minimum
Voltage Threshold Ratio is set to 0.05, input values for this phase will be set to 0 when the voltage measured
on this phase drops below (520%0.05) = 26 V,,.. When set to the default 0.0, the module will use a default
Minimum Voltage Threshold Ratio value. This configuration can not be used to set a minimum voltage
threshold ratio lower than the default value implemented by the module. To set all input values for this phase
to zero regardless of the measured voltage (for example, to disable this phase), set the Minimum Voltage
Threshold Ratio to 1.0.

Power Creep Adjustment—The power threshold below which all measured values for the phase are set to
zero (except Vims ims @and energy totals.) Specify this threshold as a percent of full-scale apparent power
(full-scale Vo) * (full-scale I ,s). The default value is 0.0%. For example to set all input values for this phase to
zero when the power drops below 10%, enter 10.0. If "Voltage Type for All Phases" is set to "0-300 V,,s Wye"
and "Full Scale Current" is set to 200, all values for this phase will be set to zero when apparent power is below
300 Vs * 50 Ay * 109% / 100% = 1500 VA.

- Select which channels you want to enable and which features you want to enable for each channel

by clicking the corresponding check box.

7. (lickthe Totals tab. Select which channels you want to enable and what features you want to enable for
each channel by clicking the corresponding check box.

8. (lickOK.
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PID loops (or simply PIDs) are used to drive an input (a process variable) toward a particular value (the
setpoint) and keep the input very close to that value by controlling an output. For example, consider
temperature control, where the input is a measurement of ambient temperature, the setpoint is the desired
temperature, and the output is a heater. The PID for this system will use a mathematical formula that controls
the output to maintain a desired temperature, efficiently adjust to changes in setpoint, and compensate for
changes in load, such as the influx of cold air. In this example, a temperature sensor (analog input), a
thermostat (analog input), and a heater control (analog output) are components of one system, controlled by
a PID loop.

This guide assumes that you are already familiar with using PIDs. PID calculations are complex and the physical

qualities of systems suitable for PID control differ greatly. This guide includes only basic information for

configuring PIDs.

« groovand SNAP PAC I/0 units support 96 PID loops.

«  groov RIO units support 4 PID loops.

«  Ananalog/digital SNAP Ethernet I/O unit supports 16 PID loops; a SNAP Ultimate 1/0 unit supports 32
PID loops.

«  Ifyou have PAC Control Professional, you can also use up to eight PID loops on mistic 1/O units.

PIDs can control isolated systems or be part of cascaded systems where one loop controls the setpoints or
input variables of others. For maximum flexibility, any PID input, setpoint, or output can be determined by PAC
Control commands.

PIDs and Strategies

The PID operates at the I/0 unit, independently of the controller. However, the controller supports logic
commands to read and write various PID parameters and modes. Once configured and initialized, a PID
operates until the 1/O Unit loses power.

When you change PID configuration in PAC Control, remember that changes are not written to the I/0 unit
until the strategy is downloaded and run. For a groov, SNAP PAC, or other SNAP Ethernet-based I/0 unit, be
sure to save PID configuration to flash memory following instructions for the I/0 unit.
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If you subsequently download a different strategy to the control engine, you'll receive an error message (-700)
reminding you that a PID loop is still running and that it may conflict with the new strategy. To turn off a PID
loop on a SNAP Ethernet-based I/0 unit, start PAC Manager and use Inspect mode to change the PID's
algorithm to None.

Each PID loop must be individually configured and tuned.

Configuration steps start in “Adding a PID Loop (groov RIO, groov EPIC, or SNAP PAC)” on page 157, and tuning
steps are described in “Inspecting and Tuning PID Loops”on page 184. For additional information, see “PID—
Ethernet Commands”on page 350; the OptoTutorial: SNAP PAC PID (form 1641); and the Tuning a PID Control
Loop technical note (form 2171).

(PAC Control) For serial-based mistic 1/0 units, see “Adding a PID Loop (mistic)”on page 160 and “PID—
mistic Commands” on page 354.

Adding a PID Loop (groov RIO, groov EPIC, or SNAP PAC)

NOTE: This section applies to groov RIO, groov EPIC, SNAP PAC, Ethernet I/O, and Ultimate I/O units.

1. With the strategy open and in Configure mode, double-click the I/0 Units folder (not the individual unit’s
icon) on the Strategy Tree.

The Configure /0 Units dialog box opens.

4 Configure 170 Units >
Name Type Port address  Watch..., Enabled RefC.. Add...
b3000enet SMAP-B3000-E... Ethern... 10.19... Disabled Enabled 0
Mixed_IO_Unit  SMAP-UP1-ADS Ethern... 127.0.... Disabled Enabled 12 —

SNAPPACR1 Ethern... Dizabled & Delete
Sprinkler_Contral  SMAP-PAC-R1 Ethern... 10.19... Disabled Enabled 3
1/0 Points...
PID Loops...
Event/Reactions. ..
< 3
Close | Help
2. Selectthel/O unit the PID will be on, and click PID Loops.
& Configure PID Loops - O >
1/0 Unit: w|  Type: |[smaPPACRL
# Mame Input Set.. Out.. Mode Enable Ref... Descri ™
e Modify...
o1 Mot ...
02 Mot ... = Delete
a3 MNot ... =
R S S SO D rosy R

3. Double-click the lowest unused number.
The Add PID Loop Dialog appears.
4, Complete the fields as described in “Add PID Loop Dialog Box"below, and then click OK.
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The new PID appears in the Configure PID Loops dialog box.
5. When you have finished configuring PIDs, click Close.
PIDs appear in the Strategy Tree under the I/0 unit.

2 I Cookies
[C5) Control Engines

[C3) Subroutines Induded
[C5) Charts

[C5) Variables

=

2l h3g00enet

2l Mixed_IO_Unit
=] %‘;‘ Sprinkler _B

=

ODEEE

= ) PIDs PDI
oops
Sprinkers p
%‘;‘ Sprinkler_Contral
Add PID Loop Dialog Box
Add PID Loop X
A ——— Mame: | | |
B — 1 Description: | |
C—— put: 1/O Point | | R | [Jsquare Root —— D
E — Low Range: High Range:
F —— setpoin: ~ |1jopoint ~| | v]
G —— output: yoront | | v

H—— om0 | ipecamo |
| ————— min Change: I:I Max Change: D (0 disables min/max change)

Output options for when the input is out of range

[ switch to manual mode when input goes out of range
J

[JForce output when input is out of range (auto mode only)

Qukput walue when input is under-range: | g and over-rande: | g
N
| Feed Forward
— 1 Algorithm: elod ype | Gain:

K Algorithm: | Velocity (Type C) Gai i

L ——— Mode: Auto v Ture L ICW -0
Gain: a

M——senmow [1 e e P

Enable communication

Cancel Help

A—Name. Type a unique, descriptive name for the PID. The name must start with a letter and may contain
letters, numbers, and underscores (spaces are converted to underscores).
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B—Description. (Optional) Enter a description of the PID.

C—Input. Select the type of input: 1/0 Point, Host, or PID Output.

«  Ifthe PID's process variable comes from an I/0 point on the same unit, select I/O Point. Choose the point
from the drop-down list or type a point name to configure a new point.

« Ifthe PID's process variable comes from the PAC Control strategy, select Host. Enter an initial value for the
input.

« Ifthe PID’s process variable is the output of another PID on this brain (a cascading control loop), select
PID Qutput. Choose the PID from the drop-down list.

D—Square Root. (Optional) If you chose I/0 Point or PID for step C, check this box if the error should be
calculated based on the square root of the process variable (applies to flow control systems where volumetric
flow is proportional to the square root of a signal from a flow transducer).

E—Low/High Range. Set the valid range of the process variable by entering the low range and the high
range. (See Output Options for optional responses to out-of-range input.)

F—Setpoint. Choose the source for the setpoint: /0 Point, Host, or PID Output.

«  Tocontrol the setpoint using a device (on the same brain) such as a potentiometer, select I/0 Point;
choose an I/0 point from the drop-down list or type a new point name.

«  To control setpoint using PAC Control or PAC Display, select Host. For Initial Value, enter the most common
operating value.

«  Ifanother PID loop will control the setpoint, select PID Output and choose the PID from the drop-down
list.

G—Output. Choose the destination for the PID output: I/0 Point or Host. (To use the output for controlling
the setpoint or input of another PID, choose Host.)

H—Lower Clamp/Upper Clamp. Enter upper and lower clamp values to prevent the output from
exceeding a desirable range. These values should equal the range of the output point, if used. Or choose
values to make sure that the output device doesn't shut off (for example, keeping a circulation pump running
regardless of the PID output) or that the output never reaches a destructively high setting (for example,
keeping a motor below maximum).

I—Min Change/Max Change. (Optional) Enter minimum and maximum change values. The output
won't respond until the minimum change is reached (for example, you may not want a heater to turn on to
correct a 1 degree error). Maximum change prevents too drastic a change in output (for example, you could
limit the increase in a pump's output to prevent pipe breakage). The default for both minimum and maximum
is zero, which disables the feature.

J—Output Options. Choose how the PID should respond if the input goes out of range. To have PAC
Control logic or an operator respond, check Switch to manual mode. To force the output to a specific value,
check that option and type the output values.

NOTE: If both boxes are checked (forced output and manual mode), the output will be forced and the PID put into
manual mode; but ifthe PID is already in manual mode, the output will not be forced. (You can use the command
Get PID Status Flags to determine current settings.)

If neither box is checked and the PID input goes out of range (as defined by E- Low/High Range) then the output will
freeze, but only while the input is out of range.

K—Algorithm. Choose algorithm: Velocity, ISA, Parallel, or Interacting. For details on algorithms, see
“Algorithm Choices —Ethernet”on page 352.
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L—Mode. Choose the Mode you want the PID to be initialized to. The main difference between Automatic
and Manual mode is that in Manual mode the PID loop stops its mathematical calculation. In both modes the
PID's output value is still copied to the analog output.

«  Auto mode: The PID makes calculations based on the difference between the input and the setpoint
resulting in changes to the output, which causes the input to move toward the setpoint.

«  Manual mode: The PID stops making changes to the output, but continues to write the PID output to the
analog point (or configured destination for the PID output). Manual mode allows PAC Control logic or an
operator to control the PID output, which in turn is written by the PID loop to the analog point (or
configured destination of the PID output).

NOTE: If the value of the analog point or configured destination is changed, it will be overwritten by the PID output.

PID et

‘ Analog
| Input ‘Output \‘\-* Output

M—Scan Rate. Enter a scan rate to determine how often the input is scanned and the controller output is
calculated. Minimum value is 0.001 (1 ms). Scan time should be greater than system lag (the time it takes for
the controller output to have a measurable effect on the system). Also consider other PIDs and tasks on the
brain competing for processing power.

N—Gain. Type a positive or negative value for Gain. Heating systems usually require a negative value and
cooling systems a positive value. NOTE: Gain is usually refined during the tuning process.

O—Fd Fwd Initial/Fd Fwd Gain. (Optional) Enter Feed forward Initial and Feed forward gain values if you
need to offset the controller output in your application. These values are constants that are multiplied and
added to the controller output; often they are not used in PIDs.

P—Tune I/Tune D. (Optional) Type Integral and Derivative settings if you know the desirable settings.
However, Integral and Derivative are not essential to basic configuration and are better determined in the
tuning process.

@ Adding a PID Loop (mistic)

(Pro only) mistic PID loops can be configured only on B3000 or B3000-B brains and G4A8R bricks. (For PID
loops on Ethernet-based I/0 units, see page 157.)

1. To configure a mistic PID loop, make sure you have the strategy open in Configure mode.
2. Onthe Strategy Tree, double-click the I/O Units folder (not the individual unit’s icon).
3. Inthe Configure I/0 Units dialog box, click the PID Loops button.

The Configure PID Loops dialog box appears, listing all PID loops on the I/0 unit.
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4 Configure PID Loops — O >
/0 Unit: | b3000b w Type: |B3000 Analog
# Name  Input  Set.. Out.. Mode Enable Ref... Descri ™
Al LS Modify...
01 Mot ...
02 Not ... = Delete
03 Not ... '
04 Not ...
et .
< >
bl B st ot s it e R o ATl R R s o s B oyonn . ]

4. If the correct 1/O unit does not appear in the 1/0 Unit field, choose it from the drop-down menu.
5. Double-click an unused line (or highlight it and click the Add button).
The Add PID Loop dialog box opens.

6. If you choose I/O Point as the Input source and Host as the Setpoint source, complete the fields below.
However, if you choose Host as the Input source and I/O Point as the Setpoint source, complete the fields
as described in “Add PID Loop Dialog Box (mistic), Host Input” on page 163.

Add PID Loop Dialog Box (mistic), 1/0 Point Input

Add PID Loop X
A ———HName: | |
B—— Description: | |
C —Mode: | Auto e D|:|Itior15. = Scan Rate: sec.———E
D
F—— mnput: yoront /| | I G
H — []Square Root [ ] Average

I—output: | V| Max Chg Rate: D__J
K————— Lower Clamp: D Upper Clamp: D__L

M——— Setpoint:  |Host ~ Tnitial Value: IE_ N
O————————— Lower Clamp: | 32768 Upper Clamp: | 32767 P

Q—— Gain: [ntegral: I:I Derivative: IE——S
|

T ——— [~Enable communication

Cancel Help

A—Name. Enter a name for the PID. The name must start with a letter and may contain letters, numbers,
and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the PID.
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C—Mode. Select whether the initial mode of the PID is automatic or manual. In Automatic mode, the PID is
automatically calculated. In Manual mode, no calculation is made.

D—Options. To set advanced options, click Options and see “Setting PID Loop Control Options (mistic PIDs)”
onpage 164.

E—Scan Rate. Enter a time (in seconds) representing the interval between PID loop calculations. The
smaller the number, the more often the PID will be calculated. The default of 0.1 specifies a PID calculation 10
times per second.

F—Input. Select whether the input for the PID calculation will be read from an I/0 point or a host device (the
controller). Your choice determines the other data required in the Input section of the dialog box. If you
choose Host, see the figure in “Add PID Loop Dialog Box (mistic), Host Input” on page 163 for additional fields to
complete.

G—Input drop-down list. (If |/O Point is selected at F) Select from the drop-down list the 1/0 point
providing the input value. If the point doesn't exist, enter a new name and add the point.

H—Square Root. (If /O Point is selected at F) Enable or disable square root extraction and averaging of the
input value prior to the PID calculation. These options are disabled by default.

I—Output. Specify the output to be driven by the PID by selecting an I/0 point from the drop-down list. If it
doesn't exist, enter a new /0 point name and add the point.

J—Maximum Change Rate. Specify the maximum absolute difference allowed for the output value as
the result of one PID calculation. For example, a maximum change rate of 10 specifies that even if a PID
calculation suggests an output change of 20 units, the maximum change allowed during the loop will be 10
units.

You can use a maximum change rate to avoid sudden, dramatic increases or decreases in the output value.
Note that the maximum change rate must be between one percent and 100 percent of the range of the
output itself, which is the difference between the output’s high-scale value (L) and low-scale value (K). The
value representing this full range will appear by default.

K—Lower Clamp, Output. Specify the minimum value allowable for the output. This value cannot be less
than the zero-scale value of the output module.

L—Upper Clamp, Output. Specify the maximum value allowable for the output. This value cannot be
greater than the full-scale value of the output module.

M—Setpoint. Select whether the setpoint for the PID calculation will be read from an 1/0 point or a host
device (the controller). The setpoint is the value to which the input will be driven. Your choice determines the
other data required in the Setpoint section of the dialog box. If you choose /0 Point, see the figure in “Add PID
Loop Dialog Box (mistic), Host Input”on page 163 for additional fields to complete.

N—Initial Value. (If Host is selected at M) Specify the initial value for the setpoint. This value must be
between the lower-clamp and upper-clamp values (O and P). The default is zero.

O—Lower Clamp, Setpoint. (If Host is selected at M) Specify the lowest possible setpoint value. Default:
-32,768.

P—Upper Clamp, Setpoint. (If Host is selected at M) Specify the highest possible setpoint value. Default:
32,767.
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Q—Gain. Specify the gain term (P) to be used in the PID calculation. This value can range between -32,768
and 32,767 but must not be zero. The default is one.

R—Integral. Specify the integral term (1) to be used in the PID calculation. This value can range between
zero and 32,767.The default is zero. (Note: The product of the scan rate and the integral term must be less
than or equal to 3,932,100,

S—Derivative. Specify the derivative term (D) to be used in the PID calculation. This value can range
between zero and 32,767. The default is zero.

T—Enable Communication. Select whether you want communication to this PID loop enabled or
disabled.

Add PID Loop Dialog Box (mistic), Host Input

Add PID Loop >

Mame: | |

Description: | |

Mode: Auto e Options... Scan Rate: SEC.

Input: Host ~ Initial Value: D—A
B — L lowScale: -32768 High Scale: | 32767 | C

Setpoint: | Host ~ Initial Value: EI—— D

Lower Clamp: | -32768 Upper Clamp: | 32767
Gain: [mtegral: l:l Derivative: l:l

Enable communication

Gl | [ i

A—Initial Value. (If Host is selected as Input source) Specify the initial value for the input for the PID
calculation. This value must be between the low-scale and high-scale values (B and C). By default, this value
is set to zero.

B—Low Scale. (If Host is selected as Input source) Specify the lowest possible input value. The default is
-32,768.

C—High Scale. (If Host is selected as Input source) Specify the highest possible input value. The default is
32,767.

D—Setpoint. (If I/0 Point is selected as Setpoint source) Select from the drop-down list the I/0 point
providing the setpoint value. If the point doesn't exist, enter a new name and add it.
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Setting PID Loop Control Options (mistic PIDs)

(Pro only) If you clicked the Options button in the Add PID Loop dialog box in step 6 of “Adding a PID Loop
(mistic)” on page 160, the PID Loop Control dialog box opens.

1. Setthe options as described in “PID Loop Control Options Dialog Box” below.

NOTE: Since you can switch between automatic and manual modes through the View PID Loop dialog box in
Debug mode, you may want to configure options for both modes.

2. When you have set the options, click OK to return to the Add PID Loop dialog box.

PID Loop Control Options Dialog Box

| PID Loop Control Options >
I Automatic Mode

A Output: (®) Enabled () Disabled

Manual Mode

B Output: (®) Enabled () Disabled

C Output Track () Yes ®No

D Setpoint Track Input: (@) Yes ONo

E Reset: O ves @ MNo

Cancel Help

A—Automatic Mode. If you want the PID calculation transferred to the output, click Enabled (the default).
If you do not want the PID calculation transferred to the output, click Disabled. In either case, the PID will
continue calculating and will not be reset.

B—Manual Mode/Output. If you want the PID calculation transferred to the output, click Enabled (the
default). If you do not want the PID calculation transferred to the output, click Disabled.

C—Manual Mode/Output Track Input. If you want the output to assume the input value, click Yes. You
can use this option to create a signal converter (for example, 4-20 mA input to 0-10 V output), since the
output is proportional to the input.

D—Manual Mode/Setpoint Track Input. If you want the setpoint to be set to the input value, click Yes.
You can use this option to smooth the transfer when returning to automatic mode.

E—Manual Mode/Reset. If you want to force the PID loop to reset when entering manual mode, click Yes.
This option stops all calculations, sets all process errors to zero, and resets the scan rate timer, leaving the
output unchanged. If you want the PID calculation to continue, click No. (When you enter automatic mode,
however, you cannot force a reset.)

mistic PID Loop Configuration Example

Here's an example of a completed mistic PID configuration for a temperature controller. The PID modifies an
output automatically every second.

The input is an 1/O point called Oven_Temperature. Its value is averaged before being applied to the PID
calculation. The output being driven is an I/0 point called Oven_Temperature_Control, which must remain
between zero and 100 units.
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Add PID Loop

Mame:
Description:

Mode:

Input:

Output:

| Temperature_Controller

| TIC-102 Oven Temperature Controller

| Auto w Options... Scan Rate: SEC.
1/0 Point ~ | COwven_Temperature_Control -
|:| Sguare Root Average

| Oven_Temperature_Contre ~ | Max Chg Rate: | 1

Lower Clamp: I:I Upper Clamp:

Setpoint:

L

:Host

Initial Value:

Lower Clamp: | -32768 Upper Clamp:

(Gain:

i [mtegral: 0.1 Derivative:

Enable communication
Cancel Help

CHAPTER 6: WORKING WITH 1/0

The maximum change rate has been
set to the full range (100), which
means we are allowing the output to
changeasmuchasitneedstoduring
each cycle.

The setpoint is read from the host
device (the controller) and is initially
set to zero. It is clamped at 400 at the
upper end.

—— For the PID calculation, the gain term is
one, the integral term is 0.1, and the
derivative term is zero.

The sample PID would appear in the Configure PID Loops dialog box like this:

i Configure PID Loops

1JO Uniit: | b3000b

Type: | B3000 Analog

#  Mame

Temperature_...
Mot Used
Mot Used
Mot Used
Mot Used
Mot Used

Input Set... Qutput

Oven_Te...

Mode

Enable

Kad

Add...
Modify...

Delete

Close

Help

Changing a PID Loop

You can change the PID loop’s configuration and its position in the I/0 unit.

1.

Make sure the strategy is open and in Configure mode. On the Strategy Tree, expand the I/0 Units folder

until you see the PIDs folder for the I/0 unit you want. Double-click the PIDs folder.

The Configure PID Loops dialog box opens, listing all configured PID loops. Remember that the number
of PID loops available depends on the I/0 unit.
PID loops are scanned by the I/0 unit in the order that they appear in this list.
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4 Configure PID Loops - O *

1O Unit: | b3000b w Type: | B3000 Analog

£  Name Input Set... Output Mode Enable | % Add...

Temperature_... Owen_Te... Host Qven_T... Modify...
01 Mot Used
02 Mot Used Delete
03 Mot Used

04 Mot Used
05 Mot Used Up- and down-arrows

Close Help

2. Tomove the PID loop to a different position on the I/O unit, use the up- and down-arrows in the dialog
box.

3. Tochange the PID loop’s configuration, double-click its name to open the Edit PID Loop dialog box.
Change the fields as necessary. For help in completing the fields, see “Adding a PID Loop (groov RIO,
groov EPIC, or SNAP PAC)” on page 157 or “Adding a PID Loop (mistic)” on page 160.

Deleting a PID Loop

Only PID loops that have a reference count of zero can be deleted. Be careful when deleting PID loops; you
cannot undo a deletion.

1. Make sure the strategy is open and in Configure mode. On the Strategy Tree, expand the |/O unit's folder
and then expand the PID subfolder to find the PID loop you want to delete.

2. Right-click the name of the PID loop and choose Delete from the pop-up menu.
The PID loop is deleted.

You can also delete a PID loop in the Configure PID Loops dialog box by highlighting it and clicking Delete.
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(Pro only) Event/reactions apply to serial-based mistic /0 units only.

NOTE: Similar events and reactions can be configured on a SNAP Ethernet-based I/0 unit using PAC Manager, but
they can interfere with PAC Control strategy logic unless you are very careful. For more information, see the
PAC Manager User’s Guide, Legacy Edition (form 1714).

Event/reactions do exactly what their name suggests: they make something happen in response to an event.
Their advantage is that they simplify and speed the control engine’s job by offloading certain control functions
from the control engine to the I/0 unit.

Examples of events are a timeout, an input or output reaching a value, or a special digital feature (such as
frequency or an on-time totalizer) reaching a value. Examples of reactions include starting an on- or off-pulse,
reading and holding a value, or activating or deactivating a mistic PID loop.

Event/reactions can be configured on mistic digital and analog multifunction 1/0 units only. You can configure

up to 256 event/reactions on a single 1/0 unit. For more information on using event/reactions, see

“Event/Reaction Commands”on page 337.

1. To configure an event/reaction, make sure the strategy is open in Configure mode. On the Strategy Tree,
double-click the /0 Units folder (not the individual unit’s icon).
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2. Inthe Configure I/0 Units dialog box, highlight the multifunction mistic /O unit and click the
Event/Reactions button.

The Configure Event/Reaction dialog box appears, showing all event/reactions contained on the 1/0 unit
(in this example, none).

f1co nfigure Event/Reactions

140 Unit: v Type: |B3000
Mumber | Grouwp .. Mame Ewent Reaction | Fef C... Diescri. Add...
0aa ot Uzed B
om Mot Used todify...
noz Mot Uszed
a3 MHat Uzed Delete
004 Mot Uzed
1] Mot Uszed
00E Not Used
ooy Mot Used e
< T Delete Group
[ Cloge ] [ Help ]

3. Ifthe correct 1/O unit is not shown, select the unit from the drop-down list.

Since only multifunction units support event/reactions, they are the only units listed.
4. Highlight an unused line and click Add, or double-click an unused line.

The Add Event/Reaction dialog box appears.
5. Complete the fields as described in “Add Event/Reaction Dialog Box” below.

Click OK.

The event/reaction appears in the Configure Event/Reaction dialog box.
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Add Event/Reaction Dialog Box

Add Event/Reaction

A —— Hame: | |
B—— Description: | |
C —1— scanonFun ®ve: (OMNo

Interrupt an Event: (ives  (8)No
This figure shows the fields in the
D —F—Event Type: \Watchdog Timeout v dialog box when you first open it.

Depending on the type of event or
reaction you select, other fields may
appear.

E—— Beaction Type: Mone v
F——— Enable communization
I Ok, l [ Cancel ] [ Help ]

A—Name. Enter a name for the event/reaction. The name must start with a letter and may contain letters,
numbers, and underscores (spaces are converted to underscores).

B—Description. (Optional) Enter a description of the event/reaction.

C—Scan on Run. If you want the I/O unit to begin scanning for the event automatically as soon as the
strategy is run, click Yes. If you want scanning to wait until it is started by a command in the strategy, click No.

D—Event Type. From the drop-down list, select an event to scan for. Complete additional fields that appear
as described in the following tables.

For digital I/O units:

For this type of event: Enter this information:

Watchdog Timeout No information required.
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For this type of event:
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Enter this information:

Counter >=Value
Quadrature >=Value
Totalize On >=Value
Totalize Off >=Value
On-Pulse >=Value
Off-Pulse >= Value
Period >= Value
Frequency >=Value
Quadrature <= Value
Frequency <= Value
Counter <= Value

MOMO Match

Specify the I/0 point to be monitored and the value to compare the I/0
point against.

Select the I/0 point from the drop-down list or specify a new name for
the point and configure it.

See "Adding a MOMO Event or Reaction (mistic I/O Units Only)” on
page 171.

Foranalog I/O units:

For this type of event:

Enter this information:

Watchdog Timeout

Analog Input >=Value
Analog Input <=Value
Analog Output >=Value
Analog Output <= Value

No information required.

Specify the 1/0 point to be monitored, the value to compare the I/0
point against, and the type of comparison value (current, average, max-
imum, minimum, or total).

Select the I/0 point from the drop-down list or specify a new name for
the point and configure it.

E—Reaction Type. From the drop-down list, select the reaction to take in response to the event. Complete
additional fields that appear as described in the following tables.

For digital I/O units:

For this type of reaction:

Enter this information:

None (no reaction)

Enable Scan for Event
Disable Scan for Event

Enable Scan for E/R Group
Disable Scan for E/R Group

Disable Scan for All Events

Set MOMO Outputs

Start On-Pulse
Start Off-Pulse

None

Select the event from the drop-down list.

Select the group from the drop-down list.

None

See “Adding a MOMO Event or Reaction (mistic I/0 Units
Only)”onpage 171.

Specify the I/O point to be pulsed and the length of the
pulse in seconds. Select the I/O point from a drop-down list
or

specify a new name for the point and configure it.
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For this type of reaction:

Enter this information:

Start Counter

Stop Counter

Start Quadrature Counter

Stop Quadrature Counter

Clear Counter

Clear Quadrature Counter

Clear On-Pulse

Clear Off-Pulse

Clear Period

Clear Totalize On

Clear Totalize Off

Read and Hold Counter Value
Read and Hold Quadrature Value
Read and Hold Totalize On Value
Read and Hold Totalize Off Value
Read and Hold On-Pulse Value
Read and Hold Off-Pulse Value
Read and Hold Period Value
Read and Hold Frequency Value

Specify the I/0 point to be affected. Select the I/O point
from a drop-down list or specify a new name for the point
and

configure it.

Foranalog I/O units:

For this type of reaction:

Enter this information:

None (no reaction)

Enable Scan for Event
Disable Scan for Event

Enable Scan for E/R Group
Disable Scan for E/R Group

Disable Scan for All Events

Read and Hold Analog Input Data

Read and Hold Analog Output Data

Activate PID Loop
Deactivate PID Loop

Set PID Loop Setpoint

Set Analog Output

Ramp Analog Output to Setpoint

None

Select the event from the drop-down list.

Select the group from the drop-down list.

None

Specify the I/0 point and type of data (current, average,
maximum, minimum or total) to be read.

Select the I/0 point from a drop-down list or specify a
new name for the point and configure it.

Specify the PID loop to be affected. Select the PID from a
drop-down list or specify a new name for the PID and
configure it.

Specify the PID loop to be affected and the setpoint
value. Select the PID from a drop-down list or specify a
new name for the PID and configure it.

Specify the I/0 point and the value to set it to. Select the
I/0 point from a drop-down list or specify a new name for
the point and configure it.

Specify the I/0 point, the ramping speed in units per sec-
ond, and the end point value to ramp to. Select the I/0
point from a drop-down list or specify a new name for
the point and configure it.

F—Enable Communication. To enable communication to this event/reaction, check to enable
communication to this event/reaction, or uncheck to disable communication.
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Adding a MOMO Event or Reaction (mistic I/0 Units Only)

(Pro only) On a digital multifunction I/O unit, a special type of event or reaction you can configure is called
MOMO (must-on, must-off). A MOMO Match event monitors several inputs and/or outputs on an I/0 unit for
a match to a specific pattern. A Set MOMO Outputs reaction defines a set of values for outputs on an I/0 unit.
You can use just a MOMO event, just a MOMO reaction, or both.

If you select the MOMO Match event or the Set MOMO Outputs reaction in the Add Event/Reaction dialog
box, additional fields and buttons appear, which are described in the following steps.

The following figure shows the additional fields and buttons that appear if you select the MOMO Match event
or the Set MOMO Outputs reaction:

Add Event/Reaction b__(|

Hame: | |

Description: | |

Seat ot Fur ®ive: (Mo

Interrupt an Event: (O 'ves () No

Ewvent Type: |MDMD Match vl
Musgt On Mazk: | | ’ Configure Mask... ]
Event
Must O Maszk: | | (%) Decimal — .
The gray Must On O Hes section
Mask and Must Off ) Binary
Mask fields show any
current mask Reaction Type: | BTN TRNETR NS —
Must On Mazk: | | ’ Configure Mask...
ust Off Mask: | | () Decimal .
) Hex | Reaction
J Binary section
Enable communication

[ 0K l[ Cancel ” Help ]

1. Toset up or change the must-on pattern or must-off pattern (called the mask), click Configure Mask in
the Event or Reaction sections.

The Configure MOMO dialog box appears, listing all I/0 points you can set in the mask.
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E

Configure MOMO

Ch. # MName
oo |Fan_4

L Jic-
=
4 O

0 [Fan B | [x
02 |Fan_8 | [x
03 |Fan_1D ||><
o | ||
05 | ||
o | ||
v | I
08 | Alam_3 | [x
08 | Alam_5 | [x
10 | Emergency_Lights 3 | |><
11 |Emergenc_l,l_Lights_5 | |><
| |

EEARERANER 2

A ||k (dk|| 40

I
1| Il
I

[ Ok l[ Cancel ][ Help ]

2. Foreach I/0 point, click the scroll arrows to indicate that the point is On, Off, or X (ignored). When you
have finished the mask, click OK.

You return to the Add Event/Reaction dialog box, and the numerical equivalent of the mask you have set
appears in the Must On Mask and Must Off Mask fields.

3. Inthe Event and Reaction sections, choose whether to display the mask in decimal, hexadecimal, or
binary form. The default is decimal.

4. When the event/reaction is configured, click OK.
The new event/reaction appears in the Configure Event/Reaction dialog box.
@ Event/Reaction Configuration Example
NOTE: Event/reactions are available on serial mistic I/0 units only.

Here's an example of an Add Event/Reaction dialog box for an event/reaction involving a counter:
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Add Event/Reaction

MHame: | Baow_Full |

Descriptior: | |

Scan on Run: @ves  OMNo

Interrupt an Event: (Cies (8 Mo

Event Type: | Counter »=%alue w |
140 Point: | South_Packing_Station w |
Compare Yalue: | 12 |
Reaction Tppe: | Start Off-Pulse w |
1/0 Paint | Drop_Unit |
Fulse Length: | 5 |

Enable communication

[ 0k, l ’ Cancel ] ’ Help ]

This event/reaction would appear in the Configure Event/Reactions dialog box like this:

Mo nfigure Event/Reactions

10 Uit | B3000_Digital w Type: | B3000 Digital
Humber Group ...  Mame Ewent Feaction RefC.. Descri. # Add,
Qoo Box Ful  Counter... StatOf.. 0 »
0o Mot Lsed Modify...
a0z Mot Ugzed
a0z Mot Uged Lelete
004 Mot Used

ans Mot Uzed
006 Nat Used
ooz Mot Uged
¢ &

Cloze ] [ Help

| £

Using Event/Reaction Groups (mistic 1/0 Units Only)

(Pro only) Since you can configure up to 256 event/reactions on an 1/0 unit, it's useful to be able to divide
them into groups of 16. By grouping related event/reactions, you can also take advantage of commands that
start or stop scanning of all event/reactions in a group.

Creating Groups

1. Make sure the strategy is open and in Configure mode. On the Strategy Tree, expand the 1/0 Units folder
until you see the E/Rs folder for the I/O unit you want. Double-click the E/Rs folder.

The Configure Event/Reaction dialog box opens, listing all configured event/reactions.
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i | Configure Event/Reactions

/0 Unit: | B3000_Digital

w Type: | B3000 Digital

Mumber  Group ... Mame Ewent Reaction  RefC... Desge, A
Q0o Bow Full  Counter.. StatOf.. 0

|

o0z Mot Used

ooz Mat Used

004 Mot Uzed

o0& Mat Used

00g Mot Uzed

o7 Mat Uzed v
< | &
[ Close ]l Help ]

Delete

e
Delete Group ]

2. To create a group, click the Name Groups button.

Mame E/R Groups

Group Marne:

X

Phyzical B4R s

E/Rs 096 to1

E/Rs 016 to 031
E/Rs 032 to 047
E/Rs 048 to 063
E/Rs 064 to 073
E/Rs 080 to 035

1

L

[ Cloze

J |

Help ]

3. Highlight a physical group of E/Rs. Click in the Group Name field and type a name.
Group names must start with a letter and may contain letters, numbers, and underscores. (Spaces are
converted to underscores.)

4. When you have finished naming groups, click Close. The names appear in the Group Name column of the
Configure Event/Reaction dialog box.

i | Configure Event/Reactions

1/0 Unit: | B3000_Digital

L Type: | B3000 Digital

Mumber | Group ... Mame Ewent Reaction = RefC... Descri,
oo Fill_Pro...  Bow Ful  Counter.. StartOf. 0

oo Fill_Pro... Mot Used

ooz Fil_Pro... Mot Uszed

003 Fill_Pro... Mot Used

04 FilLPro... Mot Used

005 Fill_Pra... Mot Used b

< | @
Close ]l Help

Add..
Muodify...

Delete

Marme Groups...

Delete Group
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Deleting Groups

When you delete a group, you're deleting only the group name, not the event/reactions that were assigned to
the group.

To delete a group name, in the Configure Event/Reaction dialog box, select any event/reaction in the group
and click the Delete Group button.

The group name is removed from all 16 event/reactions in the group, and the selected event/reaction appears
at the top of the list box.

1.

Changing Configured Event/Reactions (mistic 1/0 Units Only)

(Pro only) You can change an event/reaction’s configuration and its position in the 1/0 unit.

Make sure the strategy is open and in Configure mode. On the Strategy Tree, expand the I/0O Units folder
until you see the E/Rs folder for the I/0 unit you want. Double-click the E/Rs folder.

The Configure Event/Reaction dialog box opens, listing all configured event/reactions.

o nfigure Event/Reactions |'._| |'E| b__(|
140 Unit: | B3000_Cigital v| Type: |[B3000 Digital
MHurnber Group ... Mame Event Reaction  Ref C... Descri. A
Mot Jsed  Box Full  Counter.. StartOf. 0
0m Mot Uzed
ooz Mot Uszed A
003 Mot Usged
004 Mot Uzed
005 Mat Uszed = _ Up and down
00§ Mot Used [~
007 Nat Uised v arrows
[ Cloze ] ’ Help ]

Event/reactions are scanned by the I/0 unit in the order that they appear in this list.

To move an event/reaction to a different position on the 1/0 unit, use the up- and down-arrows in the
dialog box.

To change an event/reaction’s configuration, double-click its name to open the Edit Event/Reaction
dialog box. Change the fields as necessary.

For help completing the fields, see “Configuring Event/Reactions”on page 166.

@ Deleting Event/Reactions (mistic I/0 Units Only)

(Pro only) You can delete only event/reactions with a reference count of zero. Be careful when you delete;
you cannot undo a deletion.

1.

Make sure the strategy is open and in Configure mode. On the Strategy Tree, expand the I/0 unit’s folder
until you see the event/reaction you want to delete.

Right-click the name of the event/reaction and choose Delete from the pop-up menu.
The event/reaction is deleted.

You can also delete an event/reaction in the Configure Event/Reaction dialog box by highlighting it and
clicking Delete.
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You may want to monitor or change I/0O while you are running your strategy in Debug mode to test and

debug your strategy. PAC Control offers two ways to display and interact with 1/0 in Debug mode:

»  Inspection windows—Monitor the value of I/O points or channels, either individually or along with all
the other points or channels on an 1/0 unit. If you are monitoring a single point or channel, the window
can be minimized (to show only the IVAL and XVAL) or maximized to show more information (like the
value of any configured features). If you are monitoring an /O unit, PAC Control organizes the points or
channels by I/0 module. If you are monitoring a RIO unit, the inspection window shows all the
configured channels on the unit. You can force the values of I/0 points or channels. The rest of this
section describes how to work with inspection windows.

«  Watch windows—Monitor the value of I/0 points or channels that you select and organize in whichever
order you want. You can also add other strategy elements like PID loops and variables. You can save a
watch window with the strategy. You can create multiple watch windows, which can help you group
strategy elements in a way that makes sense to you. You can change the value of any of these strategy
elements by double-clicking on it to open the corresponding inspection dialog. For instructions, see
“Using Watch Windows for Monitoring”on page 196.

Inspecting 1/0 Units

With the strategy running in Debug mode, double-click an I/0 unit in the Strategy Tree.

PAC Control displays the Inspect I/0 Unit dialog box, showing information about the unit and its points. The
title bar shows the name of the I/0 unit and whether scanning is occurring.

Here is an example of an Inspect I/0 Unit dialog box for a groov EPIC1/0 unit:

s

7,+ "Local_l0" (scanning) X

Name: Local_IO

Error: l None Enable Comm.:

Points [Detailed]  Points [Compact]  PIDLoops  Information

Module Ch# Name Type IVAL XVAL Quality (nl
ol 0o GRv-ODCI-12 0 Panel_LED DOutput OFF OFF Good

1 Turbine_1_LED D Output |ON ON Good

2 Turbine_2_LED D Output ez OFF Good

3 Digital_Out_1 DOutput |ON ON Good

4 Digital_Out_2 D Output | ON ON Good

5 Digital_Out_3 D Output | ON ON Good

6 Digital_Out_4 D Output Good

7 Digital_Out_S D Output Good

8 Digital_Out_6 D Output Good

9 Digital_Out_7 D Output Good

10 Digital_Out_8 D Output Good

11 NotUsed == —— = =
[i [01] GRV-OVMALC-8 0 Turbine_1_Speed AOutput 0 0 Good

1 Turbine_2_Speed AOutput 0 0 Good

2 Analog_out_1 AOutput 0 0 Good

3 Analog_out_2 AOQOutput 0 0 Good b

Apply Add Watch view... Help

The dialog box would look similar if you were inspecting a SNAP /0 unit, with SNAP I/0 module part numbers
on the left. Here is an example of an Inspect I/0 Unit dialog box for a groov RIO I/0 unit:
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%+ "Floor_1_RIO" (scanning) e

Mame: Floor_1_RIO

Error: | Mone Enable Comm.: l:l =

Channels [Detailed]  Channels [Compact]  PIDLoops  Information

Channel Type Ch# MName Type IVAL KVAL Quality
Type 1 Thermocouple 1] Room_1_Temp A Input 1] 2043045  Good
Type 1 Thermocouple 1 Room_2_Temp A Input 1] 21,2023  Good
Switch Input - Powered ... 2 Room_1_Door_Status D Input Good
Switch Input - Powered ... 3 Room_2_Door_Status D Input Good

Close Apply Add Watch View. .. Help

NOTE: Scanning stops whenever you click a changeable field. It resumes as soon as you click Apply, another button,
oran unchangeable field. To apply changes, click Apply before clicking another button or field; otherwise, the
pending changes will be lost.

To change the I/0 unit’s current status, click the up or down arrow in the Enable Comm field. Then click
Apply.

- Ifyou change it, the background turns magenta until you click Apply.

—  Yeson agreen background means enabled; No on a red background means disabled.

To view an individual I/0 point or channel, highlight its name in the list.
— ToaddanI/O element to a watch window, click Add Watch. See page 196.
- Toopen aninspection window to change an I/0O point or channel, click View. Then see “Inspecting

and Changing Discrete /0 Points or Channels” or “Inspecting and Changing Analog I/O Points or
Channels"for the I/0 point or channel you are changing (discrete or analog).

To close the dialog box when you've finished inspecting the 1/0 unit, click Close.

Saving I/0 Unit Configuration to Flash

To protect the I/0 unit configuration information from being lost when the power is turned off, set the Stored
Configuration option, which saves the following parameters:

Analog Digital

« 1/0 module configuration « 1/0 module configuration
« Initial output settings « Comm link watchdog time
» Comm link watchdog time

« Temperature conversion type

« Input offset and gain settings

1. Click the Information tab.
2. (lick the Store button under Stored Configuration (Flash).

Saving to flash memory this way is the same as saving to flash by other methods, such as saving a SNAP 1/0
unit’s configuration by using PAC Manager, and is preferable to using the command Write I/0 Unit
Configuration to EEPROM.

To reset saved parameters to their powerup default values, click the Clear button.
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Inspecting and Changing Discrete I/0 Points or Channels

You can inspect a discrete point's data, change its status, or force its internal values (IVALs) or external values
(XVALs) in Debug mode. To monitor the point or channel in a watch window, see page 196.

To inspect a discrete point or channel: With the strategy running in Debug mode, double-click the I/0
point or channel on the Strategy Tree. Or double-click an I/O unit in the Strategy Tree, click the Points
(Compact) tab or Channels (Compact) tab of the Inspect I/0 Unit Dialog box, and then double-click the 1/0
point or channel.

PAC Control displays a small dialog box that shows the IVAL and XVAL.

':_ "Turbine_2_LED" (scanning) X

IVAL: [BNT | xvAL[pNT | S

|u

o The XVAL, or external value, is the “rea
the control engine.

« The VAL, orinternal value, is a logical or software copy of the XVAL that is in the control engine. The IVAL
may or may not be current, since it is updated to match the XVAL only when a strategy in the control
engine reads or writes to an 1/0 point or channel.

or hardware value as seen by the I/O unit. This value is external to

If the discrete point or channel is configured with a counter, the counter value appears instead of the status.

To change the value of a discrete point or channel: Click the Maximize button to view more
information.

»'e "Digital_Out_1" (scanning) x

IVAL: [0 | xvaL:[4 | = Maximize button

The title bar shows the name of the discrete point or channel and whether scanning is occurring.

:— "Turbine_1_RPM" (scanning) x
MName:  Turbine_1_RFM
Type:  Digital Input {31 More Info
A ——Quality: Good
B———waL | xwa.——C

D{_On-mch: : Clear
of-Latch: (SN - Clear
E —fFrequency: |0 || [0 | [ Clear
F ——Communication -

140 Unit: SI =1 Open Parent

Ppply Watch Plat > =

NOTE: Scanning stops whenever you click a changeable field. It resumes once you click Apply, another button, or an
unchangeable field. If scanning resumes before you click Apply, any changes you made are lost. Use the Clear button
to immediately clear the field.
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A—CQuality. (Read-only. Available only on some groov 1/0 modules and groov RIO units.) Indicates the
channel's data quality. "Good" indicates the channel isn't currently reporting any data quality issues. groov 1/0
modules and groov RIO units that report quality continuously poll their channels for current data values and
identify deviations between reported and expected values. When an issue is detected, a description is
displayed in this field.

When the issue is resolved, “Good"is once again displayed in this field. For more information and a list of
applicable groov 1/0 modules and groov RIO units, see “I/O Quality Commands”on page 338.

B—/VAL. The point or channel’s current internal value. Switch between On and Off; then click Apply.
C—XVAL. The point or channel’s current external value. Switch between On and Off; then click Apply.
D—0n-Latch, Off-Latch. The state of the point or channel’s on and off latches.

E— <Feature name>. Internal and external values of any feature that might have been configured, such as a
counter or frequency.

F—Communication. Control whether communication from the control engine is enabled for the I/0 unit or
point/channel.

- Yes on a green background means enabled
—  Noon ared background means disabled.

To change the communication on a point/channel, click either the up or down arrow on the Point field; then
click Apply. To change the communication on an I/0 unit:

1. Click Open Parent. PAC Control displays the Inspect 1/0 Unit dialog box.
2. (lick either the up or down arrow on the Enable comm. field.
3. Click Apply, then click Close to return to the I/O point/channel window.

Asterisks in a field indicate an out-of-range value. Dashes in an XVAL field indicate a communication error.
To add the point or channel to a watch window, click Watch and see page 196.

To view configuration information for a point or channel, click More Info.

To inspect an I/0 unit’s configuration, click Open Parent.

To close the dialog box when you've finished inspecting the 1/0 point or channel, click the “X"on the
upper right corner.

(Pro only) To add a plot control, click Plot.

3.+ "Emergency” (scanning) x

Mame: Emergency
Type:  Digital Input {11 Mare Info

XVAL:

Communication

140 Unit: =1 Open Parert

Watch = Data b | |Tme fuis b | [Jinclude IVAL

Lol
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A—Click Data to save, copy, or print the current plot.
B—Click Time Axis to adjust the resolution.

C—Cdlick Include IVAL to see a concurrent plot of the IVAL.

Inspecting and Changing Analog I/0 Points or Channels

You can review an analog point’s data, modify its status, or force its internal values or external values in Debug
mode. To monitor the point in a watch window, see page 196.

To inspect an analog point or channel: With the strategy running in Debug mode, double-click the /0
point or channel on the Strategy Tree. Or double-click an I/O unit in the Strategy Tree, click the Points
(Compact) tab or Channels (Compact) tab of the Inspect I/0 Unit dialog box, and then double-click the 1/0
point or channel.

The small dialog box that appears shows the VAL and XVAL.

«  The XVAL, or external value, is the “real” or hardware value as seen by the I/O unit. This value is external to
the control engine.

«  The VAL, orinternal value, is a logical or software copy of the XVAL that is in the control engine. The IVAL
may or may not be current, since it is updated to match the XVAL only when a strategy logic in the
control engine reads or writes an I/0 point or channel.

45 "Analog_In_1" (scanning) X

Maximize button

WAL |0 | xvaL: [-0.01872826 | 3

To change the value of an analog point or channel: Click the Maximize button to view more
information.

The title bar shows the name of the analog point or channel and whether scanning is occurring.

b4 "Analog_In_1" (scanning) X

Name: Analog_In_1

Type:  Analog Input {i1More Info

Units:  ¥DC
A— Quality: Good
B—wa: [o |xvaL: [-0.0184538 +—— C
D — Communication

1/O Unit: I:I =1 Open Parent

Apply Watch Plot == =

NOTE: Scanning stops whenever you click a changeable field. It resumes once you click Apply, another button, or an
unchangeable field. To accept the changes, click Apply before clicking another button or field; otherwise, the pending
changes will be lost.

Asterisks in a field indicate an out-of-range value. Dashes in an XVAL field indicate a communication error.

Change the fields as necessary:

A—Quality. (Read-only. Available only on some groov 1/0 modules and groov RIO units.) Indicates the
channel's data quality. "Good" indicates the channel is not currently reporting any data quality issues.
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groov /0O modules and groov RIO units that report quality continuously poll their channels for current data
values and identify deviations between reported and expected values. When an issue is detected, a
description is displayed in this field.

When the issue is resolved, “Good"is once again displayed in this field. For more information and a list of
applicable groov 1/0 modules and groov RIO units, see “I/O Quality Commands”on page 338.

B—/VAL. The point or channel’s current internal value. You can force it to any value within the valid range of
the analog point. For an input, the valid range may exceed the apparent range; that is, you may be able to
enter a value lower than the zero-scale value or higher than the full-scale value. For an output however, you
cannot enter a value outside of the range defined by the zero-scale and full-scale values. After you change it,
click Apply.

C—XVAL. The point or channel’s current external value. You can force the XVAL outputs to any value within
the valid range of the analog point; then click Apply.

D—Communication. Current point or channel status: Yes on a green background means enabled, No on a red
background means disabled. To change the status, click one of the arrows; then click Apply.

To add the point or channel to a watch window, click Watch and see page 196.
To view configuration information for a variable, click More Info.
To inspect the I/0 unit’s configuration, click Open Parent.

To close the dialog box when you've finished inspecting the 1/0 point or channel, click the “X"on the
upper right corner.

(Pro only) To add a plot control, click Plot.

%, "ail6_Pot” (scanning)
al6 _Pot
Twpe:  Analog Input (i1 More Info

I arne:

Iw¥al: 4330763 Kal: 4201997

Communication

Paint; Enabled =
1/0 Unit: Enabled & Open Parent
Gpply | [ Watch Plot << 5 | Data  » | [ValueAxis b | [ Time Asis » | '-I. Shaw VAL
| |
A B E

A—Click Data to save, copy, or print the current plot.
B—Click Time Axis and Value Axis to adjust the resolution.

C—Click Show IVAL to see a concurrent plot of the IVAL.

Inspecting Event/Reactions

(Pro only) You can review an event/reaction’s current state, modify its status, or set its internal values or

external values in Debug mode. To monitor the event/reaction in a watch window, see “Using Watch

Windows for Monitoring”on page 196. To change the event/reaction, follow these steps.

1. With the strategy running in Debug mode, double-click the event/reaction on the Strategy Tree. Or
double-click an I/0 unit in the Strategy Tree, click the Information tab of the Inspect I/0 Unit Dialog Box,
and then double-click the event/reaction.
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The View Event/Reaction dialog box appears, showing the configuration parameters for the
event/reaction. The title bar shows the name of the event/reaction and whether scanning is occurring.

Scanning stops whenever you click a changeable field. It resumes once you click Apply, another button,
oran unchangeable field. If scanning resumes before you click Apply, any changes you made are lost.

Asterisks in a field indicate an out-of-range value. Dashes in an XVAL field indicate a communication error.
Change the fields as described in “View Event/Reaction Dialog Box”below.
3. Toadd the event/reaction to a watch window, click Add Watch and see page 196.

View Event/Reaction Dialog Box

Control_Temp,_Over_300_Degrees (scanning) |._||_|E|
A — 11— Mame: |Control_Temp_Ower_300_Degrees | Enabled Comm: -z B
C 1+ It Analog_[0_nit | Errar: | M aone D
Event Type: |.-’-\na|c-g Input »= "% alua | LCompare Value:
Reaction Type: |Activate PID Loop |
IWal: AL
[ Event Occuring:
E Event Occuned:
Scan Status:
| Interrupt:
Event: |Analog Input »="alue | Il AL
140 | Oven_Temperature | | i} | | ----------
F — 1
Reaction: |.t’-‘u:tivate FID Loop | WAL SOAL
FID Temperature_Controller
[ Input: Owen_Temperature 0 4471234
G Output: | Owen_Temperature_Control i} 0
Setpaoint: | From Host 450 0

spel [ Addwiatch | [ Help

A—Name. Name of the event/reaction.

B—Enabled. Current status: Yes on a green background means enabled, No on a red background means
disabled. To change status, click one of the arrows; then click Apply.

C—Unit. The I/0 unit on which the event/reaction is configured.
D—Error. Any communication error appears here with a red background.

E—Event Occurring / Event Occurred / Scan Status. Internal and external values for whether the
event occurred or is occurring, whether scanning is occurring, and whether an interrupt is to be generated
when the event occurs. If the reaction type involves a read-and-hold operation, a Read & Hold Value field also
appears in this area, together with its internal and external values. You can change any of the internal or
external values. If you do, click Apply.

F—Event Parameters. Parameters of the event, together with their internal and external values. (This
example shows an I/0 point being monitored for the event. For a MOMO Match event, MOMO data will
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appear instead. See “MOMO Event/Reactions” below.) You can change the internal or external values. If you
do, click Apply.

G—Reaction Parameters. Parameters of the reaction, together with their internal and external values.
(This example shows the PID to be activated and the sources of its input, output, and setpoint values. We also
see the internal and external values of the input, output, and setpoint.) Depending on the reaction type, other
parameters that can appear here include an I/0 point, an event to be triggered, or MOMO data. You can
change any of the internal or external values. If you do, click Apply.

MOMO Event/Reactions

(Pro only) When a MOMO (must-on, must-off) event or reaction is involved, the bottom of the event/reaction
dialog box displays the following:

On and Off Masks. Shows On and Off Masks for the MOMO event and reaction.

Unit Status. Shows LEDs representing the external value of the digital I/O unit on which the event/reaction
is configured. Green represents one (on), red represents zero (off), and gray represents no value reported. If
there is no MOMO reaction, this set of LEDs appears below the event’s on and off masks.

Momo Display Base. Shows the display base for the MOMO event or reaction. You can switch among
binary, hex, and decimal values.

You cannot change the internal values or external values of the MOMO masks or of the 1/0 unit status.
However, other fields are the same as for other event/reactions.

' Start_Motor (scanning)

MWame: | Start_Mator | Enabled Comm: -§|

Urit: | B3000_Digital | Emor [Mane |

Event Type: |MDMD tdatch |
Reaction Type:|Set MOMO Outputs |

WAl Al
Event Occuring: Mo a Mo .
Event Occurmed: Mo H Mo a
Scan Status: H a
Interrupt: Dizabled H Dizabled H

Event: MOMO Match |

OnMask: 0 0 0O 0O 0 0 0 0O 0 0 0 0O O
OffMask: 0 0O 0 0 0O O 0 0 0 0O 0 0 O

On and Off Masks

Reaction: |Set MO0 Outputs |

OnMask: 0 0 0 0 0 O 0 0 O 000 0000
OffMask: 0 0 0 0 0 O 0 0 O 0O 00 00 0O 0

Unit Status  ———— Unit Status: @@@@ @l@@@' @@@@' @@'@@

MOMO Display Base =~ ——— MOMD Display base: () Binay (O Hex () Decimal

| sddwach || Hep |

The example above shows on and off masks for both the MOMO Match event and the Set MOMO Outputs
reaction.
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In Debug mode, you can view PID loops and tune them. This section gives you basic steps for inspecting PIDs,
determining system lag, and tuning PIDs. For additional information, see the Tuning a PID Control Loop
technical note (form 2171) and the OptoTutorial: SNAP PAC PID (form 1641). Both forms are available for
download from our website at www.opto22.com.

Inspecting a PID (SNAP PAC)

This section applies to SNAP PAC, Ethernet I/0, and SNAP Ultimate 1/0 units only. For serial mistic 1/0 units, see
“Inspecting a PID Loop (mistic)” on page 194.

1. With the strategy running in Debug mode, double-click the PID on the Strategy Tree.

-

3% pid0” - View PID Loop (scanning)

MName:  |pid0 Eror: |None

Ihput; 79,2753 Gain: 15 ScanRate: |3 FEC, Mode: Auto F
Setpoint |79 Tunel: |0.05 Scan Counts: | 112783 Enable comm; fres S
Output;  [2.252521 Tune D: |0.02

Click a tab to see or change
additional data.

— | Plat 170 Details | Mizc. Details | MAL || Velocity Algorithm (Type B)

Setpoint and Input plot.
Adjust resolution using the |
Input Axis button below the
plot. Click and drag on the
scale to move the line.

Output plot.

Adjust resolution using the
Output Axis button. Click
and drag on the scale to
move the line.

Time axis. Adjust resolution
using the Time Axis button.
Click and drag left or right [ Data b | [Input Asis » | [Quiput Asish ][ Time Asis » ]

to see other times.
[ Add Watch l [Save Tuning] [ Help ]

2. View or change PID parameters as necessary. Click the other tabs to see additional data. To tune the PID,
see page 188.

3. Toaddthe PID to a watch window, click Add Watch and see page 196.
To save, copy, or print the current plot, click the Data button and choose from the pop-up menu.

5. Tosave changes to any of the PID configuration parameters, click Save Tuning.

Determining System Lag

You can directly control the PID output to determine system lag, which is essential to setting the PID scan rate.

Considerations in setting scan rate are:
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«  Slower scan intervals may be easier to tune. The PID controller has time to see the effect of the previous
output before calculating a new output.

«  Faster scan rates may be necessary to achieve the desired response. When scan intervals are shorter than
the system lag, tuning must compensate for any over-correction from the controller output.

Also see the Tuning a PID Control Loop technical note (form 2171), available for download from our website at
www.opto22.com.

1. Determine two significantly different output settings that are within the capabilities of your system.

2. With the strategy running in Debug mode, double-click the PID on the Strategy Tree.

-

3 pid0” - View PID Loop (scanning)

MName:  |pid0 Emor: |None

Ihput; 79,2753 Gain: 15 ScanRate: |3 FEC, Mode: Auto F
Setpoint |79 Tunel: |0.05 Scan Counts: | 112783 Enable comm; fres £
Output;  [2.252521 Tune D: |0.02

Plat 170 Details | Mizc. Details | AL || YVelocity Algorithm (Type B)

[ Data  » ][Input.t‘-‘mis » ][Dutput iz b ][TimeAxis 3 ]

[ Add Watch l [Save Tuning] [ Help ]

3. Set the Mode to Manual (if not set already) and click Apply.
4. Inthe Output field, type one of your two output settings and click Apply.
Use an output value typical of your system but low enough to allow you to change output by 20%.

5. Reset your time axis, if necessary, by clicking the Time Axis and choosing from the pop-up menu. Then
choose Reset Scale Tracking from the same menu.

The span setting varies according to your system; a 3-minute span is often suitable. Until you are familiar
with the PID plot, it is recommended that you avoid using the shortest settings (10-seconds or 1-second).
After you've observed a change in the input, you can zoom in on the graph, which is described later.

6. Wait for your system to stabilize.

The system is stable when the Input value does not vary significantly (some drift can be expected).
Stabilization may take several minutes, depending on the system.
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A stable system exhibits little

changein the Input value, which —

is shown numerically and
graphically.

Adjust resolution of the
Input Axis by clicking the
Input Axis button.

10.

11.

Ald gy

<< "TemperatureControl” - View PID Loop (scanning)

MName:  |pid0 Emor: |None

| Inpuk—| 7732674 Gain: -5 ScanRate: |1 FEC, tMode: tarual =
Setpoint: {90 Tunel: |0 Scan Counts: | 249642 Enable comm: fres £
Output; {20 TureD: |0

Plaot 170 Details | Mizc. Details | AL || Velocity Algorithm (Type B)

Reset Scale Tracking

View S00% Span
View 200% Span
View 100% Span
View 50% Span
View 22% Span
View 10% Span
View 5% Span
View 1% Span

Center on Inpuk
Center on Setpoink

[ Data  » ][Input.’-‘mis » ][Dutput iz p ][TimeAxis » ]

[ Add Watch l [Save Tuning] [ Help ]

i 1

Increase the resolution of the Input Axis by clicking the Input Axis menu and choosing a span setting of 1
or 5 percent.

Center the Input Axis, if necessary, by clicking the red line at its left end and dragging it up or down until
the plot is visible.

Under the Time Axis menu, choose Reset Scale Tracking.

This is a precautionary step, as changing settings on the plot can fix the plot at a certain point in time.
Resetting the time axis ensures that you are viewing the real-time values.

In the Output field, type the other of your two output settings and click Apply.

A 20% percent increase is a moderate, detectable change for most systems. Your system may require a
larger or a smaller change to stay within safety constraints.

Wait for a discernible change in the Input axis.
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The Input axis (indicated by
the upper white arrow added
to this picture) begins to
respond to the change in
output (lower white arrow).

CHAPTER 6: WORKING WITH 1/0

Plat 1/0 Detailz || Mizc. Details | WaL || Welocity Algorithm [Type B)

78,50 Inpuat

[ Data  » ][Input.t‘-‘mis » ][Dutput.t‘-‘mis) ][Time Bz B ]

12. Increase the resolution of the Time Axis by clicking the Time Axis button and choosing a lower

percentage, such as View 1 Minute Span.
13. Scroll the Time Axis to locate the point at which you changed the Output.

Both the time and input axes should display the point at which the Output changed, the lag, and the
point the input changed. If not, adjust the Input axis and Time axis, until this information is displayed.

Plot |/0 Details | Mizc, Details | MAL | Velocity Algarithm [Type B)

[ Data  » ][Input.-’-‘n.:-cis 3 ][Dutput.-’-‘n.:-cisb ][TimeA:-:iS »

14. From the Data menu, select Cursor.
The data cursor, a line with a value bar attached to it, appears on the plot.
15. Right-click the data cursor and choose Delta X from the Style submenu.
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Plot |/0 Details | Mizc, Details | MAL | YVelocity Algarithem [Type B)

|tput

1353390

v value x-v

Flip alignment Delta ¥

[ Data  » ][Input.-’-‘n.:-cis 3 ][Dutput.-’-‘n.:-cisb ][TimeA:-:iS » ]

16. To measure the system lag (the time between the change in output and the change in input), click and
drag the first vertical red bar to just after the output change. Drag the second bar to just before the
change in input.

Plot |/0 Details | Mizc, Details | MAL | YVelocity Algarithem [Type B)

The Delta X cursor displays
the time difference between 78.50
the two vertical bars.

Drag the first bar into position
after the Output change.

Drag the second barto a
position just before the
change in Input.

[ Data  » ][Input.-’-‘n.:-cis 3 ][Dutput.-’-‘n.:-cisb ][TimeA:-:iS »

If you are unable to get the precision you want, you can view the plot at a lower time span, such as 10
seconds. You will need to reposition your plot and the measurement bars of the Delta X cursor.

The example above shows a system lag of 1.88 seconds. Generally, a suitable scan rate can be anywhere from
one-third the system lag to two times the system lag.

Tuning a PID Loop (Ethernet)

NOTE: This section applies to SNAP Ethernet and SNAP Ultimate I/0 units only. For information on tuning PID loops
on serial-based mistic I/0 units, see “PID—mistic Commands” on page 354.
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Tuning a PID involves manipulating the P 1, and D constants in real time. The following steps should be viewed
as general suggestions to show you features that are available for tuning. We highly recommend the
OptoTutorial: SNAP PAC PID (form 1641) and the Tuning a PID Control Loop technical note (form 2171) for
more detailed information. These forms are available for download from our website at www.opto22.com.

CAUTION: Before following these procedures, make sure you know the limits of the equipment being controlled
and monitored by your PID loop. Also, make sure that these points are configured properly. Any values suggested in
these steps are for example only and must be modified according to the capabilities and constraints of your system.

1. Make sure the following PID features have already been configured:

Scan Rate

Input

Input low range and high range
Output

Output lower and upper clamp.
Algorithm

Setpoint. If your setpoint changes during normal operation, tune your PID with the setpoint
configured to host, so you can simulate setpoints from an input point or from another PID.

Gain. A final gain constant will be determined by tuning, but before you can tune your PID, your gain
constant must be either a positive or negative number according to the type of system you have.
For example, a heating system reports a negative error when heat needs to be applied; a negative
gain constant turns this error into a positive output for the heater. Alternatively, a cooling system
reports a positive error when the input exceeds the setpoint; a positive gain constant maintains the
positive output to the chiller.

Optional, depending on your system: Minimum and maximum changes to Output and Output
forcing when the Input is out of range.

2. Download and run your strategy.

The current PID configuration is written to the I/O unit. You can stop your strategy at this point if you
wish, as the PID will continue operating.

3. In Debug mode, double-click the PID on the Strategy Tree.
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-

3% pid0” - View PID Loop (scanning)

MName:  |pid0 Emor: |None

Ihput; 79,2753 Gain: 15 ScanRate: |3 FEC, Mode: Auto T
Setpoint |79 Tunel: |0.05 Scan Counts: | 112783 Enable comm; fres £
Output;  [2.252521 Tune D: |0.02

Plat 170 Details | Mizc. Details | AL || Velocity Algorithm (Type B)

[ Data  » ][Input.t‘-‘mis » ][Dutput iz b ][TimeAxis 3 ]

[ Add W atch l [Save Tuning] [ Help ]

Set the PID Mode to Auto (if not set already) and click Apply.

Change the Setpoint, if desired, by typing a new setpoint and clicking Apply. (Setpoint must be
configured as Host.)

Depending on the type of system, your PID may maintain a setpoint or respond to changes in setpoint.

Experiment with setpoint changes again after tuning the P, I, and D constants.

Adjust the span of the input, output, and time axes according to how much change you expect from

your system. To set a span, click the axis button and choose from the pop-up menu.
If desired, type a new Scan Rate and click Apply.

For most systems, you should use an appropriate scan rate based on the system lag (see “Determining
System Lag” on page 184). However, you can experiment with Scan Rates before tuning the P, |, and D

constants or adjust scan rate after tuning.
Here is an example for Scan Rate:
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The lag for this system was
determined to be about 2
seconds. The left half of the
plot reflects a 0.5-second scan
rate, while the right half shows
a 3-second scan rate. Notice
both scan rates have the same
effect on the input; however,
the 3-second scanrateis using
less of the processor's
resources.
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b1t

7« TemperatureControl™ - Yiew PID Loop (scanning)

Mame: | TemperatureContral Enor: | Mone

Ihput; 20.24331 Gain: B ScanRate: |3 FEC, Mode: Auto F
Setpoint: 20 Tunel: |10 Scan Counts: | 112783 Enable comm: fres S
Output; |0 TureD: |0

Plot 170 Details | Mizc. Details | AL || Velocity Algorithm (Type B)

100

IL|
|

] /ﬂl'hl ﬂ'HI [,
. j’/ Ill_/ llt'\_/

11 : | ]

[ Data  » ][Input.t‘-‘mis » ][Dutput iz b ][TimeAxis » ]

Cloze

[ Add Watch l [Save Tuning] [ Help ]

Experiment with gain settings by typing a new value in the Gain field and clicking Apply.

The easiest way to tune most PIDs is to experiment with the gain constant first. Try various gains to see

how well the system stays at setpoint and responds to setpoint changes.

In the example below, the white arrows (added for the example) show where gain constants of -2, -5, -10,

and -20 were applied:
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hd

<« "TemperatureControl” - View PID Loop (scanning)

Mame: | TemperatureContral Enor: | Mone

Ihput; a7 5289 Gain: -20 ScanRate: |1.4 FEC, Mode: Auto T
Setpoint: {90 Tunel: |0 Scan Counts: | 112783 Enable comm: fres £
Output:  [B1.7775 TureD: |0

Plot 170 Details | Mizc. Details | AL || Velocity Algorithm (Type B)

Input
etpaint
== [utput

[ Data  » ][Input.t‘-‘mis » ][Dutput iz p ][TimeAxis » ]

[ Add W atch l [Save Tuning] [ Help

In this example, a gain setting of -30 revealed an offset error:

Plat 140 Details || Mizc. Details | WAL || Welocity Algorithm [Type B)

With only a gain constant an.00
applied, the input often
stabilizes at an incorrect
value. In this heating
example, a gain setting of -30
drove the input close to the
setpoint, but subsequent
increases failed to eliminate
the offset. It is time to try
integral constants to
eliminate the offset error.

[ Data  » ] [Inputteis » | [Output iz k| [ Time Axis » |

9. Experiment with the integral constant: in the Tune I field, type a number between 0 and 1 and click
Apply. (Your PID may require larger numbers.)

In this example, an integral constant of 0.1 corrected the offset error.
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Flat 10 Details | Misc. Detailz | AL | Welocity Algorithm [Type B)

The far left side of the plot shows
the offset before an integral
constant of 0.1 was applied. This
setting eliminated the offset. In
many applications, a minor
fluctuation around the setpoint is
acceptable, and these applications
use gain and integral only. In some
applications, however, the
fluctuations at the setpoint
indicate that the gain is too high
(too much gain makes a system
unstable) or that a derivative
constant is required.

[ Data  p ][InputAxis » ][Dutputﬁ-\:-:is} ][TimeAxis » ]

10. If derivative correction is needed, experiment with the derivative constant: in the Tune D field, type 1 and
click Apply. (Your PID loop may require a larger number.) In this example, a derivative of 10 makes a
noticeable difference in keeping the input near the setpoint.

Many PID systems are effectively controlled =5 “TemperatureControl” - View PID Loop (scanning)

with gain and integral constants 0”|y andno Mame: TemperatureContral Ermor: |Mone

derivative constant. In this example, the gain

and integral settings are maintaining the Input: 30.02628 Gain: |30 ScanFate: | 1.4 $EC. Mode: Autn L
temperature at 0.06 from setpoint. To Setpaint: {90 Turel: |01 Sean Counts: [B12581 Enable comm: Wes T
demonstrate the eﬁgct of the Qerivativg Dutput: 6671083 TuneD: [10

constant, the resolution of the input axis was

increased to show a 1 percent span. At this Plot |10 Details | Mise. Details | WAL || Welocity Algorithm [Type B)

resolution, the plot reveals changes of 0.01
degrees F.

The left side of the plot shows the effect of
gain at-30, integral at 0.1, and no derivative
constant. The arrow shows when a derivative
constant of 10 was applied. The right side of
the plot shows how the derivative constant is
keeping the input closer to setpoint.

mT—— _J'I_fI—IJ'I_IJ'I_fLIJ'LL'_rl—-—rL,——h.— .

[ Data P ][InputA:-:is » ][UutputAxis) ][Time.ﬁ.xis » ]

[ Add watch l [ Save Tuning] [ Help l

11. Click Save Tuning to save your tuning parameters to the strategy database.

Changes are lost unless you save them. You may wish to save your tuning parameters when you see any
improvement in performance, even if they are not final.
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194

PAC Control Professional X

'r The Following values will be saved to the strateqy database:
L]

Gain: -5,000000
Tune I; 10.000000
Tune 200, 000000
Scan rate: 3.000000
Feed forward: 0.000000
Feed forward gain: 0.000000
Output min change: 0.000000
Output max change: 0.000000
Oukput when input is under-range: 0.000000
Cukput when input is over-range: 0.000000

Saving these walues to the strateqgy will require the strategy
to be compiled and downloaded before entering debug mode again,

Do vou want ko conkinue?

12. ClickYes.

Values are saved to the PAC Control strategy. Remember to save PID parameters to the 1/0 unit’s flash
memory, too (see “Inspecting /0 Units”on page 176).

@ Inspecting a PID Loop (mistic)

(Pro only) This section applies to serial mistic1/0 units only. For SNAP Ethernet and SNAP Ultimate 1/O units,
see page 184.

You can review a PID loop’s data, modify its status, or set its internal values or external values in Debug mode.

To monitor the PID loop in a watch window, see page 196.To change the PID loop, follow these steps.

1. With the strategy running in Debug mode, double-click the PID loop on the Strategy Tree, or double-click
itin the Inspect I/0 Unit dialog box.

The View PID Loop dialog box appears (see “View PID Loop (mistic) Dialog Box”below), showing the
configuration parameters for the PID loop and several values you can change. The title bar shows the
name of the PID loop and whether scanning is occurring.

Scanning stops whenever you click a changeable field. It resumes once you click Apply, another button,
or an unchangeable field. If scanning resumes before you click Apply, any changes you made are lost.

Asterisks in a field indicate an out-of-range value. Dashes in an XVAL field indicate a communication error.
2. Change thefields as necessary. See “View PID Loop (mistic) Dialog Box” below.
3. Toaddthe PID loop to a watch window, click Add Watch and see page 196.

To save, copy, or print the current plot, click the Data button and choose from the pop-up menu.
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View PID Loop (mistic) Dialog Box

<.« "Heater_Controller” - View PID Loop (scanning)

Mame: | TemperatureContral Ermor: |Mone Enable Comm: [Yes | % | H
IWAL HAL Lower Clamp  Upper Clamp Mame
"~ Input: il a4 07603 Fioom_Temperature
A{ Output: ] 4372345 1] 10 Heater
| Setpaint: 84.0032 84.0032 70 0 Host
Bt 300 300
B { Integral: 1 1
| Derivative: ] ]
C _[' Scan Bate (secl [2 2
| MaxChgRate: 10 10 [0.100 to 10.000)
D_' Mode: Automatc | & Automatc | %

Input Axiz w I
Olutput Axis w
(e <] |

|

P

"

11:14:00.0 11:16:00.0 11

[addwach | [ Hep |

A—Input, Output, and Setpoint (current internal and external values). Change each to any
valid value. If lower and upper clamps appear to the right of the value, these clamps define the range of valid
values. Otherwise, the valid range is defined by the I/0 point itself. If you can change them, click Apply.

B—Gain, Integral, and Derivative (current internal and external values). You can change the
gain term to any value except zero in the range -32768 to 32767. You can change the integral and derivative
terms to any value in the range zero to 32767. If you change them, click Apply.

C—Scan Rate and Maximum Change Rates (current internal and external values). You can
change the scan rate to any value in the range 0.1 to 6553.5 seconds. You can change the maximum change
rate to a value between one percent and 100 percent of the output range (defined by the output’s zero-scale
and full-scale values). If you change them, click Apply.

Asterisks in an IVAL field indicate that a valid scan rate or maximum change rate hasn't been read yet (usually
before the strategy is run).

D—PID execution mode. A green background means Automatic, a yellow background means Manual.
Click an arrow to change the mode; then click Apply.

E—Setpoint and Input plot. Adjust resolution using the Input Axis button at right. Click and drag on the
scale to move the line.

F—Output plot. Adjust resolution using the Output Axis button. Click and drag on the scale to move the
line.

G—Time axis. Adjust resolution using the Time Axis button. Click and drag left or right to see other times.

H—Current status. Yes on a green background means enabled; No on a red background means disabled.
To change status, click one of the arrows; then click Apply.
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USING WATCH WINDOWS FOR MONITORING

While the strategy is running, you can monitor several strategy elements at once in a watch window: I/0 units,
digital and analog points, PID loops, variables, even charts. You cannot monitor subroutine parameters or
variables that are local to a subroutine in a watch window.

Unlike inspection windows, watch windows can be created the way you want, docked in a position most
convenient for you, and are saved with your strategy. You cannot change strategy elements in a watch
window, but you can open the inspect dialog box from the watch window and change the element there.

Creating a Watch Window

1. With the strategy open and in Debug mode, choose Watch > New.
2. Inthe Create New Watch Window dialog box, navigate to the location where you want the watch

window file to be kept (usually in the same folder as the strategy). Enter the watch window file name and
click Open. The empty watch window appears.

«+ Watch 2 B M=1E3
 Mee | Type | I¥AL | mvaL |

4 .

3. Add elements you want to watch in this window by clicking them on the Strategy Tree and dragging
them into place in the watch window, or by right-clicking them and choosing Watch from the pop-up
menu.

You can add I/0 units, digital and analog points, PID loops, variables, and charts. You cannot add
subroutine parameters or variables that are local to a subroutine.

Depending on which element you add and how you add it, it may appear immediately in the window, as
shown here.

‘s Waich 2 ¢ FBIX

{12} Temperature... [Analog Input - Deg...

4 .

For some elements, the Add Watch Entry dialog box appears, so you can specify what to watch.
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#1 Add Watch Entry

Mame: IDigitaI_ControI |

Select Portions Towatch:

ltems in this area vary depending __| Sl Select Al

f Mode
on the element you are watching. :
. W
This example shows a chart. gl
Black Paused At

Select watch window

I Ok, H Cancel ][ Help ]

4. If an Add Watch Entry dialog box appears, click to place or remove the check mark next to any item.
When all the items you want to watch are checked, click OK.

The element is added to the watch window.
The watch window is automatically saved.

Opening an Existing Watch Window

If a watch window was open when you exited Debug mode, it will automatically open again when you
re-enter Debug mode. To open other watch windows, follow these steps.

1. Make sure the strategy is open and in Debug mode.

2. Choose Watch > Open.

3. Navigate to the watch window you want to open and double-click its name.
The window opens in the position you left it.

Working in Watch Windows

Watch windows are flexible. You can dock the window where you want it in the PAC Control main window.
You can also move, delete, and inspect elements in the window.

«  Todock the watch window, click the docking button [ in its title bar.
The window moves to its own frame.
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"Docked” watch window

Expand or collapse the
item by clicking the + or -
sign in the box.

198

A PAC Control Professional - [Oven_Inspection_Control]

ﬁFile Edit Control Engine Debug Chart  Subroutine Mode Tools Wiew Watch  Window Help

=} Debug m ¥ 4
ookies o x =
= 2
= I Cookies thart starts - Start ;
I5) Control Engines oo
15 Subroutines Included
(=] harts
= £ Wariables
15 Mumeric Yariables
IC5) String Wariables
I5) Pointer Yariables B
15 Communication Hanc L
I5) Mumeric Tables nee the ;
: ngethe. - Speed OK?
[ String Tables een started.
I Painter Tables S ) ’
= (5 140 Units
= ‘28 Mixed_10_Unit 3 Drop the dough:
+ | Paints FECIE T Drop Dough IR A A @
[T PIDs < | 5
< | & |, Chart /
Ab Mext  qp Prev ﬂ’l Dough_Chip_Contral ﬂ’l Oven_lnspection_Control |
nt Watch i i i i i o [x
Tarme Type IVAL HWVAL A
nCookieCounter Integer 32 Wariasbhle 713
£ {02} diInspectionPassFail... Digital Input
H State (1):] OFF
On-Latch OFF OFF
Off-Latch OFF OFF 2
Debug UM

See "Docking Windows"on page 58 for more information.

To expand or collapse watch window you have added to an I/0 unit, PID loop, chart, or table, click its
plus or minus sign.

=s Watch 2
MNarme Type IVAL VAL
{12} Tewperature... Analog Input - Deg... O -272.8985

-E| Sprinkler Control
- Jroints

SMAP Hixed Ultimat...

N I S —

{00} SJwitch DO Counter
{05y Sprinkl... Digital Output OFF OFF
{12} Tempera... Analog Input - Deg... O -272.9154

Digital Control Chart
£ |

e

To rearrange elements in the watch window list, click the item you want to move and drag it to a new
location, or right-click it and choose Move Up or Move Down from the pop-up menu.

You can also sort elements in the window by clicking on the column label. For example, to sort by Type,
click the label Type in the column heading. Click again to change the order from ascending (A-7) to
descending (Z-A).

To move an element from one watch window to another, open both windows and drag the element
where you want it. To copy an element to another watch window (so it will appear in both windows),
hold down the Ctrl key while you drag it.

To delete an element, right-click it and choose Delete from the pop-up menu.

PAC Control User’s Guide, Legacy Edition




CHAPTER 6: WORKING WITH 1/0

« Toinspect an element, double-click it.

The inspect dialog box opens. For information on using it, see “Inspecting Control Engines and the
Message Queue”on page 110.
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7: Working with Strategies

INTRODUCTION

A strategy is the software program you create in PAC Control. A strategy is similar to a file in any Microsoft

Windows program. You use standard Windows menu items to create a new strategy, to open an existing

strategy, or to save a strategy. The strategy includes all the definitions and instructions necessary to control
your process. This chapter is a step-by-step reference for working with strategies in all three strategy modes:

Configure, Debug, and Online.

In This Chapter

Creating a New Strategy .. eemeeeeesssssessseneens
OpeNiNg @ StrAtegY e eeevres e ssssssssens
Saving and ClOSING ..oovvvveesvvvesvvee s

Saving a Strategy to Flash

Archiving Strategies on the Computer
Compiling and Downloading.......ccceveeeeseveveeee
Running a Strategy Manually.........coee.
Running a Strategy Automatically (Autorun)

Stopping a Strategy

(DL o U 0T To JO O

................................. page 214

page 215

.............................. page 215

Viewing and Printing

Searching and Replacing .....eececeveeeeeecisreversens
LEGACY OPLIONS wooreervrrrrreveverssssessnes s sissssssssesesen

Advanced Options

page 222

.............................. page 230
.............................. page 234

page 237

CREATING A NEW STRATEGY

Each PAC Control strategy must be located in its own directory. When you create a new strategy, you must
create a new directory or use an empty one. Each strategy in its own directory keeps all its files in one place
and makes it easy to copy a strategy to another location for modification or backup.

1. Tocreate a new strategy, select File > New Strategy, or press Ctrl+N, or click the New Strategy icon ' 1

on the toolbar.

2. Inthe New Strategy dialog box, navigate to the directory where you want the strategy to be placed.

Create a new folder if necessary.
3. Type the strategy name.

As you can see in the Files of type field, PAC Control files have an extension of .idb.

4, C(lick Open.

The new strategy is created. Its Strategy Tree and Powerup charts appear in the PAC Control main

window.
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For information on the main window, see “PAC Control Main Window" on page 52.
For programming information, see page -77.
For steps to create charts, see “Creating a New Chart”on page 239.

OPENING A STRATEGY

Only one strategy at a time can be open in PAC Control. If you currently have a strategy open, it must be closed
before another is opened. You are prompted to save changes before it closes.

Opening an Existing Strategy

NOTE: PAC Control does not support strategy (.idb) files that have been downloaded from Dropbox® cloud storage
service. If you try to run an .idb file that was stored on Dropbox, PAC Control may display an "Invalid storage format
error message and fail to open the strategy. Instead of using Dropbox, save your .idb files to a portable storage media
ortry using a different cloud storage service.

"

1. Toopen an existing strategy, select File > Open Strategy, or press Ctrl+0, or click the Open Strategy icon
= onthe toolbar.

2. Inthe Open Strategy dialog box, navigate to the strategy you want to open and click Open.
The strategy opens in Configure mode, with the windows in the same position they were when the
strategy was closed.

Opening an ioControl Strategy

If you have been using ioControl Basic or Professional with a SNAP PAC controller, migration to PAC Project
Basic or Professional is simple. Because the individual programs within the suite are essentially the same
(although they have new features and hardware support), you can simply open a strategy in PAC Control and
then save it. For safety, we recommend you back up all ioProject files before opening them in PAC Project. See
also, “Opening Strategies in PAC Control” below. For more information on migrating your system to SNAP PAC,
see the SNAP PAC System Migration Technical Note (form 1680).

Opening a Recently Used Strategy
To open a strategy you have recently used, choose its name from the list at the bottom of the File menu. The
ten most recently opened strategies are listed.

Loading a Strategy or Mode at Startup

To have PAC Control automatically start up with the strategy that was open when you exited, choose
Configure > Options and click to put a check mark next to Load Last Strategy at Startup.

To have PAC Control open strategies in the same mode as when you exited PAC Control, choose Configure >
Options and click to put a check mark next to Load Last Mode at Startup.

Opening Strategies in PAC Control

CAUTION: Once asstrategy is opened in PAC Control Professional, it can no longer be opened in PAC Control Basic.

A strategy saved in ioControl version 6.1 or less can be opened in either PAC Control Basic or Professional. A
PAC Control Basic strategy can also be opened in PAC Control Professional. However, PAC Control Professional
strategies cannot be opened in Basic or in any earlier version of PAC Control.
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@ Opening an OptoControl Strategy

(Pro only) If you are moving a strategy from OptoControl to PAC Control Professional, PAC Control will open it
and help you convert it. Although many things will convert without difficulty, planning ahead is essential to
make the job easier. Before opening an OptoControl strategy in PAC Control, read the factoryFloor to PAC
Project Migration Technical Note (form 1692).

SAVING AND CLOSING

CAUTION: Once a strategy is opened in PAC Control Professional, it can no longer be opened in PAC Control Basic.

Saving the Strategy and All Charts

To save all your work quickly, choose File > Save All. The strategy and all modified charts and subroutines are
saved.

Saving the Strategy and Some Charts

NOTE: You cannot save changes to a subroutine this way. To save a subroutine, use File > Save All, or use Subroutine
> Save or Subroutine > Save All.

1. Tosave changes to some charts but not others, click the Save Strategy icon |l on the toolbar (or choose
File > Save Strategy, or press Ctrl+9).

The Save Strategy dialog box appears, highlighting all charts modified since the last save.

A save Strategy &l

Sawe strategy and zelected charts:

[ 0K ][ Cancel ][W

2. Tosave some charts and not others, press Ctrl and then click any charts you don't want to save.
You can also click Select All to select all of the charts, or click Clear All to select none of them.
3. When only the charts you want to save are highlighted, click OK.
The strategy and the highlighted charts are saved.

Saving the Strategy to a New Name

1. Tosave the strategy and all its charts under a new name, choose File > Save Strategy As.

2. Inthe Save Strategy As dialog box, navigate to where you want the new strategy to be. Create a new
folder if necessary.

Remember that each strategy must be in its own directory.
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3. Inthe Strategy Name field, enter the new strategy name. Click Save.
The strategy and all its charts are saved under the new name in the new directory.

Saving Before Debugging

When you change to Debug mode, you are prompted to save a strategy you have modified. If you don't want
to be prompted to save before entering Debug mode, choose Configure > Options and click to remove the
check box for Prompt To Save Strategy Before Running Debugger.

Closing a Strategy

To close a strategy, click the close box in the Strategy Tree or choose File > Close Strategy.

NOTE: Since only one strategy at a time can be open in PAC Control, creating a new strategy or opening an existing
strategy automatically closes any current strategy first. If you've made changes to the current strategy, you are
prompted to save them.

SAVING A STRATEGY TO FLASH

204

When you finish working on your strategy and have downloaded it, you should save it to the control engine’s
flash memory. By default, a strategy is downloaded to the control engine’s RAM. Saving it to flash protects the
strategy in case of a power loss. You can save it to flash just once, when needed, or save every time the
strategy is downloaded.

Saving to Flash Once
You can save the strategy to flash at any time when you are in Debug mode. To do so, choose Control Engine
> Save Strategy to Flash.

Saving to Flash on Every Download

CAUTION: It is possible to wear out flash memory if you save to it many, many times. Use the following steps only
when your strategy is finished.

1. When you have finished the strategy and are in Configure mode, choose File > Strategy Options.

2. Inthe Strategy Options dialog box, click the Download tab. Check Save strategy to flash memory after
download.
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Strategy Options X
Archive Download  Serial 140 Ports  Legacy

Flash Memory

[] Set autorun flag after download

Background Downloading

[] Use background downloading and fast strategy updating

The controller must be configured for this featurs using PAC Manager.

Download Compression
None Full

Start Strategy
[] Start strateqy after download completes

Cancel Help

If a control engine loses power and then restarts, the autorun flag tells the control engine to
automatically start running the strategy that is in flash memory. If the autorun flag is not set, the strategy
must be started manually after power is restored to the control engine.

3. To have the strategy run automatically after a control engine restarts, check Set autorun flag after
download.

4. C(lickOK.

ARCHIVING STRATEGIES ON THE COMPUTER

Archiving strategies to the computer helps you track changes during development and provides a backup in
case of a failure on the control engine.

Archive files are “zip files” (files compressed into one package with a file extension of zip) and are date and
time stamped. Archives are found in the same folder as your strategy. Since a new archive file is created each
time you archive a strategy, you are free to manually delete any old archive files you don’t want to keep.

We recommend you archive both to the computer (during strategy development) and to the control engine
(when the strategy is completed). Archiving to the control engine as well as the computer makes sure that an
older strategy can always be found and updated, even after years pass and personnel changes occur. See also,
“Archiving Strategies on the Control Engine”on page 114.

PAC Control offers three ways to archive strategies to the computer:

»  Tomake an archive at any time, choose File > Archive Strategy. A dialog box shows you the name and
location of the archive file.

»  Tohavean archive automatically created whenever the strategy is closed, choose File > Strategy Options.
In the Strategy Options dialog box, select “Archive strategy to disk when strategy is closed.”

«  Tohave an archive automatically created whenever the strategy is downloaded, choose File > Strategy
Options. In the Strategy Options dialog box, select “Archive strategy to disk when strategy is downloaded.”

The archive file name will be in one of the following formats:

Archive method File name format

Manual archive or archive when strategy is closed Path\Filename.Archive.D02282007.T114351.zip
Archive on download Path\Filename.Download.D02282007.T114351.zip
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Archive method File name format

Archive when downloading from online mode Path\Filename.Online.D02282007.T114351.zip

The date stamp (D) is in the format mm/dd/yyyy. In the examples above, the date is February 28, 2007. The
time stamp (T) is in the format hh/mm/ss. In the examples above, the time is 51 seconds past 11:43 AM.

To restore an archived strategy:

1. Locate the archive (zip file) you want to restore. (You can find it in the same folder as the strategy .idb file.)
2. Create a new folder, and then unzip (extract) the archived files to the new folder.

3. From the new folder, double-click the strategy’s .idb file to open the strategy as normal.

COMPILING AND DOWNLOADING

TIP: To configure a strategy to start running at completion of the strateqy download, select the "Start strateqy after
download completes” check box on the File > Strategy Options > Download tab.

Before your strategy can be tested or run, it must be compiled and then downloaded to a control engine.
When a strategy is compiled, all the commands, OptoScript code, charts, and variable and 1/0 definitions it
contains are verified and converted into a format that the control engine can understand. Then the strategy
can be sent (downloaded) to a control engine. Only compiled strategies can be downloaded.

NOTE: Before you can download your strategy, make sure you have downloaded the latest firmware to your control
engine. For instructions, see the user’s guide for your controller or processor.

Compiling and Downloading in One Step

NOTE: Ifyou are using Ethernet link redundancy in PAC Control Professional, make sure you are downloading through
the IP address you want to use, either the primary or secondary address. See “Creating Redundant Ethernet Links in
PAC Control”on page 104 for more information.

1. With the strategy open in PAC Control, click the Debug mode icon on the toolbar, or click Mode
> Debug.

Changing to Debug mode automatically saves and compiles the strategy, including all code in
OptoScript blocks.

2. Ifyou see a Powerup Clear Expected message, click OK.
A download warning message may appear.
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Download Warning E|

!\ Strategy Mizmatch

The strategy to be downloaded does nat match the strategy already in the contral engine.
Strategy To Download

3 Mame: Sprinkler_Control
3 Checksum: A4DCBOCSCOECE13D789F123FE5148EB11
Timestamp: 07/02/09 10:56:05

Strategy in the Controller

Mame: Sprinkler_Control
Checkzum:  B2FF35307F7BC2B4EATDDAACIN34E024
Timestamp: 06430709 12:563:24
If you choosge to contite, the strategy that is in the contral engine will be replaced by thiz strategy.

Do pow want to continue the download?

[ wes || Mo | Hep |

This message tells you that the strategy to be downloaded doesn't match the strategy already loaded on
the control engine, either because it is a different strategy or because it has been changed since the last

download.
To continue the download, click Yes.

As the strategy is compiled, the Compile Progress dialog box appears. This dialog may appear only briefly.

However, if there are errors or warnings, the dialog box will stay open. You can copy the errors and
warnings by clicking the right mouse button and selecting Copy All as Text.

Compile Progress

+ii

Compiling tags...
WARMING - Serial part 2 iz being used by [/0 Unit Mixed_|0° but has not been configured for 1/0.

Compiling charts...
Condition_Delay
Conveyer_Operation
Powerup
Shipping_trea
Timer_E #ample_Chart

Compiling subroutines. ..

Building run file. ..

Done.

0 emorfs). 1 warmingls)

Progress: |HNNNNNNNRNARNNNRRENR NN NN RN NN NN RN Emos: O ﬂ W arnings: 1

Cloze

If there are errors, the strategy will not compile. Click Close to continue in Configure mode.
If there are only warnings, click Close to continue in Debug mode.
If no errors or warnings occur, the Strategy Download dialog box appears.
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X]

& | Strategy Download

E Downloading your strategy
w

Dovanload strategy: [Illllllllllllllllllllllq

=P Store to flash memony: [III ]

The Strategy Download dialog box will vary somewhat depending on your settings.

NOTE: If you are using background downloading (see “Background Downloading” on page 209), while the strategy
is downloaded, there may be a very slight degradation in performance. This is due to the overhead on the controller
or processor to process the strategy download.

4. (Optional) If there is already an active strategy which is set up to have an alternate strategy, and you want
to switch strategies, click Switch & Run to stop the active strategy and run the strategy you just
downloaded. Or, you can click Switch to stop the active strategy and make the new strategy the active
one (but not yet running).

Cancel aborts the new download. The controller is left as it was before the download occurs.

When the download is complete, you are in Debug mode. (If you receive errors, see “Types of Errors”on
page 423 and “Strategy Problems”on page 416.)

After switching strategies, you can switch back to the original strategy by clicking Control Engine > Inspect in
Debug mode and use the Switch and Run or Switch button in the Inspect Control Engine dialog box, or you
can use PAC Terminal. When the strategy is switched back, the persistent variables are created and compared.

Switching the Strategy

If there is already an active strategy which is set up to have an alternate strategy (as described in “Background
Downloading”on page 209), and you want to switch strategies, do the following:

1. In Debug mode, choose Control Engine > Inspect to open the Inspect Control Engine dialog box.
2. Choose either the Switch and Run or the Switch button.

The Switch & Run button stops the active strategy and runs the strategy you just downloaded. The
Switch button stops the active strategy and makes the new strategy the active one (but not yet running).

When the strategy is switched (as described in the previous steps), the following operations occur:

«  Persistent variables are compared. If the type and size of the persistent variable are consistent, the
contents are copied. If the type and size do not match, a new persistent variable is created. New
persistent variables are initialized to zero and new persistent strings are initialized to NULL (empty)
strings.

+ /O unit configurations are compared. If the I/O unit configurations match, I/0 will not be initialized.

«  The Powerup chart is called.

See also, “Background Downloading”on page 209.

Compiling without Downloading

Sometimes you may want to compile without downloading, just to see if a chart, subroutine, or strategy
compiles correctly. You can compile the active chart or subroutine only, just the changes you have made to
the strategy, or the entire strategy.
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Compiling the Active Chart or Subroutine

Whenever a chart or subroutine window is open and active, you can compile just that chart or subroutine. To
do so, in Configure mode, click the Compile Active View icon &  on the toolbar, or choose Compile >
Compile the Active Chart. The menu option shows the name of the chart or subroutine you are compiling.

As soon as you choose the menu option, the chart or subroutine is saved and compiled. You are alerted only if
errors are found.

Compiling Changes Only

To compile just the changes since the strategy was last compiled, choose Compile > Compile Changes. The
menu option shows the name of the strategy you are compiling.

As soon as you choose the menu option, the strategy and all modified charts and subroutines are saved and
compiled. You are alerted only if errors are found.

Compiling the Entire Strategy

To compile the entire strategy including all charts and subroutines, in Configure mode, click the Compile All
icon on the toolbar, or choose Compile > Compile All. The menu option shows the name of the strategy
you are compiling.

As soon as you choose the menu option, the entire strategy is saved and compiled. The Compile Progress
dialog box appears. You are alerted if errors are found.

Downloading Only

If your strategy has been compiled, you can download it again quickly. Downloading again is useful if you
want to run your strategy from a clean slate by reinitializing any variables that are set only on a strategy
download.

To download a strategy that has already been compiled, you must be in Debug mode. Choose Control Engine
> Download Strategy.

The Download to dialog box appears and your strategy is downloaded.

TIP: To configure a strategy to start running at completion of the strategy download, select the "Start strategy after
download completes” check box on the File > Strategy Options > Download tab.

Background Downloading

The Background Downloading feature allows you to download an updated or alternate strategy to a controller
(or processor) while the active strategy currently on the controller continues to run. With two different
strategies downloaded to the controller you can switch rapidly from one strategy to the other.

How is background downloading different from storing to flash? With background downloading,
the volatile memory space that is reserved for strategy storage is partitioned into two sections. This is how an
active strategy can continue running while an updated or alternate strategy is being downloaded to the other
partition. After the download, you decide if and when to switch to the newly downloaded strategy that is
stored in the other partition. However, with storing to flash, the flash memory space reserved for strategy
storage is not partitioned, so only one strategy can be stored to flash at a time. If a strategy is configured to be
stored to flash, then when it is downloaded, it will be stored to flash. When the controller is restarted or power
is cycled, the strategy that is currently stored to flash will be loaded.

With background downloading, you can:
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«  Download a new or updated strategy to the controller and then optionally run it. The existing strategy
continues to run during the download process until you select the option to switch to the newly
downloaded strategy. This minimizes downtime. For larger strategies, downtime is dramatically reduced.

«  Download and test a new or updated strategy but still keep the original strategy available. You can switch
back the original very quickly by manually switching from one strategy to the other, or—if the original is
still stored to flash—by cycling power.

You can use background downloading as an alternative to Online mode, which also allows you to make
changes while a strategy is running. The following table describes the differences between Online Mode and

Background Downloading:

Can you add variables, 1/0,

and charts?

Can you add and change
blocks, change instruc-
tions, and edit existing

charts?

What is downloaded in

Debug mode?

Where does the strategy
restart after download?

How is the controller
memory affected?

No

Yes

Only the edited charts are down-
loaded. All other charts keep run-
ning. When the download is done,
you are prompted to restart the
edited charts.

The affected charts restart at block 0.

When a chart is downloaded, the old
one is not deleted, so this consumes
additional memory. To free up mem-
ory used by old charts, the strategy
should be stopped and then com-
piled and downloaded.

Yes

Yes

The entire alternate strategy is down-
loaded while the entire active strat-
egy continues to run.

If you switch to the alternate strategy
after download, the strategy starts
with the Powerup chart.

Controller memory is cut in half
when background download is set it
in PAC Manager. Also, the number of
charts that can run simultaneously is
reduced by one.

To enable Background Downloading:

NOTE: Controller or processor memory is cut in half when background downloading is enabled. Also, the number of
charts that can run simultaneously is reduced by one.

1. Enable the feature in the controller or processor:
- For SNAP PAC controllers, start PAC Manager and follow these steps:

a. (lickthe Inspect icon to open the Inspect window.

b. Inthe Inspect Window's IP Address field, type the IP address for the SNAP PAC controller,

c.  Click Status Write, then scroll down to Strategy Download Method.
d

Click the Value field for Strategy Download Method, select Background from the drop-down
menu, and then click Apply.

e. Under Operation Commands, highlight “Store configuration to flash,”and click Send

Command.

The configuration is stored to flash memory and a Success message appears.
For more information, see the PAC Manager User’s Guide (form 1704).
—  For groov EPIC processors, follow these steps:

a. Log into the groov EPIC processor with an administrator account.

b. From the groov Manage Home page, click Controller > PAC Controller > Configuration.
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c. Click Background Downloading.

d. Click Save.

For more information, see the groov EPIC User’s Guide (form 2267).
2. Restart the control engine:

—  For SNAP PAC controllers, start PAC Manager and follows these steps:

a. (lickthe Inspect icon to open the Inspect window.

In the Inspect Window's IP Address field, type the IP address for the SNAP PAC controller.

b.
c. Click Status Write.
d

In the Operation section, highlight “Restart Device from powerup” (in the OptoMMP Device

sub-section) and click Send Command. The SNAP PAC is restarted.

- For groov EPIC processors, follow these steps:

a. Loginto the groov EPIC processor with an administrator account.
b. From the groov Manage Home page, click Controller > PAC Controller.

c. Click Disable. Click OK on the confirmation prompt.

d. Afterthe Status is switched to Disabled, click Enable. Click OK on the confirmation prompt.

- For either a controller or a processor, cycle power.
3. In Configure mode in PAC Control, choose File > Strategy Options.

4. Inthe Download tab under Background Downloading, select “Use background downloading and fast

strategy updating.”

5. (Optional) Under Flash Memory, select “Save strategy to flash memory after download.”

(Optional) To have the strategy run automatically after a control engine restarts, select “Set autorun flag

after download.”

Strategy Options

Archive Download  Serial 1/0 Pots  Redundancy  Legacy

Flash Memory

Background Downloading

[] Use background downloading and fast strategy updating

The controller must be configured for this feature using PAC Manager (SMAP), or groov Manage (EPIC).

Download Compression
None Full

Start Strategy
[ start strateqy after download completes

Cancel Help

7. C(lick OK.

PAC Control is now set to download the strategy in the background when you click the Debug mode icon

EEEM. Next, see “Compiling and Downloading” on page 206. See also, “Switching the Strategy”on

page 208.
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Downloading Without Using PAC Control

If you are creating strategies for users who do not have PAC Control on their systems (for example, if you are an
integrator or OEM), you can make a control engine download file that can be downloaded to a SNAP PAC
controller by using either the graphical interface in PAC Terminal or the command line interface with a batch
file. This one download file is built for a specific control engine but can also be downloaded to other similar
control engines. It contains everything PAC Control would download, including .per, .inc, and .crn files, control
engine-specific files, and initialization information.

In most cases you will want the downloaded strategy to be saved to flash memory and to start automatically
(autorun) when power is cycled to the control engine. Before you create the download file, follow the steps in
“Saving to Flash on Every Download” on page 204. Check the boxes to have the strategy saved to flash
memory after download and to set the autorun flag after download. This information will become part of the
download file.

Creating the Control Engine Download (.cdf) File

With the strategy open in PAC Control in Configure mode, right-click the name of the control engine in the
Strategy Tree and choose Compile Control Engine Download File from the pop-up menu. (You can also
choose Compile > Compile Control Engine Download File.)

The file is created in the same folder as the strategy, with a .cdf extension and a file name consisting of the
strategy’s name and the control engine’s name (for example, MyStrategy.MyEngine.cdf).

Once the control engine download file is created, it can be downloaded using either the graphical interface in
PAC Terminal or the command line interface with a batch file you create.

Downloading the .cdf File using PAC Terminal

1. Start PAC Terminal:
- InWindows, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.5.
The PAC Terminal window appears.

File Tools gonfgure View Help

Control Engines:
Controller rfdame System Type Address 1 Address 2 Status Con re Control Engines
#¥'Cookie Controller  Standard ¥127.0.0.1 “ e ]
$¥'R1 Controller Standard v10.195.55.111 #
Status Scan

%, scan Al

% Scan Selected
b >

2. Right-click the name of the control engine you want to download the file to.
3. Inthe pop-up menu, choose Download > Control Engine Download File.
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Download File n

File to Download:

Download progress:

Download Cancel

4. Enter the path and file name of the .cdf file, or click the Browse button and navigate to it. When the file
name appears in the File to Download field, click OK.

The file is downloaded to the control engine.

Using Command Lines or a DOS Batch File to Perform PAC Terminal Tasks

If you do not want your end user to have to use PAC Terminal, you can use DOS-level commands or create a
DOS batch file to download a .cdf file. In addition to downloading a .cdf file, the DOS commands can also run
or stop a strategy, or define the control engine on the PC that will download the file. PAC Terminal must be
installed on the PC where the batch file is used.

The following table lists actions you may want to take within PAC Terminal:

To do this: Use this:

Show help information for termcl -h control_engine_name

Download the specified file to the specified
controller. Compression can be between 0 -d control_engine_name filename [-z compression]
(none) and 10 (max).

Run the strategy in the specified control

. -r control_engine_name
engine

Stop the strategy in the specified control

. -s control_engine_name
engine

Send a Forth command to the control

. —-c control_engine_name Forth_command
engine

Add a control engine definition to the sys-

tem. Does not modify an existing definition. -a control_engine_name tcp ip-addr port retries
Example: timeout_ms

-a MyCE tcp 10.20.30.40 22001 0 2000

Download the encrypted SSD file to the

—-dp control_engine_name ssd_filename
controller

Prevent response messages from printing to

the DOS screen Append the DOS switch -g

This example shows lines included in a batch file that will define the control engine, download the .cdffile to
it, and then run the strategy:

termcl -a MyCE tcp 10.20.30.40 22001 0 2000

termcl -d MyCE "c:\My Project\MyStrategy.MyCE.CDEF"

termcl -r MyCE
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Changing Download Compression

If you have a very large strategy, short timeouts, and slow connections on your network, you may need to
decrease the compression level to download the strategy successfully. When you decrease compression, the
strategy takes longer to download because it is sent in smaller chunks. If you are having difficulty
downloading your strategy, follow these steps to decrease compression:

1. With the strategy open in Configure mode, choose File > Strategy Options.

2. Inthe Strategy Options dialog box, click the Download tab.

Strategy Options >
Archive Download  Seral 140 Pots  Legacy

Flash Memory
[] Save strategy to flash memory after download
[] Set autorun flag after download

Background Downloading

[] Use background downloading and fast strategy updating

The controller must be configured for this feature using PAC Manager.

Download Compression
Mone Full

. Slider

Start Strategy
[] Start strateay after download completes

Concel | | b

3. Move the slider to the left to reduce compression, and then click OK.
You may need to experiment with the setting until the strategy downloads successfully.

RUNNING A STRATEGY MANUALLY

1. With the strategy open, choose Mode > Debug.
2. (lickthe Run Strategy icon p= (or press F5, or select Debug > Run).

You can also run a strategy from the Inspecting dialog box. See “Inspecting Control Engines in Debug
Mode” on page 110.

RUNNING A STRATEGY AUTOMATICALLY (AUTORUN)

You can set the strategy to run automatically (autorun) if the control engine loses power and then restarts. In
traditional Opto 22 controllers, the OptoControl autorun function was controlled by a jumper. For PAC Control,
it's controlled by the autorun flag. If the autorun flag is not set, the strategy must be started manually after
power is restored to the control engine. The strategy must be saved in flash memory for autorun to work.

You can set the autorun flag in two ways:
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«  In Configure mode, save the strategy to flash memory and set the autorun flag every time the strategy is
downloaded. (Be careful you do not save to flash too often, as flash memory eventually wears out.) See
“Saving to Flash on Every Download”on page 204.

« InDebug mode, save the strategy to flash memory by choosing Control Engine > Save Strategy to Flash.
Then right-click the control engine in the Strategy Tree and choose Inspect from the pop-up menu. In the
Inspect dialog box, enable Autorun. (See “Inspecting Control Engines and the Message Queue”on
page 110 for more on the Inspect dialog box.)

Protecting a Running Strategy

If you want a strategy to run automatically without interruption, you can protect the strategy by disabling all
host communications to the control engine.

To protect the strategy, first make sure the strategy is saved to flash and that the autorun flag is set. To disable
host communication, start PAC Manager and set the Control Engine port to 0, and then save that change to
flash. For more information on setting this port, see the PAC Manager User’s Guide (form 1704).

NOTE: This action also disables communication between PAC Display and the control engine.

STOPPING A STRATEGY

DEBUGGING

To stop the strategy, click the Stop Strategy icon m (or press F3, or select Debug > Stop). You can also stop a
strategy from the Inspecting dialog box; see “Inspecting Control Engines in Debug Mode” on page 110.

Once the strategy is running, if it doesn't appear to be working correctly, you can use several tools in Debug
mode to figure out what the problem is. You can pause a chart or subroutine; step into, over, or out of each
block; watch it slowly step through the blocks; or add a breakpoint to a block to stop the strategy just before it
executes that block.

The chart’s or subroutine’s status is shown in the lower left-hand corner of its window. This corner shows
whether the chart or subroutine is running, stopped, or suspended, and whether the debugging tools, such as
stepping and breakpoints, are in effect. The chart or subroutine must be running in order to use these tools.

Choosing Debug Level

You can choose one of two levels of debugging:

«  Minimal Debug lets you step from block to block, but does not allow you to step into blocks. Less
information is downloaded to the control engine for minimal debugging, so downloading the strategy
takes less time and less control engine memory. The strategy also runs slightly faster.

«  Full Debug lets you step into blocks, so you can step through each instruction in an Action or condition
block and through each line of OptoScript code in an OptoScript block. If you are using OptoScript, you
will probably want to spend the additional time to download your strategy at the full debug level.

To change debug level, make sure you are in Configure mode. From the Configure menu, choose Minimal
Debug or Full Debug. The next time you enter Debug mode, the strategy will be compiled and downloaded
with the new level.
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Changing Debugger Speed

Before you enter Debug mode, you may want to consider changing debugger speed. Depending on the
number of charts and windows open in PAC Control, and depending on other processing your computer is
doing at the same time, you may find that running the debugger affects the computer’s or the control
engine’s performance of other tasks. If necessary, you can slow down the debugger by increasing the time
delay between debugging calls to the control engine, therefore leaving more processing time for other tasks.

In addition, a slower setting may be useful when checking communication using PAC Message Viewer (see
page 419)).
To change debugger speed, follow these steps:

1. With the strategy in Configure mode, choose Configure > Options. Alternatively, in Debug mode, choose
Debug > Options.

2. Inthe PAC Control Options dialog bo, click the Debugger tab.

| PAC Control Options >

Workspace Debugger  Advanced

Debugger Peformance
Hi Low

When stepping, make sure the active block is visible

Prompt before starting or stopping a strategy

Concnl | [t

3. (lickand drag the slider to the speed you want.

The default speed is shown in the figure above. Since performance varies depending on your hardware
and software, you may need to experiment to find the most efficient speed.

If you don't want the debugger to follow auto stepping, deselect “When stepping, make sure the active block
is visible.”

Pausing a Chart or Subroutine

You can temporarily stop any running chart or subroutine by pausing it. When you pause a chart or
subroutine, it finishes the instruction it was executing, then stops at the next block (in Minimal Debug) or the
next line (in Full Debug).

To pause the chart or subroutine in the active window, click the Pause Chart or Pause Subroutine icon [l , or
press F7, or select Debug > Pause Chart or Debug > Pause Subroutine.

Here's an example of a paused chart:
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= Powerup

This chart starts the program and all other charts.

0
Start Program

Wait until start flag is set
true (non-zero).

] Start the alarm monitoring,

Start Charts dough/chip control, pressure
control, and oven/inspection
charts.

v

< >
[ romee T o on Jovor o Jroso 7o s
% Chart /

Status bar—Step On - —_|

Hatch marks and a red outline appear on the Start block, indicating that this block is to be executed next. The
status bar shows Step On, which means you can step through the chart or subroutine if you wish.

Stepping Through a Chart or Subroutine

When you step through a chart or subroutine, you control the timing and execution of its commands in a
running strategy. You can see what commands are being executed when, and you can monitor the status of
variables and I/0 that are affected by the commands.

There are two types of stepping: single-stepping and automatic stepping. Use single stepping to go through
flowchart blocks at your own pace. Use auto stepping to watch the flowchart step automatically.

CAUTION: Since stepping through a running chart or subroutine—even auto stepping—slows down execution,
be cautious if your strategy is running on real equipment. For example, stepping through a strategy might leave a
valve open much longer than it should be.

Single Stepping

When you are debugging a strategy, start by using the Step Over icon to go through a chart one block at a
time. The Step Over icon may be all you need to find any problems. If necessary, go back to Configure mode
and change to full debug (see “Choosing Debug Level”on page 215) so you can step into blocks and execute
one line at a time.
1. Pause the chart or subroutine to be stepped through by pressing the Pause Chart or Pause Subroutine
icon I .
2. Tostep tothe next command block, click the Step Overicon TF (or press F10, or select Debug > Step
Over).
The commands in the highlighted block are executed, the hatch marks move to the next command
block, and the chart pauses again. Compare the chart below to the one on page 216.
The hatch mark has moved to the next block.
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= Dough_Chip_Control

runs
sly once the
as been started.

H Speed OK?

Drop the dough. =
rop Dough

v

7 Drop the chips.
Drop Chips

| KTRTY [\Bhartf’

If you need to step inside flowchart blocks and move through them one command at a time (or in
OptoScript blocks, one line of code at a time), make sure you have downloaded your strategy at the full
debug level. See “Choosing Debug Level”on page 215 for help.

If the chart or subroutine is not already paused, press the Pause Chart or Pause Subroutine icon Il .

To step inside the block you are on (the one with the hatch marks), click the Step Into icon 1 (or press
F11, or select Debug > Step Into).

The Step Into button takes you inside the current block, so
you can step one command at a time.

The red arrow indicates the command that
will be executed next.

— I0_Enabler_Chart

-\ Inttialization [ -

. I0_Enablez_Chart =13

~

// Check pointer table slement to s=ee
1f (ptIO_Unit=[nl0_EnablerIndex] == nu.

¢ Ho I-0 unit iz loaded in the ptI0
ntId_UnitCommEnableStatus[nld Enables

else - I0 Unit pointer i= walid at th:
HumberToString(nld Enablerlndex. =I0

s Get pointer to I0 Unit
pll_TnitEnetPAC = ptI0 Tnit=s[nlI0 Enal

#«  Check to see i1f the user wants tl

1if (ntI0 UnitU=erDi=able[nll Enabler:
if A TaTAlnd +CemmFnahlad fn T Tni fF
>

L1101

Ghi
|||||N|aﬂ/ i'

hart #, OptoScript Block - "10 EnablerliEnet & PAG™ - 1d IQf_

The small gray tabs at the left of The white tab shows you where you
the white tab show how you got are: inside a chart, a block, or a
to where you are. subroutine called by a chart.

To move from line to line, click either the Step Into or the Step Over icon.

If a command within the block calls a subroutine, Step Into takes you into the subroutine. Step Over skips
over the subroutine.
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7. Tostep from a command inside a block and go to the next block, click Step Out I .

Clicking Step Out when you are on a block, rather than inside it, causes the chart to resume. In a
subroutine, clicking Step Out takes you out of the subroutine.

Auto Stepping

Auto stepping lets you watch a chart’s or a subroutine’s logic in slow motion, one block at a time. A chart or
subroutine does not have to be paused before auto stepping can begin. To begin auto stepping, click the Auto
Step icon ¥, press 8, or select Debug > Auto Step Chart.

Step Auto appears in the status bar. The hatch marks move from block to block as each block’s commands are
executed. When you reach a block whose code is currently being executed, the highlight around the block
becomes changing shades of green instead of solid red (unless the block is executed very quickly).

A chart that contains flow-through logic stops when it has been stepped through. In a chart that contains
loop logic, the auto stepping continues until you stop it by pressing the Auto Step icon again.

Setting and Removing Breakpoints

Sometimes you want to see the action at one or two blocks without having to step through an entire chart or
subroutine. You can use a breakpoint to stop a running chart or subroutine just before a block is executed.

You can set a breakpoint at any block in any chart or subroutine, whether it is running or stopped, paused or
auto stepped. The strategy does not need to be running. You can set up to 16 breakpoints in one chart or
subroutine.

You can also set a breakpoint inside an OptoScript block, but not inside other types of blocks.

To set a breakpoint, follow these steps:

1. With the chart or subroutine open and in Debug mode, click the Breakpoint tool &% .
The pointer turns into a hand.

2. Toseta breakpoint on a block, click the target block to mark it with the breakpoint hand.

L - S — - ...._z.
T

Stop all control charts and
set all devices to a known
state.

Breakpoint hand

When all alarms are clear,
restart system by starting
2%, Powerup chart.

< >
o005 J8
H % Chart /

ﬁ?:"l Powerup ﬁ’lDough_Chi...

ﬁ‘lDough_\c’es... ﬁ‘lO\ren_lnsp... ﬁ Alams [

INFO Debug

A red square appears around the block and Break On appears in the status bar.
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e e

Stop all control charts and
set all devices to a known
z state.

Red square Set Devices

Stop
Conveyor

When all alarms are clear,
restart system by starting
Powerup chart.

Break On in status bar ~ —|

>
[ on Torcoron |_vouosec o8
[ 412 ]I Chart /

;?ZFI Powerup S&Dough_Chi...

S&Dough_‘u’es... S&O\ren_lnsp... 5‘,:?:"' Alamms
INFO Debug

To set a breakpoint within an OptoScript block:
- With the Select tool, double-click the block to open it.

- Inthe PAC Control toolbar, select the Breakpoint tool, place the palm of the breakpoint hand over
the line of code where you want the chart to stop, and then click the left mouse button.

A red dot marks the breakpoint. The chart will stop running before executing the marked line of code.

Note that in an OptoScript block, you can set breakpoints only on lines of code—you can't set a
breakpoint on a comment or within a comment block.

& OptoScript - Alarms - Stop Conveyor - Block 36 *

OptoScript Code:

< Ramp s=peed of conveyor to 0%, This is done by changing ac
s =zmall increments over a 20 =s=econd period.

s Calculate the =mall increment= of change to acConwveyorSpe
. . fRampValue = (0.0 - acConveyorSpeedControl) ~ 20.0;
Breakpoint set at this :

s Loop twenty times

lineofcode — | ® Mior nloopCounter = 1 to 20 step 1
s Adjust aoConveyorSpesdControl
aoConveyorSpeedControl = aoConveyorSpeedControl + fRampVal

s Delay for one =s=econd
DelaySec(1.0):
next

<7 Wake sure aoConveyorSpesdControl is at exactly 0.0
aoConveyorSpeedControl = 0.0;

< >

Close Help Command Help Ln g, Col 2

3. (lick other blocks or OptoScript lines to set additional breakpoints, or click blocks or lines currently
marked with a hand to remove the breakpoint. (Make sure that the palm of the breakpoint hand is
directly over the line you want to select.)

4. When you have finished marking or removing breakpoints, click the Breakpoint icon again or click the
right mouse button within the window.
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When the chart or subroutine runs, it pauses just before executing the breakpoint block or line. You can
inspect variables or I/0 points, disable strategy elements, change values, and try other options to see the
effect the block has.

5. Tosingle step past the breakpoint, click the Step Block or Step Line button. Or to run the chart or
subroutine at full speed after the breakpoint, click the Pause Chart icon.

Managing Multiple Breakpoints

You can see all the breakpoints you have set, and you can remove breakpoints one at a time or all at once. See
also, “Setting and Removing Breakpoints”on page 219 to use the breakpoint tool.

1. Press Ctrl+B or click Debug > Breakpoints.
The Breakpoints dialog box appears, showing all the breakpoints set in the strategy.

4] Breakpoints e
ChartfSub Mame  Block ID Block Name Block Type Remove
Alarms 36 Stop Conveyor OptoScript e al
Alarms 2 Set Devices Action -

crca | [t

2. Todelete a breakpoint, highlight it and click Remove. To delete all breakpoints in the strategy at once,
click Remove All.

3. When you have finished making changes, click OK.

Interpreting Elapsed Times

As you debug your strategy, you may notice elapsed time readings appearing in a chart’s or subroutine’s status
bar, as shown below.
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~ Sprinklers E| [E”‘S__(

.......................... ~

Wait 60 sec

10':1‘:::fff

Wait 24 hrs

F 3

...... v Read S S S O S O O O O
...... Hygrometer-----------

) "umn off sprinklers —l L — Elapsed time

[ Running |[ Step 0n ][ Break 0ff [[14180.050 5 [0 e SN TRN
% Chart /

Furn on sprinklers,

Elapsed time readings can help you determine how much time a chart, a subroutine, or a single block takes to
execute. The readings have slightly different meanings depending on what you did to make them appear, as
described in the table below:

Whenyou... Elapsed time represents...

Run a chart or subroutine and pause it  Time since the chart or subroutine started or was last paused

Single step (by line or block) Time to execute the previous block
Auto step Time to execute the most recently executed block

Time since the last pause, or if the chart or subroutine was not

Hit a breakpoint . . . .
P paused, elapsed time since it started running

VIEWING AND PRINTING

You can view and print several helpful things in a strategy as described in the following topics:
«  "Viewing Strategy Filename and Path” (below)

«  "Viewing an Individual Chart or Subroutine”on page 223

«  "Viewing All Charts in a Strategy”on page 223

«  "Printing Chart or Subroutine Graphics”on page 224

«  "Viewing and Printing Strategy or Subroutine Commands” on page 226

«  "Viewing and Printing Strategy or Subroutine Elements”on page 226

«  “Viewing and Printing a Cross Reference”on page 228

«  "Viewing and Printing a Bill of Materials”on page 228

»  “Viewing and Printing I/0 Point Mappings”on page 229

For information on viewing and changing I/0 units, see “Inspecting, Monitoring, and Changing 1/0 in Debug
Mode" on page 176. For variables, see "Viewing Variables in Debug Mode”on page 270.
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Viewing Strategy Filename and Path

To see an open strategy's file name and path, choose File > Strategy Information. A dialog box appears
showing the path and file name.

Viewing an Individual Chart or Subroutine

To view an individual chart or subroutine, double-click its name on the Strategy Tree, or choose Chart > Open
or Subroutine > Open. You can open as many of these windows as you need. The names of open windows
appear on tabs at the bottom of the PAC Control main window. Click a tab to bring its window into view.

Viewing All Charts in a Strategy

You can see the status of all charts at once and change a chart's status without having to open it.

1.

Make sure the strategy is open and in Debug mode. On the Strategy Tree, double-click the Charts folder.
The View Chart Status dialog box appears, showing every chart in the strategy:

3% View Chart Status

Marme Status Mode Breakpaint Status Pauzed At
Digital_Contral Rurning Step OFf Break OFf

Flag_Example_Chart  Stopped Step OFf Break OFf

Powerup Stopped Step OFf Break, Off

Sample Stopped Step OFf Break OFf

Simple_Error_Handli... Stopped Step OFf Break. Off

Sprinklers Running Step On Break, Off Turn off zprinklers
Timer_Example_Chart Stopped Step OFf Break OFf

To change the status of a chart, double-click the chart name.

The View Chart dialog box appears, showing the chart name, chart status, run mode, and breakpoint
status. If the chart is paused (mode is Step On), the block at which it is paused is shown in the Paused At
field. In the figure below, the chart is not paused:

£ "Alarms” - View Chart (scanning) |:||z,&|

Chart: FI.aq Example Char |
Status: |5tn|:-ped Z | Mode:|5tep o = | Breakpoints: | Break Off |3
Pauzed At | |

T T [

The title bar shows whether scanning is occurring. Scanning stops when you click one of the changeable
fields (Status, Mode, and Breakpoints) and resumes once you click Apply, another button, or one of the
other fields. If scanning resumes before you click Apply, any changes you made are lost.

To stop, run, or suspend a chart, click an arrow in the Status field to select the option. Click Apply.
To turn pausing on or off, click an arrow in the Mode field to select Step On or Step Off. Click Apply.

To observe orignore any breakpoints set in the chart, click an arrow in the Breakpoints field to select
Break On or Break Off. Click Apply.
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This action does not clear or set breakpoints, but just determines whether the chart stops at breakpoints
when it is running.

Chart changes occur as soon as you click Apply.

6. Toadd the chart to a watch window so you can monitor it with other strategy elements, click Add Watch.
In the dialog box, choose what to watch. Select an existing watch window to add this chart to, or create a
new watch window.

See “Using Watch Windows for Monitoring” on page 196 for more information on watch windows.
7.  When you have finished making changes, click Close to return to the View Chart Status dialog box.

Printing Chart or Subroutine Graphics

You can print a chart or subroutine just as it appears on screen. You can also print all charts within a strategy.
When printing a single chart or subroutine, you can preview the image to make sure it's what you want before
you print it.

NOTE: If you have trouble printing graphics, set your printer for PostScript emulation.
Setting Up the Page

Before printing graphics, you should verify your page setup, which determines how each graphic appears on a
page.
1. In Configure mode, select File > Page Setup.

The Page Setup dialog box appears.

1 Flowchart Graphics - Page Setup

Graphics Scaling

() Adjust to % nomal size
one 3 e

Fage
Print Header

[ Ok ] ’ Cancel ]l Help ]

2. Inthe Graphics Scaling area, choose whether you want each flowchart to print at a fixed percentage of
normal size or to span a specific number of pages.

- Toprintata fixed percentage, click the Adjust To option and specify any scaling from one percent to
1,000 percent.

You can type in a number or click the arrows to go up or down to the next increment of 25 percent.
Typically, percentages between 50 percent and 200 percent work the best.

- To print to a specific number of pages, click the Fit To option and select the number of pages wide
and tall you would like each chart to print.

If you choose one for each dimension, each chart prints to a single page. For each dimension, you
can specify any integer between one and 255, but be careful. Selecting values of five and five, for
example, would cause each chart to print five pages wide and five pages long, a total of 25 pages.

3. (Recommended) To print a header on each page, put a check mark in the Print Header box.

The header lists the strategy name, chart or subroutine name, date and time of printing, page number,
and column and row of the page with respect to the full chart printout.

4. (lick OKto save your settings.
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Previewing a Flowchart Printout

1.

3.

5.

To see how a chart or subroutine will print before actually printing it, open the chart or subroutine
window.

From the Chart or Subroutine menu, select Print Preview Graphics.
The preview window appears, showing the image as it will print. The cursor becomes a magnifying glass.

1 PAC Control Professional - [Dough_Vessel Pressure_Control] E”Elg|

e

Frint... Hest Page || Prew Page || Two Page Zoom [n Zoom Dut Cloze

Thie chart mairtaing te pressurs In the dough vessel tank. @\‘17 Magnifying glass cursor

The Pawerup chart starts
e chart

This chart runs
contnuously once the
Caleulats the current program hai been riarted.

rapsurs satpointminus
e deadband.

‘Wwhan praaure [n greatar
than or aqual to setpoint,
clowa the prasaure valve.

Whhan pravaure vl ve than
the setpointminus the
deadband, opan the
prasaure valve.

IPage 1 Configure

To zoom in at 200 percent, click where you want to see more closely. Click again to zoom in at 400
percent. Click a third time to return to 100 percent view.

You can also use the Zoom In and Zoom Out buttons at the top of the window to zoom in or out with
respect to the top left corner of the image.

If the image spans more than one page, click the Next Page or Prev Page buttons to view the next or
previous page. To switch between a single-page view and a double-page view, click the Two Page/One
Page button.

To print, click the Print icon to open the standard Windows Print dialog box. To change settings before
printing, click Close and see “Setting Up the Page”on page 224.

Printing One Chart or Subroutine

1.
2.
3.

To print one chart or subroutine, open its window.

From the Chart or Subroutine menu, select Print Graphics.

In the standard Windows Print dialog box, do one of the following:

- Toprint to a printer, select the printer, page range, and number of copies. Click OK.

- Toprintto afile, select Print to file and click OK. In the dialog box, type the file name and location.

Printing All Charts in a Strategy

CAUTION: You can print all charts included in a strategy, but be sure that's what you want to do before you begin.
You cannot cancel once printing has started.

1.

To print all charts within a strategy, open the strategy and check the page setup.
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For help, see “Setting Up the Page”on page 224.
2. Select File > Print All Graphics.

Printing begins immediately; no Print dialog box appears. Messages inform you of each chart’s printing
progress. To skip printing a particular chart, click Cancel when its message appears.

Viewing and Printing Strategy or Subroutine Commands

You must be in Configure mode to view and print commands.

1. Toview all commands (instructions) in a chart or subroutine, open its window and select View/Print
Instructions from the Chart or Subroutine menu. Choose whether to sort instructions by block name or
block ID number.

2. Toview all instructions in an entire strategy, select File > View/Print > All Chart Instructions.

NOTE: Subroutine instructions are not included; you can print them separately.
PAC Control processes the information and displays it in the Instructions window.

Save Print Search

B Cookies - AllChart Instructions

;l‘I'l‘]'..E: Elock Instructions for Every Chart B
STEATEGY: Cockies
DATE: OZ 05710 TIME: 10:39:5E

CHART: Alarms
RCTIONS

Action Block: Powerup (Id: ZE)
Exit to: Goto 3tart (Id: Z8)

Restart Powerup chart. This will get system going again.
Start Chart

Chart Powerup

Put Status In nChart3tatus

Action Block: Set Dewices (Id: Z)
Exit to: Stop Conveyor (Id: 36)

Lowear oven tempersture while conveyor is stopped.

Move
From Z0o0.0
Tao aolvenTenperatureControl

Close all wvalves.
Turn Off

Ar Tl T smen s aTfalra
—

You may need to resize the window and use the scroll bar to see all the data. Blocks and their instructions
are listed in alphabetical or ID number order by type of block: action blocks first, then OptoScript blocks,
then condition blocks, and finally continue blocks.

3. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To search
the data, click the Search icon. When finished, close the window.
Viewing and Printing Strategy or Subroutine Elements

You must be in Configure mode.

1. Toview a summary of I/O elements and variables configured in a strategy, select File > View/Print >
Database.
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To view the same summary for a subroutine, open the subroutine window and select Subroutine >

View/Print > Database.

The View/Print Database dialog box appears.

View/Print Database

Inciude

Numeric Variables
Sting W ariables
Painter Y ariables
140 Urits & Poirts

Mumeric T ables

String T ables

Pointer Tables
Carmmunication Hahdles

FID Loops Event/Feactions
[] Descriptions
I Ok, l [ Cancel ] [ Help ]

3. Make sure all element types you want to include are checked. Click to uncheck any elements you do not
want.

4. Toinclude descriptive comments associated with the elements, click to put a check mark next to
Descriptions.

5. ClickOK.

PAC Control processes the database and puts the data in the Database window.

Save Print Search
8| Sprinkler_Contiol - Database ['. || m] | | X |
= £ #
|l.l‘ITLE: Strategy Databasze L
STRATEGY: Sprinkler Control
DATE: 08/21/04 TIME: 12:49:44
NUMERIC VARIRABLES
NAME TYPE INIT. VALUE BREF. COUNT
Day _of_the Week INT RUN o 4
Packer Busy INT RUN o 3
Status INT RUN o 3
Sum INT RUN o o
Timer DN TIMER RUN z
COMMUNICATION HANDLES
NAME TYPE INIT. VALUE REF. COUNT
UIO0_East RUN 1024 o
v

You may need to resize the window and use the scroll bar to see all the data. For each element the name
and reference count (that is, how many times the element is used in strategy commands) are shown, plus
other information depending on the element type. The figure above shows numeric variables and
communication handles.
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6. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To search
the data, click the Search icon. When finished, close the window.

Viewing and Printing a Cross Reference

You can view and print a report of every operand in your strategy or subroutine—charts, I/0 units, analog
points, digital points, communication handles, numeric variables, string variables, pointer variables, numeric
tables, string tables, and pointer tables. The operands are cross-referenced to the charts, blocks, and
instructions in which they are used.

1. To produce a cross reference for a strategy, open it and select File > View/Print > Cross Reference.

2. Toview asimilar report for a subroutine, open the subroutine window and select Subroutine >
View/Print > Cross Reference.

PAC Control processes the data and puts it in the Cross Reference window.

Save Print Search

B Sprinkier_Conirol - Cross Reference

TITLE: Strategy Cross References b
STRATEGY : Unit 3 Monitoring
DATE: 10705706 TIME: 14:47:Z0

CHARTS

Interrupt - Mot referenced.

Morning
Chart Referenced Elock Referenced Instruction
Powerup Start Charts Start Chart

Poverup - Not referenced.

ANALOG POINTS

Refrigeration

Chart Referenced Elock Referenced Instruction
Morning Check refrigeration Line #32
Morning Check refrigeration Line #11
Morning Check refrigeration Line #11

You may need to resize the window and use the scroll bar to see all the data. Notice that the Instruction
column (at right) shows the line number the operand appears in when it is in OptoScript code.

3. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To search
the data, click the Search icon. When finished, close the window.

Viewing and Printing a Bill of Materials

You can view and print a bill of materials (BOM) that lists all the I/O units and /O modules (analog and
standard digital) required to run the strategy. (Special-purpose modules, such as serial and high-density digital
modules, are not included in the BOM.)

1. To produce a BOM for a strategy, open it and select File > View/Print > Bill of Materials.
PAC Control processes the data and puts it in the Bill of Materials window.
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B Cookizs - Bill of Materials
HE s

TITLE:
STRATEGY -
DATE:

Eill of Materials
Cookies
OZ/1E/0E

TIME: 11:15:13

Brainsg
1 GENAP Mixed Ultimate I/0

(SMAP-UP1-ADLS)

Digital Input Modules

1 SMAP-IDCED: Z.5 - Z8 VDC
Digital Output Modules

1 SNAP-ODCESSRC: 5 - &0 VDC Source

hnalog Input Modules
1 ENAP-AICTD
1 GENAP-AIV

hnalog Output Modules
1 GENAP-AOV-Z7

Totals
Total Brains: 1
Total Modules: 5

NOTE: Controllers, power supplies,

and mounting racks are not specified.
Contact your local distributor or Opto £Z for help or to purchase products.

You may need to resize the window and use the scroll bar to see all the data.

2. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To search

the data, click the Search icon. When finished, close the window.

Viewing and Printing I/0 Point Mappings

You can view and print a report that shows the location and mappings of I/0 points. You can use this report as
a look-up table for programming purposes. This can be useful with some commands that use different point
mappings such as Move 1/0 Unit to Numeric Table Ex, Move Numeric Table to I/O Unit Ex, and IVAL Move

Numeric Table to I/0 Unit Ex.

This report basically provides the same information provided in “Table Index Offset Examples,”in the PAC
Control Command Reference (form 1701) but for the actual points in the strategy.

To produce an 1/0 point mappings report for a strategy, open the strategy and select File > View/Print >

I/0 Point Mappings.

View/Print /0 Point Mappings

Thizs report shows where all the configured pointz are located on modules and
hiow they map out to various point mappings. This can be useful with zome
commands that use different point mappings. like "Maove 10 Unit ta Mumeric
Table Ex"

Report Style: (&) Formatted () Comma-separated

Optiong
Maodule Positions
Channel Positions

4-channel mappings
8-channel mappings

16-channel mappings
32-channel mappings

| oK |[ Cancel ]

On the View/Print 1/0 Point Mappings dialog box, select the report style, either Formatted or
Comma-separated, and select the position and mappings types, then click OK. A report window appears.
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B Cookies - Point Mappings

HES #

TITLE: I/0 Point Mappings s
STEATEGY: Cockies
DATE: 04707702 TIME: 1Z:36:50

Point mappings for I/0 Unit "Mixzed I0 Unit":

I/0 POINTS MO CH 4 g 1e 3z
diDoughLietrel Strit el sl b e S D Fn s S e sl a a a a a o
di Ehip el St CEE i, (i [ e A A T e u} 1 1 1 1 1
diInspectionPassFaillwitch. ... . ... ... .. .. ._.._.... a Z b Z Z Z
S ooy o 1 o e o Sty e u} 2 2 2 2 2
doDoughPressureControlWalwe. o .o .. ... ... .. ... 1 a £ a 1a 3E
deDioughDispernseWalireo s iniasing g oo e ivaa s 1 1 £ 2 17 a3
deChipPispenselalye b e st gt s 1 Z & 10 1z a4
doBejectVWalwe. o .. 1 3 7 11 13 <1
aolvenTenperatureControl. ... . . .. ... ... . ... b a a 16 3E 64
aoConveyorSpeedControl. oo ... .. ... ... Z 1 2 17 a3 &5
Al0TerTemper AEUE Bk g i i s g e 3 o 1z 24 43 26
aiboughWessel Pressure. . ... ...t iiiii e £ o1& 3z 64 1E8

S T I

What the columns mean:

Column Description

MOD The module number on the rack

CH The channel number within the module
4 4-channel mapping

8 8-channel mapping

16 16-channel mapping

32 32-channel mapping

SEARCHING AND REPLACING

You can search a chart, subroutine, or strategy for missing connections, empty condition blocks, or any
command or operand. An operand is anything that can be affected by a command, including charts, I/0O units,
analog points, digital points, and all kinds of variables. Searching includes OptoScript code within OptoScript
blocks.

You can also replace instructions or operands with similar items.

Searching

You can search a strategy or one of its charts, or you can search a subroutine.
1. Open the strategy or subroutine and select Edit > Find.
The Find dialog box appears.
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# Find

Search Scope

(%) Global
() Local

Search For
(® Operand (O Instruction (O Missing Connections (O Empty Cond. Blocks

Find

3
(o)

Tupe: Marne: Help

| Drigital Output i | | doR sjectalve w |

Also, if the item you want to find is listed in the strategy tree (such as a variable, table, or point), you can
right-click the item and select Find in the pop-up menu.

= I Paints
L giDgughLevelSwitch
Point name L ]
diChipLe: : -
" n Modify...
I diinspectionPassk :
ILUI i Configure. ..
1+ dEStop Delete

DL_",'I doDoughPressure
DL_",'I doDoughDizpense
1 45ChipDispensey Replace. 2

The item appears in the Find dialog box automatically.

Under Search Scope, to search the entire strategy, click Global. To search one chart only, click Local and
choose the chart name from the drop-down list.

If you are searching a subroutine, the search is Local and the subroutine’s name is shown.
Under Search For, choose one of the following:

- Tosearch fora chart, 1/0 unit, analog or digital point, variable, table, timer, PID loop, pointer, counter,
or communication handle, click Operand. In the Type and Name fields, choose the operand you
want from the drop-down list.

—  Tosearch for an instruction, click Instruction. Click Action or Condition, and choose the instruction
you want from the drop-down list.

- Tosearch for blocks that are not connected to other blocks, click Missing Connections.
- Tosearch for condition blocks that have no instructions, click Empty Cond. Blocks.
Click Find.

The dialog box expands and the search results appear at the bottom.
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Search Scope
-_Find
() Global =
O Local P
Search For
O 0Operand @ Instruction O Missing Connections () Empty Cond. Blocks
@® action O Condition
Instruction: Help
‘lDeIay [mSec) v ‘ Select...
Chart Block Name Block D Command
Flag_E=ample_Chart Delay 1 msec 5 Delay [mSec]
Simple_Eror_Handling_C... Delay 100 msec 9 Delay (mSec) — Search
2 occurrence(s) found. results

For more information on any item in the search results, try double-clicking the item.

5. Tosave the search results to a file or to print them, click Print. In the window that opens, click the Save
icon to save or the Print icon to print your search results.

6. When you have finished your search, close the Find dialog box.

Replacing

You can also replace any operand, instruction, or tag with a similar item. As in searching, you can replace items
in a strategy or one of its charts, or you can replace items in a subroutine.

1. Open the strategy or subroutine, and select Edit > Replace.
The Find and Replace dialog box appears.

A1 Find and Replace rg|
Search Scope Find Next
e
eplace
() Local =L
Feplace Al
Search For
© g
() Instruction
OTag
Type: MNarne:
Find wihat: |,.-3_|| Walid Types w | |aiD0ugh\-"esselPressure LY |
Replace with: |,.-3_|| Walid Types - | |aiD0ugh\-"esselPressure - |

Or, if the item you want to find is listed in the strategy tree, such as a variable, table, or point, right-click
the item and select Replace in the pop-up menu.
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= I Points
I diDoughLevelSwitch

Point name ——
Modify...
Confiqure. ..
Delete

Find...

I JaChipDispensey

The item appears in the Find and Replace dialog box automatically.

1 Find and Replace rg|
Search Scope Find Mext
(%) Global
B
Feplace Al
Search For
) Instruction -
_Help
O Tag
Point name
Type: M ame: _—
Find what: |Digital Imput v | |diEhipLeveIS witch /|/
Fieplace with: | AllValid Types | |ai16_Pat v

Under Search Scope, to search the entire strategy, click Global. To search one chart only, click Local and

choose the chart name from the drop-down list.

If you are searching a subroutine, the search is Local and the subroutine’s name is shown.

Under Search For, choose one of the following:

- Tosearch for a chart, an I/0 unit or point, or a variable, click Operand. In the Find Type and Name
fields, choose the operand you want to replace from the drop-down list. In the Replace With Type
and Name fields, choose the operand you want to use instead.

—  Tosearch for an instruction, click Instruction. Click Action or Condition, and choose the instruction
you want to replace from the Find drop-down list. In the Replace With drop-down list, choose the
instruction you want to use instead.

- Tosearch for a substring within tag names, click Tag. In the “Find what” text box under Substrings,
enter the substring you want to replace. In the “Replace with” text box, enter the replacement text.
For example, if you have several tag names that contain the substring, “Generic,” such as
nGenericCount, fGenericTemperature, and diGenericlnput, you could replace “Generic” with “Station1,”
and the tagnames would become nStation 1Count, fStation1Temperature, and diStation1Input.

Click Find Next.

When the first occurrence of the operand or instruction is found, the Instructions dialog box it appears in

is displayed.

To replace this occurrence, click Replace. To skip it and find the next one, click Find Next.

If you are replacing operands, you can replace all occurrences at once by clicking Replace All. If you are

replacing instructions, you must verify each one.

If the Edit Instructions dialog box appears, make any necessary changes and click OK to save them before

moving on.

When replacements are finished, close the Find and Replace dialog box.
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LEGACY OPTIONS

The term legacy product refers to a hardware or software product originally designed to work with
pre-SNAP PAC systems. For example, brains that were designed for mistic or Optomux® systems are legacy
products. Controllers designed to run FactoryFloor or ioProject software (and not capable of running PAC
Project software) are also legacy products. FactoryFloor and ioProject are legacy products, too. Legacy
products are listed in the SNAP PAC System Migration technical note (form 1688), available on the Opto 22
website.

When you create a new strategy, PAC Control by default shows only SNAP PAC /0 units and the commands
used with them. When you're using the SNAP PAC system only, hiding legacy I/0 units and commands makes
it simpler and less confusing to build your strategy. However, if you're using legacy hardware, you can
configure PAC Control to display legacy options in the strategy. For details, see “Enabling Legacy Options”on
page 234.

NOTE:Ifyou enable legacy I/0 units and commands in PAC Control, see the legacy versions of the PAC Control guides
for information on how to use them:

«  The PAC Control User's Guide, Legacy Edition (form 1710)
«  The PAC Control Command Reference, Legacy Edition (form 1711)
o The PAC Control Command Quick Reference (form 1713)

Existing Strategies

When you open an existing ioControl strategy in PAC Control, either Basic or Professional, PAC Control will
automatically show the I/0O units and commands appropriate to that strategy.

For example, if you have been using SNAP Ultimate 1/0, SNAP Ultimate 1/O units will be visible in the strategy.
In addition, commands used with SNAP Ultimate 1/0 but which are now deprecated (obsolete) because they
are not needed with SNAP PACs are also available.

Similarly, if you open an existing strategy that contains mistic serial I/O units, all the mistic 1/0 unit types and
commands—such as event/reaction and mistic PID commands—are automatically shown.

New Strategies

When you create a new strategy in PAC Control, either Basic or Professional, the strategy will show only the
SNAP PAC System. This means:

»  When you use a command such as Get [/O Unit as Binary Value, the only /0 units shown for Argument 1
will be SNAP PAC I/0 units (SNAP-PAC-R1, SNAP-PAC-R1-B, SNAP-PAC-R2, SNAP-PAC-EB1, SNAP-PAC-EB2,
SNAP-PAC-SB1, and SNAP-PAC-SB2).

«  Commands that are used only with legacy hardware (such as Enable Communication to Mistic PID Loop or
Get All HDD Module Off-Latches) won't be listed.

Since some Opto 22 customers work with multiple systems, legacy options can be set individually for each
strategy or subroutine. If you are using legacy hardware, you can choose the options that apply to each
strategy you're working with, without affecting other strategies.

IMPORTANT: Once you have enabled a legacy option for a specific strategy or subroutine, you cannot disable it
later for the same strategy or subroutine.
Enabling Legacy Options

Here's how to set legacy options:
1. In PAC Control, open the strategy or subroutine for which you want to change options.
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2. Choose File > Strategy Options. Click the Legacy tab.
Depending on the hardware you're using, you can set one or more of the following options:
—  Enable Ethernet, Ultimate, and Simple /O units and commands (see page 235).
- Enable high-density digital commands (see page 235).
- (Pro only) Enable mistic I/0 units and commands (see page 235).

Clickthe option you want to enable. At the confirmation dialog box, make sure it is correct, and then click
Yes. Repeat to enable other options.

The options are changed for the strategy or subroutine.

w

Enable Ethernet, Ultimate, and Simple 1/0 Units and Commands

If you're using any of the I/0 unit types shown in the following table, you should enable Ethernet, Ultimate,
and Simple 1/0 units and commands. When you do, both the I/0 unit types and the commands shown in the
table will become available in the strategy.

1/0 Unit Types Commands

SNAP-ENET-D64 IVAL Set Digital-64 1/0 UrTit from MOMO Masks [DEPRECATED]
SNAP-B3000-ENET IVAL Set M!xed 641/0 .Unlt from MOMO Masks [DEPRECATED]
SNAP-ENET-RTC IVAL Set Mixed I/0 Unit from MOMO Masks [DEPRECATED]
SNAP-UP1-D64 IVAL Set Simple 64 1/0 Unit from MOMO Masks [DEPRECATED]
SNAP-UP1-ADS Set Digital-64 /0 Unit from MOMO Masks [DEPRECATED]
SNAP-UP1-M64 Set Mixed 641/0 pnit from MOMO Masks [DEPRECATED]
SNAP-ENET-S64 Set Mixed I/0 Unit from MOMO Masks [DEPRECATED]

Set Simple 64 1/0 Unit from MOMO Masks [DEPRECATED]

Enable High-Density Digital Module Commands

All SNAP high-density digital modules are fully supported by the SNAP PAC System using regular digital point
commands. However, three of our older HDD modules can also be used with analog-capable SNAP Ultimate,
SNAP Ethernet, and SNAP Simple I/0 units, if you use the older “legacy” HDD commands.

If you are using SNAP-ODC-32-SNK, SNAP-ODC-32-SRC, or SNAP-IDC-32 HDD modules with these older /0
units, you should enable High-Density Digital module commands. When you do, the following commands
become available in the strategy:

Commands

Clear HDD Module Off-Latches Get All HDD Module On-Latches
Clear HDD Module On-Latches Get All HDD Module States

Get & Clear All HDD Module Off-Latches Get HDD Module Counters

Get & Clear All HDD Module On-Latches Get HDD Module Off-Latches

Get & Clear HDD Module Counter Get HDD Module On-Latches

Get & Clear HDD Module Counters Get HDD Module States

Get & Clear HDD Module Off-Latches Set HDD Module from MOMO Masks
Get & Clear HDD Module On-Latches Turn Off HDD Module Point

Get All HDD Module Off-Latches Turn On HDD Module Point

Enable mistic /0 Units and Commands

If you're using legacy mistic hardware with a SNAP PAC S-series controller and PAC Control Professional, you
should enable mistic I/0 units and commands. When you do, the following I/0 unit types and commands will
become available in the strategy.
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1/0 Units Types.

1/0 Unit Types

Other Types

G4D16R B3000 or B3000-B (Digital) Mistic PID Loop
G4D32RS B3000 or B3000-B (Analog) Digital Event/Reaction
G4A8R, G4RAX B100 Analog Event/Reaction
B200 SNAP-BRS Event/Reaction Group
Commands.

Commands

Clamp Mistic PID Output

Clamp Mistic PID Setpoint

Clear All Event Latches

Clear Event Latch

Convert Mistic /O Hex String to Float

Convert Number to Mistic I/O Hex String

Disable Communication to Event/Reaction

Disable Communication to Mistic PID Loop
Disable Event/Reaction Group

Disable Mistic PID Output Tracking in Manual Mode
Disable Mistic PID Output

Disable Mistic PID Setpoint Tracking in Manual Mode
Disable Scanning for All Events

Disable Scanning for Event

Disable Scanning of Event/Reaction Group

Enable Communication to Event/Reaction

Enable Communication to Mistic PID Loop

Enable Event/Reaction Group

Enable Mistic PID Output Tracking in Manual Mode
Enable Mistic PID Output

Enable Mistic PID Setpoint Tracking in Manual Mode
Enable Scanning for All Events

Enable Scanning for Event

Enable Scanning of Event/Reaction Group

Event Occurred?

Event Occurring?

Event Scanning Disabled?

Event Scanning Enabled?

Event/Reaction Communication Enabled?
Event/Reaction Group Communication Enabled?
Get Analog Filtered Value

Get Analog Square Root Filtered Value

Get Analog Square Root Value

Get Analog Totalizer Value

Get & Clear Analog Filtered Value

Get & Clear Analog Totalizer Value

Get & Clear Event Latches

Get & Restart Off-Time Totalizer

Get & Restart On-Time Totalizer

Get & Restart Period

Get Event Latches

Get Frequency

Get Mistic PID Control Word

Get Mistic PID D Term

Get Mistic PID I Term

Get Mistic PID Input

Get Mistic PID Mode

Get Mistic PID Output Rate of Change
Get Mistic PID Output

Get Mistic PID P Term

Get Mistic PID Scan Rate

Get Mistic PID Setpoint

Get Off-Time Totalizer

Get On-Time Totalizer

Get Period

Get Period Measurement Complete Status
IVAL Set Analog Filtered Value

IVAL Set Digital Binary [DEPRECATED]
IVAL Set Frequency

IVAL Set Mistic PID Control Word

IVAL Set Mistic PID Process Term

IVAL Set Off-Totalizer

IVAL Set On-Totalizer

IVAL Set Period

Mistic PID Loop Communication Enabled?
Read Event/Reaction Hold Buffer

Set Analog Totalizer Rate

Set Digital I/0 Unit from MOMO Masks [DEPRECATED]
Set Mistic PID Control Word

Set Mistic PID D Term

Set Mistic PID | Term

Set Mistic PID Input

Set Mistic PID Mode to Auto

Set Mistic PID Mode to Manual

Set Mistic PID Output Rate of Change
Set Mistic PID P Term

Set Mistic PID Scan Rate

Set Mistic PID Setpoint
Transmit/Receive Mistic I/O Hex String
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ADVANCED OPTIONS

Very few applications require changes to the “Advanced” options, which involve adding and changing
variables and points in the strategy. However, these options can be useful for strategies with a very large
number of charts.

Three options are available. Unless you are certain you need these options, do not select them.
1. To see the options, choose Configure > Options. Click the Advanced tab.
By default, these options are not selected:

PAC Control Options *

Workspace Debugger Advanced

[]When adding Pairts and Variables, do not check OptoScript blocks
[]When renaming Points and Variables, do not update OptoScript blocks
[ Allow Points and Variables with references to be deleted

Cancel Help

2. Ifyou are sure you require one or more options, choose the one(s) you need.

When adding Points and Variables, do not check OptoScript blocks: If you check this box,
when you add a point or variable, OptoScript blocks will not be searched to see if it is already being
used in the block. That makes it faster to add points and variables in a strategy that has a large
number of charts. However, reference counts are not updated during this process. When you have
finished adding all the points and variables, choose Tools > Regenerate Reference Counts.

When renaming Points and Variables, do not update OptoScript blocks: If you check this box,
you can rename a variable or point in the Strategy Tree, and it will not be renamed in any OptoScript
block. Renaming points and variables is faster in a strategy with a large number of charts that have
no OptoScript blocks; but if any renamed items exist in OptoScript blocks, the strategy will not
compile. You will have to manually edit those OptoScript blocks.

Allow Points and Variables with references to be deleted: Use this feature on variables or
points that are used only in OptoScript blocks. If the variable or point is used in an Action or
Condition block, the strategy will not compile.

NOTE: Ifyou want to delete a variable or point that shows a reference count greater than zero, but it is not
being used in the strategy, don't use this advanced option. Instead, choose Tools > Regenerate Reference
Counts to recalculate all reference counts. Then you will be able to delete the variable or point.
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8: Working with Flowcharts

INTRODUCTION

This chapter shows you how to work with flowcharts, the building blocks of your strategy. When you create a
new strategy, one chart is created for you: the Powerup Chart. You must create all the other charts to do the

work of the strategy.

In This Chapter

Creating a New Chart page 239
Working with Chart EIements ... sssess e page 240
Opening, Saving, and Closing Charts.......... .. page 249
Copying, Renaming, and Deleting Charts. ..page 250
PriNTING ChartS e sssssss s s s page 251
Exporting and IMporting Charts ... page 251

CREATING A NEW CHART

1. With your strategy open and in Configure mode, select Chart > New, or right-click the Charts folder on
the Strategy Tree and select New from the pop-up menu.

The Add New Chart dialog box appears.

# Add New Chart

Mame:

Drescription:

[ 0k, H Cancel ][ Help ]

2. Enteraname for the new chart.

The name must start with a letter, but may also include numbers and underscores. If you type spaces,
they are converted to underscores. All other characters are ignored.

PAC Control User’s Guide, Legacy Edition 239



WORKING WITH CHART ELEMENTS

3. (Optional) Type a description.

4. C(lickOK.
The new chart is listed on the Strategy Tree under the Charts folder, and the new chart window appears.
Block 0, the starting block, is shown automatically. No matter how many other blocks you add or where
you place them, block 0 is always the first block to be executed in the chart.

— New_Chart

(LAl T2 Ghart f

NOTE: Because chart windows show a small portion of a potentially large chart, a small movement with the
scrollbar can mean a big change in what you see. If you lose your flowchart in the window, select View > Center
on Blockand choose the block you want to see in the middle of the screen. Or just right-click inside the flowchart
and choose Center on Block from the popup menu.
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Chart Components

Charts can contain five kinds of flowchart blocks, lines connecting the blocks, and text.

Action Blocks are rectangles that contain one or more commands (instructions) that do the work of the
strategy, such as turning things on or off, setting variables, and so on. See “9: Using Variables and Commands”
for more information. Action blocks can have more than one entrance but only one exit.

Condition Blocks are diamonds containing questions that control the logical flow of a strategy. Condition
blocks can have many entrances, but only two exits: True and False.

OptoScript Blocks are hexagons containing OptoScript code, a procedural language you may want to use to
simplify certain tasks. See “11: Using OptoScript” for more information. OptoScript blocks can have more than
one entrance but only one exit.

Continue Blocks are ovals that contain no commands, but simply route chart logic to a new location, such as
to the top of a chart. These blocks help keep charts neat by avoiding awkward connections between two
blocks that are far apart.

Sync Blocks are used in charts that control systems with controller redundancy. When a sync block is
encountered, the redundant controllers are synchronized. For more information, see the SNAP PAC Redundancy
Option User's Guide (form 1831).

Connections are lines with arrows that connect one block to the next, directing the flow of strategy logic.
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Text explains the chart’s purpose and elements for anyone who needs to understand them later.

Using the Drawing Toolbar

The drawing toolbar includes tools for each of the elements plus a Select tool, or pointer, for manipulating
elements:

Action block
OptoScript block
Condition block
L ifontnue block
Se\ect Te><t

Con nect

Changing the Appearance of Elements in a Chart Window

You can change the background appearance of charts or subroutines, the color and size of blocks and text,
and the color of connection lines. Depending on the scope you want to affect, you can change these window
properties at three levels:

«  Across PAC Control—to change the appearance of all new charts in all new strategies, and all new
subroutines.

«  Across a strategy—to change the appearance of all new charts in the open strategy.

«  Forthe open chart or subroutine—to change the appearance of all new elements in the open chart or
subroutine window.

IMPORTANT: Note that most changes affect only new charts and their elements. Existing charts, subroutines, and
elements are not changed. To avoid having to go back and change each item individually, make sure you set the
defaults the way you want them before you create new charts. Once you have changed the defaults, see “Changing
Existing Elements to Match New Defaults” on page 243 to change existing elements to match the new defaults.

To change the appearance of charts and elements, follow these steps:
1. Choose one of the following, depending on the scope you want to change:

- Tochange all new charts in all new strategies and all new subroutines, choose Configure > Default
Properties to open the Configure PAC Control Default Properties dialog box.

- Tochange all new charts in the open strategy only, choose File > Strategy Properties to open the
Configure Strategy Properties dialog box.

- Tochange new elements in the open chart or subroutine only, choose Chart > Properties or
Subroutine > Properties to open the Configure Chart Properties or Configure Subroutine Properties
dialog box.

The dialog box that opens looks like this, except that its title may be different.

Complete the fields as described in “Configure Chart Properties Dialog Box” below.

3. When you have made all the changes, click OK.
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Configure Chart Properties Dialog Box

A —+ BackgoundColor: [ Grid Color: [ Dizplay Block 1D [] Smooth Scroling
Action Block Parameters i
T wfidth: Height; Calar; l_ Fari: | Arial - 10 point Conne&
Condition Block Parameters
width: [9g Height: Calor; l_ Fant; | Arial - 10 point 'ILT:;: —

B — wfidth: Height; Calar; ’_ Fari: | Arial - 10 point %

Continue Block Parameters Alza Appiy Ta = |
Ll “Width: Height: Color; l_ Font; | Arial - 10 point [JPAC Control
[ Strateqy
[ [ &0l charts
C—1 win Height; Fart: | Arial - 10 point
[ ok [ cancel |[ Hep | [ Resstal—

Configure Chart Properties

Flowchart Parameters

OptaScript Block

Checkpairt Black

widh: (9% | Height [48 | Color ’_ Fart: | Arial - 10 point

A—Flowchart Properties. Specify general chart display in this area. To apply these changes to existing
charts as well as to new ones, click All charts in D.

To change the chart background color from the default of white, click the Background Color box. Choose
a new color from the Color dialog box.

To change the chart's grid color from the default of black, click the Grid Color box.
The grid and block ID numbers are displayed by default. To remove them, click Display Grid or Display
Block ID’s to remove the check mark.

To enable or disable smooth scrolling in a flowchart, click Smooth Scrolling; this option is disabled by
default.

B—Action Block Parameters. Define the appearance of action blocks, condition blocks, OptoScript
blocks, and continue blocks in this area. These changes affect new blocks only, not existing blocks. (To change
existing blocks, see “Changing Existing Elements to Match New Defaults” below.)

In the Width and Height fields, type the block size in pixels. For action and continue blocks, the default
width is 96 and the default height is 48; the minimum parameters are 48 (width) and 32 (height). For
condition blocks, the default height is 64. (Note that the numbers you enter are rounded down to be
evenly divisible by 16; for example, if you enter 81, click OK and then reopen the dialog box, the
parameter reads 80.)

To change the color of the blocks from the default, click the Color box.

To change block name text formatting, click the Font box. In the Font dialog box, change the font, font
style, size, effects, and color. The default font is black 10-point Arial bold.

To change text alignment, right-click the Font box and choose left, center, or right from the pop-up
menu.

To change the color of connection lines, click a Connection line at the far right. Choose the new color
from the Color dialog box.
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C—Text. Define width, height, and font of text blocks that appear as comments in a chart or subroutine.
Default width is 192; default height is 128; the minimum for both is 16. The default font is black 10-point Arial
bold.

D—AIso Apply To. To expand the scope of the changes you've made, click these boxes. Click PAC Control
to apply the changes to all new strategies and subroutines in PAC Control. Click Strategy to apply the changes
to all new charts in the current strategy. Click All Charts to apply the changes to all new charts and all new
graphic objects added to the current strategy.

Depending on which dialog box you are in and what is currently open, one or more of these options may be
grayed out. For example, if you are in the Configure PAC Control Default Properties dialog box, it is assumed
that the changes are to be applied throughout PAC Control, and that option is therefore grayed out.

E—Reset All. To reset all parameters and options to their factory default settings, click Reset All.

Changing Existing Elements to Match New Defaults

Once you have changed the defaults for the way elements appear in a chart, you can update existing blocks,
connections, and text to match.

CAUTION: When you update existing objects to match, you cannot undo the update.

1. Right-clickan empty space in the chart whose elements you want to change. Choose Select from the
pop-up menu. From the sub-menu, choose the item type you want.

For example, to select all action blocks, choose Select > Action Blocks.
2. Right-clickagain in the chart, and choose Properties > Copy from Default from the pop-up menu.
The color, size, and font of all selected items change to match the flowchart defaults.

Drawing Blocks

Action, condition, OptoScript, and continue blocks are all drawn the same way.
1. With the chart open and the strategy in Configure or Online mode, click the tool you want to use.
1 foran action block
< for a condition block
> foran OptoScript block
@ for a continue block.
As you move the mouse into the window, you see an outline representing the block.
2. Click where you want to place the block.
The new block appears.
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— New_Chart

(AL T2 Ghart f

3. (lickin another location to place other blocks of the same type. When you have finished using the tool,
click the right mouse button, click another tool in the toolbar, or press Esc.

Naming Blocks

1. With the chart open and the strategy in Configure or Online mode, click the Select tool ;' and click the
block to select it.

Right-click the block and choose Name from the pop-up menu.

#1 Name Block

=)
o]

Help

2. Inthe Name Block dialog box, type the name and click OK.

Renaming Blocks

1. With the chart open and the strategy in Configure or Online mode, click the Select tool I; ' and click the
block to select it.

2. Right-click the block and choose Name from the pop-up menu.
3. Inthe Name Block dialog box, change the name. Click OK.

Connecting Blocks

To connect blocks, start with the chart open and the strategy in Configure or Online mode. Remember that
action blocks and OptoScript blocks have only one exit, and condition blocks have two.

Action Blocks and OptoScript Blocks

1. Toconnect an action block or an OptoScript block to the next block in a program sequence, click the
Connect tool & .
2. First click the source block and then click the destination block.
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Although you can click anywhere inside the blocks to make a connection, the connection is attached at
the side closest to where you clicked. In the figure below, Block 0 is the source block and Block 1 is the
destination block:

— New_Chart

Block 0

W

< | >

(AL T2 Ghart /

To keep your charts neat, try to draw the most direct connections possible. To do so, after clicking the
source block, move your cursor out of the block at a point closest to its destination.

3. Tocreate a bend or elbow in a connection, click wherever you want the bend while drawing the
connection.
For example, to draw the connection in the following figure, we selected the Connect tool, clicked Block
0, moved the cursor out of the block to the right, clicked at point A, clicked again at point B, and then
clicked the right side of Block 1:

— New_Chart

Block 0

< | >

(AL T2 Ghart /

4. While you're still drawing a line, to delete an elbow you don't want, click the right mouse button once to
undo it.
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If you created several elbows, you can eliminate them in reverse order with repeated right mouse clicks. If
no more elbows remain and you right-click again, you delete the connection. Once you have completed
a connection, however, you cannot undo it this way.

Condition Blocks

1. To connect a condition block to the next block in a program sequence, click the Connect tool % .
2. Click the source block.

t Connection Type

[ True Connection H False Connection ” Cancel ]

3. Indicate whether you are drawing the True connection or the False connection, and then click OK.
4. C(lick the destination block you chose (True or False).

The connection is labeled T or F depending on its type.
5. Draw another connection to the second destination block.

Itis labeled the opposite exit type.

For example, the following figure shows the True and False connections from the condition block, Block
1. If the conditions in Block 1 are true, Block 2 is executed next. If the conditions in Block 1 are false, Block
0is executed next:

— New_Chart

-  Block0

Block 2
£ | >
(115 hortcuts
LT T2 chart /
Adding Text

One of the best places to put comments about a strategy is directly on its flowcharts. Start with the chart open
and the strategy in Configure or Online mode.

1. Toadd text to a chart, click the Text tool = .

When you move the mouse onto the chart, a rectangle representing the text area appears.
2. C(lick the mouse button and type your comments.

If you type in more text than the text frame holds, it expands in length.
3. When you have finished typing, click anywhere on the chart outside the text frame.

The frame becomes invisible, and only the text appears. To change the size or shape of the text block, see
“Resizing Blocks or Text Blocks” on page 249.
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4. (lickin another location to create another text frame, or release the tool by right-clicking in the chart or
choosing another tool from the toolbar.

Editing Text
1. With the chart open and the strategy in Configure or Online mode, click the Select tool I; .
2. Double-click the text block you want to change.
Ablinking cursor appears at the beginning of the text.
3. Change the text as needed.

You can use any standard Windows Ctrl key combinations when editing, including Ctrl+arrow keys and
Ctrl4+Home or End for navigation. You can also use Ctrl+X (cut), Ctrl+C (copy), and Ctrl+V (paste).

4. When you have finished changing text, click outside the text frame.

The text block stays the same width but changes length to accommodate additional or deleted text. To
change the size or shape of the text block, see “Resizing Blocks or Text Blocks”on page 249.

Selecting Elements

Before you can manipulate most elements, you need to select them. Start with the chart open and the
strategy in Configure or Online mode.

1. Clickthe Select tool I; .
2. Toselectan action, OptoScript, condition, continue, or text block, click the block.
Handles appear around the block:

—H
l> Handles
)

I‘L: Block25
.\ Y

3. Toselecta connection, clickit.
Handles appear at the elbows and end points of the connection:

—jl Block 0

Handles

1

I—FI Block 1

4, Toselect all connections entering or exiting a block, click the block, click the right mouse button, and
choose Select Connections from the pop-up menu.

5. To select more than one element, do one of the following:
- Select the first element, hold down the Shift key, and select additional elements.
- (lickand drag the mouse to draw a rectangle completely around the elements you want to select.

- Toselect all items of the same type, right-click anywhere in the window and choose Select from the
pop-up menu. From the sub-menu, choose the item type you want.

Moving Elements

1. With the chart open and the strategy in Configure or Online mode, click the Select tool i; .

2. Tomove any action, OptoScript, condition, continue, or text block, click it. Then click and hold the mouse
button anywhere on the selected item except on its handles, and drag it to the position you want.
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You can also use the arrow keys on your keyboard to move a block in any direction. Note that when you
move a block, any connections attached to it also move.

3. Tomove a connection, click it. Then click and drag any handle in any direction.

You can also move an end point from one block to another, as long as the result is a valid connection. A
disallowed move is ignored.

4. Tomove several elements at once, select them, and then click and drag them.

If elements end up stacked on top of each other, you may need to change their z-order before you can
move them. See the following section.

Moving Elements in Front of or Behind Other Elements (Changing Z-Order)

If elements are stacked on top of each other, you can select only the one in front. To change their position
(z-order), follow these steps:

1. Clickthe element to select it.

2. Right-click the element. From the pop-up menu, choose Z-order. From the sub-menu, choose the action
you want to take:

- Bring Forward—moves the element one position closer to the front.
—  Bring To Front—moves it all the way to the front.

- Send Backward—moves the element one position closer to the back.
- SendTo Back—moves it all the way to the back.

Cutting, Copying, and Pasting Elements

You can cut, copy, and paste most chart or subroutine elements. Cut or copied elements are placed on the
Windows Clipboard, and they can be pasted in the same chart or subroutine, in a different chart or subroutine,
orin a different strategy.

A connection can be cut or copied, but it cannot be pasted unless its original source and destination blocks
have also been pasted. Block O cannot be cut.

1. With the chart open and the strategy in Configure or Online mode, click the Select tool i; .
2. Tocutorcopy element(s), click them. Press Ctrl+X to cut or Ctrl+C to copy.

You can also select the element(s) and then click Edit > Cut or Edit > Copy, or click the right mouse
button and choose Cut or Copy from the pop-up menu.

3. Topaste blocks, press Ctrl+V. You can also paste by clicking Edit > Paste, or right-clicking anywhere on a
chart and then select Paste from the pop-up menu.

Text blocks are pasted immediately. For action, condition, or continue blocks, a message appears asking if
you want to keep the original name of the block being pasted.

If you paste to a different strategy or to a subroutine, PAC Control checks the referenced variables to make
sure they match. Variables that do not exist are created. Variables that exist but are different—for
example, a table with the same name but a different table length—are noted in a log file that appears
when the paste is complete.

Deleting Elements

1. Make sure the chart is open and the strategy is in Configure or Online mode.
2. Clickthe Select tool | i: . Click the element(s) to select them.

CAUTION: Make sure you have selected the element you want. You cannot undo a deletion!

3.  Press Delete.

You can also select the element(s), right-click them, and select Delete from the pop-up menu. Block 0
cannot be deleted. If you delete a block, you'll be asked to verify the deletion.
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Changing Element Color and Size

You can change the colors and sizes of blocks, connections, and text in your chart. To change one element (for
example, the color of one block), use the steps in this section. To change more than one at a time, see
“Changing the Appearance of Elements in a Chart Window”on page 241.

Start with the chart open and the strategy in Configure or Online mode.

Resizing Blocks or Text Blocks
1. Clickthe Select tool I;  and click the block to select it.

2. (lickone of the handles, then drag it in the direction you want. To resize horizontally and vertically at the
same time, drag a corner handle.

Changing Block Colors

1. Clickthe Select tool 1;  and click the block to select it.

2. Right-click the block and choose Color from the pop-up menu.
3. Pick the color you want and click OK.

Changing Text

You can change the size, font, font style, or color of the text in any block.
1. Clickthe Select tool i: ' and click the block to select it.

2. Right-click the block and choose Font from the pop-up menu.

3. Inthe Font dialog box, make the changes you want. Click OK.
4

To change whether text appears at the left, the center, or the right of a block, select the block and click
the right mouse button. From the pop-up menu, choose Justify; from the sub-menu, choose Left, Center,
or Right.

Changing an Element Back to the Defaults
1. Select theitem and click the right mouse button.
2. From the pop-up menu, choose Properties. From the sub-menu, choose Copy from Default.
To change defaults, see “Changing the Appearance of Elements in a Chart Window”on page 241.

OPENING, SAVING, AND CLOSING CHARTS

Opening a Chart

Make sure the strategy is open. In the Strategy Tree, double-click the chart you want to open.

You can also open a chart by selecting Chart > Open, and then double-clicking the chart name in the Open
Chart dialog box, which lists all charts that are not currently open.

If a chart is open but not visible on the screen, click the chart’s name tab at the bottom of the window to make
it visible.

Saving a Chart

1. Make sure the chartis open and is the active window.
2. From the Chart menu, choose Save.

Charts are automatically saved when you choose File > Save All. If you choose File > Save Strategy or click the
Save Strategy icon gl on the toolbar, you can choose which charts to save in the Save Strategy dialog box.
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Closing a Chart

To close a chart, click the close box in the upper-right corner of the chart's window (not the PAC Control
window). You can also close a chart by pressing Ctrl+F4 when the chart window is active. If you have made
changes to the chart, you are prompted to save them.

COPYING, RENAMING, AND DELETING CHARTS

Copying a Chart

If an existing chart is similar to one you want to create, it is easier to copy it than to create a new one from
scratch. To copy a chart in the same strategy, follow the steps in this section. To copy a chart to another
strategy, see “Exporting and Importing Charts”on page 251.

1. With the strategy open and in Configure mode, select Chart > Copy.
The Copy Chart dialog box appears.

Copy Chart rg|
Fram Ta
M arme: M amne:
flams 14 | |
Description: Description:

Check the E-Stop buttan ¢
the twia level alarms.

[ 0k, H Cancel ” Help ]

In the From field, choose the chart you want to copy from the drop-down list.
3. IntheTofield, enter a name for the new chart.

The name must start with a letter and include only letters, numbers, or underscores. (Spaces are
converted to underscores).

. (Optional) Enter a description for the new chart.
5. (Click OK.
The new chart is created and appears as the active window on the screen.

Renaming a Chart

1. Make sure the strategy is in Configure mode and that the chart you want to rename is the active window.
2. From the Chart menu, choose Rename.
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1 Rename Chart

X

Description:

Contrals sprinklers for the front lavn.

I Ok H Cancel ][ Help ]

3. Enteranew name and description (optional). Click OK.
The chart is renamed.

Deleting a Chart

You can delete any charts except for the Powerup chart. However, you cannot delete a chart if it is called or
used by another chart in your strategy.

1. Make sure the strategy is open and in Configure mode.

2. Inthe Strategy Tree, right-click the name of the chart you want to delete and choose Delete from the
pop-up menu. Or, if the chart is the active window, choose Chart > Delete.

3.  Atthe confirmation message, make sure you are deleting the correct chart.

CAUTION: You cannot undo a deletion!

4. C(lick Yes to delete the chart.

The chart window disappears (if it was open), the chart is removed from the Strategy Tree, and the
strategy is saved.

PRINTING CHARTS

You can print any flowchart. To print a chart as it appears on the screen, see “Printing Chart or Subroutine
Graphics”on page 224.To print commands (instructions) for the chart, see “Viewing and Printing Strategy or
Subroutine Commands”on page 226.

EXPORTING AND IMPORTING CHARTS

To copy a chart to another strategy, you must export it as a PAC Control chart export file (.cxf file) and then
import it into the strategy where you want it.

Exporting a Chart

1. With the strategy open and in Configure or Online mode, choose Chart > Export.
The Export Chart dialog box appears.
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Export Chart fg|
From To
Mame: Mame:

Sprinkler_Control | | [§elect... ]

Diescription: D escription:

Controls sprinklers for the front
lawn.

[ Ok H Cancel H Help ]

2. Inthe From section of the dialog box, select the chart to be exported from the Name drop-down list.
3. IntheTo section of the dialog box, click Select.

Select Destination for Export File

Save jn; | .3 PAL Contral v | Q ? s [~
File name: || | [ T l
Save a bype: | PAC Control Chart Export Files [*.cxf] “ | [ Cancel ]

4. Navigate to where you want the exported chart file to be saved. In the File name field, enter a name for
the exported chart. Click Save.

You return to the Export Chart dialog box, which now shows the path and file name in the To section.
5. (Optional) Enter a description for the new chart.
Click OK.

The exported chart is saved. You can import it into any PAC Control strategy. See the next section for
information on importing charts.
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Importing a Chart

Use the Automatic Chart Import dialog box to import a chart previously exported. Also see “Exporting a Chart”
on page 251.

1.  With the strategy open and in Configure mode, choose Chart > Import.
The Automatic Chart Import dialog box appears.

Automatic Chart Import

() Beplace existing chart
To
i M arne:
| | [§elect... ] |
Description: D escription:
[ QK l ’ Cancel ] ’ Help ]

2. Atthetop of the dialog box, click Create new chart or Replace existing chart.

CAUTION: If you choose Replace existing chart, the old chart will be completely overwritten with the chart
you are importing.

3. (lick Select. Navigate to the exported chart. Click OK.
In the To section of the dialog box, enter a name for the new chart.
If you wish, enter a description. If you are replacing an existing chart, select it from the list. To copy the
imported chart description, select the text in the left description field, copy it, and paste it in the right
description field.

5. (Click OK.
The chart is imported. A Chart Import Report window shows you how the tags in the chart match with
those already in the strategy. Any tags from the chart that do not already exist in the strategy are created
and added.
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9: Using Variables and
Commands

INTRODUCTION

This chapter discusses the seven types of variables used in PAC Control: numeric, string, pointer, numeric table,
pointer table, string table, and communication handle variables.

This chapter also shows you how to use the commands, or instructions, in PAC Control and discusses the
mechanics of adding commands to your strategy flowcharts.

«  For command information to help you program your strategy effectively, see Chapter 10: Programming
with Commands.

«  Tofind out how to use commands in OptoScript code, see Chapter 11: Using OptoScript.

«  Foralist of all standard PAC Control commands and their OptoScript equivalents, see Appendix E:
OptoScript Language Reference.

In This Chapter

ADOUEVAMADIES .o
Variables in PAC CONTIOL...ovvveevveveesvevess s ssssssss s s
Adding Variables
PUDIIC ACCESS oo s ssss s ssssssss s
Changing a Configured Variable.....
Viewing Variables in Debug Mode
Adding Commands........mnn.
Changing @ COMMANG ...vevevvoreens v sssssss s s
Deleting a Command
Cutting or Copying @ COMMANT ..ccoccvvvrvevessssvvnsssssssssssessssssssne
Configuring @ Continue BlOCK........cvoveveeesvevessves s

Viewing and Printing Chart INStruCtioNS ... eeeereeseessneene page 283

ABOUT VARIABLES

As Chapter 2 mentions, variables store pieces of information in a strategy. You create a variable for each piece
of information in your control process that must be acted upon. These pieces of information might include the
name of a chart, the on or off state of a switch, communication parameters for a peer on the network, or a
table that holds a series of numbers.

Each variable has a name and a value. You assign the variable’s name in plain English, so you know what it is.
The variable’s value is the current information it represents. As a strategy runs, the variable’s name remains the
same, but its value may change. For example, the name of the variable Oven_Temperature stays the same, but
its value (the temperature of the oven) may change several times while the strategy is running.
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To illustrate variables, suppose you are regulating the amount of

water in a tank. You must keep the tank filled beyond a minimum ©

level, but you cannot let it get too full.
Level_ ="

You've already configured the I/0 points: Meter Pump_1

Level_Meter is an analog input point that registers the (Tank)

quantity of water in the tank.

Pump_1is a digital output point that turns the pump on or
of. o
Drain_1 is a digital output point that opens or closes the Drain_1

drain.

Next, you configure variables as places to hold information that these I/O points must work with:

To avoid constantly polling Level_Meter to find out the quantity of water in the tank, you create a variable
called Tank_Level_Reading in which to store the level. The input point Level_Meter is periodically
checked and the value of Tank_Level_Reading updated.

To establish the maximum and minimum levels, you create variables called Tank_Max_Level and
Tank_Min_Level. The value in Tank_Level_Reading can be compared to the values in these two variables
to determine whether the pump should be turned on or off, or the drain opened or closed, to maintain
the proper level. (You could create constant values, called literals, for the minimum and maximum levels,
but creating them as variables lets you change their values in Debug mode.)

Types of Data in a Variable

A variable stores one of six types of data: floating point, integer, timer, string, pointer, or communication
handle. When you create the variable, you designate the type of data it contains. It is always best to choose
the most appropriate data type for the information you are storing. PAC Control can store an integer in a
floating point variable, but it has to convert the data first. Unnecessary data conversions take up processor
time.

Numeric data stores numbers and can be one of the following types:

- Afloating point (or float) is a numeric value that contains a decimal point, such as 3.14159, 1.0, and
1,234.2. A good example of a float variable is one that stores readings from an analog input such as
a thermocouple. PAC Control uses IEEE single-precision floats with rounding errors of no more than
one part per million.

- Aninteger is a whole number with no fractional part. Examples of integer values are -1, 0, 1,999,
and -4,568. The state of a switch, for example, could be stored in an integer variable as 1 (on) or 0
(off).

Most integers used in PAC Control are 32-bit signed integers (usually referred to as an Int 32)
which have a range from -2,147,483,648 to 2,147,483,647. These 32-bit integers should be used for
general integer use, such as status variables, mathematics, and indexes.

64-bit signed integers (also known as an Int 64) are used for values larger than an Int 32 can
handle. The range of an Int 64 is from -9,223,372,036,854,775,808 through
0,223,372,036,854,775,807.

- Atimer stores elapsed time in units of seconds with resolution in milliseconds. Up Timers count up
from zero, and Down Timers start from a value you set and count down to zero. Timers can range
from 0.001 t0 4611686 x 10'°.

A string stores text and any combination of ASCII characters, including control codes and extended
characters. For instance, a string variable might be used to send information to a display for an operator
to see. A string variable is also used to set parameters for peer-to-peer communication. When defining
most string variables, you must specify the width of the string. The width is the maximum number of
characters that the variable may hold.
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A string variable can contain numeric characters, but they no longer act as numbers. To use them in
calculations, you must convert them into floating point or integer numbers. Conversely, a numeric value
to be displayed on a screen must first be converted into a string.

A pointer does not store the value of a variable; instead, it stores the memory address of a variable or
some other PAC Control item, such as a chart or an 1/0 point. You can perform any operation on the
pointer that you could perform on the object the pointer points to. Pointers are an advanced
programming feature and are very powerful, but they also complicate programming and debugging.

A communication handle stores information used to communicate with other entities, for example
other devices on the network or files that store data. The communication handle’s value is a string
containing the parameters needed to make a connection with a specific entity. For outgoing Ethernet
communication, for example, these parameters usually include the protocol, the IP address of the device
you are communicating with, and the port number used on the device.

After the initial connection is made, the communication handle is referenced during communication
with the entity, and then used to close communication.

Variables in PAC Control

In PAC Control there are seven types of variables:

Numeric

Numeric table

String

String table

Pointer

Pointer table
Communication handle

Numeric, string, and pointer variables contain individual pieces of data. Numeric table, string table, and
pointer table variables contain several pieces of related data in the form of a table. (A programmer would
know this type of data structure as an array.) Communication handle variables contain parameters used by
PAC Control for communicating with other devices and files.

Table Variables

In a table variable, the variable name represents a group of values, not just one. Table variables are
one-dimensional arrays, which means that each table is like a numbered list of values. You refer to each item
in the list by its number, or index. Indexes start at 0, not at 1. Here are two table examples:

In a float table, values are floating point numbers:

Index Value

0 82.0
1 86.1
2 85.0
3 74.8
4 723
5 72.7
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In a string table, values are strings:

Index Value

0 Maria
1 Tom
2 Siu
3 Andre

When you define a table, you must specify its length, which is how many values the table can store. The
length of a table is NOT the value of the last index. Since indexes start at 0, a table with a length of 100
contains indexes 0 through 99. Table length is limited only by the amount of memory in the control engine.
For more information on available memory, see “If You Have Memory Problems” on page 416.

Numeric tables store either integer values or floating point numbers (but not both in the same table). String
tables store strings. Because pointers can point to any data type (for example, an I/0 point, a chart, or even
another table), pointer tables can store an assortment of data types.

Persistent Data

Most variables can be either global or persistent in scope. Global variables are set to an initial value (which you
specify during configuration) either whenever the strategy is run or whenever it is downloaded.

A persistent variable, however, is initialized only the first time a strategy containing that particular persistent
variable is downloaded. Numeric variables (and tables) are initially set to 0. String variables (and tables),
pointer variables (and tables), and communication handles are initialized as blank, or empty. The key point
about a persistent variable is that its value is saved in the controller’s battery-backed memory; it does not get
re-initialized when the strategy is run, stopped, or started, and it does not get re-initialized if the strategy is
modified and downloaded again. A persistent variable’s value is retained until one of these events occurs:

«  Astrategy with a different name is downloaded.
«  The RAM on the controller is cleared.
«  New firmware is downloaded to the controller.
»  Astrategy download is canceled during the download process.
«  The persistent object is changed as follows:
- Apersistent table's length (integer, 64-bit integer, float, and string) was modified (either longer or
shorter).
- Apersistent string variable's width was modified.
- Apersistent string table's width was modified.

- Anpersistent variable's type has changed. For example, a persistent float variable is deleted and a
new persistent integer variable is created with the same name.

Persistent data can be very useful in certain situations. For example, suppose you have a PID setpoint that is
fine-tuned as your process runs. If the setpoint is configured as persistent, its value won't be lost if you must
re-download the strategy after making a program change.

Pointer variables, pointer tables, and timers are not allowed to be persistent; but all other variables and tables
can be. Persistent variables cannot be configured on-the-fly.

Literals

Aliteral is used like a variable, but it is constant data that never changes. A literal has no variable name, only a
fixed value, which may be a floating point number, an integer, or a string.

If you are using subroutines, see the information on literals in “Data Types for Subroutines”on page 402.
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See also “Setting Initial Values in Variables and Tables During Strategy Download” on page 266.

1. With the strategy or subroutine open in Configure mode, choose Configure > Variables.

The Configure Variables dialog box opens. This dialog box lists all the variables in the strategy or

subroutine that are of the type shown in the Type field. You can sort the data in this dialog by clicking any
of the column headers.

# Configure Variables X
Type:  Numeric Variables v | Scope: |Global -

Mame Type Init Type Init Value  Public Access  RefCount  Description Add...
Button_LED_Breath_Delay Integer 32 Run 120 32 _m
CAISO_Spot Price Float Persistent 1] 2
DigDelay Integer 32 Run 25 16 Delay amount for dig... Delete
Grid_Frequency Float Run 0 Enabled 0
nrAirTemperature Float Run 0 Enabled 1
nrilfindDirection Integer 32 Run 0 Enabled 1
nrivindSpeedMoh Float Run a Enabled 1 Wind soeed from We...

Close Help
2. Inthe Type drop-down list, choose the type of variable you want to configure.
If you select a type of Table, the column headings in the dialog box change depending on the table type.
# Configure Variables X
Type: | String Tables v | GScope: |Global hd

MName Init Type Length Width Public Access Ref Count Description Add...
CAISO_Data Persistent 3 64 Enabled [ Modify...
stWeatherData Persistent 16 128 a Weather Da

I Delete

Close Help

3. Ifyou are adding the variable to a subroutine, select Subroutine in the Scope drop-down list.

4. Toaddanew variable, click Add.

The Add Variable dialog box is displayed.

5. Complete the fields as described in “Add Variable Dialog Box".

6. ClickOK.

The Add Variable dialog box closes and the new variable appears in the Configure Variables dialog box.

Add Variable Dialog Box

The fields in this dialog box depend of the type of variable you select. The image below shows the dialog box

for a string variable.
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Add Variable *
A—— MName: | |
B__ Description: | |
C— Type: Integer 32 Table ~ | Table Length: D

Initialization
T Initialize on strategy download .
E< (@) Initialize on strategy run Fields at D and G can
differ depending on
Persistent

variable type.

F————nitial value: | 0

Public Access (Optional)

# Public Access Attribute Representations Add G
Maodify

Remove

Cancel Help

The fields in this dialog box depend of the type of variable you select. The image below shows the dialog box
for a string variable.

Add Variable k4

A— MName: | |
B —— Description: | |
C—F Tvpe: String | String Width: D

Initialization

| —_) Initizlize on strateqy download )
E< s Fields at D and G can
bersistent differ depending on
ErsistEn variable type.

F——Init’al Value: | |

Public Access (Optional)

[Imake Public (Readable) Allow Write Capability G

Corcel | [ i

And this image shows the dialog box for an Int 32 table variable.

A—Name. Enter a name for the variable. The name must start with a letter and may contain letters,
numbers, and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the variable.
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C—Type. In the Type drop-down list, select the type of data for the variable. Possible types are shown in the
following table. For more information, see “Types of Data in a Variable”on page 256.

Variable Possible Data Types

Numeric Integer 32, integer 64, floating point, up or down timer

Numeric table Integer 32, integer 64, or floating point

String String

String table String

Pointer Pointer to any data type

Pointer table Pointer to any data type, and the data type may change over time
Communication handle Communication handle

D—The fields in this area of the dialog box depend on the variable type. Available fields are:

String Width: Enter the maximum number of characters permitted in the string. The number must be an
integer between one and 1024. The greater the number, the more memory required to store the string.

Table Length: Enter an integer between 1 and 1,000,000 representing the number of elements in the table. The
greater the number, the more memory required to store the table.

Pointer to Type: From the drop-down list, select the type the pointer points to. Note that void pointers are not
allowed; a pointer must point to a specific type. Also note that you cannot point a pointer to another pointer;
PAC Control has only one level of indirection for pointers. If you try to point to a pointer, PAC Control assigns to
the new pointer the address of the object being pointed to.

E—Initialization. (For all variables except up timers and down timers)
Select one of the following:

Initialize on Strategy Run: Sets the variable to the initial value (F) each time the strategy is run (either manually
from the debugger or automatically via the autorun flag).

Initialize on Strategy Download: Sets the variable to the initial value (F) only when a strategy is downloaded.
The variable retains its current value when the strategy is stopped and then run again, either through the
debugger or autorun. It also retains its value if power is cycled. Note that this choice means the variable is
stored in battery-backed RAM, which is limited in size. To keep a variable’s current value through both power
cycles and strategy download, make the variable a persistent variable (see the Persistent option below and
“Persistent Data” on page 258). See also “If You Have Memory Problems”on page 416.

Persistent. (Not applicable to pointer variables, pointer tables, and timers.) Data in the variable, including data
in tables will be persistent. For details, see “Persistent Data”on page 258.

The following table shows how your choices about variable initialization and persistence affect what happens
to variables (applies to all variables and tables except up timers and down timers).

What happens to the variable’s value when...?

Variable Strategy stops, then starts

Same strategy is

(through debugger or Power is cycled downloaded

autorun)

Variable initialized on

Set to initial value Set to initial value Set to initial value
strategy run (default)
Variable initiali n . .
ekl milfellzed @ Retains current value Retains current value | Set to initial value
strategy download
Persistent variable Retains current value Retains current value | Retains current value
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F—Initial Value. (For all variables except pointers, up timers, and down timers) Enter the value to which
the variable is to be set initially. You can use either decimal or hexadecimal form. If you leave this field blank,
the initial value is set to zero.

For tables, each value in the table is set to the initial value. You can set individual table elements to differing
values initially in the Powerup chart. To use an initialization file to initialize the values on strategy download,
see “Setting Initial Values in Variables and Tables During Strategy Download” on page 266.

For pointer variables: When you have selected the Pointer to Type, the drop-down list in this field shows
all the valid objects for that type that are currently defined in your strategy. Choose one or leave the initial
value as NULL. A NULL value means that the pointer is created but does not initially point to anything.

For communication handles: Enter a string containing communication parameters in the correct format
for the type of communication handle you are using. The type (for example, tcp, ftp, £ile) must bein
lowercase letters, and parameters are separated by colons and commas according to the format required. See
“Communication Commands”on page 288 for information and examples.

«  Tocommunicate with a serial module, use the IP address of the brain the module is attached to, and use
the serial module’s port number according to its position on the rack, for example:
tcp:10.192.55.185:22502. For port numbers, see “Establishing an Ethernet Connection”in the SNAP Serial
Communication Module User’s Guide (form 1191). See also, TCP and UDP Port Assignments (form 1940).

«  Tocommunicate with another SNAP PAC brain, be aware of port numbers that are reserved for a specific
protocol. For more information, see TCP and UDP Port Assignments (form 1940).

«  Forother peers on the Ethernet network, be aware of port numbers they may use for specific purposes.
Ports 22000 and 22001 are reserved for the control engine. For a list of standard Ethernet port numbers,
refer to http://www.iana.org/assignments/port-numbers. See also, TCP and UDP Port Assignments
(form 1940).

« Ifyouare using the Accept Incoming Communication command to listen for communication requests,
leave out the IP address and use the following format: tcp:port

G—Public Access (Optional). This option allows the variable to be accessed by certain third-party
applications. By default, public access is disabled. For more information, see “Public Access”on page 265.

The fields for this option depend on the type of variable. If the dialog box shows check boxes for Make Public
(Readable) and Allow Write Capability:

»  Select Make Public Readable to allow the point to be read by certain third-party applications.

«  Select Allow Write Capability to allow the applications to write to the point. Note that you must make the
point public (readable) before you can allow writing.

| . ! » v O
Public Access (Optional)
[IMake Public (Readable) Allow Write Capability

Cancel Help

If the dialog box has a blank pane and buttons for Add, Modify, and Remove, follow these steps:

TIP: To enable the Add button, type a name for the variable in the Name field.

If the variable is a table, you must also enter the table length.

If the variable is a string table, you must also enter the table length and string width.
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# Public Access Attribute Representations

Add
Modify

Remove

Cancel | | Heb

Click the Add button. The Add Public Access Attribute Representation dialog box is displayed.

Note: The fields are the same on this dialog box and on the Edit Public Access Attribute Representation dialog

box.

‘t Add Public Access Attribute Representation

bed

MName: RPi_Switch_Control

Type: Integer 32

[IMake Public (Readable)

Allow Write Capability

Represent As:  (Integer 32

oK Cancel

Select Make Public (Readable). The Allow Write Capability and (for some variables) Represent As options

are now available to select.

i Add Public Access Attribute Representation

bes

MName: RPi_Switch_Control

Type: Integer 32

Make Public (Readable)

[ allowe Wirite Capability

Represent As: :Inheger 32 s

0K Cancel

(Optional.) Select Allow Write Capability to allow other applications to write to the variable.

(Optional.) If the variable’s data type allows you to represent the data to the other system as a different
type, you can select a different type from the Represent As list.

For a list of data representation options by variable type, see “Public Access”on page 265.
This image shows how to configure public access for a specific bit in an Int 32:
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3 S bl = ——
Represent As: .One Bit 5
Eit Position:
| Cancel

This image shows how to configure a specific range of elements in a table:

W W iz . "

Represent As: |Range of Elements ~

Start Index: l:l
End Index: l:l

| Cancel

This image shows a specific bit of an element in a table:

~ e, ~ o

Represent As: | One Bit of One Element ~

Table Index:
Eit Position:

Cancel

For alist of data representation options by variable type, see “Public Access” on page 265.

5. Repeat steps 3 and 4 to create different combinations of public access and data representations. For
details, “Public Access” on page 265.

6. When you've finished, click OK to close the dialog box and save the settings.
The image below shows an Int 32 variable that's been configured with different public access setting for
two different bits.
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Add Variable x

Mame: | RPi_Switch_Control |

Description: | |

Type: Integer 32 %
Initialization
(O Iniitizlize on strategy download

(®) Initialize on strategy run
O Persistent

Initial Value: | 0

Public Access (Optional)

Add
1 Readable; Bit: 4
2 Readable, Allow Writing; Bit: 8
Remove

QK Cancel Help

To change a representation, select it in the list, and then click Modify. The Edit Public Access Attribute
Representation dialog box is displayed. It has the same fields as the Add Public Access Attribute
Representation dialog box.

To delete a representation, highlight it in the list, and then click Delete.

PUBLIC ACCESS

(Applicable to PAC Control R10.a and higher.) Public access is an option that allows applications using the
Sparkplug specification for MQTT (such as Ignition by Inductive Automation) or the groov EPIC and SNAP PAC
Driver module by Cirrus Link Solutions' to read and write to PAC Control tags. Ignition can even detect
publicly accessible PAC Control tags automatically; this means you don't need to manually add tags to an
Ignition HMI.

NOTE: When reading PAC Control R10.0a (or higher) tag names with Ignition Edge for groov, be sure to:
Configure tags with public access from within PAC Control.
Use version 3.4.1 (or higher) of the Opto 22 groov EPIC and SNAP PAC Driver.

For details, see KB87534.

By default, PAC Control disables public access to tags. You can allow public access when you add or edit a
point or variable in a PAC Control strategy. You can make the tag readable, or readable and writable.
(Exception: Up and down timers are readable only.)

"For more information about the groov EPIC and SNAP PAC Driver module, see the Cirrus Link documentation website:
https://docs.chariot.io/display/CLD/Opto+22+groov+EPIC+and+SNAP+PAC+Driver.
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SETTING INITIAL VALUES IN VARIABLES AND TABLES DURING STRATEGY DOWNLOAD

Some variables also let you select the data type to be represented in the other system. For example, you can
choose to send the value of a specific Integer 32 variable to the other system as an Int 32, or as a Boolean
(where 0 is False and non-zero is True), or you can send only one of the Int 32's bits to represent a Boolean.

The options for data representations differ by variable type:

Variable

Data type

Data representation

type*
String

String Table

Numeric

Numeric
Table

options
String None Strings are 7-bit ASCII format
All Elements All elements in the table are accessible
String Table Range of Elements Only elements in the range are accessible
One Element Only the specified element is accessible
Integer 32
Integer 32 Boolean 0 is False; any non-zero number is True
One Bit 0 is False; 1 is True
Integer 64
Integer 64
One Bit 0 is False; 1is True
Float None
Up/down timer | None Timers are read-only
All Elements All elements in the table are accessible

Integer 32 Table

Range of Elements

Only elements in the range are accessible

One Element

Only the specified element is accessible

One Bit of One Element

Only the specified bit of the specified ele-
ment

Integer 64 Table

is accessible
All Elements See Integer 32 Table
Range of Elements See Integer 32 Table
One Element See Integer 32 Table

One Bit of One Element

See Integer 32 Table

Float Table

All Elements

See Integer 32 Table

Range of Elements

See Integer 32 Table

One Element

See Integer 32 Table

*Public access is not an option for pointers, pointer tables, and communication handle variables.

SETTING INITIAL VALUES IN VARIABLES AND TABLES DURING STRATEGY

DOWNLOAD

When you are adding table variables in PAC Control, you can set all table elements to one initial value in the
Add Variables dialog box. If you want to set each individual table element to its own value, however, you need
to create an initialization file and download it with your PAC Control strategy.

In addition to setting initial values for table elements, sometimes it is easier to initialize all variables during
strategy download using an initialization file.

This section shows you how to create an initialization file and download it with your strategy.
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Creating the Initialization File

A sample initialization file, Init.txt, is copied to the local hard drive when you install PAC Control. The file’s
location is C:\Users\Public\Documents\Opto 22\PAC Project <version number>\Control Basic Examples <or
Control Pro Examples, if you have PAC Control Professional>\InitVariables.

You can open this file with a text editor to see the proper syntax for each initialization entry, and then modify it
as necessary for your strategy.

IMPORTANT: Every initialization file should include the following line near the top:

\ ""DOWNLOAD COMPRESSION OFF

Make sure to enter a backslash and a space at the beginning of the line. Download compression removes the
newlines necessary for string initialization. This line tells PAC Control to turn off download compression so strings can
be initialized.

IMPORTANT: Each file must end with a carriage return so that the last line in the file is blank, and each line within
the file must end with a carriage return. If you add comments to the file, they must be preceded by a backslash (\) and
aspace.

Text Examples

NOTE: Variable names are case-sensitive and can include both upper- and lower-case letters.

Integer Example. To set an initial value of 123 for the variable INTEGER_VARIABLE, you would include the
following text in the initialization file:
123 ~INTEGER VARIABLE @!

Float Example. Floating point values must contain a decimal point. To set an initial value of 456 for the
variable FLOAT_VARIABLE, you would include the following text (with the decimal point and zero) in the
initialization file:

456.0 ~FLOAT VARIABLE @!

String Example. To set an initial value of “String Variable Test String” for STRING_VARIABLE, you would
include the following text in the initialization file. The spaces and newline are very important:
*STRING VARIABLE $INN

String Variable Test String

Communication Handle Example. To add the parameters of a communication handle named
COMM_Handle, you would include the following text in the initialization file. The spaces and newline are very
important.

*COMM Handle S$SINN

tcp:10.0.0.1:1000

Pointer Example. To have the pointer PTR_POINTER_VARIABLE point initially to INTEGER_VARIABLE, you
would include the following text in the initialization file:
~INTEGER VARIABLE MoveToPointer PTR POINTER VARIABLE

Integer 32 Table Example. To set initial values of 10, 20, 30, 40, and 50 for elements zero through four of
an integer table named My_Int_32_Table, include the following text:
10 0 }My Int 32 Table TABLE!

20 1 }My Int 32 Table TABLE!
30 2 }My Int 32 Table TABLE!
40 3 }My Int 32 Table TABLE!
50 4 }My Int 32 Table TABLE!
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Integer 64 Table Example. To set initial values of 10, 20, 30, 40, and 50 for elements zero through four of
an integer table named My_Int_64_Table, include the following text:

10.. 0 }My Int 64 Table 2TABLE!
20.. 1 }My Int 64 Table 2TABLE!
30.. 2 }My Int 64 Table 2TABLE!
40.. 3 }My Int 64 Table 2TABLE!
50.. 4 }My Int 64 Table 2TABLE!

Float Table Example. For afloat table, the initial values must include a decimal point. To set initial values of
1.1,2.2,3.3,44,and 5.5 for elements zero through four of a float table named My_Float_Table, include the
following text:

.1 0 }My Float Table TABLE!

}My Float Table TABLE!

}My Float Table TABLE!

}My Float Table TABLE!

}My Float Table TABLE!

g w N
g W DN
Sw N

String Table Example. To set initial values of “zero’,“one”, “two’, “three”, and “four” for elements 0-4 of a
string table named My_String_Table, include the following text. Make sure you turn off download
compression and use new lines as shown:

0 {My String Table STABLE@ S$INN

zero

1 {My String Table S$TABLE@ S$SINN

one

2 {My String Table $TABLE@ SINN

two

3 {My String Table STABLE@ S$SINN

three

4 {My String Table S$TABLE@ SINN

four

Pointer Table Example. Each index in a pointer table points to another item within the strategy, for
example an 1/0 point, a variable, or a chart. Setting initial values for pointer tables means designating the
items the pointer table initially points to. For example, you would include the following text to have a pointer
table named My_Ptr_Table initially point to Oven_Temperature (a variable), Alarm_Handler (a chart),
Thermocouple (an analog input), Fuel_Pump (an analog output), and Fan_1 (a digital output):

“Oven Temperature 0 PTBL My Ptr Table TABLE!

&Alarm Handler 1 PTBL My Ptr Table TABLE!

~Thermocouple 2 PTBL My Ptr Table TABLE!

~Fuel Pump 3 PTBL My Ptr Table TABLE!

~Fan_1 4 PTBL My Ptr Table TABLE!

Special Characters in the Initialization File. Note that the initial character on each line of the
initialization file is a special character that identifies the object type. Possible characters include the following:

Character Object Type

A float, integer, or timer
* string
PTR_ pointer variable
~ I/0O point
& chart
} float table or integer table
{ string table
PTBL_ pointer table
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Character Object Type

% I/0 unit

Saving the Initialization File. \When you have finished modifying the file, save it as a text file (txt file
extension) to your strategy directory. You can name the file anything you like. (You can also save it to any
directory you like, but it is good practice to save each initialization file to the directory of the strategy that
references it.)

Downloading the Initialization File

To use the file, you need to download it with your strategy.

1. With the strategy open in Configure or Online mode, choose Configure > Control Engines, or
double-click the control engine’s name.

2. Highlight the control engine and click the Download Options button.

The Download Options dialog box appears. The initialization file must be downloaded immediately after
your strategy is downloaded.

#1 Download Options E]

Filez To Download After The Strateay:

[ Add. |

[ 0K H Cancel ][ Help

3. Click Add.

4. Navigate to the initialization file you created. Double-click the file name.
The file appears in the Download Options dialog box.

5. ClickOK.

The initialization file sets values for the variables and table elements immediately after your next full
strategy download.

IMPORTANT: When you create each variable in the strategy, you must check “Initialize on Strategy
Download” in the Add Variable dialog box.

Since download options are specific to each control engine, make sure you set the initialization file as a
download option for every control engine on which the strategy will run. Because control engines have separate
initialization files, you can use the same master strategy for two or more control engines and configure
differences in variables by customizing the initialization files.

Starting the Strategy Automatically

If you want your strategy to start automatically as soon as the strategy finishes downloading to the controller
using PAC Control Debug mode, modify the Init.txt file as follows:

1. Add the following to the end of the Init.txt file:
_RUN
2. Add 1 ormore blank lines after the RuUN line
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This is required; it won't work without at least 1 blank line at the end of the file.

If you are not using the other features of the Init.txt file to initialize variables after strategy download, you can
delete the rest of the content of the file.

CHANGING A CONFIGURED VARIABLE

You can change a variable, but you cannot change a variable’s type.

1. Tochange a configured variable, make sure the strategy or subroutine is open and in Configure or Online
mode.

2. Ifyou are working in a strategy, on the Strategy Tree, expand the Variables folder until you see the name
of the variable you want to change. Double-click its name to open the Edit Variable dialog box.

3. Ifyouare working in a subroutine, choose Configure > Variables. In the Configure Variables dialog box,
double-click the name of the variable you want to change.

4. Inthe Edit Variable dialog box, make the necessary changes and click OK.
If you need help, see “Adding Variables”on page 259 or “Public Access”on page 265.

You can also change a variable from the Configure Variables dialog box by double-clicking the variable’s name
or by highlighting it and clicking Modify.

DELETING A VARIABLE

You cannot delete a variable that is referenced within the strategy or subroutine. Be careful when deleting
variables, since you cannot undo a deletion.

1. Make sure the strategy is open and in Configure mode.

2. Onthe Strategy Tree, expand the Variables folder until you see the name of the variable you want to
change. Right-click the name and choose Delete from the pop-up menu.

The variable is deleted.

You can also delete a variable from the Configure Variables dialog box by highlighting the variable’s name and
clicking Delete.

VIEWING VARIABLES IN DEBUG MODE

270

While the strategy is running in Debug mode, you can view its variables and modify the value of a variable or
of entries in a table. You can also view several variables at once—as well as other strategy elements—by
putting them into a watch window.

Viewing Numeric, String, and Communication Handle Variables

1. Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the variable you
want to view.

The Inspect Variables dialog box opens. The animated icon at the upper left assures you that the data is
fresh. The title bar includes the name of the variable and indicates whether scanning is occurring.

B nCookie_Counter” (scanning)

Walue: 42806 | [ Maximize button

2. Toview more options, click the Maximize button.
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3. "nCookie_Counter” (scanning) _ Communication handle variables
show slightly different fields.

Mame: nCookie_Counter

Walue: 42308

{31 More Info = —4— Minimize button

Scanning stops whenever you click a changeable field. It resumes once you click Apply, another button,
or an unchangeable field. If scanning resumes before you click Apply, any changes you made are lost.

If you do not want to change the value of the variable, you can click the Minimize button to shrink the
dialog box back to its original size.

3. Toview the configuration information about the variable, click More Info.

jJ bStartFlag

HNAME: bhitartFlag
DESCRIPTION:

TYPE: Integer 32 Variable
SCOPE: Global

INITIALIZED: Dowmload

INITIAL VALUE: u]

WamETT
[(watch | [DEC » |

|
.
H
i

' MHL?E e

4. Toselect the display format, click the button to the right of the Watch button.

%+ bStartFlag” (scanning)
WName: bStartFlag

Walue: |CI

® Decimal

Einary !

A numeric variable can appear as decimal, hexadecimal, or binary. A string variable can appear as ASCll or
hexadecimal.

5. Tochange the value of the variable, type the new value in the Value field and click Apply.
The field turns magenta until you click Apply.

For a string variable, if your change lengthens the string beyond its maximum width, the string is
truncated to fit.

For a communication handle variable, changing the value of the variable here has the same effect as

using a Set Communication Handle Variable command. If the communication handle is currently open,
the value will be changed but will not affect the connection.

6. To monitor the variable in a watch window, click Watch.

If you have only one watch window and it is already open, the variable appears immediately in the
window for monitoring.

Otherwise, the Add Watch Entry dialog box appears.
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#1 Add Watch Entry

Mame: | Time_of_Day

Select Partions To'watch:
Value Select Al

Clear

Select watch Window

I | [ e | [ Open. ]

I Ok, H Cancel ][ Help ]

7. Checkthe items you want to watch.
Items to watch vary depending on the variable type.
8. Inthe Add Watch Entry dialog box, do one of the following:

- If the watch window you want to use to monitor the variable is open, choose it from the Select
Watch Window drop-down list.

- If the watch window you want is not open, click Open. Navigate to it and double-click it to open it.

- Ifyou want to monitor the variable in a new watch window, click New. (For help, see “Creating a
Watch Window"on page 196.)

9. When the Add Watch Entry dialog box shows the correct items to watch and the watch window you
want, click OK.

The variable appears in the watch window.

Viewing Pointer Variables

1. Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the pointer variable
you want to view.

The View Pointer dialog box appears, showing the pointer's name, type, and item pointed to.

bt

3. "Pointer_A" (scanning)

MName: Pointer_a
Type:  Pointer Wanable

Item Pointed To: nLoopCounter

Inspect

2. Toview the status or value of the item pointed to, click the Inspect icon.

If you need help, follow the steps in “Viewing Numeric, String, and Communication Handle Variables” on
page 270.
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Viewing Numeric and String Tables

1.

3.

4.
5.

Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the table variable
you want to view.

The View Table dialog box appears, showing the table’s name, length (maximum number of entries),
width for a string table, initialization method, and security level. It also lists the index and value of each
table entry. The title bar includes the name of the variable and indicates whether scanning is occurring.
Here's an example for a string table.

' "Days_Table™ (scanning)

Mame: Dawz Table

Index Walue

0 Sunday

1 [Monday
Tuesday
Mednesday
Thursday
Friday
Saturday

(=) BE S P ]

[ appl | [ wiatch | [A5CH e | MoreInfo

Scanning for an individual table element stops whenever you select an element in the table. It resumes
for that element if no changes are made and another table element is selected, or when you click Apply.
A magenta background indicates that scanning is stopped.

To change the format of the elements, click the button to the right of the Watch button.

N e—— e e qp gy ""1"'"'-—-.-!'&’_"‘|

[ appl | [ watch | [ESCI) 5|W
Hexadecingl

For string tables, you can select either ASCIl or Hexadecimal. For numeric tables, you can select Decimal,
Hexadecimal, or Binary.

To view the configuration information, click More Info.

v ™y
- » 1 ) Days Table
nt Days_Table™ (scar| “\r) =
Mame: Daps_Table IAMES PEVE] JRE
DEZCRIPTION:
Index | Yalue TYPE: String Table
O[Sunday | MAX LENGTH: 7
1 Monday M WIDTH: 10
2 Tuesday SCOPE: Global
3 Wednesday | INITIALIZED: Fun
4 Thursday | INITIAL VALUE: Sunday
5 Friday
E Saturday ;‘
V/ |
(L&pply ] [(wfatch ] [ASCIl» ] iMoe Info:

To change a table entry, click its index number, highlight the value, and type in a new value. Click Apply.
To monitor the table in a watch window, click Watch.
The Add Watch Entry dialog box appears.
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#1 Add Watch Entry

Mame: |Da_l,Js_TabIe Length: |.7" |

Select Inderes Ta'watch:

©ak

) Single Index I:I
| to] |

) Range from |

Select watch window
| vl ’ Mew. .. ] ’ Open... l

I Ok, H Cancel ][ Help ]

In the Add Watch Entry dialog box, do one of the following:

- Ifthe watch window you want to use to monitor the table variable is open, choose it from the Select
Watch window drop-down list.

- Ifthe watch window you want is not open, click Open. Navigate to it and double-click it to open it.

- If you want to monitor the variable in a new watch window, click New. (For help, see “Creating a
Watch Window"on page 196.)

Select the indexes you want to watch.

When the Add Watch Entry dialog box shows the correct items to watch and the watch window you
want, click OK.

The table variable appears in the watch window.

Viewing Pointer Tables

1.

274

Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the pointer table
you want to view.

The View Table dialog box appears, showing the pointer table’s name, length, and the items pointed to.
You cannot change a pointer table entry in this dialog box.

£ "Pointer_Table” (scanning)

Mame: Pointer_Table

Index Walue

0 [Total Count

1 Previous_Count
2 Status

3 Llarm>

More Info

To view the status or value of the item pointed to, highlight it in the table and click More Info.
If you need help, follow the steps in “Viewing Numeric and String Tables” on page 273.
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IMPORTING OR EXPORTING VARIABLES

You can import and export variables into and out of your PAC Control strategy through a comma-separated
values file (.csv). You may want to do this to:

«  Transfer or copy over the variables from one strategy file to another.
«  Expedite changes to many variables.

To export your variables:
1. Inyour PAC Control strategy, right-click on the Variables branch of the strategy tree.
2. Click Export to CSV format.

3. Navigate to the folder where you want to save the .csv file and type in a name for the file in the File name
field.

4. (lick Save.

If you wanted to make any changes to the variables, it's important that you understand the format of the
information in the file; see “Format of .CSV File”.

To import your variables:

1. Inyour PAC Control strategy, right-click on the Variables branch of the strategy tree.
2. (lickImport to CSV format.

3. Navigate to the folder where you stored your .csv file. select it, then click Open.

Format of .CSV File

In the .csv file, each row represents one variable. The first column must be a keyword, which represents the

data type:
INT32_VAR Integer 32
INT64_VAR Integer 64
FLOAT_VAR Float
STR_VAR String
DNTMR_VAR Down timer
UPTMR_VAR Up timer
CMHDL_VAR Communications handle
INT32_TBL Table of integer 32 data
INT64_TBL Table of integer 64 data
FLOAT_TBL Table of float data
STR_TBL Table of string data
PTR_TBL Table of pointers

Each column in the row represents information about that variable; the information depends on the data type
of the variable.

Format of the .csv file

Keyword Fields, in the expected order/columns

INT32_VAR VarName Description InitializationKind InitialValue PAReps
INT64_VAR VarName Description InitializationKind InitialValue PAReps
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Format of the .csv file

Keyword Fields, in the expected order/columns

FLOAT_VAR  VarName Description InitializationKind InitialValue PublicAccessRead PublicAccessWrite

STR_VAR VarName Description InitializationKind InitialValue StringWidth PublicAccessRead PublicAccessWrite
DNTMR_VAR VarName Description PublicAccessRead

UPTMR_VAR VarName Description PublicAccessRead

CMHDL_VAR VarName Description InitializationKind InitialValue

INT32_TBL TbIName Description InitializationKind InitialValue TableLength PAReps

INT64_TBL TbIName Description InitializationKind InitialValue TableLength PAReps

FLOAT_TBL  TbIName Description InitializationKind InitialValue TableLength PAReps

STR_TBL TbIName Description InitializationKind InitialValue StringWidth TableLength PAReps
PTR_TBL TbIName Description InitializationKind ;abIeLengt

If you plan on creating variables or altering variables through a .csv file, review the following information
about the fields:

«  VarName or TbIName—The name of the variable or table variable. The name must follow PAC Control
conventions (for example, it cannot start with or contain spaces, it cannot start with a number, and so
forth). Maximum length is 50 characters.

«  Description—A brief description of the variable surrounded by straight quotes. To leave the description
field blank, enter a space in straight quotes (like this:" " ). Maximum length for the description is 127
characters.

« InitializationKind—Indicates how to initialize the variable. Enter one of the following values.
—  ON_Run: Initialize the variable on strategy download.
—  ON_Download: Initialize the variable when the strategy runs.

—  Persistent: (Not applicable to timer variables.) This values makes the variable persistent. For more
information about persistent variables, see “Persistent Data”on page 258.

«  StringWidth—The width of a string. The maximum width you can give a string is 1024 characters.

«  TableLength—The length of the table; the format of the value and maximum you can specify depends
on the data type:

- String tables: Specify the string width and table length; for example: 15;99. Note the semicolon
between the numbers. The maximum width you can give a string is 1024 characters. The maximum
table length is 1,000,000 elements.

- Integer and float tables: The table length. Example: 99.

«  PublicAccessRead or PublicAccessWrite—To learn more about public access, see “Public Access”on
page 265.You specify one of the following values:

- 1toenable public access read/write.

- Otodisable public access read/write.

«  PAReps—Public access attribute representation, which means the ability to select a segment of the
value of a variable or change the type of the value of a variable. This is available only with some variable
types; see the table on page 266.

- Id: A unique ID assigned by PAC Control. If you are creating a new variable, specify 0 so that PAC
Control can create an ID when you import the .csv file. If there is already a value in this field, do not
change this value.

—  PublicAccessRead: Specify 1 to enable, 0 to disable. If you want to enable public access write to this
variable, you must enable public access read.
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- PublicAccessWrite: Specify 1 to enable, 0 to disable. If you want to change the representation of this
variable (see RepresentAsSetting), you must enable public access write.

- RepresentAsSetting: Indicate which segment of a variable to allow as public access or to change the
data type of the value of some variables:

- Fornumeric variables (INT32_VAR and INT64_VAR), you can:

- enable public access to the full variable by specifying 0,-1 for INT_ASFULL.

- enable public access and change the representation of the value from numeric to boolean by
specifying 1,-1 for INT_ASBOOL.

- enable public access to only a specific bit of the integer by specifying 2, BitPosition for
INT_ASBIT.

—For table variables (INT32_TBL, INT64_TBL, FLOAT_TBL, STR_TBL), you can:

- enable public access to the entire table by specifying 0, -1, -1 for TBL_ALL.

- enable public access to a range of the table (including the starting and ending index) by
specifying 1, Startindex, Endindex for TBL_RANGE.

- enable public access to one element of the table by specifying 2, Startindex, Startindex for
TBL_ONE.

- enable public access to one bit of one element of the table by specifying 3, Startindex,
BitPosition for TBL_ONE_ASBIT.

ADDING COMMANDS

To make a block in a strategy flowchart do the work it's intended to do, you add one or more commands.
Commands use the 1/0 points and variables you've already configured, as well as other elements in your
strategy. A command, for example, might turn on a digital point, move a value to a variable, or check to see
whether a chart is running. PAC Control contains more than 500 commands you can use. A command in PAC
Control is often called an instruction.

You can add commands to action blocks, condition blocks, and OptoScript blocks. Continue blocks just move
flowchart logic to another block. (See “Configuring a Continue Block”on page 282.)

To add commands to an action or condition block, follow the steps below. (To add commands to an
OptoScript block, see “OptoScript Functions and Commands” on page 381 and “Using the OptoScript Editor”
on page 394.)
1. With the strategy open in Configure or Online mode and the flowchart open, double-click the block to
which you want to add a command.
The Instructions dialog box appears. The highlighted area shows where the new command will be
added.
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& Instructions - New_Chart - Block 4 Ed
Highghed srea ——
Modify. ..
Delete
Mext Blodk
| Previous BIod{J
- '// The Operator group
sk appears in the dialog
@® AnD box only for condition
Oor blocks, not for action
| . blocks.
! Close ! ! Help | Command Help
2. (lick Add to open the Add Instruction dialog box.
4 Add Instruction Ed
Instruction:
| Abzolute Value - | Select... i
Comment:
Type Mame
of | All Valid Types v| | aiDoughVesselPressure B |
Put Resultin | All valid Types v| | aoConveyorspeedContral v |
| CK I | Cancel | | Help | | Command Help |

3. Ifyou know the command you want, enter its name in the Instruction field by typing it in or by choosing
it from the drop-down list. Skip to step 7.

If you don't know the command name, click Select.
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i Select Instruction

Groups:

Angalog Point

Chart

Communication
Control Engine
Deprecated

Digital Paint

Error Handling

1/ Unit

IO Unit - Event Message
IO Unit - Memory Map
IO Unit - Scratch Pad
Logical

Miscellaneous

PID - Ethernet

Instructions:

T

Absolute Valus ~

Add
Arccosine
Arcsine
Arctangent

Clamp Float variable
Complement

Cosine

Decrement Variable
Divide

Hyperbolic Casine

Clamp Float Table Element

Clamp Integer 32 Table Element
Clamp Integer 32 Variable

Generate Random Mumber

s

Pointers Hyperbalic Sine o
Sirnnlatinm Hunerhnlic- Tannent
| Cancel Help | Command Help |

Click the name of a command group in the left column to display all the commands in that group. In the
right column, click the command you want.

For more information on any command, click the command name and click Command Help to open
help. You can also look up the command in the PAC Control Command Reference (form 1701).

When the command you want is highlighted, click OK to return to the Add Instruction dialog box.
(Optional) Enter a comment about the purpose of the instruction.
Comments help explain the command’s purpose in this block and are helpful to anyone who debugs or

updates the strategy later.

Complete each argument for the command by typing in the Type and Name fields or by choosing from

the drop-down lists.

4 Add Instruction Ed
Instruction:
| subtract ~ Select...
Comment:
| COpen pressure valve when vessel pressure is less than setpoint of 0.5 psig
~

Type Mame

| Float Variable vl | fDoughPressureSetpaint B |
Minus | Flaat Literal ~| |o.s |
Put Resultin | Float Variable v| | fSetpointMinusDeadband v | g

Cancel Help Command Help

If the argument type is a literal (or constant), you must type it in. You can use either decimal or

hexadecimal form.

If you type in the name of an item that doesn't exist, for example a variable or I/O point, you are
prompted to add it to the strategy.
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Comment —|

Command

Each command requires a certain number of arguments, from zero to eight. For help in completing
arguments, see the PAC Control Command Reference or the online help for the specific command you're
using.

When the arguments are complete, click OK.

You return to the Instructions dialog box, which now shows the command you just added. Notice that
the comment you entered appears just above the command. The arguments you entered appear as part
of the instruction. The highlight shows where the next command will be placed if you add another
command to this block.

Here is an example of an Instructions dialog box for an action block:

i Instructions - New_Chart - Adjust Pressure Valve - Block 1 Ed

— Open pressure valve when veszel pressure is less than setpoint of 0.5 psig Add...
Subtract

Arguments ———— Minus 0.5

Highlight ——

10.

floughPressure Setpoint Modify. ..

—— Put Result in fSetpointMinusDeadband Delete

ot i e i Nexct Block

| Previous Block

Close Help Command Help

To add another command, click to place the highlight where you want the command to appear. Click
Add and repeat the steps in this section.

If you highlight a command that’s already in the dialog box, the new command will appear just before it.

TIP: Ifyou are adding commands to several blocks at once, you can quickly move from block to block in the
chart by clicking the Next Block or Previous Block buttons in the Instructions dialog box.

If you're working with a condition block, clicking Next Block opens a dialog box so you can select which block to
choose, since condition blocks have two exits. The same dialog box appears if you click Previous Block and the
block you're working with has connections coming from more than one block.

If you put more than one command in a condition block, complete the Operator group as follows:
- If both commands must be true to exit the block true, click AND.
- Ifonly one of the commands must be true to exit the block true, click OR.

Here is an example of an Instructions dialog box for a condition block with two commands. In this case,
the block will exit true if either of the commands is true.
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ﬁ Instructions - Mew_Chart - Sunday or Wednesday? - Block 4 Ed
Is dayoftheweek Add...
Equal?
To 3 Modify. ..
Is dayoftheweek Delete
Equal?
114 0 Next Block Either the first

command OR the
| | PrevieusBlodk | |, second command can

be true for this

Operato

g;nr condition block to exit
true.

®0oRr

Close Help Command Help

CHANGING A COMMAND

1. With the strategy open in Configure or Online mode and the flowchart open, double-click the block
containing the command you want to change.

NOTE: To change commands in OptoScript blocks, see “Using the OptoScript Editor” on page 394.

2. Inthe Instructions dialog box, double-click any line of the command you want to change.
You can also click the command to highlight it and click Modify.

3. Inthe Edit Instruction dialog box, make the necessary changes.
For help, see “Adding Commands”on page 277.

4. (lick OKto return to the Instructions dialog box, where you can see the changed command.

DELETING A COMMAND

You can delete a command permanently, or you can comment out a command so it is temporarily skipped,
usually for debugging purposes.

Permanently Deleting a Command

1. With the strategy in Configure or Online mode and the flowchart open, double-click the block containing
the command you want to delete.

NOTE: To delete commands in OptoScript blocks, see “Using the OptoScript Editor” on page 394.

2. Inthe Instructions dialog box, click any line of the command you want to delete.

CAUTION: Make sure you select the correct command. You cannot undo a deletion!

3. (lick Delete or press Delete on the keyboard.

Commenting Out a Command

You can mark certain commands so that the strategy temporarily ignores them. Commenting out one or more
commands can help you pinpoint problems in a strategy.

1. With the strategy in Configure or Online mode and the flowchart open, double-click the block containing
the command(s) you want to comment out.
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NOTE: To comment out commands in OptoScript blocks, see “Using the OptoScript Editor” on page 394.

In the Instructions dialog box, click the first command you want to comment out. Click Add.

In the Add Instructions dialog box, choose the instruction Comment (Block). Click OK.

You retumn to the Instructions dialog box, and all the instructions in the block from that point on are
grayed out, indicating that they will be ignored when the strategy runs.

Click just beyond the last command you want to comment out. Add another Comment (Block)
instruction.

When you return to the Instructions dialog box, all commands between the two Comment (Block)
instructions are grayed out.

When you no longer want the strategy to ignore the command(s), delete the two Comment (Block)
instructions.

NOTE: The Comment (Block) command is used for this purpose. The Comment (Instruction) command just
places an explanatory comment in the Instructions dialog box. It does not affect any commands.

CUTTING OR COPYING A COMMAND

For commands in action, condition, and continue blocks you can cut or copy commands to the Windows
clipboard and then paste them in the same block or in another block, or even in a block of another chart
within the same strategy. For OptoScript blocks, see “Using the OptoScript Editor”on page 394.

1.

With the strategy in Configure or Online mode and the flowchart open, double-click the block containing
the command you want to cut or copy.

In the Instructions dialog box, click any line of the command you want to cut or copy.

To cut or copy more than one command, hold down the Shift key while you click all the commands to be
cut or copied at once.

NOTE: To cut and paste all commands in a block, copy and paste the entire block, and then change its name if
necessary.

Press Ctrl+X to cut the command(s) or Ctrl+C to copy them.
You can also click the right mouse button and choose Cut or Copy from the pop-up menu.
The command is cut or copied to the Windows clipboard.

PASTING A COMMAND

Once you have cut or copied a command, you can paste it into any block in the same strategy.

Choose one of the following, and then press Ctrl+V:

To paste the command in the same block, click where you want to insert the command.

To paste the command at the end of the instruction block, move the cursor just below the last instruction
and click to highlight the empty space.

To paste the command to another block, click Close to exit the current Instructions dialog box and
double-click the block where you want to place the command. Click where you want to insert the
command.

CONFIGURING A CONTINUE BLOCK

Continue blocks do only one thing: jump to another block. Thus, the only information you need to provide in
a continue block is the name of the block to jump to.
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1. With the strategy in Configure or Online mode and the flowchart open, double-click the continue block
you want to configure.
You can also click the block, click the right mouse button, and choose Detail from the pop-up menu.
The Select Continue Block Destination dialog box appears, listing all blocks in the chart.

i Select Continue Block Destination Ed
-~
Block Id: Mame Type e
21 Restart Condition
2 Set Devices Action
1] Start Action
36 Stop Conveyar OptoScript
3 Stop Charts Action
]
£ >
Cancel Help

2. Click the destination block and click OK.

VIEWING AND PRINTING CHART INSTRUCTIONS

To view or print commands in a chart, see “Viewing and Printing Strategy or Subroutine Commands”on
page 226.
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10: Programming with

Commands

INTRODUCTION

Commands (or instructions) in PAC Control are roughly grouped by function. This chapter tells you what you

need to know about each group in order to program your PAC Control strategy effectively. For detailed
information on using a command, see the PAC Control Command Reference (form 1701) or for legacy

commands, see the PAC Control Command Reference, Legacy Edition (form 1711).

In This Chapter

Analog Point Commands
Chart Commands.....c. e
Communication Commands .
Control Engine Commands
Digital Point Commands
Error Handling Commands
Event/Reaction Commands
/0 Quality Commands
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Logical Commands
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ANALOG POINT COMMANDS

The following commands are used with analog points:

Offset and Gain Others

Calculate & Set Analog Gain Get & Clear Analog Filtered Value'

Calculate & Set Analog Offset Get & Clear Analog Totalizer Value

Set Analog Gain Get Analog Filtered Value'

Set Analog Offset Get Analog Square Root Filtered Value'
Get Analog Square Root Value'

Minimum/Maximum Values Get Analog Totalizer Value

Get Analog Maximum Value Get HART Unique Address

Get Analog Minimum Value Ramp Analog Output

Get & Clear Analog Maximum Value Receive HART Response

Get & Clear Analog Minimum Value Receive HART Burst Response

Send/Receive HART Command

Set Analog Filter Weight

Set Analog Load Cell Fast Settle Level
Set Analog Load Cell Filter Weight
Set Analog Totalizer Rate

Set Analog TPO Period

! Applies only to mistic 1/0 units used with PAC Control Professional

Offset and Gain Commands

Although you normally calibrate analog points in PAC Manager, PAC Control provides commands to set the
values for a point’s offset and gain. (For more information about calibrating offset and gain, see “Reading and
Writing to Analog Points”in the PAC Manager User's Guide (form 1704).

If you already know a point’s offset and gain, you can set the values in PAC Control by using the Set Analog
Offset and Set Analog Gain commands. If you don't know the offset and gain, you can use the Calculate & Set
Analog Offset command, and then use Calculate & Set Analog Gain to have the brain calculate the offset and
gain for you—but again, calibration is typically performed in PAC Manager, and not within a strategy’s logic.

Analog Totalizers

Analog totalizers are used to track total volume or quantity. For example, if an analog point measures gallons
per minute, you could use an analog totalizer to determine the total number of gallons moved over time.

To read the value and leave the totalizer running, use the command Get Analog Totalizer Value. To read the
value and set the totalizer back to zero, use the command Get & Clear Analog Totalizer Value.

Minimum/Maximum Values

The Opto 22 brain automatically keeps track of minimum and maximum values for analog input points.
Min/max values are often used to monitor pressure or temperature.

To read the minimum or maximum value and leave it as is, use Get Analog Minimum Value or Get Analog
Maximum Value. To read the minimum or maximum value and clear it—for example, to record the minimum
pressure in each 24-hour period—use Get & Clear Analog Minimum Value or Get & Clear Analog Maximum
Value.
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Analog Totalizers
@ Analog totalizers are used to track total volume or quantity. For example, if an analog point measures gallons
per minute, you could use an analog totalizer to determine the total number of gallons moved over time.

To read the value and leave the totalizer running, use the command Get Analog Totalizer Value. To read the
value and set the totalizer back to zero, use the command Get & Clear Analog Totalizer Value.
Analog Points and OptoScript Code

In OptoScript code, an analog 1/0 point can be used directly, wherever a float variable can be used. For
example, you can assign an analog point a value, or use points directly in mathematical expressions and
control structures. For more information, see “Using I/0 in OptoScript”on page 382.

Reading or Writing Analog Points

The Move command is the main command used to read or write analog points.

CHART COMMANDS
The following commands control charts in the strategy:
Call Chart Continue Calling Chart
Calling Chart Running? Continue Chart
Calling Chart Stopped? Get Chart Status
Calling Chart Suspended? Start Chart
Chart Running? Stop Chart
Chart Stopped? Suspend Chart
Chart Suspended?

For information about charts in a PAC Control strategy, see “PAC Control Terminology” on page 49.

About the Task Queue

How do subroutines fit into the task queue?

Whenever a chart calls a subroutine, the subroutine temporarily inherits the task in use by the calling chart
along with its priority.

Does a task always use all of its allocated time?

Not always. If a chart or subroutine runs in a loop, all allocated time is used. If a chart or subroutine does not
need all of its allocated time to complete its job, all remaining time (including any portion of a time slice) is
given up.

The following conditions cause a chart to use less than a full time slice:

«  The chart or subroutine stops.

«  The chart or subroutine is suspended.

»  ADelay command is used.

Using the command Delay (mSec) with a value of 1 millisecond is a handy way to give up the time slice while
waiting in a loop for a condition to become True. For more information, see the Optimizing PAC Project System
Performance technical note (form 1776)..

PAC Control User’s Guide, Legacy Edition 287


http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3965
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3965

COMMUNICATION COMMANDS

When does the requested change to a chart or task status take effect?

Not immediately. In any multitasking system, timing and synchronization issues are always a concern. The
time required for a particular request to be implemented depends on the number of tasks currently running
and the specified chart’s location in the task queue. We recommend using commands such as Calling Chart
Suspended? and Chart Running? to determine the status of a chart.

COMMUNICATION COMMANDS

Th following commands refer to moving data among entities that store and transfer data:

Accept Incoming Communication Receive Pointer Table
Clear Communication Receive Buffer Receive String

Close Communication Receive String Table

Communication Open?

Get Active Interrupt Mask'

Get Communication Handle Value
Get End-Of-Message Terminator
Get Number of Characters Waiting
HTTP Get

Send Communication Handle Command
Send Email

Send Email with Attachments

Set Communication Handle Value

Set End-Of-Message Terminator

Transfer N Characters

HTTP Post Calculate Content Length Transmit Character

HTTP Post From String Table Transmit NewLine
Listen for Incoming Communication Transmit Numeric Table
Open Outgoing Communication Transmit Pointer Table
Receive Character Transmit String

Receive N Characters Transmit String Table

1

Receive Numeric Table Transmit/Receive Mistic I/O Hex String

Receive Numeric Table Ex Transmit/Receive String

Receive Numeric Variable

! Applies only to mistic 1/0 units used with PAC Control Professional

Communication Handles

A communication handle (also known as comm handle or COM handle) is a variable in PAC Control that stores
the parameters needed to connect to a specific entity for the purpose of exchanging data. The entity may be
another device on the network, a file located on the control engine, or some other thing that stores or
transfers data. The value of a communication handle variable is a string consisting of communication
parameters, separated by colons and commas.

Communication handles are used to open and close communication channels, and to transmit and receive
data. You can use communication handles to:

«  Communicate with devices (including serial communication modules) via an Ethernet connection

«  Communicate with devices via a physical serial port on a SNAP PAC controller

«  (reate, read, and write data to local and remote files and tables

For example, you might use a UDP communication handle to communicate with another device on the

network via a UDP/IP connection, and use an FTP communication handle to send data from a controller to a
file ona PC.
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NOTE: Acommunication handle s not required to use the SNAP PACREST API. To configure HTTPS access to your PAC's
RESTful server and learn how to call the API, visit developer.opto22.com.

In many cases you'll define a communication handle variable and never change it, because the parameters
rarely change. However, in some cases it might be useful to change it.

PAC Control provides these types of communication handles:

For Ethernet communication via TCP/IP, or with SNAP PAC serial modules.

TCP Note that outgoing (client) TCP communication handles in PAC

(page 290) firmware R9.5a (or higher) support secure data exchange via SSL/TLS. Currently, SSL is
not supported in incoming (server) TCP communication handles.

ubP For lightweight Ethernet communication via UDP/IP.

(page 297) 9 9 ’

File For creating files to be stored on a control engine, and for reading or writing to files on

(page 305) a control engine.

FTP For accessing files on a local file system (like a network drive), or on an FTP server. Also

(page 312) used to transfer files between two servers.
For communication with serial devices that are physically connected in one of the fol-
lowing ways:

Serial e via a groov serial module (GRV-CSERI-4).

(page 316) e viaan RS-232 or RS-485 connector on a SNAP PAC R-series or S-series controller. Do

not use this method for serial devices connected through SNAP serial communication
modules or serial-based SNAP |/O units.

IMPORTANT: Ifyou are using TCP/IP or UDP connections, consult commercially available texts on TCP/IP or UDP
that discuss client/server architectures, so you'll understand how the protocol works and what to expect during
communication.

Communication Timeout Values

Each type of communication handle has a default timeout value (the amount of time the system waits for a
command to complete). Timeouts prevent systems from wasting resources when something is wrong.

Communication Handle Type Default Timeout Value

TCP 10 seconds
UDP 10 seconds
File 1 second
FTPe 30 seconds
Serial 1 second

3See note on page 313 about FTP timeout values in SoftPAC.

For the TCP, UDP, and Serial communication handles, you can set a different timeout value and read the current
timeout value for an already open communication handle. For TCP and UDP only, you can also set the timeout
values for receiving data, and for opening both incoming and outgoing communications. For details, see the
“Communication Commands” section in the PAC Control Command Reference (form 1701).

Adding Communication Handles

Using the Add Variable dialog box, you can create variables for each type of communication handle. For more
information about variables, see “Adding Variables” on page 259.

To add a communication handle:

1. Inthe Strategy Tree, under Variables, right-click Communication Handles, and then choose Add to open
the Add Variable dialog box.
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magy =i

= |5 variables
(=) Mumeric Variables
|5y String Variables
|5 Painter Variables

'} Communication Handleg,
[T Mumeric Tables Add...
[h String Tables Conﬂgurem

|5 Painter Tables
1j0 Uniits

Delete

2. At the minimum, complete the following fields:
- Name: Create an appropriate name, such as TCP_Handle.

- Type: Select Communication Handle.
— Initial Value: Varies with type.

—  For TCP, see page 290.

—  For UDP, see page 297.

—  ForFile, see page 305.

—  ForFTP see page 312.

—  For Serial, see page 316.

Add Variable

LB

Name — Mame: |
Description: |

Type L Type: |Eommunication Handle Vl
Initialization

() Initialize on strateqy download
(%) Initialize on strategy run
() Persistent

Initial Value ——InitiaIEaIue:l

[ Ok H Cancel H Help

TCP Communication Handles

TCP communication handles exchange data with accessible devices anywhere on a network and even over

the Internet. Use TCP when you need reliable data transmission with error handling and message retries.

«  When bandwidth is a concern and possible data loss is not an issue, you may prefer to use UDP
communication handles. For details, see page 297.

«  Ifthe devices sharing data are both control engines, it may be easier to use the Scratch Pad areas on each
to transfer data (instead of using communication commands). For details, see “I/0O Unit—Scratch Pad

Commands”on page 344.

Because SNAP serial communication modules are IP-addressable, you communicate with them by using a TCP
(or UDP) communication handle rather than a Serial communication handle. This way, a strategy running on a
PC or SNAP PAC device can access serial devices connected to modules on a remote SNAP PAC R-series or
EB-series device (which in this case, acts as an Ethernet-to-Serial converter).
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TCP Connections

TCP is a connection-oriented protocol, which means a connection must be established between the client
(the device requesting the data) and the server (the device providing the data) before the devices exchange
data. This connection is typically called a handshake. TCP ensures reliable data transmission, but the
handshake and reliable data transmission require more bandwidth than UDP,

Outgoing (client) TCP communication handles in PAC firmware (R9.5a and higher) support secure data
exchange via SSL/TLS'—two similar types of Internet protocols that provide authentication (that is,
established proof of identification) over an encrypted network channel. Lower versions of PAC Control and
PAC firmware support SSL over TCP only with these commands:

o HTTP Get

o HTTP Post

«  Send Email

«  Send Email With Attachment commands.

For more information about SSL/TLS, see “Step 4: Install a new CA Root Certificate” on page 323.

Incoming and Outgoing Communication
TCP communication is normally requested by the device that needs the data.

For example, when a PAC Control strategy running on a SNAP PAC I/O unit needs the value of a set of variables

from another strategy running on a different SNAP PAC controller:

«  The controller (the client) requests communication using the command, Open Outgoing
Communication.

«  The second controller (the server) uses the Listen for Incoming Communication command, and then the
Accept Incoming Communication command to establish the connection.

Once connected, data is transmitted and received in both directions.

Depending on the situation, you may want to have both devices request communication and establish two
connections between them. That way if one device goes offline and then comes online, you can have the
flowchart logic set up to immediately open communication again.

In some cases, however, one of the devices may be incapable of requesting communication; for example, a
serial device such as a barcode reader attached to a serial communication module on a controller. The serial
device is incapable of requesting Ethernet communication; essentially it can only listen and provide data
when asked. In cases like this, the controller must use Open Outgoing Communication to initiate
communication. (For serial devices attached directly to a serial port on a SNAP PAC controller or brain,
SNAP-LCE controller, or SNAP Ultimate brain, see “Communicating with Serial Devices”on page 316.)

Outgoing Communication. For outgoing communication (that is, communication initiated by the client),
the communication handle’s value follows these patterns:

tcp:<Server's IP address or hostname> : <port listening for requests>

Basic TCP . :
asl Example using hostname: tcp:rhino.acme.com:23456

tcp:<Secure server's IP address or hostname>:<port listening for requests>,ssl[]
SSL/TLS over TCP Example: tcp:rhino.acme.com:23456,ss1[]
Note the comma after the port number.

Notes
o "tcp”is lowercase.

UDP protocol does not support SSL/TLS.

PAC Control User’s Guide, Legacy Edition 291



COMMUNICATION COMMANDS

«  Ahostname is user-friendly name for the IP address. Hostnames are usually created by a company's IT
department. (Before you substitute a hostname for a controller's IP address, use PAC Manager to
configure the DSN parameter for the controller. For details, see the PAC Manager User's Guide,
form 1704).

«  Forinformation about ports, see page 292.

«  Only TCP supports outgoing (client) communication with SSL/TLS authentication and encryption. To use
SSL/TLS, your controller must have an installed security certificate. (For information about security
certificates, see “Step 4: Install a new CA Root Certificate” on page 323.)

Examples:

Communication Handle Value
Outgoing Communication Protocol:Server’s IP Address or

Hostname:Port

Ethernet TCP - to a serial communication module on anotherrack tcp:10.192.54.10:22506

Ethernet TCP - to a remote server (using the server's hostname)  tcp:my server:255

Ethernet TCP (with secure SSL/TLS) - to a remote server tcp:10.192.56.185:443,ss1[]
Ethernet TCP - to a serial communication module on the same tcp:10.192.55.90:22511

rack (uses SNAP PAC R-series or SNAP Ultimate brain’s or

IP address or loopback IP address) tcp:127.0.0.1:22511

To add a communication handle to a PAC Control strategy, see the steps starting on page 289. In the Add
Variable dialog box, enter the communication handle value in the Initial Value field.

Add Variable 3

Mame: | TCP_Comm_Handle_Qutgoing |

Descrption; | |

Tupe: | Communization Handle |

Initialization
() Initialize on strateqy download
(#) Initislize ot strategy run
() Persistent

Communication
Irikial Yalue: |top:10.192.56.185:22004 | handle value

[ QK H Cancel H Help ]

Port Numbers. To communicate with other control engines or other devices on a network, you can use any
port number that is not already in use by that device. For example, you can safely use ports 22004 and 22005,
which have been assigned to Opto 22 by the Internet Assigned Numbers Authority (IANA). Opto 22 has
allocated these Ethernet port numbers for customer use. In general, anything below 1024 is already
predefined and shouldn't be used unless you are implementing a predefined protocol that already has a
reserved port.

If you do not know what port number to use, ask your network administrator or check the list of standard
reserved Ethernet port numbers at www.iana.org/assignments/port-numbers to see ports that may apply to
your devices on your network.

The following port numbers are the defaults, reserved by Opto 22 devices for the purposes shown.

Port # Purpose

20 FTP (file transfer protocol) for get, send, and dir functions
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Port # Purpose

21 FTP (file transfer protocol)

25 SMTP (simple mail transfer protocol)

161 SNMP-based enterprise management systems
502 Modbus/TCP

Main command processor, OptoMMP-based (also used by SNAP PAC controllers and
brains, SNAP Ethernet I/O, and E1/E2 brains)

2222 and 44818 Ethernet/IP

2001

22000 Opto 22 controllers and brains
Host port

22001 For information on configuring the host port, see the PAC Manager User's Guide
(form 1704).

22002 Opto 22 controllers and brains

22003 Opto 22 controllers and brains

22500-22531 Serial communication modules

50000-50999 Internal messaging

Note that port numbers on the SNAP Ultimate brains, SNAP-LCE controllers, and SNAP PAC controllers and
brains are the default ports; some may have been changed for security reasons. (For details, see the section on
Security in the PAC Manager User's Guide, (form 1704.)

Incoming Communication. For incoming communication (that is, communication requested by another
device), the communication handle value is the protocol and the port number separated by a colon (;). Note
that only TCP tracks senders so there is no mix up in the data sent and received.

Example:

Communication Handle
Incoming Communication Value

Protocol:Port

Ethernet TCP (for example, to use a controller as an HTTP server) tcp: 80

To add a communication handle, see the steps starting on page 289. In the Add Variable dialog box, enter the
communication handle value in the Initial Value field.

Mame: | TCP_Comm_Handle_|ncoming

Add Variable 3
|
|

Description: |

Tvpe: | Communication Handle |

Initialization
() Initialize on strateqy download
(%) Initialize on strategy run
() Persistent

Communication
handle value

Initial Yalue: |top: 22004 |

Ok H Cancel H Help
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Opening and Closing TCP Communication Handles

When using TCP communication handles, keep in mind that the controller has a limited amount of TCP/IP
resources, so you need to be careful about how frequently these communication handles are opened and
closed. TCP communication handles are meant to be left open as long as possible.

Per the TCP/IP specification, each time one of these resources is closed, the closed resource unavailable for 120
seconds. Rapidly attempting to open and close TCP communication handles quickly places all available
resources in the unavailable condition.

Once this unavailable state occurs, a communication handle will be unable to gain a resource upon the next
Open Outgoing Communication command. This effectively causes a lock out of any new TCP/IP connections
to be made with the controller (whether from the strategy or externally).

The lock out affects applications such as PAC Control, PAC Display, PAC Manager, OptoOPCServer, and PAC
Terminal. These applications will either have intermittent or no connectivity with the controller.

The solution to this dilemma is to control the rate at which TCP communication handles are opened and
closed. When a TCP communication handle is closed (whether a result of a prior successful or unsuccessful
opening), it should be reopened no sooner than 3 seconds. If this reopening fails to succeed, double the delay
to 6 seconds. If this subsequent reopening fails, double the delay to 12 seconds. And thereafter, subsequent
reconnections should be performed no shorter than every 24 seconds. This throttling of the opening allows
several TCP/IP resources to expire their closing timer.

TCP Communication Handle Examples

The following diagram shows an example of a communication handle value for outgoing communication:

Outgoing Communication

SNAP R-series /0 Device A
IP address: 10.192.59.45 IP-address: 10.192.59.31

B ©| Request communication

, ;’ ‘ Communicate
5 < >

Communication Handle value:

tcp:10.192.59.31:22004
1 |1 |

\

|P address Port number

Receives communication on
port 22004

orvTo 22

For incoming communication, the communication handle value could be:

Incoming Communication

SNAP R-series I/0 Device A
IP address: 10.192.59.45 IP address: 10.192.59.31

h Sends communication to
10.192.59.45 on port 22004

H@ 4 Request communication

Communicate
E. <

Communication Handle value:
tcp:22004

orvTo 22

PAC Control User’s Guide, Legacy Edition



CHAPTER 10: PROGRAMMING WITH COMMANDS

Communication Handles for Serial Communication Modules. For communication with serial
devices through a serial communication module, the communication handle value consists of the IP address
of the brain the module is attached to, plus the serial module’s port number according to its position on the
rack.

NOTE: For port number information, see “Establish an Ethernet Connection” in the SNAP Serial Communication
Module User's Guide (form 1191).

Here are two examples of communication handles for communicating with serial modules, the first showing
communication through a module on the same rack as a SNAP PAC R-series controller, and the second
showing communication through a module on a different rack.

Fora serial module on the samerack, use
the loopback IP address 127.0.0.1, which

To a Serial Module on the Same Rack : i
tells the brain to talk to its own rack. You

can also use the brain’s own IP address
(in this example, 10.192.59.45), but the
loopback address allows you to change
the IP address of the brain without
having to change the communication

SNAP R-series I/0
IP address: 10.192.59.45

-

Serial Device

T3> SNAP-SCM

ort 22507
N P handle.
o
»
Communication Handle value:
tcp:127.0.0.1:22507
ortcp:10.192.59.45:22507
L I |
P address/ por\t number  NOTE: For port number information, see “Establish an Ethernet

Connection”in the SNAP Serial Communication Module User’s
Guide (form 1191).

To a Serial Module on a Different Rack

SNAP R-series I/0 SNAP EB-series 1/0
IP address: 10.192.59.45 IP address: 10.192.59.62
> Serial Device
=&, Cthernet network .
e § I <7 SNAP-SCM
",‘ > ",‘ PN port 22507
3’ "

Communication Handle value:

tcp:10.192.59.62:22507
1 | |

\

IP address Port number

NOTE: For port number information, see “Establish an Ethernet
Connection”in the SNAP Serial Communication Module User’s
Guide (form 1191).

Using Flowcharts to Control TCP Communication

When a control engine is communicating with another device using TCP, it runs a PAC Control flowchart or

charts to control communication.

«  For outgoing communication on controller COM ports and serial modules, the flowchart uses the
command Open Outgoing Communication to request a connection.
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«  Forincoming communication on controller COM ports, which is requested by another device, the
flowchart must first use Listen for Incoming Communication and then use Accept Incoming
Communication to establish a connection.

«  Forincoming communication on serial modules, which is requested by another device, the
flowchart uses the Open Outgoing Communication and Communication Open? commands to establish
a connection.

The control engine’s TCP/IP flowcharts should open communication once and then continue to transmit or
receive using the communication handle. Constantly opening and closing communication for each
transaction wastes time and is inefficient.

As a simple example, the flowchart at right is designed
to receive data from a serial device, such as a barcode

*~ Serial_Comm™

reader, through a serial communication module on the '

same rack as a SNAP PAC R-series I/0 unit. e Block 0
Communication with serial modules in this example is A T I

done via TCP It can be done from the SNAP PAC R-series S

system itself, as in this example, or from another TCP/IP ~ 1" Open outgoing
device on the network. .. . .. . . . . | communication

In this example, the R-series I/0 unit establishes T
communication through the serial module using the -
communication handle: tcp:127.0.0.1:22507 S waiting

The loopback IP address is used, since the serialmodule  ff .~ .~

is on the same rack. : .l‘_.

When characters are detected in the receive buffer, the : '| Y

/0 unit receives the string and processes it, and then - u =

after a short delay checks for another message. S _

Communication remains open for additional messages. . SRME“ St

This simple flowchart illustrates the basics of handling e _
communication, without any error checking. However, ¢ 2
while receiving and transmitting, TCP/IP control charts DShoteuts [100% 1w
should also monitor the status value returned by D chart/ -

commands such as Transmit Numeric Table and Receive

Numeric Table, and close communication if there are errors. If your PAC Control application opens sessions but
does not close unused or bad sessions, the maximum number of sessions could be used up. Note that
communication should not be closed for timeout errors from Receive commands (error numbers —37 and —
39), however, because these errors simply mean that there was no data waiting in the receive buffer for the
specified session.

To save time, before using a Receive command (such as Receive String or Receive Numeric Table), TCP/IP
charts should use the command Get Number of Characters Waiting. If there are zero characters waiting, then
there is no reason to use the Receive command. It is also a good idea to start a down timer, and then loop on
the Get Number of Characters Waiting command until either there are more than zero characters waiting, or
the timer expires.

The following chart is also an example of TCP/IP communication on controller COM ports, but with three
differences: in this case another device is requesting communication, the peer will both transmit and receive,
and error checking is shown for the commands Get Number of Characters Waiting and Receive Numeric Table.

Similar error checking should be used for transmit commands, which in this strategy are in another chart.
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*= Incoming_Comm_Control EI@PE

............................. ~

0 msec
............ 58 G e
...... vl s i actm . F.

count -37 or
397 - _.commu

nication

3 Clear receive

(1) Shortcuts 100% w

If the devices communicating with each other are all SNAP R-series or Ultimate I/0 systems, be careful not to
have one of them send information to another faster than the receiving system can pull it out of its receive
buffer. When a control engine receives data from the Ethernet network, it holds the data in memory (the
buffer) until the PAC Control flowchart removes it with a Receive command. If the data is not removed fast
enough, the receive buffer will fill up. You can prevent this problem by transmitting the information less
frequently. If the same chart is transmitting and receiving, you can alter the chart so that it receives more often
than it transmits.

Ethernet Connections and Ports

The number of Ethernet connections available varies by hardware, type, and in some cases firmware version,
such as 80 on current SNAP PAC R-series 1/0 system:s.

The host connection is on port 22000 or 22001 and is used to communicate with the PC that runs PAC Control.
These port numbers are reserved for this purpose, but they can be configured. For information see the PAC
Manager User’s Guide (form 1704).

Peer-to-peer connections can be on any other port number that is not already used on the network; these
connections are used to communicate with other control engines or other devices on the network. When you
assign port numbers for peer-to-peer connections, make sure you do not assign port numbers that devices on
your network may use for specific purposes. For a list of standard Ethernet port numbers, see
Www.iana.org/assignments/port-numbers.

UDP Communication Handles

The User Datagram Protocol (UDP) is a fast, lightweight communications protocol that is sometimes used as
an alternative to TCP (see page 290). UDP is used to transmit messages—called datagrams—across an IP
network from a source IP address and source UDP port to a destination IP address and destination UDP port.
UDP communication handles most often used when bandwidth is a concern and reliable data transmission is
not required.
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Important Characteristics of UDP
o Usesport numbers to help distinguish different types of requests.
«  Hasan optional checksum function to ensure the datagram is delivered intact

»  Usesa connectionless transmission model, which means it doesn't do a “handshake”or otherwise ensure
that the receiving IP address is available and ready to receive.

«  Does not guarantee datagram delivery. If a delivery fails, it does not perform retries.

«  Does not preserve datagram sequencing. Datagrams may arrive at the destination in a different order
than they were sent.

« Isunaware of congestion at the receiving IP address. If the receiver's queue becomes full, subsequent
datagrams are dropped.

NOTE: When using UDR if packet sizes are larger than about 1200 bytes and the data transmission interval is about
I millisecond or faster, SNAP PAC hardware controllers may not be able to receive the data, and communication
handles in SNAP PAC Sim and SoftPAC software controllers may close unexpectedly.

UDP Communication Handle Categories

AEElE Local Characteristics Remote Characteristics Communication Handle Value

Category

May be used to communicate with multiple
The local UDP port is remote IP addrgssgs and ports by using
Local o Send Communication Handle Command,
specified by the N . " udp:<local port>
Bound communication handle set.dst:<ip address>:<port>" or
’ "set.dst:<hostname with fully qualified
domain name>:<port>".
. Communicates with the communication
Remote Local UDP port is chosen , o
. handle’s specified remote IP address and udp:<remote IP address>:<remote port>
Bound by the operating system. o
Can be used to communicate with multiple
remote IP addresses and ports by using
Unbound Local UDP portis chosen | Send Communication Handle Command udo:
by the operating system. | with a destination string like "set.dst:<ip p:
address>:<port>" or "set.dst:<hostname
with fully qualified domain name>:<port>".
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Configuring a Local Bound UDP Communication Handle

Alocal bound communication handle is used to receive UDP datagrams through a known UDP port. You can
also configure the communication handle to transmit data to a specific destination. For details, see the “Set
Communication Handle Value” command in the PAC Control Command Reference (form 1701).

To add a communication handle to a PAC Control strategy, see the steps starting on page 289. When using the
Add variable dialog box, the initial value follows this pattern:

udp:<local bound port number>

Add Variable 4

Mame: | udp_23456 |

Description: | configure the local bound communication handle value |

Type: Communication Handle
Initilization
() Initialize on strategy download
(®) Initialize on strategy run
(") Persistent

Initial Value: | udp: 23456

Cancel Help

In OptoScript, the instruction follows this pattern:

SetCommunicationHandleValue ("udp:23456", cmhMyLocalBoundCommHandle) ;

In this example, data sent via UDP to UDP port 23456 is received by the PAC Control strategy. UDP datagrams
sent to the bound port will be received on all active Ethernet or Wireless Ethernet interfaces.

Configuring a Remote Bound UDP Communication Handle

A remote bound UDP communication handle is typically used to communicate to another device that
receives UDP datagrams on a bound (preset) port number. The remote port number allows transmitters to
direct the datagram’s destination.

To add a communication handle to a PAC Control strategy, see the steps starting on page 289. In the Add
Variable dialog box, enter the communication handle value in the Initial Value field

The remote bound communication handle value has the following format:
udp:<remote IP Address>:<remote port number>

Example:

udp:192.168.1.100:23456

OptoScript example:

SetCommunicationHandleValue ("udp:192.168.1.100:23456",
cmhMyRemoteBoundCommHandle) ;

Action block example:
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configure the remote bound communication handle value Add...

Set Communication Handle Value
From "udp:192.168.1.100:23456" Modify...
To cmhMyRemote BoundCommHandle
Delete

Mext Block

Previous Block

| Command Help

The example configures a communication handle that transmits data to the destination host IP address
192.168.1.100, UDP port 23456.

Configuring an Unbound UDP Communication Handle

The unbound communication handle is very similar to the remote bound category. The only difference is the
communication handle value does not specify the local port.

To add a communication handle to a PAC Control strategy, see the steps starting on page 289. In the Add
Variable dialog box, enter the communication handle value in the Initial Value field.

The unbound UDP communication handle value has this format:

udp:

OptoScript example:

SetCommunicationHandleValue ("udp:", cmhMyUnboundCommHandle) ;

Action block example:

configure the unbound communication handle value Add...

Set Communication Handle Value
From "udp:" Modify...
To cmhMyUnoundCommHandle

Delete

Mext Block

Previous Block

| Command Help

Opening the UDP Communication Handle

To open either an unbound or bound communication handle, use the OpenQOutgoingCommunication
command.
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OptoScript example:

1320penUnboundResult =
OpenOutgoingCommunication (cmhMyRemoteBoundCommHandle) ;

i1320penBoundResult =
OpenOutgoingCommunication (cmhMyLocalBoundCommHandle) ;

Action block example:

open the remote bound communication handle Add. ..

Open Outgoing Communication
Communication Handle cmhMyRemoteBoundCommHandle Modify...

Put Result in i320penUnboundResult

Delete
open the local bound communication handle
Open Cutgoing Communication Mext Block
Communication Handle cmhMyLocalBoundCommHandle
Put Result in i320penLocalBoundResult Previous Block

To find out if the handle opened successfully, inspect the result from the OpenOutgoingCommunication
command. A zero result means the opening succeeded. A negative value indicates the communication
handle was not opened.

Closing the UDP Communication Handle
To close any communication handle, use the command “CloseCommunication.”

OptoScript example:

CloseCommunication (cmhMyRemoteBoundCommHandle) ;

Action block example:

Close Communication
Communication Handle cmhMyLocalBoundCommHandle
Put Status in i32CloseResult Modify...

I, | -

Mext Block

Previous Block

| Command Help

Many applications never close a communication handle once they are opened. If a communication fault were
to occur on an unbound communication handle, the handle continues to remain open and may still be used
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to resume communications. If the communication handle was bound, it too remains open and datagrams will
be received once the network problem is corrected.

Transmitting Datagrams with a Remote Bound Communication Handle

The following commands may be used to transmit data with an open UDP communication handle.
o Transmit Character*

»  Transmit Numeric Table

«  Transmit Pointer Table

»  Transmit String

«  Transmit String Table

«  Transmit/Receive String

*If transmitting several sequential characters of a string, use Transmit String instead.

When using these commands, the data may be transmitted to the IP address and UDP port specified when
the UDP communication handle was opened.

To add a communication handle to a PAC Control strategy, see the steps starting on page 289. In the Add
Variable dialog box, enter the communication handle value in the Initial Value field.

OptoScript example:

i32TransmitResult = TransmitNumTable (4, 2, i32tMyDataTable,
cmhMyRemoteBoundCommHandle) ;

Action block example:

transmit data from remote bound to local bound communication handle Add...
Transmit Numeric Table
Length 4 Modify...
Start at Index 2
Of Table i32tRemoteBoundReceivedData Delete
Communication Handle cmhMyRemoteBoundCommHandle
Put Status in i32RemoteBoundTransmitResult Mext Block

I cvious Block

|| Help | Command Help

This example transmits elements 2, 3, 4, and 5 of table i32tMyDataTable to the IP address 192.168.1.100, UDP
port 23456. All four elements are transmitted in a single datagram over the network.

Transmitting Datagrams with a Local Bound Communication Handle

Transmitting with a bound communication handle requires the communication handle’s destination (the IP
address and port) to be set. Use the command “Send Communication Handle Command”to configure these
destination parameters. Once the destination is set, the same data transmit commands may be used.

To add a communication handle to a PAC Control strategy, see the steps starting on page 289. In the Add
Variable dialog box, enter the communication handle value in the Initial Value field.

OptoScript example:
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i32SendResult = SendCommunicationHandleValue (cmhMyLocalBoundCommHandle,
"set.dst:192.168.1.101:12345");

i32TransmitResult = TransmitNumTable (4, 2, i32tMyDataTable,
cmhMyLocalBoundCommHandle) ;

Action block example:

+ Instructions - Powerup - Example n
Send Communication Handle Command ~ Add, ..
Communication Handle cmhMyLocalBoundCommHandle
Command "set.dst:192.168.1.101:12345" Modify...
Put Status in i325etResult
Delete
Transmit Humeric Table
Length 4 Mext Block
Start at Index o
Of Table i32tLocalBoundModifiedData Previous Block
Communication Handle cmhMyLocalBoundCommHandle
Put Status in id2LocalBoundTransmitResult

.

| Close || Help | Command Help

This example first configures the local bound UDP communication handle to transmit the data to the IP
address 192.168.1.101, UDP port 12345. Subsequent data transmissions will be sent to the same IP address
and UDP port until a SendCommunicationHandle with a new destination IP address or UDP port is
commanded.

Determining when a Datagram Has Arrived

Use the command “Get Number of Characters Waiting” to determine if datagrams have arrived on the UDP
communication handle.

OptoScript example:
132BytesWaiting = GetNumberOfCharsWaiting (cmhMyLocalBoundCommHandle) ;

Action block example:

& Instructions - Powerup - Example “
Get Number of Characters Waiting Add...
Communication Handle cmhMyLocalBoundCommHandle
Put in i32LocalBoundDataWVaiting Modify...
I, O
Mext Block
Previous Block

Close | | Help Command Help
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304

The strategy should inspect the result value from the command. When positive, this indicates the amount of
data pending. When receiving a positive result, the value indicates the amount of data contained in the
current datagram.

In some cases, a timer is used to limit how long the chart will wait for data to arrive. This is usually configured
as a loop and includes either an up- or down-timer to monitor the elapsed time. Within the loop, checking for
the number of characters waiting, include a “Delay Millisecond” command with a reasonable delay time to
allow the chart to release its timeslice.

Receiving Datagrams

Use the following commands to receive datagrams from a bound or unbound UDP communication handle.
«  Receive Character

«  Receive N Characters

«  Receive Numeric Table

«  Receive Numeric Table Ex

«  Receive Numeric Variable

«  Receive Pointer Table

»  Receive String

«  Receive String Table

When the chart logic has determined that a datagram is pending on the communication handle, the data
may be received.

When receiving the datagram, ensure that all of the bytes contained within the current datagram reported by
the command “Get Number Of Characters Waiting” are received. Once all the data of the current UDP
datagram is received, the next datagram may be received. The reading of the entire datagram within PAC
Control's implementation of UDP messaging differs from typical programming environment “socket”
implementations.

Retrieving The Received Datagram’s Source IP address and Source UDP port

When a datagram is received, the identity of the transmitter can be retrieved using the “Send Communication
Handle Command”command. The command returns the values in a numeric format. To set a destination
address and port so that a reply can be sent on the same communication handle, these values must be
converted to strings and formatted into a command string understandable by Send Communication Handle
Command.

OptoScript example:
// retrieve the datagram’s source IP address and source port

i32SourceIpAddress = SendCommunicationHandleCommand (cmhMyBoundCommHandle,
"get.src");

i32SourcePort = SendCommunicationHandleCommand (cmhMyBoundCommHandle,
"get.srcport");

// convert numeric source values to strings
Int32ToIpAddressString (i32SourcelpAddress, sSourcelpAddress);

NumberToString (i32SourcePort, sSourcePort);

// create a command string for the "Send Communication Handle Command"

sReplyAddress = "set.dst:" + sSourcelpAddress + ":" + sSourcePort;

The result stored in sReplyAddress (for example “set.dst:192.168.1.100:54321") is used as the command string
to set the next transmission destination to send a datagram to IP address “192.168.1.100," port 54321.
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Managing and Accessing Files in the Control Engine’s File System

The internal storage available for file storage depends on the device:
2

»  About 2 GB on a groov EPIC processor

«  About 4 MBon a PAC S-series controller

«  About 2 MBon a PAC R-series controller or SNAP Ultimate brain

«  About 1 MBon a SNAP-LCE.

«  File storage on a SoftPAC controller is limited only by the size of your hard drive and the drives available
on your network.

Any type of file can be stored on the device, and files can be sorted into directories or folders just as they can
on a PC. The control engine can read them, add data to them, and even send data from them via several
different methods to another device on the network.

If you want more storage, you can add external storage devices:

«  groov EPIC processors allow you to store files on USB storage devices. For more information about
connecting a USB storage device, see the groov EPIC User's Guide (form 2267).

»  SNAP PAC controllers allow you to store data or files on a microSD card. For more information about
accessing a microSD card, see the user's guide for the controller.

NOTE: For SNAP PAC controllers, certain FTP commands may also be useful when dealing with files, even if the files
are all local. For example, the dir command is available with comm handles.

Understanding Private, Secured, and Unsecured Areas (groov EPIC Processors Only)

The groov EPIC processor subdivides the file system into three areas:

«  private—This area is visible only to the control engine. Any files that you create in your PAC Control
strategy are stored in the private area, unless you explicitly indicate that they be stored in the unsecured
area. You cannot access this area from groov Manage; therefore, you cannot upload files to the private
area through groov Manage.

«  secured—fFiles stored in the secured area are accessible only to control programs that use
authentication over a secure protocol. You cannot access these areas from PAC Control strategies. You can
upload files to the secured area through groov Manage. For instructions on uploading files, see the groov
EPIC User's Guide (form 2267).

« unsecured—*iles stored in the unsecured area are accessible by the PAC strategy or any control
program. You can also upload files to the unsecured area through groov Manage. For instructions on
uploading files, see the groov EPIC User's Guide (form 2267).

Before you begin programming commands that create files, determine in which of these areas you want to
store your files. Your decision may affect the format of the file name, as well as the availability of those files to
other programs, like Node-RED flows.

Format of the Communication Handle Value for File Access

To create, write to, and read from files on the control engine, use a file communication handle. The format for
the handle’s valueis: file:<open mode>,<filename>

Note that file islowercase.

The amount of memory available on a groov EPIC processor can vary. To find out how much is available, go to groov
Manage and click Info & Help, then System Status. The amount currently available is displayed in the Resources
section, in the Memory Available row.
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Values for open mode. Open modes are:

Open mode Description

r Opens afile for reading. If the file does not exist or cannot be found, an error is returned.

w Creates a new file and opens it for writing. If the file already exists, its contents are
deleted.

a Opens a file for writing at the end of the file (appending). If the file doesn't exist, it is cre-

ated.

Formats for filename. You can use the following formats for groov EPIC processors; SNAP PAC, SoftPac,

SNAP-LCE, or SNAP Ultimate controllers; and SNAP Ultimate controllers:

« filename.extension—The path to the file is the current working directory. For the groov EPIC processor,
the file is stored or located in the private area.

«  /path/filename.extension—If the path does not exist, it is created. For the groov EPIC processor, the path
and file are stored or located in the private area.

You can use the following formats only for groov EPIC processors. The ~ mark indicates the home directory of
the private area:

«  ~/filename.extension—The file is stored or located in the home directory of the private area.

«  ~/path/filename.extension—If the path does not exist, it is created. The path and file are stored or
located from the home directory of the private area.

«  ~/unsecured/filename.extension—The file is stored or located off the root directory of the unsecured
area, where control programs and PAC Control strategies can access it.

«  ~/unsecured/path/filename.extension—If the path does not exist, it is created. The path and file are

stored or located off the root directory of the unsecured area, where control programs and PAC Control
strategies can access it.

Notethat you can’t specify that a file or path be created in the secured area nor access a file in the secured area of the
groov EPIC processor. This area is not accessible to PAC Control strategies.

Examples of File Communication Handle Values (groov EPIC and SNAP PAC)

In the following examples of file communication handle values, remember that the groov EPIC processor adds
the corresponding file (and path, if applicable) to the private area:

Creates the file myfile.txt and opens it for writing. file:w,myfile.txt

Opens the existing file myfile.txt so data can be

. file: file.
appended toit. tle:a,myfile.txt

Creates the file Temperature_data.txt in the
directory Data_files and opens it for writing. Ifthe file:w,Data files/Temperature data.txt
directory doesn't exist, it is created.

Opens the file Temperature_data.txt in the

a R file:r,Data fil T t data.txt
directory Data_files for reading. ile:r,Data_files/Temperature data.tx

Examples of File Communication Handle Values (groov EPIC only)
The following examples apply to the private area, which is accessible only to control programs with

authentication over secure protocols.

Creates the file Fuel_level.txt in the private home

. R L file:w,~/Fuel 1 1.
directory and opens it for writing. ile:w,~/Fuel level.txt
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Opens the existing file Fuel_level.txt in the
sub-directory tank1 of the private area so data can be file:a, ~/tankl/Fuel level.txt
appended to it.

The following examples apply to the unsecured area of internal storage, which is accessible to PAC Control
strategies and control programs.

Creates the file Fuel_level.txt in the home
directory of the unsecured area and opensit file:w,~/unsecured/Fuel level.txt
for writing.

Opens the file Fuel_level.txt in the sub-direc-

. file:r,~ k1l/Fuel 1 1.
tory tank1 of the unsecured area for reading. LS /T e S R AT, el i

The following examples apply to a USB storage device that is assigned to the unsecured area. A couple of
things to know about these examples:

»  When the USB storage device was mounted to the groov EPIC processor, it was configured as Unsecured.

«  Aportion of the path was assigned by groov Manage; specifically, the /run/media/sdbl part. When
you try this example, you'll want to check in groov Manage for the name that it assigned to that portion
of the path.

For more information or instructions on either of these points, see groov EPIC User's Guide (form 2267):

Opens the file Fuel_level.txt in the

. file:r,/run/media/sdbl/Fuel level.txt
home directory. -

Opens the file Fuel_level.txt in the

. file:w,/run/media/sdbl/tankl/Fuel level.txt
sub-directory tank1. -

NOTE: Data written to a file may not be written immediately. Once the communication handle is closed, all of the
data is finalized and saved to the file. For this reason, you should close the communication handle before trying to
read data from the file.

Adding a Communication Handle

To add a communication handle, see the steps starting on page 289. In the Add Variable dialog box, enter the
communication handle value in the Initial Value field.

MName: |E0mm_H andle_File |
Diescription: | |
Tvpe: | Communication Handle |

Initialization
() Initialize on strategy download

(#) Imitialize on stratey un

() Persistent
Communication
Initial W alue: |file:w,myfile.t:-ct I handle value
k. l [ Cancel ] [ Help
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Limitations and Usage Notes for Files Stored on a Processor or Controller

Keep the following limitations in mind as you program the file communication handle to access the
controller’s file system:

Maximum length for file names and directory 127 characters

names
File name characters allowed All ASCII characters except *, 2, null,and /
Path name component separator /

Maximum number of files and directories that

. 16
can be open simultaneously

For groov EPIC processors: The length of a path name

is limited to approximately 254 characters. Therefore,

if you create short path names, the directory depth
Maximum directory depth can be deeper. If you create long path names, the

directory depth is shorter.

For SNAP PAC controllers: Limited only by available

memory

Limited only by available memory. Each file uses 516
Maximum number of files bytes of overhead plus its number of bytes rounded
up to the nearest multiple of 516 bytes.

Limited only by available memory. Each directory

Maximum number of directories uses 516 bytes.

Approximately:

« 2 GB on groov EPIC processor?

* 4 MB on a SNAP-PAC-S1
Maximum amount of memory available in the « 2 MB on a SNAP PAC R-series controller or SNAP
control engine’s file system Ultimate brain

« 1 MB on a SNAP-LCE controller

These values can vary slightly depending on the con-

trol engine firmware version.

4The amount of memory available on a groov EPIC processor can vary. To find out how much is available, go to groov
Manage and click Info & Help, then System Status. The amount currently available is displayed in the Resources
section, in the Memory Available row.

If power to the control engine is turned off, files are destroyed unless they have been saved to flash memory.
For information on saving files to flash using PAC Control commands, see “Commands Relating to Permanent
Storage”on page 332.

Limitations and Usage Notes for Files Stored on a USB Storage Device (groov EPIC only)

If your groov EPIC processor has a USB storage device inserted into a USB port, you can use PAC Control
commands with files on a USB storage device just as you would with any other file in the processor’s file
system. Before programming the commands, review the requirements and instructions on connecting and
configuring USB storage devices in the groov EPIC User's Guide (form 2267). You will also want to find the path
name that groov EPIC assigns to the USB storage device.

Limitations and Usage Notes for Files Stored on a microSD Card (SNAP PAC only)

If your SNAP PAC controller has a microSD card slot in the top of the controller's case, you can use PAC Control
commands with files on a microSD card just as you would with any other file in the controller’s file system. Just
keep these helpful tips in mind:
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« Include the card’s directory name in the path in the file communication handle, for example:
file:a,/sdcard0/VoltLog.txt

«  Filename length: See your controller's user's guide for card compatibility information. Filenames up to
127 characters can be used on higher-capacity microSDHC cards. However, on lower-capacity standard
microSD cards (2GB or less, formatted with FAT16), all files you store on the card must be named with a
maximum of eight characters in the name plus three characters in the extension (8 dot 3 format), for
example:datafile. txt

« Instead of allowing multiple charts in your strategy to access the microSD card, use just one chart for
handling all calls (for example, communicating, reading, and writing) to the card. Allowing multiple
charts to access the card can cause conflicts and potentially slow down processing.

«  Toomany filesin a directory can cause slow processing. Minimize the number of files in each directory on
the microSD card; for example, keep less than 1,000 files in each directory-including the root directory.
Periodically remove any files that are no longer needed in order to keep the quantity down, or consider
storing files in subdirectories.

«  Consider using a persistent table (at least initially) to keep frequently accessed data, and then write the
data to the microSD card every hour or so. Logging data directly to a microSD card is much slower than
storing the data in a persistent table.

For more information on using the microSD card, see the controller's user guide.

Working with Files in Your Strategy

The commands you use with a communication handle vary according to the action (the open mode) defined
in the handle’s value. To change actions—from read to write, for example—you can use Set Communication
Handle Value to change the handle’s value.

Use these command with any file  Use these command with file comm Use these command with file comm

communication handle handles in Read mode handles in Write or Append mode

Close Communication

Communication Open? . . Transfer N Characters
. . Receive Numeric Table .

Get Available File Space Receive Pointer Table Transmit Character

Get Number of Characters Waiting Transmit NewLine

Receive String

Receive String Table

Send Communication Handle Command
(find)

Transmit Numeric Table
Transmit Pointer Table
Transmit String
Transmit String Table

Open Outgoing Communication

Send Communication Handle Command
(delete, getpos, or setpos)

Set Communication Handle Value

Set End-of-Message Terminator

To work with files in your strategy, first use the command Open Outgoing Communication.

Writing to a File. For example, suppose you have data in your strategy in a string table (Product_Table) that
you want to write to a file (Products.txt) in a directory (Company Data) on the control engine. Here's how you
would doit:

1. Use Open Outgoing Communication to open a file communication handle. The value of the handle
would be: file:w, /Company Data/Products.txt
Use the condition Communication Open? to make sure the communication handle opened.

3. Toput the data from the string table into a comma-delimited file (which is easy to open in database
software), use the command Set End-Of-Message Terminator to indicate that a comma should be used
as the delimiting character. Or, if you want each line of your data to end with a LF (line feed), set the EOM
(end-of-message) terminator to 10 (decimal), which is the ASCIl code for LF. See “ASClI Table” on
page 368 for other EOM characters.
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4. Use the command Transmit String Table to transmit data from Product_Table directly into the
Products.txt file. Iltems from the string table are separated by commas in the file.

Strategy
Control Engine File System

Product_Table Company Data/ Products.txt

0 Bats

Bats,Baseballs,
Batting gloves,

1 Baseballs

2 Batting gloves Catcher’s mitts
3 Catcher’s
mitts

5. Use the command Close Communication to close the communication handle.

Reading aFile. As another example, suppose you have a file on the control engine that was placed there

via FTP. (See the next section for details on using the FTP communication handle.) You want to read this file

(New_Data.txt) and place the data in it into a string table (Data_Table) in your strategy.

6. Use Open Outgoing Communication to open a file communication handle. The value of the handle
wouldbe: file:r,New Data.txt

7. Use the condition Communication Open? to make sure the handle opened.

8. Use the command Set End-Of-Message Terminator to indicate what character in the New_Data.txt file
should be read as the delimiting character. (In the example shown below, it's a slash.)

TIP: Ifthe lines of data in the text file end with LF (line feed), set the EOM (end-of-message) terminator to 10
(decimal), which is the ASCll code for LF.

9. Use the command Receive String Table to receive the data from New_Data.txt directly into Data_Table.
To read the whole file, use a value of -1 for the Length parameter.

Control Engine File System Strategy
New_Data.txt Data_Table
0 485
485/622/35/56/
7841/20 1 622
2 35
3 56
4 7841
5 20

Notice the numbers used in this example. These are numbers represented as strings. For the purpose of
storing and sending data, this is the simplest way to represent them. If you need to use them in
calculations, however, you must first convert them to numeric values. You can do so in your PAC Control
strategy by using a command such as Convert String to Float or Convert String to Integer 32. (See “String
Commands”on page 361 for more information.)

10. It might also be helpful to use the command Send Communication Handle Command which provides
the following commands that you can use when accessing files.
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- find: locates data in the file if each line has a unique identifier.
- getpos returns an integer that indicates the current position in the file.
—  setpos:<position> jumps to the specified position within the file.

- find:<mystring> (strings only) searches for the string within the file and returns its location as an
offset from the current position in the file. The file must have been opened in r (read) mode."

11. Finally, close the communication handle by using the command Close Communication.

A More Complex Example. Here's a more complex example which shows the actual OptoScript code. In
this example, someone on the network needs the value of several variables in the PAC Control strategy
running on the control engine. This person has sent to the control engine via FTP a comma-delimited text file
(ProductRequest.txt) containing the names of the variables. (See “Moving Files via FTP”on page 312 for
information on FTP)

This section of the PAC Control strategy reads the variable names from the text file in the control engine’s file
system and places the names in a string table (Product_Names). Next, the strategy uses the command Get
Value From Name to place the values of the variables into another table (Product_Info). The data from this
table is then written to another text file (Productinfo.txt) on the control engine, which can later be sent via FTP
to the person who requested the data.

The whole operation (including the FTP portions, which are not covered in this example), might look like this:

Requestor Control Engine PAC Control Strategy

I:I File System

— ProductRequest.txt Product_Names String Table
ProductRequest.txt FTP Num_Widgets, e 0 | Nam_wWidgets
Num_Widgets, o Num_Gﬁdg(?ts, . ——
Num_Gadgets, Num_Thingies, um_Gadgets
L Num_Whatnots

hlum_thingies 2 Num_Thingies
Num_Whatnots -

3 Num_Whatnots

Get Value
From Name
Froductales e Product_lInfo String Table
9556, 10867 5432 Productinfotxt
R 9556, 10867, 5432, 0 | 9556
- e ? o 1 | 10867
2 5432
3 23

The OptoScript code in this example also makes use of the command Set Communication Handle Value to
change the value of a specific communication handle during the operation.

Sets the value for the communication

handle chAFile. SetCommunicationHandleValue ("file:r, ProductRequest.txt",chAFile) ;

Opens the communication handle and status = OpenOutgoingCommunication (chAFile) ;
checks to make sure it opened. if (status == 0) then

Sets the end-of-message terminator to a
comma because the file to be read is SetEndOfMessageTerminator (chAFile, ','");
comma-delimited.
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Reads the contents of the file Pro-
duct_Names into a string table.

Loops through the items in Product_Names
table and places the values they represent
into another string table, Product_Info.
(Note that the “numbers” in the Pro-
duct_Info table are not true numbers, but
string representations of numbers.)

Closes communication.

Changes the value of the communication
handle; it is now set to write to the file
Productinfo.txt on the control engine.

Opens the communication handle and
checks to make sure it opened.

Makes the Productinfo.txt file comma-
delimited, too.

Writes the data from the Product_Info string
table into the Productinfo.txt file on the
control engine.

status = ReceiveStrTable (4,0, Product Names,chAFile);
index = 0;
while ((index < 4) and (status == 0))

status = GetValueFromName (Product Names [index],

Product Info[index]);

index = index + 1;
wend
status = CloseCommunication (chAFile);

SetCommunicationHandleValue ("file:w,ProductInfo.txt",chAFile);

status =
if (status == 0)

OpenOutgoingCommunication (chAFile);
then

SetEndOfMessageTerminator (chAFile, ',"'");
status =

endif
endif

TransmitStrTable (4,0, Product Info,chAFile);

Deleting Files and Moving Within Them. Another command you'll find useful with file communication
handles is Send Communication Handle Command. It provides a way for you to send a series of file
manipulation commands to delete files, find a position within the file, or jump to a specific position within the
file. For syntax and usage notes on the Send Communication Handle Command, see the PAC Control
Command Reference (form 1701) or online help.

For example, in order to find specific data in a file, you can program a series of Send Communication Handle
Commands that sends each of the following commands.

+ find:<mystring>

(for strings only) Use this command to search for a string within the file and return its location as an offset
from the current position in the file. The file must have been opened in r (read) mode.

* getpos

Returns an integer that indicates the current position in the file.

«  setpos:position

Jumps to the specified position within the file.

Moving Files via FTP

As explained in the previous section (“Managing and Accessing Files in the Control Engine’s File System,”
starting on page 305) the control engine’s memory includes a substantial area available for file storage. You
can move files to and from file storage using the File Transfer Protocol (FTP):

«  Tomove files to and from file storage using another device such as a PC, use any standard FTP
software. See instructions in the PAC Manager User's Guide (form 1704). A maximum of five devices can

312

FTP files to a control engine simultaneously.

«  Tomove data to and from file storage programmatically, a strategy can request or send a file using
an FTP communication handle, explained in this section. A maximum of 16 communication handles can

be used simultaneously to move data via FTP.

FTP also allows you to get a directory listing of files on a remote server or in the local file storage area. In

addition, if your SNAP PAC controller has a microSD card slot in the top of the controller’s case, you can use the

FTP communication handle to manipulate files on a microSD card.
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FTP Communication Handle Examples

The value for the FTP communication handle is in the format:

ftp:<IP address>:<port>,<username>,<password>,<optional timeout>

ftp Use all lowercase letters.
IP address IP address (or URL) of the destination device (where the file will go).
port Default portis 21, with 20 for the data port.

Enter the username and password set up for the destination device. If
the destination device is another control engine or the local server, use
anything except an empty string.

username
password

Specify a communication timeout value in seconds, or leave this param-

ti 1 ti t
optiona Hmeou eter out to use the default of 30 seconds.*

Timeout Values In SoftPAC—The operating system sets the actual timeout value, which may differ from the
value you specified. The operating system sets a minimum actual timeout of 4 seconds and increases the
value by increments of 4 to a maximum of 20 seconds. If you specify a value that is outside of this range of
values, the operating system sets the timeout value as follows:

PAC Control returns the
following error code after

If you pass avalueinthe the operating system sets

following range: the timeout value to: exceeding ticout;
.001 - 4.0 seconds 4 seconds Open Timeout (-50)
4.1 - 8.0 seconds 8 seconds Open Timeout (-50)
8.1-12.0 seconds 12 seconds Open Timeout (-50)
12.1 - 16.0 seconds 16 seconds Open Timeout (-50)
16.1 - 20.0 seconds 20 seconds Open Timeout (-50)
> 20.0 seconds 21 seconds FTP Connect Failed (-447)

Here are two examples of FTP communication handle values:
ftp:10.22.55.35:21, jsmith, 2towers, 60 (timeout increased to 60 seconds)
ftp:10.192.54.195:21,m,m (no timeout specified)

To add a communication handle, see the steps starting on page 289. In the Add Variable dialog box, enter the
communication handle value in the Initial Value field.

Mame: | Comm_Handle_FTP

Add Variable 3
|
|

Description: |

Tvpe: | Communication Handle |

Initialization
() Initialize on strateqy download
(%) Initialize on strategy run
() Persistent

Communication
handle value

Initial Yalue: | ftp:10.22.55.35:21 jsmith, 2towers 50—

Ok H Cancel H Help
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Setting the FTP Mode

If you are connecting to an FTP site behind a firewall, you may need to set a mode for the session. After the
communication handle is open, you can set the FTP mode by issuing one of the following commands:
»  ForActive FTP:
i32ResultCode = SendCommunicationHandleCommand (cmh, "active");
»  ForPassive FTP:
i32ResultCode = SendCommunicationHandleCommand (cmh, "passive");

Using FTP Communication Handles in Your Strategy

Suppose you have data you need to send via FTP to a device on the network whose IP address is 10.192.56.45.
Your user name on this device is JoeG and your password is hello. You expect the default timeout of 30
seconds to be adequate.

There are two ways you can send the data: all at once, or in pieces over time. If your data file is less than 1 MB
in size, you can send it all at once. If it is larger, or if you want to append additional data to a file that already
exists, you send it in pieces.

Sending or Retrieving the Data All At Once. This method is better for small data files; files larger than
1MB may take a long time to transfer, and the control engine may become unresponsive during the process.

For Sending: Suppose you want to send the data currently in the file SendThisData.txt on the control engine
to a file HunkoData.txt on the device.

Here's how you would send the data in your PAC Control strategy.

1. Use the command Open Outgoing Communication to open an FTP communication handle. The value of
the handle would be: ftp:10.192.56.45:21,JoeG,hello

Use the condition Communication Open? to make sure the communication handle opened.

3. Use the command Send Communication Handle Command to specify the file name and send the file in
one step.

Use the communication handle command send:<local filename>, <remote filename> as follows:
send:SendThisData.txt,HunkoData.txt
If the remote file name already exists, it is overwritten.

4. When you have finished sending data to the file, use the command Close Communication to close the
communication handle.

For Retrieving: Suppose you want to get the data from the file GetThisData.txt on the device, and retrieve it
to the file HunkoData.txt on the control engine.

Here's how you would retrieve the data in your PAC Control strategy.

1. Use the command Open Outgoing Communication to open an FTP communication handle. The value of
the handle would be: ftp:10.192.56.45:21,JoeG,hello

Use the condition Communication Open? to make sure the communication handle opened.

3. Use the command Send Communication Handle Command to specify the file name and retrieve the file
in one step.

Use the communication handle command get:<remote filename>,<local filename> as follows:
get:GetThisData.txt,HunkoData.txt
If the local file name already exists, it is overwritten.

4. When you have finished retrieving data from the file, use the command Close Communication to close
the communication handle.

Sending the Data in Pieces. To append data to an existing file, or to send a very large file (larger than 1
MB), you can send data in pieces.
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Suppose you want to append data from a strategy variable or table to an existing file named HunkoData.txt on
the device. Here’s how you would send the data:

1. Use the command Open Outgoing Communication to open an FTP communication handle. The value of
the handle would be: ftp:10.192.56.45:21,JoeG,hello

Use the condition Communication Open? to make sure the communication handle opened.

3. To specify the file name on the remote server, use the command Send Communication Handle
Command. The communication handle command you send is:
dest:HunkoData.txt

4. Use aTransmit command (such as Transmit String or Transmit Numeric Table) to send the data. In the
command, use the name of the FTP communication handle you just opened.
Data is appended to the file. (If the remote file name is new, the file is created and the data placed in it.)

5. When you have finished sending data, use the command Close Communication to close the
communication handle.

If you are sending a large file from the control engine to the device, you would need to open up two
communication handles: an FTP handle just like the one in the example above, and a File handle for the file on
the control engine. Then use the Transfer N Characters command to send the file in chunks.

For another example, see the diagram in “A More Complex Example”on page 311, which shows how FTP
communication handles and file communication handles might be used together. See the PAC Control
Command Reference or online Help for detailed information on commands.

Retrieving a Directory Listing

The OptoScript code in this example makes use of the command Set Communication Handle Value and the
dir option to retrieve a directory listing.

Sets the value for the
communication handle chA-
File.

Opens the communication
handle and checks to make
sure it opened.

Requests directory listing,
returns number of listings.

Makes sure “dir” worked.
Firmware must be version R7.1
or greater.

Reads in listings to stList.
NOTE: Each listing from an
Opto 22 device server ends
with these hex bytes: 0D 0A
and is delineated from the
next by a 00.

// Configure the chFTP comm handle to log into itself. The username and
// password don't matter--they just can't be left empty. We'll use the
// loopback address of 127.0.0.1 so this code is more portable.

SetCommunicationHandleValue ("ftp:127.0.0.1:21,noimporta,whocares", chFT
P )
// Open the communication handle (log in to the local server)
nStatus = OpenOutgoingCommunication( chFTP );
if (nStatus == 0) then
nStatus = SendCommunicationHandleCommand( chFTP, "dir" );
if (nStatus >= 0) then
nFileCount = nStatus;
// Set the EOM character to 00
SetEndOfMessageTerminator ( chFTP, 0x00 );
nStatus = ReceiveStrTable( nStatus, 0, stList, chFTP );
if ( nStatus == 0 ) then
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for nIndex = 0 to (nFileCount - 1) step 1
Optional: Parses each listing GetSubstring ( stList[nIndex], 0, 17, stDateTimeStamps[nIndex] )
into separated tables for: g
1. date/time stamp (first 17 GetSubstring( stList[nIndex], 18, 21, sTemp );
characters) ntSizes[nIndex] = StringToInt32( sTemp ) ;
2. file size (next 21 characters) GetSubstring ( stList[nIndex], 39, 1000, stFilenames[nIndex] );
3. file name (remaining
characters) and removes the nLength = GetStringLength ( stFilenames[nIndex] ) ;
0D OA left over on the end of GetSubstring ( stFilenames|[nIndex], 0, nLength - 2,
the file name. stFilenames [nIndex] );
next
Further parsing could be done endif
on the date/time stamps, endif
depending on how those val- |endif
ues will be used. CloseCommunication( chFTP );

Communicating with Serial Devices

There are several ways to connect serial devices to a groov or SNAP PAC system:
«  Directly to a processor or controller

-~ Ona SNAP-LCE or SNAP Ultimate controller, firmware version R5.1c or higher is required.
»  Through a serial module

After you connect the devices, you can send or receive data directly from a serial device, such as barcode
readers, weigh scales, or any intelligent device.

Your PAC Control strategy communicates with these intelligent devices through communication handles
(serial or TCP).

If you are connecting serial

. ...then the PAC Control strategy will... Follow the instructions...
devices...

to a groov EPIC processor, SNAP PAC con-

. communicate through a serial communication handle. in the rest of this section.
troller, or a groov serial module

to a SNAP PAC serial module communicate through a TCP communication handle. on page 290.

The rest of this section describes how to enable communication with serial devices connected as described in
the first situation above:

1. Connect the device.

“Connecting Serial Devices Directly to a Processor or Controller”on page 316
—  “Connecting Serial Devices to a groov Serial Module” on page 317.
Configure the serial port as described on page 317.
Identify the port number or numbers as described on page 317.
Create the communications handle in PAC Control as described on page 318.
Program the communications flow as described on page 320.

e whN

Connecting Serial Devices Directly to a Processor or Controller

Several Opto 22 SNAP PAC controllers and the groov EPIC processor (GRV-EPIC-PR1) provide a way to directly
connect a serial device:

groov EPIC processor. On the bottom, through the USB ports. You connect the serial device to a
USB-to-serial adapter, which then connects to one of these ports. You can expand the number of serial
devices you can connect to the processor by first connecting a USB hub to one of these ports, then attaching
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adapters to each port in the hub. For a description of how this works, see “Connecting Serial Devices”in the
groov EPIC User's Guide (form 2267).

SNAP PAC, SNAP-LCE, and SNAP Ultimate controllers. On the top. The following diagram shows
some examples:
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Connecting Serial Devices to a groov Serial Module

The groov serial module provides serial data communications for a variety of applications. For specific
instructions on connecting serial devices to these modules, see the groov Serial Modules Data Sheet (form
2296).

Configuring the Serial Port

For serial devices connected through a groov serial module, you don't need to do any port configuration in
groov Manage.

For serial devices connected to a SNAP PAC, SNAP-LCE, or SNAP Ultimate controller, configure the serial port as
instructed in the following sections:

«  For SNAP PAC R-series and SNAP Ultimate controllers: “Configuring Serial Ports on an On-the-Rack
Controller”of either the PAC Manager User's Guide (form 1704)

«  For SNAP PAC S-series controllers: “Configuring Serial Ports on a Standalone Controller” of either the PAC
Manager User's Guide (form 1704)

«  For SNAP LCE controllers: “Configuring Serial Devices” of the SNAP-LCE User’s Guide (form 1475)

IMPORTANT: For SNAP PAC, SNAP-LCE, and SNAP Ultimate controllers, be sure to use PAC Manager to set the
control function of any serial port you want to use to None. Otherwise, you will get a -20, (Resource Busy), error.

Identifying the Port Name or Number Assigned to a Serial Device

Each of the ports (whether they be on the processor, controller, or a groov serial module) is assigned a port
name or number. PAC Control communication handles need to know that name or port number. To find that
name:
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»  For SNAP PAC, SNAP-LCE, and SNAP Ultimate controllers, see the section that describes port numbering
in the respective controller's user’s guide.

«  Forgroov EPIC, see “Finding the device name and port number assigned to a serial device”in groov EPIC
User's Guide (form 2267).

Creating a Communication Handle for Serial Devices

In your PAC Control strategy, create a variable with the type Communication Handle. This variable will
represent the serial device. (For instructions on adding a communication handle, see the steps starting on
page 289.)

NOTE: Be sure to use a single communication handle for each of a controller's physical serial ports. If two charts were
to run simultaneously while sharing an open communication handle, it is possible for one serial port to transmit data
(on the wire) at the same time the remote device is transmitting a response.

You can specify the initial value for the variable in one of the following formats:

«  Format 1—For serial devices connected to SNAP PAC and SNAP-LCE controllers. You must use this
format for serial devices connected to SNAP Ultimate controllers. For instructions, see “Format 1”on
page 318.

«  Format 2—For serial devices connected to SNAP PAC and SNAP-LCE controllers. You must use this
format for serial devices connected to groov EPIC processors and groov serial modules. For instructions,
see "Format 2"on page 319.

Format 1. You can use this format for serial devices connected to SNAP PAC and SNAP-LCE controllers. You
must use this format for serial devices connected to SNAP Ultimate controllers.

The format for the communication parameters is:

ser:<port number>,<baud rate>,<parity>,<data bits>,<stop bits>

The valid values for these parameters are:

Setting Valid Values

UlO:0or1
SNAP-PAC-51:0,1,0r 2

port number SNAP-PAC-S2:0,1,2,0r3
SNAP-PAC-R1, R1-B,and R2: 0
SNAP-LCE: O or 1

baud rate 230400%, 115200, 76800, 57600, 38400, 19200, 9600, 4800, 2400, 1200, or 300
parity n, o, or e (none, odd, or even)

data bits 8or7

stop bits lor2

*230,400 baud is not available on SNAP Ultimate and SNAP-LCE controllers.

EXAMPLE OF FORMAT 1

Here is an example of a serial communication handle value for a device connected to a SNAP PAC controller:
ser:0,115200,n,8,1 (port0, baud rate of 115,200, no parity, 8 data bits, and 1 stop bit)

In the Add Variable dialog box, enter the communication handle value in the Initial Value field.
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Initial Yalue: | ser.0.115200,8.1
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Format 2. You can use this format for serial devices connected to SNAP PAC and SNAP-LCE controllers. You
must use this format for serial devices connected to groov EPIC processors and groov serial modules.

With this format, you prefix the parameter values with keywords. This format:

«  offers more flexibility because you can specify keywords in any order. Each keyword must be lowercase
and followed by an equal sign and a value, with no spaces (even after commas), and

«  offers more parameters that you can specify; for example, you can specify RTS / CTS on a serial port on a
SNAP S-series or R-series controller.

The format for the communication parameters is:

«  Forgroov serial modules:

@<channel name>:<keyword>=<value>, <keyword>=<value>, ...

Note that you do not specify the port number.

»  Forgroov EPIC processors or SNAP PAC controllers:
ser:<keyword>=<value>, <keyword>=<value>, ...

NOTE: You must include at the minimum the port number and one parameter. Otherwise, it will not work.

If a parameter is not specified, the current value is used, so if you are unsure of the current value for a

parameter, you should specify it.

The keywords and possible values are:

Keyword Valid Values

Comments

port

baud

parity
data
stop

mode

rts-cts

timeout

groov EPIC processor and SNAP PAC and
SNAP-LCE controllers: see documentation
groov serial module: do not use

230400, 115200, 76800, 57600, 38400,
19200, 9600, 4800, 2400, 1200, or 300

E,e, 0,0, N, n, 9%
8,7

1,2

0,522*

0,1,2

an integer or float value

For a list of available ports, see the documentation that came with your
processor or controller.

* A value of 9 is used for RS-485 multi-drop communications.
The number of data bits
The number of stop bits
* 522 enables I/0 mode. 0 should be used for everything else.

This is only for RS-232 mode.

0 turns rts/cts off.

1 enables symmetrical (full-duplex) rts-cts flow control.

2 enables asymmetrical (half-duplex) rts-cts flow control. By default the
system waits up to one second for cts to be asserted.

A length of time in seconds. The default is 1 second.
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EXAMPLES OF FORMAT 2

«  Foradevice connected to a groov EPIC processor’s USB port O:

ser:port=0,baud=115200,data=8,parity=n, stop=1, rts-cts=0

«  Foradevice connected to port #2 of a USB hub connected to USB port 1 on the groov EPIC processor:

ser:baud=115200,data=8, parity=n, rts-cts=1,stop=1,port=1.2,timeout=1.5

«  Foradevice connected to a groov serial module:

@Watt Meter:baud=115200,parity=n,data=8, stop=1

Note that no port number is specified.

o For devices connected to a SNAP PAC controller:

ser:port=0,baud=115200,data=8,parity=n, stop=1,rts-cts=0
ser:baud=115200,data=8, parity=n, rts-cts=1,stop=1,port=0,timeout=1.5

In the Add Variable dialog box, enter the communication handle value in the Initial Value field. (Due to the
long value, part of the value is not visible.)

Mame: | Comm_Handle_FTP

Add Variable 3
|
|

Description: |

Tvpe: | Communication Handle |

Initialization
() Initialize on strateqy download

(%) Initialize on strategy run

() Persistent
Communication
|nitial ¥alue: |ser:p0rt=D,baud=1 15200,data=8.parity=n.z handle value
[ Ok l [ Cancel ] [ Help ]

Programming the Serial Communications Flow

Program the communication flow in your PAC Control strategy as follows:

1. Add the command Open Outgoing Communication.

2. \Verify that the communication handle opened by adding the Communication Open? command.

3. AddTransmit, Transfer, and Receive commands to send or receive data as necessary. Remember to check
for any errors. Make sure your strategy receives data promptly:

—  For SNAP PAC, SNAP LCE, and SNAP Ultimate controllers: Incoming serial communication is buffered
up to 127 characters. If more than 127 characters come in before the strategy receives them, the
additional characters are lost.

—  For groov serial modules: Incoming serial communication is buffered up to 4096 characters. If more
than 4096 characters come in before the strategy receives them, the additional characters are lost.

NOTE: Leave the communication handle open for as long as you expect communication, instead of closing it
after each transaction.

4. When you have finished sending and receiving data, add the Close Communication command to close
the communication handle.

See the PAC Control Command Reference (form 1701) or online Help for details on using specific commands.

For more detailed information on setting serial communications, see the PAC Manager User’s Guide
(form 1704).
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Sending an Email

There are two email commands that you can add to a strategy that instruct the control engine to send an
email to recipients via SMTP:

»  Send Email sends a text-only email.

«  Send Email with Attachments sends text and one or more attached files such as log files, status
reports, and images.

The following examples are just a few of the many possible uses for these commands:

«  Send out updates of a system's status.

«  Acritical system sends hourly status emails; if no email arrives after an hour, it means something is wrong.
»  Send an email in case of an alarm condition.

«  Send a daily status report.

The rest of this section describes what you need to do to prepare your groov EPIC processor or SNAP PAC
controller to send an email, then shows you an example of how to add programming to your strategy that
creates and sends an email.

Configuring Your Controller or Processor to Send Emails

There are a few things you must do and some decisions you must make before you can start programming
your strategy to send emails:

Step1: Make sure the controller or processor has an IP address.
Step 2: Choose between a corporate email account or a free email account
Step 3: Collect SMTP server information for the corporate email account

Step 4: Install a new CA Root Certificate, and then install it.

Step1: Make sure the controller or processor has an IP address. In addition to an IP address, make

sure the controller or processor are assigned an appropriate Subnet Mask, DNS, and Gateway for the network.

«  For SNAP PAC controllers, see the instructions on assigning an IP address in the PAC Manager User’s Guide
(form 1704).

«  Forgroov EPIC processors, see the instructions on connecting the processor to a network in the groov EPIC
User's Guide (form 2267).

Step 2: Choose between a corporate email account or a free email account. The Send Email

commands require an existing email account.

« If you want to use a corporate email account, discuss the following items with your network
administrator:

—  Determine if the company’s SMTP server supports either AUTH LOGIN or AUTH PLAIN
authentication. The Send Email commands require one of these authentication methods. The
commands do not support AUTH MD5 nor AUTH CRAM-MDS.

- Determine if the company SMTP server implements SSL or TSL security.

- If the company SMTP server implements SSL (Secure Sockets Layer) or TSL (Transport Layer
Security), determine whether the root certificates in your SNAP PAC controller or groov EPIC
processor are trusted by the SMTP server.

«  If youwant to use a free email account such as Outlook.com® or Yahoo!® Mail, you'll need to verify that
the root certificate installed in your SNAP PAC controller or groov EPIC processor is trusted by the SMTP
servers of your email service provider.

Step 3: Collect SMTP server information for the corporate email account. If you will be using a
corporate email account, ask your network administrator for the following information about the SMTP server:
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«  Outgoing SMTP server name or IP address
« Port
«  Security type: SSL and TLS are standard security technologies for establishing an encrypted link

between a web server and a browser. Make note of which technology is implemented on your company
SMTP server because you'll be specifying this information in the server information table (see “Send Email
with Attachments Example”on page 323).

If your company SMTP server does not implement any security, you'll be specifying “none”in the server
information table and the connection will not be authenticated. However, be aware of the following
situations:

- Ifthe target mail server doesn't require SSL or TLS, the login will succeed.

- If the target mail server does require SSL or TLS, the login will fail.

Most servers require encryption, so unless you're using an in-house server, you'll probably be specifying
SSLorTSL and need a root certificate.

«  Root certificate (if applicable): A root certificate validates an SSL or TLS secure connection. (If you are
unfamiliar with how root certificates work, see “Understanding root certificates” on page 322.) If you and
your network administrator determine that the root certificate installed in the SNAP PAC controller or
groov EPIC processor is not trusted by the company’s SMTP server, you must obtain a new root certificate
and install it on your controller or processor.

You don't need to install a root certificate to send email if:
- You're using a SoftPAC controller. (SoftPAC uses the certificates installed in Windows).
- Your email service provider uses the Equifax® or Digicert® certificates built-in to PAC firmware
(available in R9.5a and higher).
UNDERSTANDING ROOT CERTIFICATES

You must install a security certificate if you want to have secure network communications using SSL/TLS
Internet protocols. A security certificate is a digital tool used by Web browsers and other network services to
validate the identity of the server your computer is connecting to. For example, before you access email or
make a payment over an HTTPS Internet connection, the server and your computer verify their identities by
exchanging information about their security certificates. If something is wrong with the certificates, your
browser typically displays a warning that the connection is not secure.

A CA certificate is a type of security certificate that is issued by a Certificate Authority, which is a trusted entity
(for example, Digicert® and GoDaddy®) that issues legitimate digital security certificates. A root certificate is a
kind of security certificate that ensures the certificate’s authenticity by identifying the root CA (that is, the
original source of the certificate’s verification). Root certificates use a special kind of cryptography known as
public key infrastructure.

PAC firmware R9.5a and higher include certificates for Equifax and Digicert. This means that if you are using
PAC firmware R9.5a (or higher) and PAC Manager R9.5a (or higher), you may not have to install a separate CA
root certificate to send emails. However, you may need to install a CA root certificate if:

«  Your email service provider doesn't use the same certificates in PAC firmware.
«  Youwantto use an HTTPS Get or HTTPS Post communication handle.

«  Youwant to use a SNAP PAC device (as a client) to make a connection to other secure devices via a TCP
communication handle.

Before you can install a CA root certificate, you must:

«  Have a CAroot certificate that uses Base64 ASCII format. (Your company’s IT department should be able
to provide this, as they will know the server it needs to match. For example, if the certificate is for email, it
must match the email server.)

- You can tell a certificate file is Base64 ASCII format if:
—  The file has a .PEM extension; or
- Youopen the file in a text editor (such as Notepad) and you see the line:
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SNAP PAC controller can accept only one certificate per file. You can tell whether there is only one
certificate in a file by opening the file in a text editor and verifying there is only one line that says,

«  Know where to locate the certificate on your network (that is, its path and filename).

Step 4: Install a new CA Root Certificate. If you need to install a new root certificate into a groov EPIC
processor, see the instructions on managing certificates in the groov EPIC User’s Guide (form 2267).

For a SNAP PAC controller, you use PAC Manager to place the certificate in the /pki/roots-certs folder.

NOTE: As part of the process of installing the certificate on the controller, the controller will be restarted to
activate the certificate. You may need to schedule a system shutdown to coordinate putting the certificate on the
controller and rebooting the controller.

To place a root certificate in the /pki/root-certs folder on your controller:

In the PAC Manager menu bar, click Maintenance .
In the Command list, select Upload File To I/0 Unit.

3. Click the Browse button | and browse to the location of the certificate. Select the certificate, and then
click OK.

4. Inthe Destination field, type /pki/root-certs/ and the name you want the certificate to have on the
controller; for example:
/pki/root-certs/Equifax Secure Certificate Authority.cer

5. Select the IP address of the SNAP PAC device that you want to install the certificate on.

r ~
=5 /0 Unit Maintenance X
Command
Install Firmware Filename: IP Addresses Add
Install Module Firmware = =
Install 1jO Coprocessor Firmware | C:\Equifax_Secure_Certificate_AL J 99,999,98.920 =
Install CA Root Certificate Modify...

Destination:

Download File From I/0 Unit
Ipload File To IO Unit i Jpkifroot-certs Equifax_Secure_Ce Delete

Delete File On IO Unit
Read Filenames On IO Unit

Save Files To Flash Save...
Read Files From Flash
Clear Flash Files Load...

Sync 1O Unit to PC Time

“w S e B o i, ptson

e

Click Execute.

(Optional) Repeat steps 26 if you have additional certificates to install.
Select the Save Files To Flash command, and then click Execute.
Restart the SNAP PAC device to activate the certificates.

v LN

Send Email with Attachments Example

The simple example strategy below demonstrates how to use OptoScript to create and send an email using
the Send Email with Attachments command. You can of course use the PAC Control versions of the Send Email
commands. However, with OptoScript you can more easily see and edit each of the email components—the
Server information, Recipients, Message Body, and Attachment File Names. For a description of the syntax and
a list of the options available for these commands, see the PAC Control Command Reference (form 1701).

A sample chart to send email is available at www.opto22.com. Go to Support > Downloads and then search
for Sample PAC Control Basic Chart to Send Email in Samples and Freeware.
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The strategy is comprised of only one chart, the Powerup chart, which has two OptoScript blocks, Init Tables
and SMTP Send. The first OptoScript block, Init Tables, contains the email body. The second one, SMTP Send,
uses the Send Email with Attachments command to send the email and attachments.

Here's how you build this example:

Create a new strategy and then choose Configure > Control Engine to configure a control engine. For

instructions on configuring a control engine, see “Associating the Control Engine with Your Strategy” on

1.
page 102.
2,
“Adding Variables” on page 259.
Name Type
nResult Integer32
3. Create a string variable as follows.
Name Width
CRLF 256
4.
page 259.
Name Table Length String Width
arrstrAttach 10 256
arrstrBody 100 1024
arrstrRecipients 10 256
arrstrServer 10 256
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To the Powerup chart, add an Action Block followed by two OptoScript Blocks and then one more Action
Block.

Position Name Type Function

First Begin Action Start

Second Init Tables OptoScript Contains the email body

Third SMTP Send OptoScript Sends the email and attachments
Fourth End Action End

Connect the blocks starting with the first Action Block.

Begin

y

b
1
Init Tables
W
2
{ SMTP Send >._ SMTP Send sends the email and attachments
W
3

End

Init Tables contains the email body

Add code to the InitTables OptoScript Block.

This block creates the contents of the string tables which include server information, a recipient list, the
body of the email, and a list of attached files.

The first line in the block defines CRLF as a carriage-return / linefeed combination, chr(13)+chr(10),
which starts a new line in the email body. Defining this value allows you to use CRLF instead of having to
spell out the chr(13)+chr(10) combination each time. For a double carriage-return / linefeed
combination, use CRLF+CRLF.

NOTE: If multiple emails with the similar subject and body text are sent through the same email account, the
emails may be flagged as SPAM by the email service provider and not be delivered. To avoid this, you may need
to add code to the subject and body text that changes the text dynamically with each new email.
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CRLF = chr (13)+chr (10); // For convenience
__ arrstrServer[0] = "myaccount@speedmail.com"; // User Account
arrstrServer[l] = "mypassword"; // Password
arrstrServer[2] = "smtp.speedmail.com"; // Server
arrstrServer[3] = "587"; // Port#

A arrstrServer[4] = "tls"; // "ssl", "tls", "none"
arrstrServer[5] = "to.tx:2000"; // These are optional:
"to.tx:nnnn", "to.rx:nnnn", "to.cx:nnnn", "badcert:0", "revoked:0",
"expired:0", "matched:0", "knownca:0"

B arrstrRecipients[0] = "xyz@mymail.com"; // Recipient list
arrstrRecipients[1l] = "abc@yourmail.com";

B | arrstrRecipients([2] = ""; //This blank ends the
recipient list
arrstrRecipients[3] = "johndoe@hismail.com"; //This recipient will be

L ignored

— arrstrBody[0] = "Opto Email Example"; // Subject line
arrstrBody[1] = "Hello:"+CRLF; // Body starts here
arrstrBody[2] = CRLF; // Could have been combined
above
arrstrBody[3] = "This is an example of an email that can be sent from a
PAC ";
arrstrBody[4] = "controller. It includes three attachments: two JPG

C images, ";
arrstrBody[5] = "and this strategy."+CRLF+CRLF;
arrstrBody[9] = "Sincerely, "+CRLF;
arrstrBody[10] = "Opto Controller";
arrstrBody[11l] = ""; // This blank denotes end of
body

L arrstrBody[12] = "This is not included in the body.";

— arrstrAttach[0] = "My image file.jpg"; // List of files to attach
arrstrAttach[l] = "Another image file.jpg";
arrstrAttach[2] = "A zip file.zip";

D arrstrAttach([3] = ""; // This blank ends the
attachment list
arrstrAttach[4] = "Attachment.jpg"; // This attachment will be
ignored

< >

A—Server Information. The first five elements of the server table are required. The sixth
element is optional.

—  Element 0 (shown as arrstrServer[0] in the example): User account
Here are the ways that you can specify the user account and “from”names in element O:

If you want this: Use this:

No user account and no “from” arrstrServer[0] = "";

User Account only, (“from” uses the arrstrServer[0] = "MyAccount";
account name)

Account only (no “from”) arrstrServer[0] = "MyAccount:";
“from" only (no user account) arrstrServer[0] = ":FromName";

Separate account and “from” names arrstrServer[0] "MyAccount :FromName";
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—  FElement 1 (shownasarrstrServer [1] inthe example): Password

For a corporate email account, the values you specify for the next three elements (Server, Port, and

Security) are based on information you obtained from your network administrator when you completed

“Step 3: Collect SMTP server information for the corporate email account”on page 321.

—  Element 2 (shown as arrstrServer[2] inthe example): Server

—  FElement 3 (shownas arrstrServer [3] inthe example): Port number

—  Element4 (shown as arrstrServer [4] in the example): Security
Remember: specify “none” only after reviewing “Step 3: Collect SMTP server information for the
corporate email account”on page 321.

—  FElement5 (shownasarrstrServer [5] inthe example): (optional) Transmission timeouts and
which SSL errors to ignore.
If you want to change the timeouts for transmitting, receiving, and connecting, see “Setting
Timeouts for the Send Email Commands”on page 328. The default is 10,000 milliseconds (10
seconds) for each.

If you want to specify that the control engine ignore certain SSL errors, see “Ignoring SSL errors” on
page 328.The default is that no SSL errors are ignored.

B— Recipients. Enter the email address for each recipient. Make sure the recipients list contains at
least one valid entry.

C—Message Body. Element zero is always the subject line. Each line is entered as a separate
string. However, they will be concatenated in the body of the email. The email body starts with element
one, and continues to the first empty element or the end of the table, whichever comes first. Note that a
blank line is not the same as an empty element.

D—Attachment File Names. Any files you specify in the attachments table must exist on the
SNAP PAC controller's file system (RAM, flash, or SD card) or the groov EPIC processor’s file system (flash).
Specify the path and file name as follows:

- Ifafileisin the root directory, just specify the file name.

- Ifthefileisin a subdirectory, specify the full path name.

- For SNAP PAC controllers, if a file is in a subdirectory of the SD card, you must put /sdcard0 in
front of the full path name. For example, /sdcard0/temp/file.text indicates that file.txt is in the
temp subdirectory on the SD card.

- Foragroov EPIC processor, if a file is in the secure area, you must put ~/ in front of the full path
name. For example, ~/temp/file.text indicates that file.txt is in the temp subdirectory of the
secure area. If afile is in the unsecured area, you must put ~/unsecured in front of the full path
name. For example, ~/unsecured/temp/file.text indicates that file.txt is in the temp
subdirectory of the unsecured area.

You can attach any kind of file, so long as there is room in the file system. However, be cautious about file
size; many Internet service providers still have a 10 MB attachment limit.

8. Add code to the SMTP Send OptoScript block.
This block invokes the Send Email with Attachments command to send the email with attachments:

// Send email with attachments, using the tables set up previously
nResult = SendEmailWithAttachments (
arrstrServer, // Table with server info
arrstrRecipients, // List of recipients
arrstrBody, // Body text
arrstrAttach ); // List of attachments
« [ b

9. (lick Debug, and then click Run Strategy.
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The email and attachments are sent to the recipient(s) in your list.

For more information on these commands, see the PAC Control Command Reference (form 1701).

Setting Timeouts for the Send Email Commands

The default Send Mail commands timeout for transmitting, receiving, and connecting is 10,000 milliseconds
(10 seconds) when you have filled in elements 0—4 of the Server Information table (see page 326). If you want
to change one or more timeouts from the default, add an element 5 and specify the value as follows:

Use this command (where “nnnn” is the timeout in

LD E e milliseconds):
Set transmit timeout "to.tx:nnnn"
Set receive timeout "to.rx:nnnn”
Set connect timeout "to.cx:nnnn”

Each timeout command is independent of the others so you can use one, two, or all three of the commands in
any order. If you use more than one command, put a space between each one.

The following example sets the transmit timeout to 20 seconds and the receive timeout to 15 seconds. The
connect timeout is not changed.

arrstrServer [5]="to.tx:20000 to.rx:15000"

Table hame Element 5 Transmit timeout Receive timeout

Ignoring SSL errors

You can specify options to ignore certain SSL errors when the strategy attempts to send an email. Before you
specify these options, carefully review (preferably with your network administrator) whether the need to send
the email outweighs the risk of ignoring certain SSL errors. You can specify any of the following options in
element 5 of the server information table:

To ignore this error: Specify this option:

Certificate is corrupt or unusable "badcert:0"

Certificate was revoked by the issuing authority "revoked:0"

Current date is beyond the certificate’s end date "expired:0"

Neither the certificate’s common name nor subject alternate name "matched:0"

matches the name of the host you're talking to ’

The authority that issued the certificate isn’t in the database of known R .
knownca:0

issuers

If you specify more than one option, put a space between each one. The following example instructs the
control engine to ignore SSL errors about corrupt certificates or certificate names that don't match.

arrstrServer [5]="badcert:0 matched:0"

Ignore messages about Ignore messages about
Table name Element 5 corrupt certificate names not matching
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Retrieving a Webpage

Use the HTTP Get command to retrieve non-secure (HTTP) or secure (HTTPS) content from a web page. The
example provided here uses the HTTP Get command in OptoScript to retrieve secure content from
www.google.com. For more information on this command, see the PAC Control Command Reference (form
1701).

To retrieve HTTPS content from a website, you will first need to:

Obtain the root certificate used by the target website to validate an SSL secure connection. (Your
company’s IT department should be able to provide this, as they will know the server it needs to match.)
Install the root certificate on your SNAP PAC controller. For instructions, see “Step 4: Install a new CA Root
Certificate”on page 323.

NOTE: If you are using a SoftPAC controller, you don’t need additional root certificates to use HT TP Get— the
necessary certificates are preinstalled with Windows.

[ Pointer Variables
I5) Communication Handles \& 1
(=) Numeric Tables
|5 String Tables
2 pststrTblBody
2 DstStrTbiHdr

S HTTP_SrcStrTblBody

nSendStatus = HttpGet(
DstStrTblBody. /7 Return body data dest string table
DstStrTbhlHdr, /7 Return header data dest string table

m

. / 0 for non-secure, <>0 for SSL
strCmd, 77 URI
nHttpStatus, 7/ Status returned by HTTP server
nPortSSL, /7 Port to which you want to connect

41>\ chant,

strURL ); 7/ Address, (numeric or www.google.com.
<l »

v JLNet ¢ Prev 1% Powerup

Confi| Output:

HTTP_SrcStrTblBody. // Source body data string table (may be
1 Ve

d: PAC Control Professional - [Powerup] [E]@
ﬁ, File Edit Configure Chart Subroutine Compile Mode Tools View Window Help |-
B
Bicots 1o o BRI L R
"
GoogleHttps o= 4 OptoScript - Powerup - Get Content (=3
5 € Veriebes X me |G| 4 RB|D M| AR %= =
= () Numeric Variables
% nHttpStatus o OptoScript Code:
132 rortsSL r Begin HoveToStrTableElements( ", 0, -1, HITP_SrcStrTblBody): R
xL‘;—é,‘;’nSendStams MoveToStrTableElement=s("", 0, -1, DstStrTblHdr): T
© [ String Variables HoveToStrTableElements("", 0, -1, DstStrTblBody):
stcmd ,—L strURL = "wyw.google.com";
58] struRL i stxCnd = "/";
E { GetContent nPortSSL = 443

[ Save J l Cancel l ’ Help ] [ Command Help Ln 19, Col 1

For this example, you'll need to install the Equifax Secure Certificate Authority (DER encoded X.509) root
certificate, which is available at www.opto22.com. (Go to Support > Downloads and then search for Equifax
Root Certificate in Samples and Freeware.) For instructions to install the certificate, see page 323.

1.

Make sure the controller is assigned an IP address as well as the appropriate Subnet Mask, DNS, and
Gateway for the network. For more information on how do this, see the PAC Manager User's Guide
(form 1704).

In PAC Control, create a new strategy.

Create the following numeric (Integer 32) variables set to “Initialize on strategy run.” For more
information, see “Adding Variables” on page 259.

Variable Name Type

nHttpStatus Integer32
nPortSSL Integer32
nSendStatus Integer32
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4. C(reate the following string variables.

Variable Name Type Width

strCmd String 100
strURL String 256

5. Create the following string tables. For more information, see “Public Access”on page 265.

Table Name Type Length Width
DstStrTbIBody String 100 1024
DstStrTbIHdr String 100 1024
HTTP_SrcStrTblBody  String 10 256

6. Add an Action Block named Begin, and an OptoScript Block named Get Content to the Powerup chart.
7. Connect the Begin block to the Get Content block.

1
Get Content

8. Add the following code to the OptoScript Block.

MoveToStrTableElements ("", 0, -1, HTTP SrcStrTblBody);
A MoveToStrTableElements ("", 0, -1, DstStrTblHdr);
MoveToStrTableElements ("", 0, -1, DstStrTblBody);

B —+—strURL = "www.google.com";
C —+—strCmd = "/";
D —+ —nPortSSL = 443;

nSendStatus = HttpGet (

DstStrTblBody, // Return body data dest string table

DstStrTblHdr, // Return header data dest string table
E —F——HTTP SrcStrTblBody, // Source body data string table (may be empty)
F—, // 0 for non-secure, <>0 for SSL

strCmd, // URL

nHttpStatus, // Status returned by HTTP server

nPortSSL, // Port to which you want to connect

strURL ); // Address, (numeric or www.google.com, etc)

4| §

A—MoveToStrTableElements. These lines ensure that the tables are empty.
B—Web address. The text string used for argument 7. For example “www.google.com”.

C—Sub-page. A forward slash (/) indicates the root level.
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D—Port number. 80 is the standard port if you want to retrieve HTTP content. 443 is the standard port if
you want to retrieve HTTPS content.

E—Timeouts. Use element [0] of the table for Argument 2 to change the timeouts for transmitting,
receiving, and connecting. For details, see “Setting Timeouts for the HTTP Get and HTTP Post from String Table
Commands”on page 331.

F—Security mode. Use 0 to retrieve non-secure connection HTTP content. Use a number other than zero
(such as 1) to retrieve secure HTTPS content.

9. (lick Debug, and then click Run Strategy.
10. Double-click the DstStrTblBody table to see whether the webpage content was retrieved. If content was
retrieved, you will see HTML code.

5. "DstStrTblBody" (scanning)
Name: DstStrTblBody

>

Index Value

<!doctype html><html itemscope="itemscope" itemtype="http://schema.org/WebPa...
02693,4004334,4004844, 4004949, 4005865,4005875,4006426,4006442,4006727,400705...
mers={};google.startTick=function(a,b) {google.timers[a]={t:{start:google.tim...
;position:absolute;top:-999px;visibility:hidden;z-index:998;right:0}.gbto #g...
:0}#gbg .gbm{right:0}.gbxms{background-color:#ccc;display:block;position:abs...
moz-box-shadow:0 2px 4px rgba(0,0,0,.2);-webkit-box-shadow:0 2px 4px rgba(0,...
4c4c4c;background-image:none;_ background-image:none;background-position:0 -1...
background:url (//ssl.gstatic.com/gb/images/b_8d5afc09.png) ;_background:url(/...
bmt : focus {background: {eee;cursor:pointer;outline:0 solid black;text-decorati...
9 c .gbps, .gbpc .gbps2{display:block;margin:0 20px}#gbmplp.gbps{margin:0 10px}...
10 :8px 20px 10px}.gbmpiaw{display:inline-block;padding-right:10px;margin-botto...
11 x 1px rgba(0,0,0,.1) ;box-shadow:inset 0 0 O 1px #fff,0 1px 1px rgba(0,0,0,.1...
12 lorStr='#4787ed') ;border:1px solid #3079ed;color:#fff!important;margin:0 O}....
13 ge:-ms-linear-gradient (top, #£5£5f5, #f1£f1f1) ;background-image:-o-linear-gradi...
14 d-image:-ms-linear-gradient (top, #fff, #fbfbfb) ;background-image:-o-linear-gra... v
m [ »

[

N N =)

ol
Mers o

Setting Timeouts for the HTTP Get and HTTP Post from String Table Commands

The default timeout for transmitting, receiving, and connecting is 10,000 milliseconds (10 seconds). If you
want to change one or more timeouts from the default, specify the value in element [0] of the table for
Argument 2, as follows:

To do this: Use this command (where “nnnn” is the timeout in milliseconds):

Set transmit timeout "to.tx:nnnn"
Set receive timeout  "to.rx:nnnn"

Set connect timeout  "to.ox:nnnn"

Each timeout command is independent of the others so you can use one, two, or all three of the commands in
any order. If you use more than one command, put a space between each one.

The following example sets the transmit timeout to 20 seconds and the receive timeout to 15 seconds. The
connect timeout is not changed.

HTTP SrcStrTblBody[0]="to.tx:20000 to.rx:15000"

Table hame Element 0 Transmit timeout Receive timeout
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CONTROL ENGINE COMMANDS

The following commands refer to the control engine:

Calculate Strategy CRC

Erase Files In Permanent Storage
Get Available File Space

Get Control Engine Address

Get Control Engine Type

Get Firmware Version

Get Number of Charts

Get Redundant Controller State
Get Redundant Controller Status
Get Strategy Name

Load Files From Permanent Storage
Retrieve Strategy CRC

Save Files To Permanent Storage
Start Alternate Host Task

Commands Relating to Permanent Storage

The term “Permanent Storage”in three of the commands listed above refers to the control engine’s flash
memory. Files that are saved to flash memory remain in the control engine even when power to it is turned
off. On a SoftPAC controller, files are saved to the PC's hard drive.

These commands do NOT affect firmware files, configuration data, or strategy files saved to flash; they affect
only files at the root of the control engine’s file system. For more information on the file system, see “Managing
and Accessing Files in the Control Engine’s File System” on page 305. For the specifics on individual
commands, see online help or the PAC Control Command Reference (form 1701).

CAUTION: Since these commands write to flash memory, use them sparingly within your strategy and make sure
they do notend up in aloop. You can literally wear out flash memory if you save to it or erase it too many times.

DIGITAL POINT COMMANDS

The following commands are used with digital points:

Basic Commands
Off?

On?

Turn Off

Turn On

Totalizers

Get Off-Time Totalizer

Get On-Time Totalizer

Get & Restart Off-Time Totalizer
Get & Restart On-Time Totalizer

Counters'

Clear Counter

Get Counter

Get & Clear Counter
Start Counter

Stop Counter
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Latches

Clear All Latches
Clear Off-Latch

Clear On-Latch

Get Off-Latch

Get On-Latch

Get & Clear Off-Latch
Get & Clear On-Latch
Off-Latch Set?
On-Latch Set?

Pulses

Generate N Pulses

Get Off-Pulse Measurement

Get Off-Pulse Measurement Complete Status
Get & Restart Off-Pulse Measurement

Get On-Pulse Measurement

Get On-Pulse Measurement Complete Status
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Get & Restart On-Pulse Measurement
Period and Frequency Start Continuous Square Wave
Get Frequency Start Off-Pulse
Get Period Start On-Pulse
Get Period Measurement Complete Status
Get & Restart Period
Get TPO Percent
Get TPO Period
SetTPO Percent
Set TPO Period

! Some digital point commands are available only in PAC Control Professional. Some commands are avail-
able only on some I/O units. For more information for each command, see the PAC Control Command Ref-
erence (form 1701) or online Command help.

States, Latches, and Counters

The following diagram illustrates states, latches, and counters. While states and latches apply to digital points
on all 1/0 units, counters depend on the capability of the brain. See the brain’s data sheet for specifications.

States, Latches, and Counters

State is ON Off latch is true (1) State is ON
ON: when value changes P
from ON to OFF.
On latch is true (1)
T when value changes l
from OFF to ON.
OFF:  meeeeeee——
State is OFF State is OFF
State: OFF ON OFF ON
On Latch: OFF ON ON (no change) ON (no change)
Off Latch: OFF OFF ON ON (no change)
Counter: 0 1 1 (no change) 2
Latches

Latches are an extremely high-speed digital function. Both on-latches and off-latches are available. Latches are
automatic and do not have to be configured.

When the value of a digital input point changes from off to on, an on-latch is automatically set. While the
value of the point may return to off, the on-latch remains set until cleared, as a record of the change. Similarly,
an off-latch is set when the value of a digital point changes from on to off, and it remains set until cleared.

To read a latch and clear it at the same time, use the command Get & Clear On-Latch or Get & Clear Off-Latch.
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Counters

Most standard digital inputs can be used as counters to count the number of times the input changes from off
to on. The availability of counters depends on the brain’s capabilities, and the speed of counters depends on
the module.

For information on brain capabilities, see the SNAP PAC Brains Data Sheet (form 1689).

For more information on module counting speed, see the module’s specifications at www.opto22.com. On
the website, select Products > SNAP PAC System > Brains and 1/0 > Digital I/0.

NOTE: You can use counters on high-density modules with SNAP-PAC-RT and SNAP-PAC-R1-B controllers, and
SNAP-PAC-EBT and SNAP-PAC-SBT brains with firmware R8.1 or higher.

Before using a counter, you must configure the point as a counter. (See “Adding I/0 Points”on page 130 or use
PAC Manager.) Counters on Ethernet and SNAP PAC I/O units do not need to be started, and they cannot be
stopped. Therefore, do not use the Start Counter and Stop Counter commands with SNAP PAC /0 units.
However, you can use Get Counter and Get & Clear Counter.

Counters on mistic I/0 units must first be started using the Start Counter command. In addition to Start
Counter, you can use the following commands on mistic 1/0 units: Stop Counter, Get Counter, Get & Clear
Counter, and Clear Counter.

Quadrature Counters

Quadrature counters require a special module and configuration, but once they are configured, you use the
same commands (such as Start Counter and Clear Counter) for them as for reqular counters.

NOTE: You can use counters on high-density modules with SNAP-PAC-RT and SNAP-PAC-R1-B controllers, and
SNAP-PAC-EBT and SNAP-PAC-SBT brains with firmware R8.1 or higher.

Before using a counter, you must configure the point as a counter. (See “Adding I/0 Points”on page 130 or use
PAC Manager.) Counters on Ethernet and SNAP PAC1/0 units do not need to be started, and they cannot be
stopped. Therefore, do not use the Start Counter and Stop Counter commands with SNAP PAC /O units.
However, you can use Get Counter and Get & Clear Counter. A positive value means that phase A leads phase
B. See additional details in the PAC Control Command Reference or online Help.

Counters on mistic 1/0 units must first be started using the Start Counter command. In addition to Start
Counter, you can use the following commands on mistic 1/0 units: Stop Counter, Get Counter, Get & Clear
Counter, and Clear Counter. A positive value means that phase B leads phase A.

Totalizers

Digital totalizers track the total time a specific input point has been on or off. For example, you could track how
long a pump, fan, or motor has been on. Digital totalizers are useful for periodic maintenance. Before using a

totalizer, you must configure the point with this feature. (See “Manually Adding groov I/O Modules & Channels
or SNAP /O Modules & Points” on page 132 for help.) The availability of totalizers depends on the brain; see the
brain’s data sheet for more information.

To check total time and leave the totalizer running, use Get Off-Time Totalizer or Get On-Time Totalizer. To
check total time and reset the totalizer to zero, use Get & Restart Off-Time Totalizer or Get & Restart On-Time
Totalizer.

Pulses

Pulsing commands send on- and off-pulses to an output point. The availability of pulsing depends on the
brain; see the brain’s data sheet for specifications.
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Generate N Pulses. The command Generate N Pulses is frequently used to flash a light or sound an alarm.
For example, you could sound a two-second alarm four times. In the arguments, you set the number of times
the on-pulse is sent, the length of the on-pulse, and the length of the off-pulse. Generate N Pulses always
starts with an off-pulse. If you resend this command, make sure to leave sufficient time in between so it does
not interfere with itself.

Start On Pulse and Start Off Pulse. The commands Start On Pulse and Start Off Pulse send a single
pulse cycle:

«  Start On Pulse starts with an on-pulse of a length you determine, and ends with an off-pulse.
«  Start Off Pulse starts with an off-pulse of a length you determine, and ends with an on-pulse.

Both of these commands can be used as time delays. For example, if a light is on and you want to turn it off
after 30 seconds, you can send a Start On Pulse command, setting the on-pulse to be 30 seconds long. At the
end of that time, the off-pulse is sent to turn off the light.

You can also use this type of command in a loop to turn a digital point on or off for short intervals. For
example, you could create a loop that checks the level of liquid in a tank and pulses on a drain if the level is too
high. The advantages of using a pulse command are that the point does not have to be turned off, and if
communication is lost to the point, the point does not remain on.

Pulse Measurement commands measure pulses on digital input points. For details, see the specific
command in the PAC Control Command Reference or online Help.

IVAL and XVAL

In PAC Control, all I/O points have two values:

«  XVAL—The external value, or XVAL, is the “real” or hardware value and it is located on the I/O unit (the
brain). This value is external to the control engine and strategy logic.

«  IVAL—The internal value, or IVAL, is a logical or software copy of the XVAL that is located in the control
engine. The IVAL may or may not be current, since it is only updated when strategy logic accesses the 1/0
point.

As you run your programs in Debug Mode and monitor /O points, you'll see that IVAL and XVAL usually match.
If the IVAL does not match the XVAL, it just means that your strategy logic is not reading from or writing to the
I/0 point in question at the moment.

How the XVAL and IVAL Values Help You Debug. Simulate, and Test

To test output performance, you may want to force an 1/0 point to a particular value. If the program is actively
writing to that I/0 point, you need to disable the communication from the control engine to the I/0 point.
Then you can change the XVAL to force the output to a particular value. If the program is stopped, there is no
need to disable the communication.

To test program logic, you may want to force an I/0 point to a particular value. However, doing so may be
difficult or inconvenient. (For example, if an 1/0 point monitors daylight, switching between day and night
would require waiting for sunrise and sunset.) In these situations, you can disable the communication from
the control engine to the I/O point. Then, you can change the IVAL of an I/0 point to simulate a particular
value.

You can disable the communication from the control engine to the I/0 point in two ways:

«  The more common way is from within Debug mode, by double-clicking a point on the Strategy Tree and
modifying the point’s settings and values through the Inspection dialog box. (See “Inspecting and
Changing Discrete /0 Points or Channels”on page 178.)

«  The second way is from within the strategy, using commands such as Disable Communication to Digital
Point, Disable Communication to Analog Point, or Disable Communication to I/0 Unit. (See “Simulation
Commands”on page 361.)
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Additional Commands to Use with Standard Digital Points

Although not listed under Digital Point commands, several other commands can be used for digital
operations:

«  Use Move to cause an output to assume the state of another input or output. A digital input or output
that is on returns a True (non-zero). A True (non-zero) sent to a digital output turns it on.

«  Use NOT to cause an output on one I/0 unit to assume the opposite state of an input on another /0
unit.

« Use Get I/0 Unit as Binary Value to get the state of all points at once. Then use Bit Test to determine
the state of individual points. This method is much faster than reading each point individually.

«  Use Set I/0 Unit From MOMO Masks to control all outputs at once.

Standard Digital Points and OptoScript Code

In OptoScript code, a standard digital I/0 point can be used directly, wherever a numeric variable can be used.
For example, you can turn a point off by assigning it a value of zero, or turn it on by assigning it a non-zero
value. You can also use standard digital points directly in mathematical expressions and control structures. For
more information, see “Using I/0 in OptoScript”on page 382.

Reading or Writing Digital Points

The Move command is the main command used to read or write digital points.

ERROR HANDLING COMMANDS

The following commands refer to handling errors:

Add Message to Queue Get Error Code of Current Error

Add User Error to Queue Get Error Count

Add User I/0 Unit Error to Queue Get ID of Block Causing Current Error
Caused a Chart Error? Get Line Causing Current Error

Caused an I/0 Unit Error? Get Name of Chart Causing Current Error
Clear All Errors Get Name of I/O Unit Causing Current Error
Copy Current Error to String Get Severity of Current Error

Disable I/O Unit Causing Current Error Remove Current Error and Point to Next Error
Enable I/O Unit Causing Current Error Stop Chart on Error

Error on 1/0 Unit? Suspend Chart on Error

Error?

All good programmers must deal with errors. These error handling commands are used to monitor errors,
figure out which I/0 unit caused an error, disable or re-enable communication to the I/O unit, and clear errors
and other messages from the message queue. For a simple example of an error handler chart, see page 89. For
more on the message queue, see “Queue Messages”on page 424.

You can use the command Add User Error to Queue to add your own information, warning, or error message
to the queue. This command can be helpful in troubleshooting.
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I0 Enabler Sample Strategies

Sample "IO Enabler”strategies are available on the Opto 22 website. The logic in these sample strategies is
designed to automatically recover communications to any I/0 unit that temporarily goes offline (that is, has
communications disabled) for any reason. Choose a sample that is compatible with your system
configuration. Each sample has the same basic code:

« 1/O Enabler for Ethernet, SNAP PAC, and Multifunction and Remote Simple (RS) mistic Brains
http://www.opto22.com/site/downloads/dl_drilldown.aspx?aid=3605

o |/O Enabler for Ethernet, SNAP PAC, and Multifunction mistic Brain
http://www.opto22.com/site/downloads/dl_drilldown.aspx?aid=3603

« |/OEnabler for Ethernet and SNAP PAC Brains
http://www.opto22.com/site/downloads/dI_drilldown.aspx?aid=3604

EVENT/REACTION COMMANDS

&

(Pro only) The following commands cannot be used with Ethernet-based I/0 units. They are used with
event/reactions on mistic 1/0 units, and are available only in PAC Control Professional when legacy I/0 units
and commands are enabled. To enable legacy I/0 units and commands, see “Legacy Options”on page 234.

NOTE: Similar events and reactions can be configured on a SNAP Ethernet-based I/O unit using
PAC Manager, but they can interfere with PAC Control strategy logic unless you are very careful.
For more information, see the PAC Manager User’s Guide, Legacy Edition (form 1714).

Clear Event Latch Enable Scanning for Event

Clear All Event Latches Enable Scanning of Event/Reaction Group
Clear I/0 Unit Interrupt Event Scanning Disabled?

Disable Interrupt on Event Event Scanning Enabled?

Disable Scanning for All Events Generating Interrupt?

Disable Scanning for Event Get Event Latches

Disable Scanning of Event/Reaction Group Get & Clear Event Latches

Enable Interrupt on Event Interrupt Disabled on Event?

Event Occurred? Interrupt Enabled on Event?

Event Occurring? Read Event/Reaction Hold Buffer

Enable Scanning for All Events

Understanding Event/Reactions (mistic Only)

(Pro only) An event/reaction lets you distribute control logic to an I/O unit, so that some of the logicin a
strategy can be run on the I/0 unit independently of the controller. Event/reactions are supported by most
mistic protocol brains. To verify, check the data sheet for the brain you are using.

As the name suggests, an event/reaction consists of an event and a corresponding reaction. The event is a
state you define that the I/O unit can recognize. The defined state can be a combination of values, inputs, and
outputs. Each time the event becomes true, its corresponding reaction is executed once.

On a digital multifunction I/0 unit, for example, any pattern of input and output states (on and off) can
constitute an event. On an analog I/0 unit, an event could occur when an input channel attains a reading
greater than a selected value. Examples of reactions include turning on or off a set of outputs, ramping an
analog output, or enabling or disabling other event/reactions.
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Event/reactions are stored in each I/0 unit. As soon as power is applied to the I/0 unit, all event/reactions for
which scanning is enabled are scanned continuously in the same order in which they were configured in PAC
Control. Since each mistic 1/0 unit can be configured with up to 256 event/reactions, complex tasks and
seguences can be performed on an I/0 unit.

For step-by-step instructions on configuring event/reactions, see “Configuring Event/Reactions”on page 166.

Why Use Event/Reactions?

«  Toreduce communication overhead between the I/O unit and the controller.

«  Todistribute control logic sequences to the I/0 unit rather than concentrating them in the controller.
«  Tohandle high-speed logic functions more efficiently by distributing them to an /0 unit.

«  Toincrease the execution speed of a strategy in the controller.

Typical Applications for Event/Reactions
«  Motor-starting logic

«  Drum sequencers

o Alarms

«  Analog biasing

«  Power-up sequencing

Using an Interrupt Chart with the Generating Interrupt? Command (mistic
Only)

@ (Pro only) There are two reasons to use an Interrupt chart:
«  Tobe promptly notified of critical events that occur on the I/0 unit.

« Toallow an event on one /0 unit to quickly cause a reaction on another I/O unit using logic in the
Interrupt chart as the gateway. (For maximum speed and efficiency, configure reactions to occur at the
I/0 unit whenever possible.)

To use an Interrupt chart, follow these steps:
1. Wire the interrupt lines from mistic 1/0 units to the controller.
2. Use the Generating Interrupt? command to determine which I/O units are generating an interrupt.
3. Foreach /O unit that is generating an interrupt, do the following steps:
a. Use the command Clear I/0 Unit Interrupt.
b. Use the command Event Occurred? to determine which event/reaction(s) caused the interrupt.
c. Foreach event that occurred, use the command Clear Event Latch.
d. Reactto each event as desired.

IMPORTANT: Check every event that may have caused the interrupt. There may have been multiple events.

See “Using an Interrupt Chart for Event/Reactions (mistic only)” on page 87 for a simple example.

|/0 QUALITY COMMANDS

NOTE: Applicable only to:

PAC Control R10.0a and higher for groov I/0 modules.
PAC Control R10.3a and higher for groov RIO modules.
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/0 Quality commands let you know if an exception condition has happened on a groov /0 or groov RIO
channel.

Get I/0 Channel Quality Get I/0 Channel Quality

groov I/0 and groov RIO modules that report quality continuously poll their channels for current data values
and identify deviations between reported and expected values. For example, when a channel on a GRV-IV-24
reports a value greater than 10% above range, the module sets a quality indicator code 15 (Input is more than
10% above the maximum range) on the channel. When the issue is resolved, the quality indicator code returns
to 0 (zero). For a list of quality indicator codes and descriptions, see the user’s guide for the corresponding
groov EPIC processor or groov RIO module.

Not all modules report quality indicator codes. The ones that do are:

groov /0 Modules:

+  GRV-IAC-24 «  GRVHICTD-12 «  GRV-OAC-12

«  GRV-ACK12 «  GRV-RTD-8 «  GRV-OACI-12

«  GRV-IDC-24 «  GRV-TM-12 «  GRV-ODCSRC-24
+  GRV-IDC-12 «  GRV-TMI-8 +  GRV-OVMALC-8
«  GRV-IDCIFQ-12 e GRVHTR-12 »  GRV-OVMAILP-8
«  GRV-IDCSW-12 «  GRV-IV-24

+  GRV-IMA-24 «  GRV-VI-12

«  GRV-IMAI-8 «  GRV-IVIRMS-10

groov RIO Modules:

»  GRV-R7-MM1001-10
«  GRV-R7-MM2001-10
«  GRV-R7-11VAPM-3

A quality indicator doesn't always mean a serious problem, but it's definitely something you should
investigate. It may indicate a configuration issue or an issue with a field device or field wiring. For example, if
you write a maximum output value that's higher than a channel’s normal range, the module may report a
quality indicator code of 21 (Output is at positive range limit); that is, the output channel is functioning
normally at its maximum positive range, despite the fact that your configuration tried to set its maximum
range to an out-of-range value.

Quality Indicator Codes

A brief description of a channel's quality indicator is visible when you are scanning the channel in
PAC Control’s Debug mode. When you use a PAC Control I/0 Quality command, a code is returned instead of
the description. The following is a list of valid quality indicator codes and their definitions.

Reportable by Description

Any channel reporting

quality

Data quality is good. No exception conditions occurred.

Analog input is not in range; firmware can't determine if above or below range.
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Code

13
14

15

16

17

18

19

20

21

Reportable by

Any channel configured
for |, g Vimg OF True
Power

Any channel configured
for |, g Vimg OF True
Power

Any channel configured
for Iy Vimg OF True
Power

mss

Any channel configured
for | s or Vs

Description

Analog input above operating limits.

Analog input below operating limits.

Module isolated field circuitry in reset; part of module firmware to auto-recover field circuitry
that may be in an undefined state.

Module failed communication with isolated field circuitry like analog to digital and digital to ana-

log converters.

Digital output is on, but current is not flowing. May indicate an open circuit or blown fuse in field
equipment.

Table lookup calculation beyond plus table end.
Table lookup calculation beyond minus table end.

Analog input is 10% above the highest range. Applicable to unipolar (zero and positive values

only) and bipolar (can include negative and positive values) signal ranges.

In the following examples, the module would set the quality indicator code to 15For example:

« A channel on a GRV-1V-24 module is configured for £10 VDC and the field signal is actually
12 VDC.

» A channel on a GRV-IMA-24 module is configured for 0-20 mA and the field signal is actually
23 mA.

« A channel on a GRV-IMA-24 module is configured for 4-20 mA and the field signal is actually
23 mA.

« Achannel on a GRV-IVAPM-3 module is configured for 0-5 A, and the field signal is actually
5.5 A

To determine the highest range value, see the specification table.

Analog input is 10% below the lowest range. Applicable only to bipolar (can include negative
and positive values) signal ranges. :
To determine the lowest range value, see the specification table.

Analog input is below lower limit for unipolar channels.

Analog output fault.

» When configured for voltage, indicates the load resistance is too low (that is, the load is
drawing too much current to maintain the voltage).

» When configured for current, indicates very high resistance or possible open circuit.

Analog output driver over temperature condition, output may cycle on and off.

Field excitation/loop voltage fault

Analog output is at the upper range limit. Applicable only when the value written exceeds the
maximum limit. Indicates the module has clamped the output to the limit. Can be caused by a
configuration or logic error; for example, the strategy sent a value to the channel that is above
the channel’s maximum range.
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Code Reportable by Description

Analog output is at the lower range limit. Applicable only when the value written is lower than
the minimum limit. Indicates the module has clamped the output to the limit. Can be caused by a

22 configuration or logic error; for example, the strategy sent a value to the channel that is below
the channel’s minimum range.

23 Isolated field compensation circuitry or calculation does not give valid data.

2 Digital input feature measurement fault. For feature types 2 (on time totalizer) and 18 (off time

totalizer).

Any channel reporting

. Channel not present.
quality

|/0 UNIT COMMANDS

The following commands are used to communicate with an 1/0 unit, which controls a group of I/0 points:

Clear I/0 Unit Configured Flag Move I/0 Unit to Numeric Table Ex

Get I/0 Unit as Binary Value Move Numeric Table to I/0 Unit

Get I/0 Unit as Binary Value 64 Move Numeric Table to I/0 Unit Ex

Get Target Address State' Set All Target Address States'

I/0 Unit Ready? Set 1/0 Unit Configured Flag

IVAL Move Numeric Table to I/0 Unit Set 1/0 Unit from MOMO Masks

IVAL Move Numeric Table to I/0 Unit Ex SetTarget Address State'

Move 1/0 Unit to Numeric Table Write 1/0 Unit Configuration to EEPROM

T PAC Control Professional only

CAUTION: Write I/0 Unit Configuration to EEPROM is not the recommended method for saving configuration to
flash memory. If it is used too often or is in a loop within a strategy, flash memory can literally wear out. Instead of
using this command in the strategy, it is better to store configurations to flash manually using either PAC Manager
(see the PAC Manager User’s Guide, form 1704, for instructions) or PAC Control in Debug mode (see “Inspecting I/0
Units”on page 176).

@ Commands for Ethernet Link Redundancy

(Pro only) The three target address commands (Get Target Address State, Set Target Address State, and Set All
Target Address States) are used to manually change the path of communication between the controller and
the 1/0 unit(s), based on the IP address used for the I/0 unit. These commands let you switch communication
from a primary to a secondary IP address (or vice versa) or enable or disable communication to the primary or
secondary address.

Ethernet link redundancy to 1/0 units is available only in PAC Control Professional, only from a SNAP PAC
controller,and only to Ethernet-based I/0 units. The secondary IP address for an I/O unit may be for the
second Ethernet network interface on a SNAP PAC R-series controller, or it may be for a separate I/0 unit. If it is
a separate unit, the primary and secondary /0 units must be the same type (for example, SNAP-PAC-EBT) and
have exactly the same points, because they are configured together under one name.

One or both target addresses (primary and secondary) can be enabled, but only one address (the active
address) will be used by the controller at one time. For link redundancy, both the primary and secondary
addresses must be enabled. When an I/0 unit is configured with two IP addresses, the default is for both to be
enabled and the primary address to be active.
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One address is always active. If communication fails through the primary address, the control engine
automatically switches to the secondary address. It continues to use the secondary address until
communication fails through the secondary address or until you change the active address using Set Target
Address State (for one I/0 unit) or Set All Target Address States (for all I/O units on the control engine).

You may also want to use these commands to disable one address, for example if you are doing maintenance
or repair on a network segment and need to switch communication to another segment temporarily.
Disabling one address, of course, means that you no longer have link redundancy.

If both addresses are disabled or unavailable, then communication is not possible and communication to the
/0 unit becomes disabled. If both addresses are disabled, and you want to bring the I/O unit back online, you
must first enable one or both of the addresses and then enable communication to the I/0 unit.

You can find out which addresses are enabled for an I/0 unit and which address is currently active by using
Get Target Address State. If an address is enabled but is not functional when a strategy is started or when
communication for an I/0 unit is changed from Disabled to Enabled, an error is posted in the controller's error
queue.

To use these commands, you must have already designated primary and secondary IP addresses when
configuring I/0 units. For steps, see “Adding an I/0 Unit"on page 125. For additional information about link
redundancy, see "Creating Redundant Ethernet Links in PAC Control” on page 104.

Table Commands

The table commands for I/0 units affect the states or values of all points on the I/O unit at once. For example,
you can use the command Move I/0 Unit to Numeric Table to read the states of all digital points and the
values of all analog points on one I/0 unit and place them into a table for easy retrieval. Table commands
move data very quickly for faster throughput.

Three of the table commands—IVAL Move Numeric Table to /O Unit Ex, Move I/0 Unit to Numeric Table Ex,
and Move Numeric Table to I/O Unit Ex—provide support for high-density points. A Points per Module
parameter lets you specify the number of points required. For example, if you are using 32-channel modules,
you would pass a 32. But if you are only using 8-channel modules, you could pass an 8 instead. This allows
table sizes to be as small as possible.

Other commands relating to tables can be found in the following topics:

“Miscellaneous Commands” on page 350
“Logical Commands”on page 345
“Mathematical Commands”on page 347
“Pointer Commands” on page 359
“String Commands”on page 361.

|/0 UNIT—EVENT MESSAGE COMMANDS

The following commands refer to event messages sent from SNAP PAC, SNAP Ultimate or SNAP Ethernet I/0
units. They do not apply to mistic event/reactions.

Get I/0O Unit Event Message State Set 1/0 Unit Event Message State
Get I/0 Unit Event Message Text Set I/O Unit Event Message Text

A SNAP PAC, SNAP Ultimate, or Ethernet I/0 system can send a message as a response to an event that occurs
within strategy logic. For example, if pressure in a pipe reaches a certain level, the system can send a warning
email message to a technician. Or data about a process can be streamed to a computer every 30 seconds for
monitoring.
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CAUTION: Events and reactions (including event messages that are processed separately from your strategy) can
conflict with strategy logic. Ifyou are using PAC Control, use strategy logic instead of local events and reactions on the
/O unit, or be very careful that local events and reactions do not conflict.

Use PAC Manager to configure event messages, following the steps in the PAC Manager User’s Guide
(form 1704). You can configure the following types of event messages:

«  Email or paging messages sent to a person

«  Simple Network Management Protocol (SNMP) traps sent to an enterprise management system
«  Serial messages sent through a serial communication module to a serial device

«  Streamed data sent to a device for processing by a software application.

I/0 Unit—Event Message commands are commonly used to find out the state or text of an event message, or
to set its state. Event messages can be in the following states:

«  Active—The message has been triggered by the event. If it was configured to be sent just once, it has
been sent. If it was configured to be sent at intervals, it is continuing to be sent.

« Inactive—The message is not currently triggered by the event.

«  Acknowledged—The message has been triggered by the event but has been acknowledged by the
receiver so it will not be sent again. (Acknowledgments occur only if the receiving application writes
them to the brain’s memory map.) Acknowledged is functionally equivalent to Inactive, but can be useful
in some cases to determine whether the receiver has received the message.

The command Set I/0 Unit Event Message Text is used to dynamically change a message or to “recycle”a
message if you run out of event messages on an 1/0 unit (128 event messages are available for each I/0 unit).
For more information, see individual commands in the PAC Control Command Reference or online help.

|/0 UNIT-MEMORY MAP COMMANDS

The following commands refer to the memory map in an Opto 22 memory-mapped device, either a controller
oran 1/0 unit. In the case of a controller/brain, they can refer to the device’s own memory map or a memory
map on another device.

Read Number from 1/0 Unit Memory Map Write Number to I/O Unit Memory Map

Read Numeric Table from I/O Unit Memory Map Write Numeric Table to I/0 Unit Memory Map
Read String from I/0 Unit Memory Map Write String Table to I/0 Unit Memory Map
Read String Table from 1/0 Unit Memory Map Write String to I/0 Unit Memory Map

Memory map commands make it possible for advanced users to read from or write to any Opto 22
memory-mapped device, such as a SNAP PAC controller or brain, or a SNAP Ultimate or Ethernet I/O unit. You
can use these commands to read or write to any address within the memory map. The commands are
especially useful for reading data from a SNAP device using newer features that may be available in the
memory map but are not yet incorporated into PAC Control.

NOTE: Ifyou are reading or writing to the device's Scratch Pad area, use the /0 Unit—Scratch Pad commands instead
(see page 344). If you are changing event messages, use the I/0 Unit—Event Message commands instead
(page 342).

In order to use these commands with a SNAP PAC S-series, or SoftPAC, or SNAP-LCE controller, first you need to
create an 1/0 Unit of the type Generic OptoMMP Device to represent the controller. Use the controller's IP
address or the loopback address, 127.0.0.1.

When you use these commands, make sure that you read or write the correct type of data (integer, float,
string) to match the specified memory map address. The control engine doesn't know what type of data is in
any particular address, so it cannot convert the data type.
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Since these are 1/0 unit commands, remember to check all return values and errors to make sure the
command was successful. If a command variable contains a value that is obviously wrong—for example, a
memory map address in an incorrect format—communication to the 1/0 unit will be automatically disabled.

See the OptoMMP Protocol Guide (form 1465) to determine the memory map addresses and data types you
need.

1/0 UNIT-—SCRATCH PAD COMMANDS

The following commands are used for peer-to-peer communication for sharing strategy data with other
Opto 22 memory-mapped controllers on the network. These commands are used by PAC Control to read or
write to the Scratch Pad area in the memory map of a groov EPIC processor, a groov RIO module, a SNAP PAC
controller, a SNAP Ultimate I/0 unit, or a SNAP-LCE controller.

Since each read (get) or write (set) command is completed before another occurs, commands cannot interfere
with each other. For example, a get command won't read a partial string while a set command is writing the string.

Get I/O Unit Scratch Pad Bits Set 1/0 Unit Scratch Pad Bits from MOMO Mask
Get I/0 Unit Scratch Pad Float Element Set 1/0 Unit Scratch Pad Float Element

Get I/0O Unit Scratch Pad Float Table Set 1/0 Unit Scratch Pad Float Table

Get I/0 Unit Scratch Pad Integer 32 Element Set 1/0 Unit Scratch Pad Integer 32 Element
Get I/0 Unit Scratch Pad Integer 32 Table Set I/0 Unit Scratch Pad Integer 32 Table

Get I/0 Unit Scratch Pad Integer 64 Element Set 1/0 Unit Scratch Pad Integer 64 Element
Get I/0 Unit Scratch Pad Integer 64 Table Set 1/0 Unit Scratch Pad Integer 64 Table

Get I/0 Unit Scratch Pad String Element Set 1/0 Unit Scratch Pad String Element

Get I/0 Unit Scratch Pad String Table Set I/0 Unit Scratch Pad String Table

Because these are I/0 unit commands, in order to use these commands with a SNAP PAC S-series, or SoftPAC,
or SNAP-LCE controller, first you need to create an I/0 Unit of the type Generic OptoMMP Device to represent
the controller. Use the controller's IP address or the loopback address, 127.0.0.1.

Also because these are I/0 unit commands, remember to check all return values and errors to make sure the
command was successful. If a command variable contains a value that is obviously wrong—for example, a
memory map address in an incorrect format—communication to the I/0 unit will be automatically disabled.

Each controller or SNAP Ultimate I/0 unit running a PAC Control strategy can place data in its own or another’s
Scratch Pad area, and each can retrieve data that has been placed in the Scratch Pad area by other devices
using other applications. Using these commands eliminates the need to open communication handles (see
“Communication Commands”on page 288), thus speeding up peer-to-peer communication.

The memory map Scratch Pad area supports four data types: bits, integer 32s, floats, and strings.
«  Fordetails on the Scratch Pad area, see the PAC Manager User's Guide (form 1704).
«  For the complete memory map, see the OptoMMP Protocol Guide (form 1465).

«  Fordetails on using the Scratch Pad for peer-to-peer communication with a controller, see the controller’s
user’'s guide.

The following page shows a simple example of how Scratch Pad area data exchange would work between
two SNAP R-series I/0 systems.

Create two tables for PAC_R_A, one for its own data that will be shared (A_Shared_Data) and another for data
it will read from PAC_R_B (B_Data). Also create two tables for PAC_R_B, one for its own data (B_Shared_Data)
and one for PAC_R_A’s data (A_Data).
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Suppose PAC_R_A and PAC_R_B are sharing 600 integer elements of the
10,240 integer elements available in the Scratch Pad

PAC_R_A writes data from its
own PAC Control strategy table <
to its own Scratch Pad area, A_Shared_Data Integer elements i
which SPAC_R_B can then read. (indexes 0-599) 0-599 Q‘I
B_Data Q
N &
Meanwhile, PAC_R_B writes ’
data from its B_Shared_Data
table to its Scratch Pad area, m m
which PAC_R_A reads. B_Shared_Data Integer elements 05'
(indexes 0-599) 0-599 OI
&
NOTE: When the SNAP R-series I/0 unit is writing to its own Scratch Pad, use the loopback IP address, 127.0.0.1

This portion of the flowchart in PAC_R_A (without error checking) might look like this:

As you can see, PAC_R_A uses the Set I/0 Unit
Scratch Pad command to write the data from its
own table to its own memory map. PAC_R_A also
_________________ reads data from PAC_R_B'smemory map and places
..... . it in table B_Data.

= Scratch_Pad_Peer* |:| |§|b__(

.......... F

""" Set 10 Unit Scratch Pad Integer 32 Table Add.
""" 1/0 Unit PAC_R_A
""" Length 600 M adify...
""" To Index [}
From Index 0 Delete
From Table A_Shared_Data
Put Status in Scratch_Pad_status Mext Block
Previous Block

X

structions - Scratch_Pad_Peer - Read PAC_R_B data

Get 10 Unit Scratch Pad Integer 32 Table Add...
10 Unit PAC_R B
L . Length 600 rodify...
A5|m|larﬂovvchart would be in B o
PAC_R_B's strategy, to handle To Index 0 Delste
writing to its own Scratch Pad area To Table B_Data

and reading from PAC_R_A. Put Status in B_Data_status Mest Block
I (oo Bock

[ Cloge ] [ Help ] Command Help

LOGICAL COMMANDS

The following commands perform logical functions.
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Commands ending a question mark (for example, AND? and OR?) indicate an instruction for a condition block.

AND
AND?

Bit AND
Bit AND?
Bit Change
Bit Clear
Bit Copy
Bit NOT
Bit NOT?

Bit Off in Numeric Table Element?

Bit Off?

Bit On in Numeric Table Element?

Bit On?

Bit OR

Bit OR?

Bit Rotate

Bit Set

Bit Shift

Bit Test

Bit XOR

Bit XOR?

Equal to Numeric Table Element?
Equal?

Flip Flop JK

Float to Int32 Bits

Get High Bits of Integer 64
Get Low Bits of Integer 64

Greater Than Numeric Table Element?

Greater Than or Equal to Numeric Table Element?

Greater Than or Equal?

Greater?

Int32 to Float Bits

Less Than Numeric Table Element?
Less Than or Equal to Numeric Table Element?
Less Than or Equal?

Less?

Make Integer 64

Move 32 bits

NOT

Not Equal to Numeric Table Element?
Not Equal?

NOT?

Numeric Table Element Bit Clear
Numeric Table Element Bit Set
Numeric Table Element Bit Test
OR

OR?

Set Variable False

Set Variable True

Test Equal

Test Greater

Test Greater or Equal

Test Less

Test Less or Equal

Test Not Equal

Test Within Limits

Variable False?

Variable True?

Within Limits?

XOR

XOR?

Understanding Logical Commands

For condition blocks, the Instructions dialog box provides options to designate AND or OR for multiple
commands. If you have more than one command in the same condition block and you choose the AND
option, all of the commands must evaluate true for the block to exit true. If you have more than one command
in a condition block and choose the OR option, the block exits true if any of its commands evaluates true.

Logical actions and conditions work with integers, individual bits within an integer, a single digital I/0 point, or
a digital I/0O unit. These values are treated as Boolean; that is, they are either True or False.

For complex logical operations, you may find OptoScript code easier to use than standard PAC Control
commands. See “Using Logical Operators”on page 390 for more information.
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Logical True and Logical False
PAC Control always returns a value of +1 to indicate True in an integer variable.

Adigital input or output that is on also returns a True (+1). Any non-zero value sent to a digital output tumns it
on. False is defined as zero (0).

For individual bits within an integer variable, bits that are set (1) indicate on. Bits that are cleared (0) indicate
off.

While floats can be used in logic, integers are strongly recommended whenever any bits are referenced. Since
PAC Control does not permit bits in a float value to be altered, float values must be converted to integers
before bits can be evaluated. See “Mathematical Commands”on page 347 for further information on integers
and floats.

MATHEMATICAL COMMANDS

The following commands perform mathematical functions:

Absolute Value Raise to Power

Add Round

Clamp Float Table Element Seed Random Number
Clamp Float Variable Square Root

Clamp Integer 32 Table Element Subtract

Clamp Integer 32 Variable Truncate

Complement

Decrement Variable Trigonometry
Divide Arcsine

Generate Random Number Arccosine
Increment Variable Arctangent
Maximum Cosine

Minimum Hyperbolic Cosine
Modulo Hyperbolic Sine
Multiply Hyperbolic Tangent
Natural Log Sine

Raise e to Power Tangent

Using Integers

In PAC Control, an integer 32 is a 32-bit signed number ranging from -2,147,483,648 to 2,147,483,647 (+2
billion). An integer 64 ranges from -9,223,372,036,854,775,808 to 9,223,372,036,854,775,807.

An integer can only be a whole number (-1,0, 1, 2, 3, etc). In other words, integers do not include a decimal
point. The result of an integer operation is always an integer, even if it is placed in a float variable. For example,
if 9is divided by 10, the result is zero (0.9 truncated to an integer). To receive a float result, at least one of the
operators would have to be a float. Use the Truncate command to round down to the nearest whole number.

Controlling Rounding

Use the Round command to round up or down to the nearest whole number. Note that 1.50 rounds up to 2.0,
and 1.49 rounds down to 10.
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Using Floats

While computers, CPUs, and electronic devices (such as Opto 22 controllers) store numbers in binary format,
most often they represent real numbers as floating point numbers, or floats. For example, in industrial
automation applications, all analog values read from an 1/0 unit are floats. Floats represent real numbers in
scientific notation: as a base number and an exponent.

The IEEE Standard for Binary Floating-Point Arithmetic (IEEE 754) is the most widely used standard for
floating-point computation. It defines how to store real numbers in binary format and how to convert
between binary and float notations.

Opto 22's SNAP PAC System uses IEEE single-precision floats, which have 32 binary digits (bits). The IEEE 754
32-bit float format is as follows:

1 bit 8 bits 23 bits
X XXXXXXXX XXRXKXXXXXXXXXXXKKKKXXX
Sign Exponent Significand

Float calculation: (-1)29"x [1 + Significand/2%] x 2 (Exponent-127)

While this is an excellent standard for the purpose, it has limitations that could cause issues if you're not aware
of them. Squeezing infinitely many real numbers into a finite number of bits requires an approximate
representation. Most floats cannot be exactly represented using this fixed number of bits in a 32-bit IEEE float.
Because of this, rounding error is inherent in floating-point computation.

In PAC Control (and in PAC Manager and the OptoMMP protocol), a float is a 32-bit IEEE single-precision
number ranging from +3.402824 x 10738 to +3.402824 x 1038, These single-precision floats give rounding
errors of less than one part per million (1 PPM). You can determine the limit of the rounding error for a
particular float value by dividing the value by 1,000,000.

This format guarantees about six and a half significant digits. Therefore, mathematical actions involving floats
with seven or more significant digits may incur errors after the sixth significant digit. For example, if the integer
555444333 is converted to a float, the conversion yields 5.554444¢*8 (note the error in the 7th digit). Also,
converting 5.554444e*8 back to an integer yields 555444352 (note the error starting in the 7th digit).

Float Issues and Examples

Accumulation of Relatively Small Floating-point Values. \When adding float values, the relative size
of the two values is important. For example, if you add 1.0 to a float variable repeatedly, the value of the float
variable will correctly increase in increments of 1.0 until it reaches 1.677722e™* (16,777,220).

Then the value will no longer change, because 1.0 is too small relative to 1.677722e™ to make a difference in
the significant digits. The same thing will occur if you add 0.0001 to 2,048.0, or add 1,000.0 to 1.717987¢™'°,
The key is the relative size of the numbers.

Here's another way to think of it. Suppose your bank could keep track only of seven digits. If you were
fortunate enough to have one million dollars ($1,000,000) in your account and tried to add 10 cents ($0.10) to
it, you would not be able to, because the 10 cents is not big enough relative to the total to be significant. Since
the bank has only seven digits to keep track of your money (in this example), one digit has to fall off the end:
either the 10 cents falls off the right side or the million digit falls off the left side. Which would you rather see in
your bank account?

Seven digits available: 112(3|4|5|6|7
Amount in account: 110|/0(0[0|0]O
Add 10 cents (0.10)? (digit falls offonright) [ 1 |0 [ 0|0 |0 |0 | O
Add 10 cents (0.10)? (digit falls offonleft) [0|0 [0 |0 |0 |0.| 1 Oops!
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Note that moving the point indicator doesn't help, because the exponent is separate. If the seven digits for the
account represent millions of dollars (1.000000) rather than dollars (1,000,000), the 10 cents would be
0.0000001—still too small to be represented by the seven digits:

Seven digits available: 11213
Amount in account 1./0(0|0]|0|0]|O
Add 10 cents (0.0000001)? (digit falls off on

right) 1.{0(0|0]|0|0]|O

Add 10 cents (0.0000001)? (digit falls off on left) [.0| 0 | 0|0 | 0| 0 | 1 | Oops again!

The key is that it is not the size of the numbers that matter, but rather their relative size.

So if you are accumulating relatively small values in a float variable over a long period of time, at some point,
the float value will stop increasing even though you continue to try to add to it.

Comparing Floating-point Values for Equality. Due to rounding errors and the way floating-point
calculations are performed, comparing two floats for equality can yield inaccurate results. The precision of
comparisons depends on the relative size of the float values as compared to the difference between them.

Forexample, if 2,097,151.0 is compared for equality with 2,097,152.0, the result will indicate that the two floats
are equal, even though it's obvious they are not. The reason is that the difference between the two values is
1.0, and 1.0 compared to one of the compared values (2,097,151.0) is too small; it is less than one part per
million.

In this case, 2,097,152.0 divided by 1,000,000 is 2.1. If the difference between the two values is at least 2.1,
then the equality comparison is guaranteed to be correct. So if 2,097,152.0 and 2,097,149.0 were compared for
equality, the result will indicate they are not equal, because the difference (3.0) is greater than one part per
million (2.1). Any time the difference is at least one part per million, the result is guaranteed to be accurate. If
the difference is less than 1 PPM, it may or may not be accurate.

One method that programmers use to work around this issue is to subtract one float from the other and then
compare the absolute value of the result to a limit.

For example:

Float Diff = Floatl - Float2;

If (AbsoluteValue (Float Diff) < 1.0 ) then
SetVariableTrue (EqualityFlag) ;

Else
SetVariableFalse (EqualityFlag);

Endif

Helpful Links for More Information

From Wikipedia, the free encyclopedia: http://en.wikipedia.org/wiki/IEEE_754
Real numbers: http://en.wikipedia.org/wiki/Real_number

Good example: http://en.wikipedia.org/wiki/Single_Precision

Rounding error: http://docs.sun.com/source/806-3568/ncg_goldberg.html

Comparing floating point numbers:
http://www.cygnus-software.com/papers/comparingfloats/comparingfloats.htm

Mixing and Converting Integers and Floats

An analog value read from an I/0 unit and put into an integer is converted from float to integer automatically.
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MISCELLANEOUS COMMANDS

To maintain the integrity and accuracy of a numeric type (float or integer), keep all item types the same. For
example, use the Move command to copy an integer value to a variable float when you want float
calculations.

MISCELLANEOUS COMMANDS

The following commands are used with tables and for other purposes. Many of them are commonly used.

Comment (Block) Get Value From Name

Comment (Single Line) Move

Flag Lock Move from Numeric Table Element

Flag Unlock Move Numeric Table Element to Numeric Table
Float Valid? Move Numeric Table to Numeric Table
Generate Reverse CRC-16 on Table (32 bit) Move to Numeric Table Element

Get Length of Table Move to Numeric Table Elements

Get Type From Name Shift Numeric Table Elements

Comment Commands

The comment commands listed above are used with standard PAC Control commands in action blocks and
condition blocks. For information on using comments in OptoScript blocks, see step 10 in “Using the
OptoScript Editor”on page 394.

Comment (Single Line) and Comment (Block) commands are used in two entirely different ways:

«  Comment (Single Line) enters a comment to help explain a block or an instruction within a block.
Usually block names and comments within instructions are sufficient, but you can use Comment (Single
Line) if you need more room for explanations.

+  Comment (Block) comments out instructions. In other words, it tells the strategy to temporarily ignore
certain instructions within a block. It can be useful in debugging or for saving work when a strategy is
temporarily changed.

To use it, place one Comment (Block) command at the beginning of the area you want to ignore, and
place another Comment (Block) command at the end of the area. If you do not place the second Comment
(Block) command, all the remaining instructions in that block are ignored. Areas that are commented out
appear in the Instructions dialog box as gray.

PID—ETHERNET COMMANDS

The following commands are used with PID loops on SNAP PAC and SNAP Ethernet-based I/0 units. For mistic
/0 units, see "PID—mistic Commands”on page 354. Since PID loops are configured and tuned in Configure
Mode while creating your PAC Control strategy, you may not need to use these commands. PID commands are
typically used to change input or output location (for example, if the input is on another I/O unit) or to change
tuning parameters based on a change that occurs while the strategy is running (such as a recipe change).

For steps to configure and tune PIDs, see “Configuring PID Loops”on page 156. For more information about
PID loops on Ethernet-based I/0 units, how to tune them, and how to use them in PAC Control, see the
OptoTutorial: SNAP PAC PID (form 1641).

Get PID Configuration Flags Get PID Tune Integral
Get PID Current Input Set PID Configuration Flags
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Get PID Current Setpoint

Get PID Feed Forward

Get PID Feed Forward Gain

Get PID Forced Output When Input Over Range
Get PID Forced Output When Input Under Range
Get PID Gain

Get PID Input

Get PID Input High Range

Get PID Input Low Range

Get PID Max Output Change

Get PID Min Output Change

Get PID Mode

Get PID Output

Get PID Output High Clamp

Get PID Output Low Clamp

Get PID Scan Time

Get PID Setpoint

Get PID Status Flags

Get PID Tune Derivative
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Set PID Feed Forward

Set PID Feed Forward Gain

Set PID Forced Output When Input Over Range
Set PID Forced Output When Input Under Range
Set PID Gain

Set PID Input

Set PID Input High Range

Set PID Input Low Range

Set PID Max Output Change

Set PID Min Output Change

Set PID Mode

Set PID Output

Set PID Output High Clamp

Set PID Output Low Clamp

Set PID Scan Time

Set PID Setpoint

Set PID Tune Derivative

Set PID Tune Integral

Whatis a PID?

A proportional integral derivative (PID) control system (often referred to as a PID loop) monitors a process
variable, compares the variable’s current value to a desired value (a setpoint), and calculates an output to
correct error between the setpoint and the variable. Because the calculation is comple, it is done by a
mathematical formula that is adjusted (tuned) for each PID loop. The mathematical formulas vary, but all PID

systems share these fundamental concepts:

«  They evaluate a process variable against its setpoint.

«  They control an output to correct the process variable.

«  The output comprises proportional, integral, and derivative calculations.
«  The effect of proportional, integral, and derivative calculations is modified by user-determined P, I, and D

constants.

« TheP 1 and D constants need to be tuned for each system.

PID Loops on I/0 Units

SNAP PAC controllers and brains provide 96 PID loops per I/0 unit. Analog/digital SNAP Ultimate I/0 units
provide 32 PID loops per I/0 unit; SNAP Ethernet I/0 units provide 16 PID loops per unit. Because PIDs run on
the 1/0 side of the SNAP PAC R-series controller and Ultimate brain, not on the control side, these PIDs will
keep running on the SNAP PAC R-series or Ultimate I/0 unit even if the PAC Control strategy stops.

In PAC Control, you can configure each of the PID loops with unique settings for a large number of parameters.
For a simple PID loop, you must configure at least the following:

«  Input (the process variable being monitored)
«  Setpoint (the desired value)

«  Output (the I/O point that effects change in the system)

«  Scantime (how often the input is sampled)
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«  PID algorithm used (four algorithms are available; see “Algorithm Choices —Ethernet”on page 352.
«  Valid range for input

«  Upper and lower clamps for output

«  Minimum and maximum change for output

You can also configure the following parameters if necessary:

«  Forced output value or use of manual mode if input goes out of range
«  Feed forward gain

«  Square root of input

In the SNAP PAC, SNAP Ultimate, and SNAP Ethernet PIDs, the derivative is applied only to the process variable
(the input) and not to the setpoint. This means you can change the setpoint without causing spikes in the
derivative term. These PIDs also prevent integral windup by back calculating the integral without the
derivative term. The feed forward term (“bias”) is added before output clamping and has a tuning factor.

If desired, you can cascade PIDs by simply using the output point of one PID loop as the input point for
another.

Algorithm Choices —Ethernet

When you configure a PID loop, choose one of these algorithms3:
«  Velocity (Type Q)

« ISA

o Parallel

» Interacting

Velocity (Type C) is typically used to perform velocity control. The ISA, Parallel, and Interacting algorithms are
derived from the article “A Comparison of PID Control Algorithms” by John P. Gerry in Control Engineering
(March 1987). These three equations are the same except for the tuning coefficients; converting from one
equation to another is merely a matter of converting the tuning coefficients.

3The following obsolete algorithms support PID loops configured before PAC Project R9.5. For details, see the Opto 22
KnowledgeBase article KB82058
+ Velocity (Type B) Obsolete
ISA (Obsolete)
Parallel (Obsolete)
Interacting (Obsolete)
Do not use these obsolete algorithms with groov RIO. For other devices, you can continue to use them, but Opto 22
recommends you use the new algorithms when configuring new PID loops.
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Key to Terms Used in Equations

Derivative tuning parameter. In
Process variable; the input to the units of seconds. Increasing mag-
PV TuneD . . .
PID nitude increases influence on out-
put.
SP Setpoint Output Output from the PID
InL . The Error (PV - SP) from the previ-
nooy Range of the input Err 1 e Error ( SP)from the pre
InHi - ous scan
Integrator. Anti-windup is applied
OutLo, . .
. Range of the output Integral | aftertheoutputis determined to
OutHi s
be within bounds.
) Proportional tuning parameter. PV from the previous scan and the
Gain R K PV1l, PV2
Unitless. May be negative. scan before that.
Integral tuning parameter. In
units of seconds. Increasing mag- , Actual scan time (time since previ-
Tunel . . . ScanTime
nitude increases influence on ous scan)
output.
Equations Common to All Algorithms
Err = PV - SP
Span = (OutHi - OutLo) / (InHi - InLo)
Output = Output + FeedForward * TuneFF
Equations Common to ISA, Parallel, and Interacting
Integral = Integral + Err
TermP = Err
TermI = Tunel * ScanTime * Integral
TermD = (TuneD / ScanTime) * ( PV - PV1 )
Velocity (Type C) Algorithm
ATermp = ( PV - PV1 )

In this part of the formula, you adjust Tunel.
ATermI = Tunel * ScanTime * Err

In this part of the formula, you adjust TuneD.
ATermD = TuneD / ScanTime * (

In this part of the formula, you adjust Gain.
Aoutput = Span * Gain *

ISA (or “Ideal”) Algorithm
Output = Span * Gain * (

Parallel (or “Independent”) Algorithm
Output = Span * (

Interacting (or “Classic”) Algorithm

Output = Span * Gain * ( TermP + TermI ) * (
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PID—MISTIC COMMANDS

PID—MISTIC COMMANDS

@

(Pro only) The following commands are available only in PAC Control Professional, and are used for PID loops

running on mistic 1/0 units only. To enable legacy I/0 units and commands in PAC Control, see “Legacy

Options”on page 234.

For PID loops on Ethernet-based I/0 units, see “PID—Ethernet Commands”on page 350.

Clamp Mistic PID Output

Clamp Mistic PID Setpoint

Disable Mistic PID Output

Disable Mistic PID Output Tracking in Manual Mode
Disable Mistic PID Setpoint Tracking in Manual Mode
Enable Mistic PID Output

Enable Mistic PID Output Tracking in Manual Mode
Enable Mistic PID Setpoint Tracking in Manual Mode

Get Mistic PID Output Rate of Change
Get Mistic PID P Term

Get Mistic PID Scan Rate

Get Mistic PID Setpoint

Set Mistic PID Control Word

Set Mistic PID D Term

Set Mistic PID I Term

Set Mistic PID Input

Get Mistic PID Control Word
Get Mistic PID D Term

Get Mistic PID | Term

Get Mistic PID Input

Get Mistic PID Mode

Get Mistic PID Output

Set Mistic PID Mode to Auto

Set Mistic PID Mode to Manual

Set Mistic PID Output Rate of Change
Set Mistic PID P Term

Set Mistic PID Scan Rate

Set Mistic PID Setpoint

Whatis a PID?

A proportional integral derivative (PID) control system (often referred to as a PID loop) monitors a process

variable, compares the variable’s current value to a desired value (a setpoint), and calculates an output to

correct error between the setpoint and the variable. Because the calculation is comple, it is done by a

mathematical formula that is adjusted (tuned) for each PID loop. The mathematical formulas vary, but all PID

systems share these fundamental concepts:

«  They evaluate a process variable against its setpoint.

«  They control an output to correct the process variable.

«  The output comprises proportional, integral, and derivative calculations.

«  The effect of proportional, integral, and derivative calculations is modified by user-determined P,1,and D
constants.

« TheP 1 and D constants need to be tuned for each system.

Using PIDs on mistic 1/0 Units

(Pro only) Eight PID loops are available per I/0 unit. The PID algorithm used with mistic protocol brains, such

as the serial B3000 or B3000-B and the G4A8R, is the velocity PID algorithm. It is an interacting type with a

reverse output.

« Interacting means that the gain is distributed to each term in the equation. Therefore, if you double the
gain, you also double the integral and derivative terms.

«  Reverse output means that the output increases as the input decreases. The reverse output mode is used
for pump-up control, such as maintaining level, pressure, and flow as well as heating.

For cooling or pump-down control, direct output is required. To switch to direct, simply reverse the sign of the
gain. For example, a gain of 1.28 would become -1.28. Note that this is not negative gain. The minus sign
serves only to change the type of PID output from reverse to direct.
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This velocity PID algorithm (also referred to as the incremental PID algorithm) is inherently anti-windup since it
has no summation in the integral term to saturate. The algorithm is described on pages 160-162 of the book
Microprocessors in Instruments and Control by Robert J. Bibbero, published by John Wiley and Sons.

Velocity PID Equation (PID—mistic)
(Pro only)

Change in output = Gain *

[(Error — Last Error) +

(Integral * Time * Error) +

{(Derivative/Time) * (Error — (2 * Last Error) + Oldest Error)}]

where:
«  FErroris (Setpoint — Input) in Engineering Units
o Timeis (Scan Rate/60), which results in time in minutes

All values are in Engineering Units.

The change in output calculated by this formula is added to the existing PID output. If the input span and the
output span are different, the change is normalized and then added to the output. This is accomplished by
converting the change to a percentage of the input span. The same percentage of output span is then added
to the output.

Gain (P)

For those familiar with the term “proportional band,” gain is simply the inverse. Gain acts directly on the
change in error since the last scan. (Error is the setpoint minus the input value in engineering units.) Therefore,
in the case of steady-state error (that is, change in error = 0), gain alone has no effect on the output. For this
reason, gain cannot be used alone. Gain is also used as a multiplier on the integral and derivative.

The velocity PID algorithm uses gain much as it is used in the Honeywell “type A" PID and the Bailey “error
input”type PID. Higher gain results in increased output change. Too much gain results in output oscillation.
Too little gain results in very slow performance.

Integral (1)

This term acts only on the current error. It is used to reduce the current error to zero. Note that during
steady-state conditions, integral multiplied by current error multiplied by gain is the only thing affecting the
output. The larger the integral value, the larger the change in output.

A positive integral value is required. Integral that is too low will result in undershoot. Integral that is too high
will result in overshoot.

Derivative (D)

This term acts only on the change in slope of the input signal. Its purpose is to anticipate where the input will
be on the next scan based on a change in the rate of change of the input value. In other words, it changes the
output as the input gets near the setpoint to prevent overshooting or undershooting.

Derivative is used in “feed forward” applications and in systems where the loop dead time is long. Its action
type is unlimited (that is, it has no filtering). If the input signal is noisy and the derivative value is greater than
zero, the input value must be filtered. See “Input Filtering” on page 356 for details. If the slope of the input
signal has remained unchanged for the last two scans, the derivative has no effect.

Judging by the change in direction of the input, the derivative contributes an appropriate value to the output
that is consistent with where the input will be at the next scan if it continues at its current rate of change.

The derivative is very useful in loops with a long dead time and long time constants. To disable it, set it to zero.
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Integral-Derivative Interaction

Integral and derivative can try to move the output in opposite directions. When this is the case, the derivative
should be large enough to overcome the integral. Since the derivative is “looking ahead”based on the change
in slope, it has a bigger picture than the integral does.

This interaction can be observed when the input is below the setpoint and is rising fast. The integral tries to
increase the output (which only makes things worse), while the derivative tries to decrease the output. The
derivative does this because at the current rate of change of the input, there will be an input overshoot if the
output is increased. Therefore, the derivative needs to be large enough to counteract the integral when
necessary.

Configuration Tips (PID—mistic)
(Pro only)

Gain. The gain value must not be zero. If input engineering units are negative, the output may move in the
direction opposite from the one desired. If so, reverse the sign of the gain.

Integral. The integral is required and must be greater than zero.

Input. The input must not be bipolar. An input range of -10 to +10, for example, will not work. Values such as
-300 t0-100,-100 to 0, and 0 to 100 are acceptable. If an application has a bipolar input range, it will have to
be rescaled to a generic range, such as 0 to 100. The setpoint range will then have to match this generic input
range.

Setting the output lower and upper clamps. Setting clamps is particularly important if the device
controlled by the output signal has “dead areas” at either end. For example, say the output is scaled 0-10. It is
connected to a valve that begins to open at 1.25 and is “effectively”fully open at 5.75 (even though it may only
be 70% open). Set Lower Clamp to 1.2 (valve closed) and Upper Clamp to 5.75 (valve effectively fully open).
This prevents reset windup, potentially resulting in dramatically improved control when the output value has
reached either limit and has to suddenly reverse direction.

Setting the maximum change rate of the output. The Max Change Rate can be ignored, since it
defaults to 100% per scan. To limit the output rate of change, set Max Change Rate to 10% to start. This setting
would limit the output rate of change to 100% in 10 scan-rate periods.

Output. The output can be preset or changed at any time by an operator or by the program. For example, if
the output should start at 40% whenever the system is activated, simply set the PID output (or the analog
channel output) to this value under program control.

Manual Mode. The factory default causes the setpoint to track the input when the PID is in manual mode,
which means that the setpoint will be altered when in manual mode. If you don't want the setpoint to be
altered when in manual mode, disable the setpoint track output feature so that when the PID is in manual
mode, the setpoint will not be changed.

Input Filtering. If the input signal is noisy, you may want to filter it. To do so, follow these steps:

1. Use the command Set Analog Filter Weight, specifying the appropriate analog input channel. Use a filter
weight value of less than 10 times the scan rate. Otherwise, the loop cannot be tuned.

Configure the PID loop to use the average/filtered value.

3. You can store the configuration to EEPROM or Flash memory to save the filter weight and the input type
(current or average). This can be helpful when re-enabling an I/0 unit after a loss of communication.

PAC Control User’s Guide, Legacy Edition



CHAPTER 10: PROGRAMMING WITH COMMANDS

Tuning Guidelines (PID—mistic)
(Pro only)

Setting the Scan Rate

The scan rate should be set as fast as possible or as fast as the controlled equipment will allow, unless there are
rare and unusual circumstances. Setting the scan rate to be longer than the dead time will result in a PID
controller that is so sluggish that it cannot adequately respond to disturbances, and setpoint changes will be
extremely slow.

There are, however, exceptions to this rule. If the output of the PID is implemented on equipment that cannot
handle fast scan changes, set the PID scan loop to as fast as the equipment can handle. Most control valves,
which are very commonly controlled by PID loops, can handle 0.1 second scan rates just fine. However, there
are definitely types of equipment that can't handle this. One example would be big gates at big dams. Moving
one of these gates is a major event that takes a long time, so one of the control goals is to minimize gate
movement. For the flow controllers on these gates, it may be necessary to set the scan time several times
longer than the dead time. This allows reaching the setpoint with fewer moves of the gate.

The terms “aggressive”and “conservative” are extremely subjective and depend on the process. “Aggressive”
tuning can be thought of as tuning where the speed of reaching the setpoint is the primary concern, and
overshoot is tolerated to gain fast response. “Conservative” tuning can be thought of as tuning required in a
system where overshoot is not tolerated, and speed of response is sacrificed to prevent overshoot.

The tuning suggestions given here are to achieve the fastest response with no overshoot. This would be on
the “aggressive” side of “conservative”tuning. Tuning rules found in control textbooks such as Ziegler-Nichols
typically advocate “quarter amplitude decay,” which means an overshoot that results in an undershoot that is
1/4 the amplitude of the overshoot and then an overshoot that is 1/4 the amplitude of the undershoot, etc.
until it stabilizes on the setpoint. This kind of tuning could be considered “very aggressive.”

Determining the Loop Dead Time

To determine the dead time, put the PID output in manual mode, then set the output somewhere around
midrange. After the loop has achieved a steady state, change the output by at least 10% of its span. Measure
the time (in seconds) that it takes the input to start responding to the change. This is the dead time.

Tuning

The tuning guidelines below are followed by a series of graphs showing the effects of implementing various
multiples of the “optimal”gain and integral. The “optimal” gain and integral are multiplied by 2 (too high) and
0.5 (too low), and every combination of these tuning parameters is shown on the graphs. Comparing actual
PID loop performance with these graphs can usually identify what adjustments are necessary to improve the
tuning of the actual PID loop. It is important to use a graphical tool, like PAC Display, to assist in the tuning
process. (Note that the graphical PID tuner in PAC Control cannot be used for tuning mistic PID loops.)

These graphs and guidelines are just generalizations. They won't be valid in all possible cases; they are just a
guide to help.

These tuning guidelines can be used both to solve tuning problems in an existing loop or as a help to start
tuning a new loop.

IMPORTANT: Textbook tuning rules, such as Ziegler-Nichols tuning methods, DO NOT work for tuning the velocity
PID algorithm.

Solving Tuning Problems
Oscillations. Oscillations can be caused either by gain that is too high or integral that is too high. If the

process variable oscillates below the setpoint, it is probably caused by the gain being too high. If it oscillates at
the setpoint, it is not possible to know by looking at the graphs which tuning parameter is causing the
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problem. Try cutting either the gain or integral, but not both at the same time, to find out which one is
causing the problem.

Overshoot. Overshoot is usually caused by the integral being too high. Gain that is too high can also cause
overshoot, but that is usually in conjunction with the integral being too high.

Any PID loop can be made to not overshoot and not oscillate if the gain and integral are set low enough, but
the response will be slow.

Performance. There is a limit on how fast a good, stable response can be. The middle chart is the best that
can be done with no overshoot and no oscillation. The ones with the gain and integral too high move toward
the setpoint faster, but they overshoot and oscillate. There will be a point that is the best the PID loop can be
tuned, and it will not be possible to get a faster stable response. There are trade-offs between having a fast
response and having a stable PID loop that does not overshoot the setpoint.

Starting the Tuning Process for a New PID Loop

Asimple and safe method is to start out at a very low gain and integral as shown on page 358 in the lower-left
chart. Increase the gain without changing the integral until the fastest response is achieved without
oscillation. It still won't reach the setpoint, but the key here is getting a fast response that doesn't oscillate
(middle left graph). Now leave the gain alone and increase the integral until it reaches the setpoint without
oscillating (middle graph). This completes the tuning.

When increasing the gain and integral, it is fastest to just keep doubling them. When the process variable
starts oscillating, then make smaller gain and integral changes.

For example, start out with a gain of 0.1 and an integral of 0.1. Next try a gain of 0.2 while keeping the integral
at0.1;then a gain of 0.4, then 0.8, then 1.6, then 3.2. If the PID loop starts oscillating with a gain of 3.2, then try
a gain of 2.0 or something in the middle between 1.6 and 3.2. Then make smaller changes until the best gain
is found. Suppose the best gain was 2.3; the next step is to keep the gain at 2.3, and then change the integral
t0 0.2, t0 0.4, and then t0 0.8, and so on, until the best integral is found.

Derivative

Tuning the derivative term is not addressed in these graphs because most PID loops are fine without it.
Derivative in the Opto 22 implementation of the velocity PID algorithm works fine for disturbance rejection;
the derivative should be kept very, very low. However, using derivative does not work well for setpoint
changes because it will cause spikes in the output. This is because the derivative term of the velocity PID
algorithm is calculated based on the error, which is the difference between the setpoint and the process
variable. If the setpoint changes, then instantly a jump in error occurs and results in a jump in output.
Therefore, it is best to use a derivative term of 0 when cascading PID loops.

Tuning Graphs (PID—mistic)
(Pro only)
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POINTER COMMANDS

The following commands are used with pointers:

Clear Pointer
Clear Pointer Table Element
Get Pointer From Name

Move from Pointer Table Element

Move to Pointer

Move to Pointer Table Element
Pointer Equal to NULL?

Pointer Table Element Equal to NULL?

Understanding Pointers

Like integer and float variables, a pointer variable stores a specific number. However, the number is not data—
it is the memory location (address) of data. The pointer “points”to data rather than containing the data.

A pointer in PAC Control can point to many different types of objects:

«  Anothervariable

«  Adigital point or object

«  Ananalog point or object
« Anl/Ounit
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A chart

Pointers cannot point to other pointers, however. If you try to move a pointer to a pointer, PAC Control just
duplicates the existing pointer.

The following table lists the objects that pointers can point to.

Other
Objects

Analog

Objects Variables

Digital Objects

1/0 Units

GRV-EPIC-PR1
GRV-R7-MM1001-10
GRV-R7-MM2001-10
GRV-R7-11VAPM-3

SNAP-PAC-R1 Integer Variable
SNAP-PAC-R1-B Float Variable
SNAP-PAC-R2 String Variable
Digital Input SNAP-PAC-EB1 Pointer Variable
Digital Output Analog Input SNAP-PAC-EB2 Down Timer Variable Chart
Counter Analog Output | SNAP-PAC-SB1 Up Timer Variable
Quadrature Counter SNAP-PAC-SB2 Integer Table
SNAP-ENET-D64 Float Table
SNAP-UP1-D64 String Table

SNAP-B3000-ENET, Communication Handle
SNAP-ENET-RTC
SNAP-UP1-ADS
SNAP-UP1-M64

SNAP-ENET-S64

Advantages of Using Pointers

For certain types of operations, pointers can speed up programming and make the strategy more efficient.
Pointers are usually recommended only for experienced programmers, however, because their misuse can
result in unpredictable behavior. They also complicate strategy debugging. If you use too many pointers, it's
easy to lose track of what's pointing to what.

If you choose to use pointers, be sure you use the text tool to document your charts in detail.

Referencing Objects with Pointers

There are two types of pointers—pointer variables and pointer tables.

Pointer Variables. A pointer variable contains a single pointer to a single object. You can set the initial
value for a pointer variable when you configure it, or you can set it later by using the command Move to
Pointer.

Once the initial value is set, you can reference it using any command you would use for that type of object. For
example, if the pointer points to a string variable, you can use any command for the pointer that you would
normally use for a string variable, such as Append String to String or Convert String to Float.

Pointer Tables. A pointer table contains a list of objects of different types, each of which can be pointed to.
For example, the object at index 0 could be a chart, the object at index 1 a digital point, and the object at
index 2 a string variable. An example of using a pointer table for indexing is shown on page 95.

When you create a pointer table, no initial values are set. You can use the Move to Pointer Table command to
setindividual values in the table.
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A pointer table element cannot be directly referenced. It must be copied to a pointer variable first, using the
command Move From Pointer Table Element. Once it is in the pointer variable, you can reference it as you

would any object of that type. For example, if index 3

in a pointer table points to a counter input, use Move

From Pointer Table Element to put the counter input address in a pointer variable. Then you can use any
command for the pointer variable that you would normally use with a counter input, such as Start Counter or

Clear Counter.

SIMULATION COMMANDS

The following commands are used for simulation and

program testing:

Communication to All I/O Points Enabled?
Communication to All I/O Units Enabled?
Disable Communication to All I/O Points
Disable Communication to All I/O Units
Disable Communication to Event/Reaction’"2
Disable Communication to I/0 Unit

Disable Communication to Mistic PID Loop ' 2
Disable Communication to PID Loop
Disable Communication to Point

Disable Event/Reaction Group' 2

Enable Communication to All I/0 Points
Enable Communication to All I/0 Units
Enable Communication to Event/Reaction’ 2
Enable Communication to I/0 Unit

Enable Communication to Mistic PID Loop'" 2
Enable Communication to PID Loop

Enable Communication to Point

Enable Event/Reaction Group" 2

Event/Reaction Communication Enabled?’-2
Event/Reaction Group Communication Enabled?' 2
I/0 Point Communication Enabled?

1/0 Unit Communication Enabled?

IVAL Set Counter

IVAL Set Analog Filtered Value

IVAL Set Analog Maximum Value
IVAL Set Analog Minimum Value
IVAL Set Analog Point

IVAL Set Frequency 2

IVAL Set I/0 Unit from MOMO Masks
IVAL Set Mistic PID Control Word 2
IVAL Set Mistic PID Process Term'2
IVAL Set Off-Latch

IVAL Set Off-Pulse

IVAL Set Off-Totalizer?

IVAL Set On-Latch

IVAL Set On-Pulse

IVAL Set On-Totalizer?

IVAL Set Period?

IVAL Set TPO Percent

IVAL Set TPO Period

IVAL Turn Off

IVAL Turn On

Mistic PID Loop Communication Enabled?’ 2

PID Loop Communication Enabled?

! PAC Control Professional only
2 mistic 1/0 units only

The Disable commands disconnect the strategy from the real-world device, so that it can be tested without
affecting field devices. While the real-world devices are disabled (or if they don't exist) the IVAL commands can
be used for testing and simulation. For details on individual commands, see the PAC Control Command

Reference (form 1701) or online help.

STRING COMMANDS

The following commands are used with strings:

Append Character to String

Generate Reverse CCITT on String
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Append String to String

Compare Strings

Convert Float to String

Convert Hex String to Number

Convert IEEE Hex String to Number
Convert Integer 32 to IP Address String
Convert IP Address String to Integer 32
Convert Mistic I/0 Hex String to Float' 2
Convert Number to Formatted Hex String
Convert Number to Hex String

Convert Number to Mistic /0 Hex String" 2
Convert Number to String

Convert Number to String Field
Convert String to Float

Convert String to Integer 32

Convert String to Integer 64

Convert String to Lower Case

Convert String to Upper Case

Find Character in String

Find Substring in String

Generate Checksum on String
Generate Forward CCITT on String
Generate Forward CRC-16 on String

Generate Reverse CRC-16 on String
Get Nth Character

Get String Length

Get Substring

Move from String Table Element
Move String

Move to String Table Element
Move to String Table Elements
Pack Float into String

Pack Integer 32 into String

Pack Integer 64 into String

Pack String into String

Set Nth Character

String Equal to String Table Element?
String Equal?

Test Equal Strings

Trim String

Unpack String

Verify Checksum on String
Verify Forward CCITT on String
Verify Forward CRC-16 on String
Verify Reverse CCITT on String
Verify Reverse CRC-16 on String

! PAC Control Professional only
2 mistic 1/0 units only

Using Strings

NOTE: All numbers in this discussion of strings are decimal unless otherwise stated.

A PAC Control string is a sequence of characters that can be grouped together. Characteristics of strings

include the following:

«  Strings are always referred to by name (and, if in a table, by index).

«  Fach character is represented by one byte.

«  FEach character is represented by its ASCl code (0 to 255).
« Astring containing no characters is referred to as an empty string.

«  Strings are frequently used in serial communication as a container for moving numeric characters from

one device to another.

« Although a string may appear to contain numeric values, it does not. Digits 0" through “9”are characters
just as much as “A"through “Z"; they do not represent numeric values.

To illustrate, let's look at the number 22. This is a decimal number representing a quantity of 22. The
number 22 can be represented in a string in several ways, here are two of them:

- As“22":two character 50's (The ASCII code for 2 is 50.)
- As"16" acharacter49 ("1") and a character 54 (“6") (The hex value of 22 is 16.)
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Note that the string representation of the number 22 is no longer a number. It is simply one or two ASCII
characters. The string representation of a number must be converted to a numeric value if it is to be used
in calculations. Several Convert commands are available for this purpose.

« Instandard PAC Control commands, do not use double quotes around string literals. You can use single
quotes, but they are not required.

«  In OptoScript code, you must use double quotes for string literals. See “11: Using OptoScript”for more
information.

String Length and Width

The width of a string is the maximum length a string can be; length is the actual number of characters
contained in the string. A string with a width of 100 may currently be empty, which means its length is zero. A
string with a width of 10 containing the characters “Hello "has a length of six (five for “Hello” and one for the
space after the “0"). Although a string’s length may change dynamically as the string is modified by the
program, its width remains constant.

When you configure a string variable or string table, you set the width of the string. All the strings in a PAC
Control string table must be of the same width.

PAC Control supports a maximum string width of 1024. For applications requiring wider strings, you can use
several strings to hold the data, use string tables, or use numeric tables, as described in the next section.

Using Numeric Tables as an Alternative to Strings

Since a string is nothing more than a sequence of characters, you can store a string in a numeric table, with
each table element holding a character. The advantage of using numeric tables for strings is that a numeric
table can store strings of any size. The disadvantages are:

«  Memory usage is much greater.

«  Nostring conversion functions are available for numeric tables. An intermediate temporary string would
be required to use string commands for these tables.

Strings in PAC Control can have a width of up to 1024.

Strings and Multitasking

Although string commands are completed before the current task loses its time slice, it is important to note
that a string that is constructed in more than one step may require more than one time slice to complete.

For example, if a string is being constructed in two steps (such as Move String “Hello”and Append String to
String “ World"), after the first step a task switch could occur, and another chart looking at the resulting string
might see “Hello” rather than “Hello World.”

If another chart is relying on a completed string, you can use a temporary string for building the string, and
then move it to the final string. This idea is illustrated in the following example, where a string variable named
MSG_String is built in two steps using a temporary string:

1. Move the string literal “The pressure is “ to a temporary variable named sTemp.
2. Append astring variable, sPressure, to sTemp.
3. With the complete string now built, move sTemp to MSG_String.

Adding Control Characters to a String

You can input most control characters in a string by typing a backslash (\) followed by the two-character hex
value of the character. For example, to add an ACK (Ctrl+F) character, enter \06 as part of the string.
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This technique works for all control characters except null (\00), carriage return (\OD), line feed (\OA),
backspace (\08), and Ctrl+Z (\1A). To add these characters to a string, you must use the Append Character
command.

To input a single backslash in a string, type in a double backslash (\\).

Sample String Variable

»  Declared Name: String_1

«  Declared Width: 22

«  Maximum Possible Width: 1024

«  Bytes of Memory Required: Declared Width + 4 =22+ 4 =26

Width is 22

swingt | | | | | LI LTI TP PP P]T

Length is 0

Astring is referred to by its name. Initially the previous string is empty, giving it a length of zero. Later, during
program execution, seven characters are added to String_1, increasing its length to seven:

Width is 22

[stingt  [ofpfrfof Jefo] | | | [ [ [ [ [ [ [ [ ][]
<— lengthis7 ——

Sample String Table

«  Declared Name: Promo_Messages

«  Declared Width: 26

«  Maximum Possible Width: 1024

«  Declared Length (Number of indexes, or items, in table): 5

«  Maximum Possible Length (Size): 1,000,000

«  Bytes of Memory Required: (Declared Width + 4) x Declared Length = (26 + 4) x 5 =150

Width is 26
Index 0 O|P|T|O 212 S|IN|A|P P|A|C S|Y|S|T|E|M|S
Index 1 I'{n ofvijalft]i e I'1/1]10
Index 2 Dle|l|iflv|e]|r]|s clo|nft|r|o]l
Index 3 plrijofg|r|la|m|m|a il rfiltly], a|n|d
Index 4 eln|tle|r|p|r|i|s]|e clo|nfinfef|lc|t]i|v|i|t]|y]!

A string table is a collection of strings. Each string is referred to by the name of the table it is in and the index
where it can be found. The length of the table is the number of strings it can hold. Because string table
indexes start with zero, indexes can range from zero to the table length minus one.

The width of each string in the table is the same. The length of each string can vary from zero to the
configured width of the table.
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String Data Extraction Examples
To extract various pieces of information from a string, use the command Find Substring in String. Consider the
following example:

01 23 456
sing 1 olp|Tfo] Jafef | [ [ | [ [ [ ] [ [ ][] []]

One way to get two separate pieces of information from this string is to get characters 0-3 and then get
characters 5 and 6, as shown in the following examples.

Find Substring in String: Example 1

String_1 stringvariable

Start At 0 integer literal

Number Of 4 integer literal
Move To Sub_String1 string variable (width = 5)

Results in:

01 2 3 4
Sub_stringt |[O|P|T|O] |

Find Substring in String: Example 2

String_1 string variable

Start At 5 integer literal

Number Of 2 integer literal
Move To Sub_String2 string variable (width = 5)

Results in:

01 2 3 4
[sub_string2 [2[2] | | |

String Building Example

Strings are assembled using commands Move String, Append Character to String, and Append String to
String. Consider the following original string and the examples that follow:

01 2 3 45 6 7 8 9 1011 1213 14 15 16 17 18 19 20 21

sting 1 [s[NJaf[p[ Jpfajc] | [ [ | [ [ [ [ ][] ][]
Move String

From OPTO string literal

To String_1 stringvariable

Results in (note that Move String erased the previous contents of the string):
01 2 3 4 5 6 7 8 9 1011 12 13 14 15 16 17 18 19 20 21

sting1 Jofp|Tjof | | [ [ | [ [ ][] ][] ]7]]
< lengthis4>

Append Character to String

From 32 integer literal (represents a space)
To String_1 string variable
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Results in (note the space character in position 4):

01 2 3 4 5 6 7 8 9 10 11 1213 14 15 16 17 18 19 20 21

|String_1 |O|P|T|O|

<—lengthis5—

Append String to String
From

To String_1

Results in:

string literal
stringvariable

01 2 3 45 6 7 8 9 1011 1213 14 15 16 17 18 19 20 21

sting 1 [o|P|T|O]

[2f2] [ [ ] ]|

<——Llengthis 77—

Append Character to String

From integer literal (carriage return)
To String_1 string variable
Results in:
01 2 3 4 5 6 7 8 9 1011 1213 14 15 16 17 18 19 20 21
[stingt _[o[P[T]o] [z]2w] | | | | HEEEE

<——Llengthis &—>

Comparison to Visual Basicand C

The following table lists PAC Control string commands and their equivalents in Microsoft Visual Basic_ and C. If

you are using OptoScript, see “E: OptoScript Language Reference,” for additional comparisons.

PAC Control Command
Append Character to String

Append String to String
Convert Hex String Number

Convert Number to
Formatted Hex String

Convert Number to String
Convert String to Float
Convert String to Integer 32

Get Nth Character
Get String Length

Get Substring
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Visual Basic

S$ =S$ + Chr$(MyChar%)

S$ =SS + "Hello"
1% ="&h" +S$

S$ =Hex$(1%)

S$ = CStr(1%)

F = CSng(S$)

1% = CInt(S$)

MyByte% =
ASC(MIDS(Str$,n%,1))

MyLENGTH% = LEN(Str$)

SubStr$ = MIDS(StrS,i,n)

c

i = strlen(str);
str[i] = MyChar;
str[i+1]1=0;

strcat(str, "Hello");

sscanf(str,'%x",&Num);
sprintf(str,"%x"iNum);
sprintf(str,"%d"iNum);
sprintf(str,'%f".fNum);

sscanf(str,"%f"&fNum);
fNum = atof(str);

sscanf(str,"%d" & Num);
iNum = atoi(str);

MyByte = str[n];

iLEN = strlen(str);

strncpy(subStr,&strlil,n);
subStr[n] ="\0’;



PAC Control Command

Move String

Test Equal Strings

String Equal?

String Equal to

String Table Element?

CHAPTER 10: PROGRAMMING WITH COMMANDS

Visual Basic
STRS ="Hello"

Equal% = (STR$ = "Hello")
if STRS = "Hi" then...

if STR$(n%) = "Hi" then...

(&

strcpy(strDest,"Hello");

i = strcmp(str1,"Hello");

if(Istrcmp(str1,"Hi"))

if(Istrcmp(str1[n],"Hi")

Convert-to-String Commands

The five convert-to-string commands are typically used when printing a number to a port. The ASClI table on

the following page shows how various parameters affect the string as it is converted. Note the following:

«  Some commands add leading spaces to achieve the specified length. These spaces are indicated with
underscores (_).

«  Floats (if used) are automatically rounded to integers before conversion except when using the
command Convert Number to Formatted Hex String.

Command Parameters Convert-to-String Commands
- |2 g f3 . . N
£ |52 5 _ | % £g | £3 | £
S 5 TE| . L xTw S o [ [ [
> 9 w E| S Evgog%n Ty = 5 = 5w S €
v e ] =] ST ~o v s Zwn Z o Z 't
= O - g c Z 5 0 v a - X w £ v a
[TAN~] v 5 (7] 0L o > 3 9 = 'S =
Ee |2« " |5EES E S ST s & > 8
52 Eo >’ 2% ) € o € o c
20 E [ v o + o= o
- 2 < O = _j v v v
2 VU o -
- L
16.0 1 4 41800000 16.0 10 1.6e+01 1.6e+01
16.0 2 4 41800000 FHE 10 1.6e+01 1.6e+01
n -16.0 1 4 C1800000 FHXX FFFFFFFO -1.6e+01 -1.6e+01
[1]
o
o 1.23 1 4 3F9D70A4 _1.2 1 1.23e+00 1.23e+00
12.3 1 4 4144CCCD 12.3 C 1.23e+01 1.23e+01
0.0 1 4 00000000 _0.0 0 0.0e+00 0.0e+00
16 1 4 0010 16.0 10 __16 16
" 16 2 4 0010 FHER 10 __16 16
S
o
A -16 1 4 FFFO FRxR FFFFFFFO _-16 -16
-
c
- 0 1 4 0000 0.0 0 ___0 0
1000 1 2 ** ** 3E8 1000 1000
**** Indicates an overflow. The whole-number portion of the result-
ing string is too long for its space.
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ASCII Table

The following table shows ASCIl characters with their decimal and hex values. For characters 0-31, equivalent
control codes are also listed; for example, a carriage return (character 13) is equivalent to CTRL+M (shown in

the table as AM).

Dec | Hex | CC | Char Dec | Hex | Char Dec | Hex | Char Dec | Hex | Char
0 00 @ NUL 32 | 20 Space 64 40 @ 9 | 60 !
1 01 AA SOH 33 | 21 ! 65 41 A 97 | 61 a
2 02 AB STX 34 | 22 “ 66 42 B 98 | 62 b
3 03 | AC ETX 35 | 23 # 67 | 43 C 99 | 63 C
4 04 AD EOT 36 | 24 $ 68 44 D 100 | 64 d
5 05 AE ENQ 37 | 25 % 69 45 E 101 | 65 e
6 06 AF ACK 38 | 26 & 70 46 F 102 | 66 f
7 07 NG BEL 39 | 27 ! 71 47 G 103 | 67 g
8 08 AH BS 40 | 28 ( 72 48 H 104 | 68 h
9 09 Al HT 41 29 ) 73 49 | 105 | 69 i
10 | OA AJ LF 42 | 2A * 74 | 4A J 106 | 6A j
11 0B AK VT 43 2B + 75 4B K 107 | 6B k
12 0C AL FF 44 | 2C , 76 4C L 108 | 6C I
13| 0D | AM CR 45 | 2D - 77 | 4D M 109 | 6D m
14 OE AN SO 46 | 2E 78 4E N 110 | 6E n
15 OF AO S| 47 | 2F 79 4F 0} 111 | 6F o]
16 10 AP DLE 48 | 30 0 80 50 P 112 | 70 p
17 11 AQ DC1 49 | 31 1 81 51 Q 113 | 71 q
18 12 AR DC2 50 | 32 2 82 52 R 114 | 72 r
19 13 AS DC3 51 33 3 83 53 S 115 | 73 s
20 14 AT DC4 52 34 4 84 54 T 116 | 74 t
21 15 AU NAK 53 | 35 5 85 55 U 117 | 75 u
22 16 AV SYN 54 | 36 6 86 56 \ 118 | 76 \%
23 17 AW ETB 55 | 37 7 87 57 w 119 | 77 w
24 | 18 | AX | CAN 56 | 38 8 88 | 58 X 120 | 78 X
25 19 AY EM 57 | 39 9 89 59 Y 121 | 79 y
26 1A 4 SUB 58 | 3A 90 5A A 122 | 7A z
27 1B Al ESC 59 | 3B ; 91 5B [ 123 | 7B {
28 | 1C A\ FS 60 | 3C < 92 | 5C \ 124 | 7C |
29 | 1D Al GS 61 | 3D = 93 | 5D | 125 | 7D }
30 1E AN RS 62 | 3E > 94 5E A 126 | 7E ~
31 1F A us 63 | 3F ? 95 | 5F _ 127 | 7F | DEL
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TIME/DATE COMMANDS

The following commands refer to time, dates, and days:

Copy Date to String (DD/MM/YYYY)
Copy Date to String (MM/DD/YYYY)
Copy Time to String

Convert Date & Time to NTP Timestamp
Convert NTP Timestamp to Date & Time
Get Date & Time

Get Day

Get Day of Week

Get Hours

Get Julian Day

Get Minutes

Get Month

Get Seconds

Get Seconds Since Midnight

Get System Time

Get Time Zone Description
Get Time Zone Offset

Get Year

Set Date

Set Day

Set Hours

Set Minutes

Set Month

Set Seconds

SetTime

SetTime Zone Configuration
Set Year

Synchronize Clock SNTP

These commands can be used for timing a process or for making sure things happen according to a set
schedule. For example, you could use the command Get Seconds Since Midnight at the beginning of a
process and again at the end of the process, and then subtract the two numbers to find out how long the

process took.

You can set the time and date on the control engine by synchronizing it with the PC; in PAC Control Debug
mode, choose this option while viewing the control engine (Control Engine > Inspect). You can also use these
commands to set the time and date on the control engine. Commands with NTP in the name refer to the

Network Time Protocol.

TIMING COMMANDS

The following commands are used for timers and delays in a strategy.

Timers

Continue Timer

Down Timer Expired?

Get & Restart Timer

Pause Timer

Set Down Timer Preset Value
Set Up Timer Target Value

Start Timer

Stop Timer
Timer Expired?

Up Timer Target Time Reached?

Delays
Delay (mSec)
Delay (Sec)

Delay Commands

Delay commands are used frequently in strategies to pause the logic. Here are two reasons to use Delay

(mSec) or Delay (Seq):
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«  Toallow time for the state of an input to change before it is checked again. For example, a delay could
give an operator time to release a button before the state of the button is rechecked, or allow time for an
alarm state to change before rechecking.

« Toletachart give up the remainder of its time slice, when its logic does not need to run constantly. For
more information on using delays in this way, see the Optimizing PAC Project System Performance
technical note (form 1776).

Using Timers

Timers are a special type of numeric variable. A PAC Control timer stores elapsed time in units of seconds with
resolution of milliseconds. Down timers continuously count down to zero, and up timers continuously count
up from zero. Timers can be paused and continued.

To create a timer in PAC Control, configure a numeric variable and select the type Up Timer or Down Timer.
You can use any PAC Control command (for example, Move) that references a numeric variable to access a
timer. You can view the current value of a timer at any time in PAC Control Debug mode.

Since the timer is independent from the control engine’s clock, over thousands of seconds, the timer and the
control engine’s clock will not match. Timers do not place any additional load on the CPU.

Down Timer Operation

The Set Down Timer Preset Value command sets the time the down timer will start from, but does not start
the timer. Use the Start Timer command to start the timer counting down to zero. (Since the default preset
value for a down timer is zero, nothing will happen if you use the Start Timer command before setting a
value)

Alternatively, you can use the Move command to set the time the down timer will start from. If you use Move,
the down timer begins counting down immediately. If program execution speed is a priority, use the Move
command and put an integer value rather than a float into the timer. This action eliminates the
float-to-integer conversion time.

Note that if you use the Move command, any value you set using Set Down Timer Preset Value is overwritten,
and subsequent Start Timer commands start the timer from the value last sent by the Move command.

To determine if the timer is finished, use the condition Down Timer Expired? This condition is true any time the
down timer has a value of zero. Down Timer Expired? is much faster than using the condition Equal? to
compare the timer to a value of zero.

The Stop Timer command forces the timer to stop and puts its value at zero. If you want to halt the timer and
have it maintain its value at the time it was stopped, use the Pause Timer command instead. When you use
Pause Timer, you can move the timer's value at the time it was stopped to a variable. You can also use the
Continue Timer command to resume the timer where it left off.

Up Timer Operation

The Set Up Timer Target Value command sets the time for the Up Timer Target Time Reached? condition. It
does not start the timer, however, and the timer does not stop when it reaches the target value. You must start
the up timer from zero by using the Start Timer command.

If you use the Move command to move a value to an up timer, the value you moved becomes the target value
and the up timer starts timing immediately. (Note that the timer does not start from the value you moved; it
always starts at zero.)

The up timer does not stop when it reaches the target value. To determine if the timer has reached its target
value, use the condition Up Timer Target Time Reached? This condition tests the timer to see if it is greater
than or equal to the target time.
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The Stop Timer command forces the timer to stop and resets it to zero. If you want to halt the timer and have it
maintain its value at the time it was stopped, use the Pause Timer command instead. After you use Pause
Timer, you can then move the timer’s value at the time it was stopped to a variable. You can also use the
Continue Timer command to resume the timer where it left off.
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INTRODUCTION

This chapter shows you how to create and use OptoScript, an optional programming language that can

simplify certain types of operations in PAC Control. Modeled after computer languages such as C and Pascal,

OptoScript code gives you an alternative to using standard PAC Control commands.

In addition to the examples provided here, see the Control Basic Examples directory on your hard drive for a
fully annotated example strategy. OptoScript information is also provided in the SNAP PAC Learning Center

User's Guide (form 1638).

You will find OptoScript easy to use if you already have computer programming experience. Beginning
programmers may also want to try it for control operations involving extensive math calculations, string

handling, or complex loops and conditions.

This chapter assumes that you have some programming experience. Experienced programmers may want to

see “Notes to Experienced Programmers” on page 443.

In This Chapter

FaY o1 TV @] 010 1T o] OO page 373
When 10 USe OPtOSCHPT .uvvvrviievve e ssssrsres s seesssssssssesesssssssssensssns page 374
OptoScript Functions and CommMaNnds...........c.evveeeeesccsvrereeseris page 381
OPLoSCript SYNEAX o veveevevsseesevervrsssenssensenns

OptoScript Data Types and Variables

OptoScript Expressions and Operators page 388
OptoScript CONrOl SETUCTUTES .o page 391
Using the OptoSCript EAITOr ... page 394
Troubleshooting “Unable To FINd" Errors ... page 397
Troubleshooting SYNTaxX EITOIS ... page 397
Debugging Strategies with OptoSCript..... e page 399

ABOUT OPTOSCRIPT

OptoScript is a procedural type of computer language similar to Pascal, C, or BASIC. It can be used within any
PAC Control strategy or subroutine to replace or supplement standard PAC Control commands. It does not add
new functions, but offers an alternative method within PAC Control's flowcharting environment to simplify

some common programming tasks.

OptoScript code cannot be mixed with commands in action or condition blocks; it is used in its own

hexagonal flowchart block. The following figure shows an example of an OptoScript flowchart block and its

contents:
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OptoScript editor

OptoScript - Oven_Control - Block 1

v Actions < Conditions  *(%) Yariables & Test Compile

L
- Oven_Control OptoScript Code:

if (Oven_Temperature »= 450) then
Cwen_Alarm = 1; -~ Set the oven alarm
el=se
Owen_Alarm = 0; - (lear the oven alarm
endif

.
>

i Ghortcuts  [100% v )
= OptoScript code

Chart /

OptoScript block
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You'll want to use OptoScript for some common programming tasks that can be more difficult to do using
standard PAC Control commands than using a procedural language. Extensive math calculations or complex
loops, for example, can be done with standard commands but take up a lot of space on a flowchart.

When you use OptoScript, however, be aware that it is not self-documenting. Make sure you frequently use
comments to explain what the code does, so that when you come back to it a year later—or when someone
who is not as familiar with the code or the strategy must change it—it can be easily interpreted.

This section shows examples of using OptoScript for:

«  Math expressions

«  String handling

«  Complexloops

«  (Case statements

«  Conditions

«  Combining math expressions, loops, and conditions

For Math Expressions

OptoScript is especially useful for mathematical computations. Math expressions are simpler and easier, and
many of them are built right into the language, instead of requiring commands such as Add or Multiply.
OptoScript has no limitations on the number of parentheses you can use in math expressions.

Here's an example of a mathematical expression in OptoScript:
integerl = (integer2 + 2) * (floatl / (float2 - 2) - 3);

To accomplish the same computation using standard PAC Control commands, you would need to create at
least two intermediate variables and use five instructions, as shown below.
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1 Instructions - Math_Expressions - Block 16

Add ~ Add...
integer? 1
Plus 2
Put Result in tempintegeri
Delete
Subtract
float2 Mest Black.
Minus 2
Put Result in tempfloath Prewvious Block
Divide
float1
By tempfloat
Put Result in tempfloath
Subtract
tempfloath
Minus 3.0
Put Result in tempfloath
Multiphy -
tempfloath
Times tempintegeri
Put Result in integer1
W
0
’ Cloze l [ Help

As you can see, the OptoScript version of this math expression is not only simpler to create, but also easier to
understand once created.

For String Handling

If your strategy transmits and receives serial data, you will want to try using OptoScript code. In standard PAC
Control, forming and parsing (decoding) serial data can take several blocks. In OptoScript, string handling can
be easier.

The following figure shows a flowchart designed to send the string request, “What type of plane?”and parse
the response.

Compare these blocks and instructions with the ones on the following page, done in OptoScript.
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N Instructions - String._Handler - Build new request E|
Move String P Add...
From “plane™
= String_Handler* To sVehicle
Building a string using standard
Move String PAC Control can require several
From “What type of * commands.

To Request Newt Black
2 | RN H&pend String to String Bl
: Append sYehicle

Block D

E

13 . o
Build new | - To Request If substrings or individual
regquest d A 4 String to Stri characters within a string must
. en rn (1] rn

iy 9 I " be handled, a standard PAC

R i s D Append is in stall
Control block can become

29 . To Request

Send request quite large.

Convert Humber to String

: * S Convert nStall
Put Result in =5tall
Receive :
response : Append String to String
. Append
: * i D To Get Substring A Add...
. From String Response 3 =
Parse : Append String to String Start at Index 1
response Append Hum. Characters 1

B | O A o Put Result in Classification
& . Get Substring Mext Block
N : et Blac
Exit ] < =

From String Response

Start at Index 2
[ Clase ] [ Help Hum. Characters 2

Put Result in Model

(1) Shaortcuts Convert String to Integer 32 —

Chart /‘ Convert Maodel
Put Result in Model_Humber
/g
e P A e e e i
< I >
[ Cloze ] [ Help ]

The OptoScript version of the String_Handler flowchart is more compact. The string request can be built more
easily, and parsing the response takes up much less space.

If you handle more complex serial data than in the String_Handler example, you will find OptoScript code
even more useful.
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& OptoScript - String _Handler - Build & send reguest
*O Actions  +<» Conditions  #(% Variables @ Test Compile e

OptoScript Code:

Fequest = &
Pequest = "What" + " tgp=" + " of planse?":

( TransStringViaSerialPort (Request. 1):

|

In OptoScript code, several strings and

Block D

variables can be combined to build the
request in one line.

e Build new

reguest

*Receive &
parse
TESnONse

In OptoScript code, the commands used to

1

parse the response take up less space, so
they all can be seen at once.

29

Send request

& OptoSchipt - String_Handler

- Receive & parse response

AR

Receive v &ctions @ Conditions (7 Yarishles @ Test Compile 48
response
* OptoScript Code
: : ReceiveStringViaSerialPort (Response, 1):;
Parse
response (GetSubstring(RespDnse, 1. 1. Clas=sification) ;>
: { : GetSubstring(Respon=e, 2, 2, MHodel):
GetSubstring(Response. 2. 3. Model_Temp):
25 Hodel += Model_Tenp:
Exit
Model Humber = StringTolnti2{Model):
al >
. N
>
(i) Shorteuts | 100% w
Chart /

For Complex Loops

Strategies that use complex loops—for example, to repeat an operation while a condition remains true—are
easier to create and take up less space in a flowchart when done in OptoScript. While loops, repeat loops, and
for loops are all available.

«  While loops repeat a process while a test is true (the test comes at the beginning of the process).

«  Repeat loops repeat a process until a test is false (the test comes at the end of the process). This kind of
loop is guaranteed to execute at least once.

«  Forloops repeat a process for a specified number of times.

Below is an example of a while loop as it would appear in standard flowchart commands, contrasted with the
way it could be handled in an OptoScript block.
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‘WHILE LGOP - -
- (test for the-hour) -

In standard PAC Control commands, the
Get Hour .. . | loop takes several blocks, each containing
one or more instructions.

; o : In OptoScript, the loop is in a single block that
Do Something| - | | 1ot pour contains one condensed instruction.
) l - m cript - Powerup - Test Hour
— Get Hour »3 Actions &> Conditions ) Wariables 4% Test Compile

. .. . | OptoScript Code:
. o while ({GetHours() »= 8) and (GetHours() < 17))
Continue on...| - - -~ - - /7 do something!

wend

For Case Statements

Case or switch statements create multiple decision points. They can also be easier to do using OptoScript. Here
is an example of a case statement:

In standard PAC Control commands, the case
statement requires several sets of condition and

g action blocks, each containing commands. In OptoScript, the code is
Check Day '

all'in one block.

/= : switch (GetDayOfWesk( )
= T Fan Control case 1: »~ Monday
Run fans 1 &2| - - ’ : Fan_1 i

- . . Fan_2 :

5 c case 2: /7 Tuesday

|
[T}
[=F=T2

Run fans 3 8 4 Fan 7

= Co Fan_1 = 1
Run fans 1 &2| - - Fan_2 : %
o o

45 : : Fan_2
Run fans3 &4 Fan_3

|
[T}
==

caze 5: ~/ Friday

40 T Fan_3
Run fans 1 &2| - - Fan_4

[T
[=F=Nr

default: v Saturday or Sunday

ocooo

15 .
Turn off all o Fan 4

fans o break
endswitch
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Using OptoScript for case statements saves space in the flowchart and lets you see all the possible cases in
one dialog box.

For Conditions

Like loops and case statements, conditions can be simpler when done in OptoScript code. /f/then, if/then/else,
and if/then/elseif statements can all be mixed and nested as needed. Here's an example of a simple if/then/else
statement as it could be done in standard PAC Control commands and in OptoScript:

...... : In standard PAC Control commands, even a simple
------ o it/then/else statement requires three blocks.

R T e
Set Alarm A o <Check 0ven>
o o & Temp _/

- Check Oven Temp

In OptoScript, a single block contains
the statement.

...... A +O Ackions  +» Conditions  H71 Yariables &TestCompile #h '?.s

...... e OptaScript Code:

if (Oven_Temperature »= 450) then
Ovyen_Alarm = 1: » Set the oven alarm
else
Oyen_Alarm = 0; ~~ Clear the oven alarm
endif

|~
|

OptoScript is even more useful for more complex conditions, such as the following:
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[

Check -

Delay 60 sec

Temperature

Turn on
Fan 1

Turn off

7] T 30
urn on
Send alarm —]

Fan 2

all fans

9
'Iaemperature

Control

In OptoScript, all the condition and
action blocks and their commands
are consolidated into one block.

5 OptoScript - Temperature_Control - Temperature Control

+O Ackions  +» Conditions  +71 Wariables & Test Compile

OptoScript Code:

if (Temp Probe > 80) then
Fan_1 = 1. »v Turn on fan 1

if (Temp Probe > 95) then
Fan_2 = 1. »v Turn on fan 2 too

if (Temp Probe > 105) then
Alarm = 1: v Send alarm — temperature too high
endif
endif

else ~-Turn off all fans
iF

0

m
w
=
-

]

DelaySec (60); ~~ Wait 1 min before checking temp again

For Combining Expressions, Operators, and Conditions

The real power of OptoScript can be seen in complex operations.
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Start ‘-

uesday or

Friday? Delay 1 hour

; Erassf"l’ rees
% Control

This portion of a sprinkler

7 e -+« . .. .. ... controlsystem uses standard
Temps - - - - - - - PACControl blocks and

oo commands to control watering

of grass and trees.

1%.".later grass
for 10 mins

Max_Temp =80
or +10?

The OptoScript version of Grass/Trees
Control handles the loops,
conditions, and operators easily in a
single block.

3 - L
Water grass Water Trees 3 Delay 1 min

for 20 mins

Turn off Trees

5 OptoScript - Sprinkler_Control - GrassfTrees Control

+3 Actions  +< Conditions  *() Yariables  #2% Test Compile L A a-h

OptoScript Code:

<% Setz Grass and Trees sprinklers to run on Tuesdays and Fridays
a= long as it's not raining %

if ({({GetDayQiWesk() == 2) or (GetDayQiWeslk() == 5} and {(Humidity < 983) then
if ({Max Temp > 80) or (Hax Temp == Yesterday_Temp + 10)) then

Grass = 1;
DelaySec (1200); - Water grass for 20 mins
Grass = 0;

else
Grass = 1;
DelaySec (600): ~~ Water grass for 10 mins
Grass = 0;

endif

while (Soil Moisture < 30}
Trees = 1. ~~ Water trees
wend

el=

=
DelaySec (3600); - Wait one hour before checking the day again
endif

Generally speaking, the more complex the combination of math expressions, logical and comparison
operators, loops, and conditions, the more convenient it is to use OptoScript code rather than standard blocks
and commands.

OPTOSCRIPT FUNCTIONS AND COMMANDS

Since functions in OptoScript are provided by commands almost identical to the standard commands in PAC
Control, you have the same complete range of functions. There are no additional functions for OptoScript
code, and you cannot make your own functions.
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Standard and OptoScript Commands

In many cases you can easily recognize OptoScript commands, because they are almost the same as standard
PAC Control commands. All spaces are removed from the OptoScript commands, however, and in some cases
words in the command are abbreviated or left out. Commands are case sensitive. Here are some examples of
the same commands in PAC Control and in OptoScript:

Get Counter GetCounter

Set Down Timer Preset Value SetDownTimerPreset
Delay (mSec) DelayMsec

Convert Float to String FloatToString

Get Number of Characters Waiting GetNumCharsWaiting

Some commands are built into OptoScript functionality. Some of these have OptoScript commands and some
do not; you can use either the built-in functionality or the OptoScript command, if it exists. Here are some
examples:

PAC Control Command OptoScript Command Built-In Equivalent Example

Move = item1 = value
Add + 1+2

Less? < valuel < value2
Turn On TurnOn = [non-zero] digital3 =1
Turn Off TurnOff =0 digital3=0
Comment (Single Line) // // comment
Set Nth Character SetNthCharacter s1[5]1="c

See Appendix E: OptoScript Language Reference for a table of all PAC Control commands and their OptoScript
equivalents. In addition, OptoScript equivalents for each command are shown in the PAC Control Command
Reference and in the online command help.

Using 1/0 in OptoScript

One advantage of OptoScript is that any named /0 point can be used directly, wherever a numeric variable
can be used, rather than requiring a variable. Digital points behave like integer variables that have only two
possible states: zero (off) or non-zero (on). Analog points behave like float variables.

For example, you can turn a digital point off by simply assigning it a value of zero:
Light Switch = 0;

You can turn a digital point on by assigning it any value other than zero:
Light Switch = 1;

Light Switch -1;

Light Switch = 486;

You can use /O points directly in mathematical expressions:
fLimit = Pressure Input + 50;

Or use them directly in control structures, for example to turn off the light if the door is closed:
if (not Door) then

Light Switch = 0;
endif
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You can set an output based on the value of an input or a variable:
LEDO1l = Switch A;
Proportional Valve = fPressure Control

You can use a point directly with a command:

fRange = GetAnalogMaxValue (Temp Input) - GetAnalogMinValue (Temp Input) ;
TurnOn (Fan_A) ;

IsOn (Fan_ A);

OPTOSCRIPT SYNTAX

Here is a sample section of OptoScript code to illustrate syntax.

Each statement is followed by a
fPressure = 300.0; < semicolon.

nTotal = ntTable[O] + ntTable[l] + ntTable[Z];<\\Tab|ee|ementsareputin square
brackets next to the table name.
while ((GetHours() >= 8) and (GetHours() < 17))

|
Fan A = 1; —Parentheses are used as separators for

q expressions and operators. You can use an
wen unlimited number of parentheses.

// Send alarm if oven temperature too hot.
if (Oven Temperature >= 450) then
Oven Alarm = 1; // Set the oven alarm

Line comments appear on a separate line or
after a statement. They are preceded by two
slashes and a space Block comments (not

\/

else illustrated) are preceded by /* and followed
Oven Alarm = 0; // Clear the oven alarm by */.
endif

) < Parameters (arguments) fora command
nCheck = GenerateChecksumOnString (0, sMessage) ;T jejisted in order within parentheses

nError Block = GetIdOfBlockCausingCurrentError(); | following the command. Commands that
RemoveCurrentError () ; have no arguments must still include the
parentheses.

sGreeting = “Hello, world!”;
nPos = FindCharacterInString('!', 0, sGreeting) ;‘\ Anindividual character can be in single

I~ quotesor in double quotes, depending on its
type. A string must be in double quotes.

NOTE: Each block has only one exit point. It is not possible to use return tojump out of the current block.

More About Syntax with Commands

As noted in the previous sample, arguments for a command are listed in the parentheses following the
command. Arguments are listed in order beginning with argument 1. To find out the arguments for any
command, see the PAC Control Command Reference or online command help.

SetDownTimerPresetValue (60.0, Minute Timer)

command (argument 1, argument 2)
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EnableIOUnitCausingCurrentError ()

command (no arguments)

There are two types of OptoScript commands: procedure commands and function commands.

Procedure commands accomplish an action and return no value. Here are some examples:
RemoveCurrentError () ;
ClampInt32TableElement (10, 0, 5, x1);

Function commands return a value from their action, so the value can be placed somewhere. In the
following examples, the value is placed in the variable at the beginning of the statement:

nMonth = GetMonth () ;

fSquare Root = SquareRoot (99);

nPosition = FindCharacterInString('S', 0, sName);

When you compare these examples to the identical commands in standard PAC Control, you'll notice that the
returned value for the standard PAC Control command is an argument. In OptoScript the returned value is not
an argument, thus reducing the number of arguments by one. In the first example, the standard command
Get Month has one argument, which is where the result is placed. The OptoScript command equivalent,
GetMonth, has no arguments and places the result in the variable,

In most cases you will use the value a function command returns by placing it in a variable, a control structure,
or a mathematical expression. Occasionally, however, you may not need to use the result. For example, the
command StartChart returns a status. If you do not need to track the status, you can ignore it by not placing
the result anywhere, for example:

StartChart (Fan Control);

OPTOSCRIPT DATA TYPES AND VARIABLES
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Unlike most procedural languages, PAC Control maintains a database of all declared variables, which is shared
with PAC Display. Variables are not declared in OptoScript code, but are created (declared) within PAC Control.
(See "9: Using Variables and Commands.”) Variables are not declared in OptoScript because local variables are
not allowed. All variables are global for the strategy (or global within a subroutine).

If you use a variable in OptoScript code that does not currently exist in the strategy, you'll receive an error
message when you test compile the code and can add the variable then.

Variable Name Conventions

With OptoScript and in PAC Control generally, it's a good idea to get into the habit of indicating the variable
type in each variable’s name. Some variable types may be obvious in the name itself, but others are not. For
more information, see “Naming Conventions”on page 85.

Using Numeric Literals

Here are examples of how to use numeric literals in OptoScript. Formats are automatically converted if they
don't match the variable type. For example, if a value of 300.2 were assigned to an integer 32, the value would
be converted to 300.

Decimal Integer 64 Literals assigned to variables.
Integer 64s have an i64 at the end.
dVariablel = 0i64;

dVariable2 = 10i64;

dVariable3 -1231i64;

Decimal Integer 32 Literals assigned to variables.
nVariablel = 0;

nVariable2 = 10;

nVariable3 = -123;
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Hexadecimal Integer 32 Literals assigned to

variables. Hex notation starts with Ox. Hexadecimal Integer 64 Literals assigned

Digits A-F may be upper or lower case. to variables.

nVariablel = 0x0; dVariablel = 0x0i64;

nVariable2 = 0x10; dVariable2 = 0x10i64;

nVariable3 = 0x12AB34CD; dVariable3 = 0x1234567890ABCDEFi64;

nVariable3 = 0xl12ab34cd;

Float Literals assigned to variables.

(Float literals may use scientific notation.)
fVariablel = 0.0;

fvariable2 = 12.3;

fVvariable3 = -123.456;
fvariable3 = -1.23456e2;
fVariable3 = -12345.6e-2;

Making Assignments to Numeric Variables

Values are easily assigned to variables.

Simple Integer 32 assignments. Simple Integer 64 assignments.
nl = 1; nnl = 2i64;
n2 = nl; nn2 = nnl;

Simple assignments between different data types.

Simple Float assignments. (Types will be automatically converted to match.)

f1 = 3.0;
nl = 4.0;
f2 = f1
nnl = nl;
f1 = nl;

Using Strings

As noted in the section on syntax, a string in OptoScript must be in double quotes. An individual character can
be used either as a string (in double quotes) or as an integer value representing that character in ASClI (in
single quotes). When you assign a single character to a string, use double quotes to avoid a syntax error; for
example: sString = "a";

To change a single-character integer into a string, use the Chr () keyword as shown below:

sString = Chr('a'"); n = 97;
sString = Chr (97); sString = Chr(97)

NOTE: Ifyou intend to retrieve the string data in either PAC Display or OptoOPCServer, to avoid an error do not use the
Chr() keyword character to insert an embedded null, e.g. Chr(0).

Strings can be used in the following ways.

As string literals (must be all on one line). As string variables.
sGreeting = "Hello, world!" sOutgoing = sIncoming;
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A string can be thought of as a table of characters.
The number in square brackets is the character’s index.
(Note that the index starts with the number zero.)

a7 CER R G0 LR e D R e The following code would result in sGreeting equaling

a character value to a string variable, you

. L “Hello!”
can either quote a character or give its .
. sGreeting = "Hello...";
ASCll value. For example, the following :
K sGreeting[5] = '!"';
two statements are equivalent: ,
sGreeting[6] = "!"';

sSEEt el — e (A7) 5 sGreeting[7] = sGreeting[6];

sStringl Chr (65) ;

A character element of a string variable may be treated
like an Integer 32 value.
nNumber = sString2[l] * sString2[2];

Clear a string using empty quotation marks.
sStringl = "";

The + operator is used to paste strings together. There is no limit to the number of + operators you can
use on a line. The + operator must be used in an assignment statement.

sStringl = "Hello ";
sString2 = "world";
sString3 = "!";

After the three lines above, the following two lines would produce the
same result:

sString4 = sStringl + sString2 + sString3;

sString4 = sStringl + "world" + sString3;

Use the += operator to append one string to another and change the value of one of them into the result.
In the following example, the value of sName would change to “Smith, John":

sName = "Smith, ";

sFirstName = "John";

sName += sFirstName;

The Chr() keyword can be used to convert a numeric value into a one-element string.
sString5 = sStringl + sString2 + Chr('!'");
sString5 = sStringl + sString2 + Chr(33);

Working with Pointers

The use of pointers is an advanced programming technique that is very powerful. For more information on
using pointers, see “Pointer Commands”on page 359.

NOTE: Except for the equal operator (==), the comparison operators (see page 389) can be used only with a numeric
expression. They cannot be used with a null which is not considered to be a number.

For the following examples, assume that:

nl = 5;
fl1 = 9.2;
sl = "test 123";

Using the “&" Character to Point to a Tag's Address

A pointer variable or pointer table element contains the address of the object (tag) it is pointing to; this is
different than the tag itself. In OptoScript, the “&"means address of. It is used as a prefix to a tag in OptoScript
when moving the address of a tag into a pointer. PAC Control commands were designed to act on tags and
not just the address of the tags. The “&" prefix tells the controller to use the address of the tag and not the tag
itself.

Set the pointer. The types must match or the control engine will generate an error.
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pnl = null;
pnl = &nl;
pfl = &fl;
psl = &sl;

pchtl = &Powerup;

Using the “&" Character to Move a Pointer

When moving a pointer to pointer, use the “&*” prefix.
To move a value from a pointer to another pointer:
pVariable0 = &*pVariablel;

To move a value from a pointer to a pointer table:
ptTable[0] = &*pVariabled;

Using the “*" Character to De-reference a Pointer

Use the asterisk (* symbol) to de-reference a pointer. It will then behave just like the variable to which it is
pointing. The following two statements are equivalent:

n2 = *pnl + *pfl

n2 = nl + f1;

The "*" character has to be used as a prefix to a pointer in OptoScript so that the tag that is pointed to will be
used instead of the address of the tag. When using a pointer with normal PAC Control commands you need to

de-reference the pointer because PAC Control commands are designed to use tags instead of the address of
the tags.

Using the Comparison Operator “=="

To see if a pointer is pointing to something, use the comparison operator == (see page 389) to compare it to
null. This use is similar to standard PAC Control condition commands such as Pointer Equal to NULL?

For example:

n2 = pnl == null;

n2 = null == pnl;

if (ptl[0] == null) then

Determining Which Variable to Use

Pointers are very useful when you don't know what variables need to be used until runtime. For instance, the
next example uses a switch statement (see page 392) to determine which variable to use based on the day of
the week. It then uses a pointer to perform a calculation using the correct variable.

switch (GetDayOfWeek())
case 0: // Sunday

pnl = n2;
break

case 6: // Saturday
pnl = n3;
break

default: // Monday-Friday
pnl =5 n4;
break

endswitch

Use the pointer to set the chosen variable.

PAC Control User’s Guide, Legacy Edition 387



OPTOSCRIPT EXPRESSIONS AND OPERATORS

*pnl = n5 * f1 - 5;
For More Information

For more information and examples of using pointers in OptoScript, see:
«  Pages "Pointer Commands”on page 359 and “Pointers and Indexing”on page 95.
«  See Appendix E: OptoScript Language Reference

«  Download the OptoScript Examples: click here, or go to the Opto 22 website and search for “OptoScript
Examples.”

Working with Tables

Following are some examples for using numeric, string, and pointer tables.

Numeric tables.

ntTablel[0] = 1;

ntTablel[1] = 2.0;

ntTablel[2] = nVarl;

ntTablel[3] = ntTablel[2];

ntTablel[4] = ntTablel [ntTablel[0]];

ntTablel[5] = nVarl + ntTablel[2] * 3.1;

nVarl = ntTablel[0];

nVarl = (ntTablel[0] + ntTablel[1l]) * ntTablel[2];

String tables.

stStrT1[0] = "Hello, ";

stStrT1[1] = "world";

stStrTl[2] = stStrT1[0] + "™ " + stStrTl1[1l] + Chr('!");

sStringl = stStrTl1l[2];

Pointer tables.

ptTable6[0] &*pVariable2;
ptTable6[1] &nVarl;
ptTable6[2] = &stStrT1[0];
stStrT1l[0] = *ptTable6[2];

Pointer tables. Note that types are not checked when putting pointers into a pointer table. However,
when a pointer is moved from a pointer table element into a pointer variable, the types are checked at
runtime by the control engine and must match. For example, assume that the following elements have
been placed in table ptPointT:

ptPointT[0] = null;

ptPointT[1] = &nLED A;

ptPointT[2] = &fTemp;

ptPointT[3] = &sStringl;

ptPointT[4] = &Powerup;

Based on this information, the first two of the following statements are good. The third one is bad and
will cause a control engine error, because the element at ptPointT[3] is a string and therefore does not
match the variable pntl, which is defined as an integer 32:

pnl = ptPointT[1];

pfl ptPointT([2];

pnl ptPointT[3];

OPTOSCRIPT EXPRESSIONS AND OPERATORS

OptoScript includes mathematical expressions as well as comparison, logical, and bitwise operators. Because
expressions and operators are built into the OptoScript language, several standard PAC Control commands
such as Multiply, Bit Shift, and Greater Than or Equal? are not used.
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Addition. .
Subtraction.
nCount = nLast Count + 2;
= ) nNumber A = nNumber B - 250;
fPressure = 1.5 + fReading; - - _
fRange = fMax Temp - fMin Temp;
nTotal = nMonday + nTuesday + 10; - -
Multiplication. A
P . Division.
nQuantity = nBoxes * 12;
nBoxes = nCount / 6;
nHours = nSeconds * 60 * 60; . .
fConversion = fLimit / 2.0;

fMax Speed = fSpeed * 16.52;

Modulo division. If any argument is a float, it is
rounded to an integer before the division occurs.

nVarl = nVar2 % 2;
nVarl = 2 % nVar2 % nVar3;
fFloatl = fFloat2 % 2.5;

Mixture of operators.
nAvg (nHrs_ A + nHrs B) / 2;
nvVarl fFloat2 + nVar3 * 4;

Use parentheses to clarify groupings and meaning. You can use an unlimited number of parentheses.

nVar2 *
(nvVar2 + 2) *

(fFloat2 - 2.0);
(nVar3 +

nVarl
nVarl

(fFloatl /

(fFloat2 - 2)) - 3);

The *, /, and % operators have greater precedence than + and -. For order of precedence, see “Operators’

4

on page 444, In the following lines, line #1 is equivalent to line #3, not to #2.

nl = n2 + n3 * n4;
nl (n2 + n3) * n4;
nl n2 + (n3 * n4);

Using Comparison Operators

All OptoScript comparison operators return an Integer 32 value of zero (false) or of non-zero (true). OptoScript
supports the following comparison operators for comparing two numeric values:

NOTE: Except for the equal operator (==), the comparison operators can be used only with a numeric expression.
They cannot be used with a null which is not considered to be a number.

Operator and Meaning Example

== equal nVarl = nVar2
<> notequal nVarl = nVar2
< lessthan nVarl = nVar?2
<= less than or equal nvarl = nvar2
> greater than nVarl = nVar2
>= greater than or equal nVarl = nVar2

== fFloat3;
<> fFloat3;
< fFloat3;
<= fFloat3;
> fFloat3;
>= fFloat3;

More complex examples.
nVarl = (nVar2 * 2)
nVarl (nVar2 * 2)

<

(fFloat3 / 9

o) 8
(fFloat3 / 9.5);

You can also use the equal operator to test whether two strings are equal. For example:

nVarl = sStringl == sString2;
nVarl = sStringl == "abc";

nVarl = sStringl == stStrT1[0];
nVarl = stStrTl1[0] == stStrT1l[1l];

However, you cannot use the not equal (<>) operator to test whether two strings are not equal. Instead,

use OptoScript similar to the following:

if (not (sStringl == sString2)) then
nVarl = 999;
endif
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When you use a comparison operator in an if statement, it isn’t necessary to put the result in a variable
because the result is used (consumed) by the if:
if (fICTD Input <= Avg Temp) then
Fan A = 0;
endif

Using Logical Operators

All OptoScript logical operators return an Integer 32 value of zero (false) or of non-zero (true). OptoScript
supports the following logical operators for numeric values:

Operator and Meaning Example

and Result is true if both values are true nVarl = nVar2 and nVar3;

or Result is true if at least one value is true  |nvarl = nVar2 or nVar3;

x0T Result is true if only one value is true nVarl = nVar2 xor nvar3;

not invert the logical value nVarl = not nVar2;

Any number of logical operators can be Logical operators are left-associative.

chained together. For example, these two lines are equivalent.
nVarl = nVar2 and nVar3 and nVar4; nVarl = nVar2 and nVar3 or nVar4;
nVarl = nVar2 and nVar3 or nVar4; nVarl = (nVar2 and nVar3) or nVaré4;
The not operator precedes a value (it takes a The following two lines are equivalent:

value only onits right-hand side): nVarl = not nVarl and not nVar2;
nVarl = not nVar2; nVarl = (not nVarl) and (not nVar2);

Logical operators can be combined with comparison operators to create complex logical expressions.

nVarl = (nVar2 < 1) and (nVar3 == 6.5);

nVarl = (nVar2 < 1) and (sStringl == "abc");

nVarl = ((nVar2 < 1) and (nVar4 xor nVar5) or (not (fFloatl == fFloat2));
nVarl = not (nVar2 < 5); // same as "nVarl = nVar2 >= 5;"

When you use a logical operator in an if statement, it isn't necessary to put the result in a variable because
the result is used (consumed) by the if:
if (Motor 1 or Motor 2) then
Motor 3 = 0;
endif

Using Bitwise Operators

All OptoScript bitwise operators operate on integer values. OptoScript supports these bitwise operators:

bitand bitwise and bitorbitwise or

bitxor bitwise xor bitnotbitwise not

<< left shift >>right shift

Use the bitwise and operator to and together the

two values bit by bit. Hex literals can be convenient.
nl = n2 bitand 2; nl = n2 bitand 0x0002;

nl = n2 bitand n3;

Use the bitwise or operator to or together the two val- | Use the bitwise xor operator to xor together the two

ues bit by bit. values bit by bit.

nl = n2 bitor 2; nl = n2 bitxor 2;

nl = n2 bitor 0x0002; nl = n2 bitxor 0x0002;
nl = n2 bitor n3; nl = n2 bitxor n3;

390 PAC Control User’s Guide, Legacy Edition



CHAPTER 11: USING OPTOSCRIPT

The left-shift operator shifts the left value's bits to the left by the right value.
nl = n2 << 2; // left shift n2's value by 2
nl = n2 << n3; // left shift n2's value by n3

The right-shift operator shifts the left value's bits to the right by the right value.
nl = n2 >> 2; // right shift n2's value by 2
nl = n2 >> n3; //rightshiftn2's value by n3

Precedence

For alist of operators from highest to lowest precedence, see “Operators” on page 444.

OPTOSCRIPT CONTROL STRUCTURES

OptoScript provides the following structures to control the flow of logic in the code:
o If Statements” (below)

o "Switch or Case Statements”on page 392

«  "While Loops”on page 392

»  “Repeat Loops"on page 393

«  “For Loops”on page 393

If Statements

If statements offer branching in logic: if statement A is true, then one action is taken; if statement A is false (or
statement B is true), a different action is taken. /f statements are very flexible; here are several examples of
ways you can use them.

Since a comparison operator returns an Integer 32
value, it can be used as the test value.
if (nl > 3) then

Any numeric value can be tested by the if state-
ment. NOTE: The value is first converted to an Int32.
if (nl) then

f1 = 2.0;
niff 2.0; f2 = 6.5;
© endif

An optional e 1 se statement can be added.

Complex logical operations can also be used.
P 9 P if (nl > 3) then

if ((nl > 3) and (not nl == 06))

e £1 = 2.0;

£1 = 2.0; elii > 6557

enﬁfz 6-5; £3 = 8.8;
endif
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Multiple elseif statements can be used to chain
together several tests. The e 1se statement is still | /f statements can be nested. Each if requires an
allowed at the end. endif.
if (nl > 3) then if (nl > 3) then
f1 = 2.0; f1 = 2.0;
£f2 = 6.5; £f2 = 6.5;
elseif (nl < -3) then
f3 = 8.8; if (nl1 % 10) then
elseif (nl == 0) then f1 = f1 * 2;
£f3 = f1 * £2; f2 = f2 * 3;
else else
f1 = 0; £3 = 0;
f2 = 0; endif
f3 = 0; endif
endif

Switch or Case Statements

A switch or case statement also offers branching logic and can be used in place of if statements when the
expression can match one of a number of numeric values. The value for each case can be a numeric constant
or a mathematical expression only. Comparisons and logical operators cannot be used in cases, nor can
strings. If a case involves a float, the float is converted to an integer before use. Notice that only one case can

be tested at a time.

Here's an example of a switch statement.

While Loops

The value of the expression in parentheses, nNumber, is compared to each

switch (nNumber) +«—f— Ofthecases.Ifthe case matches the value of nNumber, the action is taken.
case 1:
£1 = 10'\
break \\ Make sure you use a colon (;) after each case.
case 2:
fl1 = 15; ™ If a case matches the value of nNumber, the break statement after citation
break immediately exits the switch. Notice that a semicolon is not used after
case (n2 * 2): break.
£1 = 20; '\
de?;i?}t( ) ™ You can use a mathematical expression as a case.
fl i 0; \\ If no case matches, the default action is taken. Using a default is optional; if you
f2 = -1; use it, it must be at the end of the list.
break

endswitch <«—————1— A switch statement must be followed by endswitch.

The while loop is used to execute a list of statements while a given condition is true. The condition is tested at

the beginning of each loop.

For example, this loop sets the first five elements (elements 0 through 4) of a table (ntTable) to a value of 10:

nIndex = 0; ¢
while (nIndex < 5)

d
ntTable[nIndex] =

nIndex = nIndex +
wend

1
1

0; €—
;
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While loops can be nested and can contain other kinds of program statements. Each while needs a
matching wend at the end. For example:

while

ntl

wend

while

nl = 0;

(nl < 100)

[nl1] = nl;

nl = nl + 1;

((nl > 50) and (nl < 60))
ntl[nl] = nl * 100;
nl = nl + 1;

wend

Repeat Loops

Repeat loops, in contrast to while loops, are used to execute a list of statements until a given condition is true.
Because the condition is tested at the end of each loop, the content of the loop will always be executed at

least once.

This example sets the first five elements of ntTable to 10. Compare this example to the example for while loops
to see the difference.

nIndex

repeat
ntTa
nInd

until

=0;:

ble[nIndex] = 10; €4—
ex = nIndex + 1; 4—

(nIndex >= 5); ¢—

Initialize the counter.

Set the table element.

Increment the counter.

Exit loop if condition is true.

Repeat loops can be nested and can contain other kinds of program statements. Each repeat statement

needs a matching unti1 statement at the end.

For Loops

For loops can be used to execute a list of statements a certain number of times.

The for line sets up a predefined initial value and a predefined final value for the counter that counts the
repetitions. The line also includes the steps by which the counter gets from its initial value to its final value
(step 1 counts by ones; step 2 counts by twos, and so on). The step is required. The counter can be any
numeric variable or 1/0 point, but its value will always be a whole number. The initial value, final value, and
step can be any numeric expression; they are converted to integer 32s.

CAUTION: A step value of zero creates an infinite loop. A float step value between —0.5 and 0.5 also creates an
infinite loop, since it is rounded to zero when converted to an integer 32.
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This example results in nVariable equaling 6:

nVariable = 1; The counter starts at zero, and its final value is 4. It will
for nCounter = 0 to 4 step 1 <——— countuponestepatatime.

nVariable = nVariable + 1;
next < The for loop must end with next.

. Other step amounts can be used, including nega-

The for loop counter can be used in the loop. . .

. . . tive steps. Do not use a zero step, which creates an
This example sets the first five elements of S -
table ntTable to 10: infinite loop. This example sets elements 0, 2, and 4

) of ntTable to 20:
for nIndex = 0 to 4 step 2
ntTable [nIndex] = 20;
next

for nIndex = 0 to 4 step 1
ntTable[nIndex] = 10;
next

Predefined values can be a numeric expression, but they are evaluated only at the beginning of the
loop. For instance, the following example will loop 0 to 15 because the upper limit of nSide*3 is evalu-
ated only at the beginning of the loop, not each time through the loop:
nSide = 5;
for nLength = 0 to (nSide * 3) step 1
nSide = 1;
next

For loops can be nested and can contain other types of statements. FEach for requiresa next attheend.

USING THE OPTOSCRIPT EDITOR

1. To use the editor, create an OptoScript block in the flowchart where you want the code to appear. (For
more information on creating charts and blocks, see “8: Working with Flowcharts.”) Double-click the
OptoScript block to open the editor.

The editor is similar to the editor for Microsoft Visual Basic . You can resize the editor window as needed
to see the code.

ﬂ OptoScript - Dough_Chip_Control - Start Conveyor - Block 17 >
Toolbar ——r@ +@& |@ | ¥ | i |M e |,¢ ¥ % "% | a0 iE
OptoScript Code:
Type OptoScript -~
code in this area.
L
< >
Output:
See results of
test compile in
this area.
| Column
and line
Cancel Help Command Help Ln 16, Col 7 numbers
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The following tools are provided in the OptoScript toolbar:

Button Description Button Description

+B Actions Insert Action Command 4 Find
v Conditions Insert Conditions Com- H Replace
mand
T Insert Conditions Com- % Toggle Bookmark
mand
2% Test Compile.~ Test Compile % Clear All Bookmarks
& Cut % Next Bookmark
Copy % Previous Bookmark
Paste a-h Toggle Whitespace
3 Undo i= Increase Indent
| Redo i= Decrease Indent

Begin typing OptoScript code in the top area.

You'll notice that what you type is automatically color-coded to help you:

—  Blue—operators and control structures

- Purple—values
- Green—comments

- Black—commands and names of variables, 1/0 points, charts, and other items

- Red—string literals.

If you want to see white-space marks to help line up code, click the Toggle Whitespace button in the
toolbar. To hide the marks, click the button again.

To use a command, place your cursor in the OptoScript code where you want the command to appear.

Click the Insert Actions or Conditions button in the toolbar.

ﬁ Select Instruction

Groups:

Chart

Communication
Control Engine
Deprecated

Digital Paint

Error Handling

1/ Unit

IO Unit - Event Message
IO Unit - Memory Map
IO Unit - Scratch Pad
Logical

Mathematical
Miscellaneous

PID - Ethernet
Pointers

Sireu il atinm

~

Instructions:

_—

|CalcSetAnalogGain ¥

CalcsetanalogOffset
GetAnalogMaxvalue
GetanalogMinValue
GetanalogTotalizerValue
GetClearAnalogMaxvalue
GetClearanalogMinvalue
GetClearAnalogTotalizervalue
GetHartUniqueAddress
RampAnalogOutput
ReceiveHartBurstResponse
ReceiveHartResponse
SendReceiveHartCommand
SetAnalogFilterWeight
SetAnalogGain
SetAnalogloadCellFastSettelevel

Sethnalnnl nadCelFiltarilainkt

x

[Jindude parameter helps

Cancel

Help Command Help
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4.

10.

In the Select Instruction dialog box, select the command group from the left-hand column, and then
select the command name from the right-hand column.

For information on any command, highlight it and click Command Help, or just double-click the
command name.

NOTE: If you know the command name, you can just type it into the OptoScript code. Remember that
OptoScript command names may be different from standard PAC Control commands. See “E: OptoScript
Language Reference,” for more information.

To include information about the instruction in the OptoScript code, select “Include parameter helps.”
Click OK.

The command appears in the OptoScript code.

To use a variable, table, /0 unit or point, chart, counter, timer, or similar item, place your cursor where you
want the item to appear in the code. If you know the item’s exact name, enter it and skip to step 9. If

you're not sure of the item’s name, locate it in the Strategy Tree, enter it, and skip to step 9. Or for a
variable, click the Add Variable icon .+ in the toolbar.

Select Variable >
Type: Mame:
All Valid Types aiDoughVesselPressure
Ps -
Analog Input ai0venTemperature
Analog Output Alarms
Chart aoConveyorSpeedControl
Communication Handle aoOwvenTemperatureControl
Counter bStartFlag
Digital Input diChipLewvelSwitch
Digital Output diDoughLevelSwitch
Down Timer Variable diEStop
E1l dilnspectionPassFailSwitch
E2 doChipDispenseValve
Float Table doDoughDispenseValve
Float Variable doDoughPressureControlvalve
Frequency doRejectValve
G4EB2 Dough_Chip_Control
Generic OptoMMP Device Dough_Vessel_Pressure_Control
Integer 32 Table dtCookieMotionTimer
Integer 32 Variable fDoughPressureSetpoint
Integer 64 Table fRampValue
Integer 64 Variable fSetpointMinusDeadband
Off Pulse Mixed_IO_Unit
Off Totalizer V nChartStatus =,
Cancel Help

In the Select Variable dialog box, select the variable type from the left-hand column, and then select the
variable name from the right-hand column.

The item appears in the code.

Use the Tab key on the keyboard as you type to indent lines as needed. To increase or decrease
indentation for a line of code you've already typed, highlight the line and click the Increase Indent or
Decrease Indent button in the toolbar.

Enter comments to document what the code does, so anyone who must debug or maintain the code
can clearly see your intentions.

Comments appear in green. Line comments must be preceded by two slashes, for example:

// This is a line comment.

Block comments must be preceded by one slash and an asterisk, and be followed by the same two
elements in reverse. For example:

/* This is a block comment that goes
beyond one line. */
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11. Use the Bookmark buttons in the toolbar as needed to set or clear temporary bookmarks within the code
and to move between them.

Bookmarks mark lines of code so you can easily find them and jump from one bookmark to the next.
Bookmarks remain only while the editor is open; they are not saved when the dialog box is closed.

12. When you have finished entering all the code for an OptoScript block, click the Test Compile button in
the toolbar to compile the code for this block.

The code is compiled, and the results appear in the bottom part of the OptoScript window:

& OptoScript - Dough_Chip_Control - Start Conveyor - Block 17 >

TR RN WP

e e | B | & R >

OptoScript Code:

<7 Calculate the =mall increments of change to aoConveyorSpees
fRampWalue = (55 .0 — aoConveyorSpeedControal) o 20.0:

<7 Loop twenty times
for nloopCounter = 1 to 20 =tep 1
<4 Adjust aocConveyorSpesdContral
acConveyorSpeedControl = aoConveyorSpesdControl + fRampWVali

< Delay for one second
DelaySec(l.0):
next

Resultsafter code’is Output:
compiled i

y, 0 warning(=)

Cancel Help Command Help Ln 3, Col 13

NOTE: The next time the chart is compiled, all OptoScript code within the chart will be compiled again.

If errors are found, you can fix them now or later. Begin with the first one (the one on the
lowest-numbered line), since later errors are often a result of earlier errors. To check a command, place
the cursor anywhere in the command name and click the Command Help button. If you need to add
variables or other items that don't exist in the strategy, do so after step 12.

13. When you have finished with the code in this OptoScript block, click OK to save your work and close the
editor. You return to the flowchart.

TROUBLESHOOTING “UNABLE TO FIND” ERRORS

Also see “Troubleshooting Syntax Errors” below.
If you test compile an OptoScript block and receive “unable to find” errors, try the following suggestions.
For Commands

Check the exact spelling of the command, including upper and lower case. OptoScript commands are similar
to standard PAC Control commands, but contain no spaces and some abbreviations.

Also check that the command is necessary in OptoScript. Some common commands, including comparison
commands such as Less? and mathematical commands such as Add, are replaced with operators built into the
OptoScript language. Check Appendix E: OptoScript Language Reference the PAC Control User's Guide for
equivalent OptoScript commands.
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The easiest way to make sure the command you enter is valid is to enter it by clicking one of the Insert
Command buttons in the OptoScript Editor and choosing the command from the Select Instruction dialog
box.

For Variables or Other Configured Items

Variables, I/0 units and points, counters, and other configured items in your strategy—as well as charts—
have usually been created before you use them in OptoScript code. Check their exact spelling, including
underscores and upper and lower case, to make sure they are correct in the code. The easiest way to make
sure spelling is correct is to enter the variable or other item by clicking the Insert Variable button in the
OptoScript Editor and choosing the item from the drop-down lists.

If the item has not yet been configured or created, use the normal PAC Control methods to do so. For help, see
the chapters in this guide on configuring /0 and using variables.

IMPORTANT: In nearly all applications, you want points and variables to be identical in the Strategy Tree and
in OptoScript blocks. For example, if you change the name of a variable or point in the Strategy Tree, you want
the name changed in OptoScript blocks as well.

However, it is possible to turn off some of these automatic updates and cross-checks. To check whether
they've been turned off:

1. With the strategy open in Configure mode, choose Configure > Options.
2. C(lickthe Advanced tab.

PAC Control Options *
Workspace Debugger Advanced

[]When adding Pairts and Variables, do not check OptoScript blocks
[]When renaming Points and Variables, do not update OptoScript blocks
[ Allow Points and Variables with references to be deleted

Cancel Help

3. Lookto seeif any boxes are checked. If they are, you may need to make manual adjustments. (See more
information in “Advanced Options”on page 237.)
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TROUBLESHOOTING SYNTAX ERRORS

Check for the following common syntax errors:
Missing Code

Check for obvious errors first. For example, make sure nothing essential has been left out of (or unnecessarily
added to) a statement:

Sample Statement Should Be Missing Code

iTotal = x + y + ; iTotal = x + y + z; Last operator missing a variable
iTotal = x + v + z iTotal = x + y + z; Semicolon missing

sGreeting = Hello!" sGreeting = "Hello!" First quotation mark missing on the string
iTime = Get Hours; iTime = GetHours () ; 2953 e 7 SR Eel e

parentheses missing after the command

Parentheses mismatched (last half miss-

x = (1L + (x -y x = (1 + (x - vy)); ing)

Check to make sure operators are used correctly. You may want to review “OptoScript Expressions and
Operators”on page 388.

If you are using control structures such as loops or if statements, especially if they are nested, make sure all
required elements are present. For example, every i £ must have a then and an endi £. See "OptoScript
Control Structures”on page 391 for more information.

Type Conflicts

Type conflicts are caused when different data types are incorrectly mixed. For example, you cannot assign an
integer to a string. Make sure data types are correct. It is easier to keep track of data types if you use Hungarian
notation when naming variables. See “Variable Name Conventions”on page 384 for help.

DEBUGGING STRATEGIES WITH OPTOSCRIPT

Before trying to debug strategies containing OptoScript code, make sure the code has been compiled within
each block, or choose Compile All to do all blocks at once.

When you begin debugging the strategy, start by stepping through whole blocks. If you run across a problem,
then step within that block. Stepping within the block is discussed in “Choosing Debug Level”on page 215.
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INTRODUCTION

This chapter shows you how to create and use subroutines.

In This Chapter

About Subroutines page 401
Creating Subroutines page 402
Using Subroutines page 408
Viewing Subroutines page 412
Printing SUDTOULINES ....oooeeee v sssesss s page 413

ABOUT SUBROUTINES

A subroutine is a custom command that represents a series of commands. Subroutines are useful anytime you
have a group of commands that is repeated in a strategy or used in more than one strategy. Subroutines are
built using the same tools and logic used to create charts. Once built, you can call them at any time from any
chart in any strategy or from another subroutine. (You cannot call subroutines recursively, though; that is, a
subroutine cannot call itself, nor can a subroutine called by a subroutine call the original subroutine.)

NOTE: To call a subroutine from another subroutine, you need SNAP PAC firmware R9.5a or higher.

Like charts, subroutines start at block 0 and move sequentially through command blocks to the end. They use
variables, inputs, and outputs. They can use OptoScript code. Each subroutine is displayed in its own window,
and you can open and view several subroutine windows at once.

Unlike charts, however, subroutines are independent from a strategy. You don't need to have a strategy open
to create or change a subroutine. And if you do have a strategy open, creating a subroutine has no effect on
the open strategy unless you specifically link them together. (Debugging a subroutine, however, requires that
it be called from a strategy.)

A second important difference between subroutines and charts is that subroutines offer two ways to work
with variables and other logical elements: they can be passed in or they can be local to the subroutine.

«  Passed-in items are passed into the subroutine by the strategy. They are referenced when the
subroutine is executed. If a parameter is passed by reference, the subroutine will pass the value back to the
strategy. For example, you could create a subroutine to add 3.0 to a passed-in float variable. If they are
passed by value, the updated value is not passed back to the strategy by the subroutine. For more
information, see the next section, “Data Types for Subroutines.”

When the subroutine ends, the float variable will contain a new value. Passed-in items are called
subroutine parameters, and you can use up to 12 of them in a subroutine.
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«  Local items are created when a subroutine begins, and they are destroyed when it ends. For example, a
subroutine could take a passed-in item, copy it to a local variable, and add 3.0 to that local variable for
use within the subroutine. The local variable is created when the subroutine is called, and it disappears
when the subroutine ends.

Data Types for Subroutines

The following data types may be used in subroutines for both passed-in items and local items:
«  Numeric variables (integers, floats, and timers)

«  Numeric literals (integers and floats). If you are familiar with other programming languages, literals are
similar to “passed by value” parameters, while variables are like “passed by reference” parameters. Other
types besides numeric can be passed into the subroutine through literals, however; see below for more
information.

«  Numeric tables

«  String variables

«  String literals

«  String tables

«  Communication handles

The following data types are also supported:
«  Forpassed-in items: 1/0 points, I/0 units, and pointer tables
«  Forlocal items: pointer variables

The following data types are not supported in subroutines: PID loops, event/reactions, and charts.

Although most variables passed in and out of a subroutine must be of a specific type, literals that are passed
into subroutines can take several types. Using a string literal, you can pass in either a string literal or a string
variable. Using a numeric literal, you can pass in an analog point, a digital point, an integer variable, a float
variable, or a timer variable.

This flexibility in using literals makes it easier to use a subroutine in multiple strategies. For example, a literal
passed into a subroutine from two strategies might be a float value in one strategy and an analog pointin the
other.
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Tips for Subroutines

As a general rule, keep subroutines as small as possible to do the job they're intended for. Extra variables and
unnecessarily large table sizes can affect the memory available for running subroutines.

A Put Status In parameter appears automatically in every subroutine. This parameter is used to let you know
whether the subroutine was called successfully, in the same way that function commands return a status.
Make sure that you always check the status code after calling a subroutine. Subroutine status codes are:

0 Success

-67 | Out of memory

Null object error. Make sure you are not passing a pointer that points to
null.
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-72 | Nesting too deep

Invalid subroutine or parameters. In configure mode, choose Edit >
Find, select Global and Operand, and then click Find to search for
objects with the same name as the subroutine. Rename any objects that
you find.

-73

Drawing the Flowchart

1. Inthe PAC Control main window (with or without a strategy open), choose Subroutine > New.
The Create New Subroutine dialog box appears.

f Create Mew Subroutine b |
Look in: | inCookies v| e ? Ll
MName - Date modified Ty

Mo items match your search.

< >

File name: || | I Open

Files of type: | PAC Control Subroutine Files (*ish) ~ Cancel

2. Enterasubroutine name.

The name must start with a letter, but may also include numbers and underscores. It cannot include
spaces or other characters.

The subroutine name will become a command (instruction) in PAC Control. It's a good idea to make it a
descriptive name indicating the purpose of the subroutine, for example, “Variable_Increase_Notification.”
You cannot use the name of any existing command (for example, “Add").

3. Navigate to the directory where you want to store the subroutine and click Open.
Unlike strategies, multiple subroutines can be saved to the same directory.
A new subroutine window is created.

S Variable_Increase_Motification EIIEI
....................... A
........ 2 sx &m ogn ax an g% an &
........ m 0 3 3 3 3 3 3 3 3
....................... v
£ >

(i)Shortcuts | 100% ~
| ! Suhroutine/

4, Add blocks and connections and name the blocks as you would in a chart, as shown in the example
below.
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=S Variable_Increase_Motification™ EI@

< >

(i)Shortcuts | 100%

Y Suhruutinef

You can also copy existing flowchart blocks from another subroutine or chart and paste them into the
new subroutine. See “Cutting, Copying, and Pasting Elements”on page 248.

5. Save the subroutine by selecting Subroutine > Save.

Configuring Subroutine Parameters

Before you can call a subroutine from a strategy, you must configure the variables and other logical items that
are passed into it. These passed-in items, called subroutine parameters, are the only information that is shared
between a subroutine and the calling strategy. Twelve parameters can be passed into a subroutine, and since
a table can be a parameter, those 12 parameters can include a large amount of data.

An item passed into a subroutine may be called by one name in the strategy and by another name in the
subroutine. In fact, if a subroutine is used for more than one strategy, it is good practice to select generic
names in the subroutine. For example, if you create a subroutine to average values in any float table, the table
might be named Float_Table in the subroutine. You could use this subroutine to average pressures in a table
named Pressure_Values from a strategy, and Pressure_Values would be referred to as Float_Table in the
subroutine.

1. With the subroutine open, select Subroutine > Configure Parameters.
The Configure Subroutine Parameters dialog box appears.
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4 Configure Subroutine Parameters - [m} *
Subroutine Name: Group:
| Variable_Increase_Motification | Subroutines ~

Subroutine's OptoScript Name:

| Variable_Increase_Motification |

Comment:

# Prompt Type Name RefCo. ™ Add...
1 PutStatusIn Integer 32 Vari... Not Available S
Modify...

2
3 Delete
4
5
£

Cancel Help

In this dialog box you determine the way the subroutine is called from the strategy.

From the Group drop-down list, choose the command group you want the subroutine to appear in.
For example, if you create a subroutine to find the average value of several variables, you could choose
Mathematical as the command group. The default group is Subroutines.

(Optional) Enter a comment to explain the purpose of the subroutine.

Notice that one parameter, Put Status In, has been automatically entered for you.

This parameter is used to return status information on the subroutine, and it always appears at the
bottom of the parameter list. A subroutine essentially becomes a command within a chart or another
subroutine, and subroutines are similar to function commands that return a status. Since the system itself
returns this status parameter, the name of the status parameter is not available in the subroutine. When
you add the subroutine to a strategy, you choose the variable the status will be placed in.

IMPORTANT: Make sureyou always check returned status codes for all subroutines. Subroutine status codes
and their meanings are:

0 Success

-67 | Out of memory

Null object error. Make sure you are not passing a pointer that points to
null.

-72 | Nesting too deep

Invalid subroutine or parameters. In configure mode, choose Edit >
Find, select Global and Operand, and then click Find to search for
objects with the same name as the subroutine. Rename any objects that
you find.

-73

For each parameter you add, do the following steps.

NOTE: What you enter here appears in the Add Instruction dialog box when the subroutine is called from within
the strategy. See page 407 for an example.
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a. Highlight the first empty line (below the Put Status In parameter) and click Add to open the Add

Subroutine Parameter dialog box.

ﬁ Add Subroutine Parameter *
Prompt: | | |
MName: | |
Type: | w
| Cancel Help

b. Inthe Prompt field, enter the prompt text you want to show in the Add Instruction dialog box in the

strategy. This field is limited to 16 characters.

c. Inthe Name field, enter the name of the parameter (the argument) as it will be referred to in the

subroutine. This name is used within the subroutine only.

d. From the Type drop-down list, choose the type of item to be passed into the subroutine.
Use variables for values the subroutine changes (passed by reference); use literals for values the

subroutine uses but does not change (read-only or passed by value).

e. (lick OK. The parameter appears in the Configure Subroutine Parameters dialog box, above the Put

Status In parameter. (Scroll up to see it if necessary.)

i Configure Subroutine Parameters

Subroutine Name: Group:

| Variable_Increase_Motification | Subroutines ~
Subroutine's OptoScript Name:

| Variable_Increase_Motification |

Comment:

|

# Prompt Type Name RefCo, ™

Put Status In Integer 32 Vari... Mot Available

2
3
4
5
<

/

OK | Cancel Help

Modify...

lete

Reference
count

. Up-and
down-arrow
buttons

6. Repeat step 5 for each parameter. To change a parameter, highlight it and click Modify. To change the
order of a parameter in the list, highlight it and click the up- or down-arrow button in the dialog box. To

delete a parameter, highlight it and click Delete.

NOTE: You cannot delete the Put Status In parameter or change its order in the list, and you cannot delete a
parameter that has a reference count greater than zero (indicating that it is used in the subroutine). Also, if you
add or delete parameters after including a subroutine in a strategy, you may receive an error and will need to

add the subroutine to the strategy again.

7. When the parameters appear the way you want them in the list, click OK.
The parameters you have named can now be used in the subroutine’s commands.
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Here's an example of a completed Configure Subroutine Parameters dialog box, showing three parameters to

be passed into the subroutine.

When the subroutine is called from the strategy, these parameters appear in the Add Instruction dialog box:

Subrouting's OptoScript Name:

| Variable_Increase_Motification |

Comment:

ﬁ Configure Subroutine Parameters - O
Subroutine Name: Group:
| Variable_Increase_Motification | Subroutines ~

Then Enter Text

#
1
2 | Is Greater Than
3
4
£

X

Names used in the subroutine
may differ from those used in the
strategy.

Prompt and Type
parameters from the
subroutine define the
instruction in the
strategy.

Type Narme Ref Co, ™
Integer 32 Vari..{|  Counter o Modify. . Add/Edit Instruction dialog
Integer 32 Vari.. Previous_Counter a o box in the strategy
String Variable Warning_Motice a Delete
& Edit Instruction X
_ Subroutine
file name
Instruction:
| 'Uariable_Ina'ease_Noﬁﬁ\aﬁon R Select...
Comment: \
I \\ |
A\ A
(Type " /Mame N\
i | Integer 32 Variable b | Cookie_count B |
Is Greater Than | Integer 32 Variable v | Previous_cookie_count w |
Then Enter Text | String Variable w | Production_status “ |
Put Status In | Integer 32 Variable v | Sub_status w |
o B
Cancel Help Command Help

Adding Commands and Local Variables

Adding commands (instructions) to subroutines is exactly like adding instructions to charts. For help, see
“Adding Commands”on page 277. If you are using OptoScript code within a subroutine, see Chapter 11 for
help on creating code. You can copy and paste instructions from one block to another within the same
subroutine; if you have trouble copying and pasting instructions from one chart or subroutine into another,
simply paste the entire block and then modify it.

You may also need to add local items to be used in the subroutine only and discarded when the subroutine is
finished running. Adding variables to subroutines is also like adding variables to charts. For help, see “Adding

Variables”on page 259.

Remember that the subroutine is separate from any strategy and can be called by any strategy. I/O units and
points are specific to a strategy, so they cannot be added to a subroutine. Also, note that commands and
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OptoScript code within a subroutine can use only the passed-in and local items in the subroutine, not items in
the strategy that calls the subroutine.

Compiling and Saving the Subroutine

1. With the subroutine open, select Compile > Compile Subroutine.
When the subroutine has finished compiling, the cursor returns to its normal form.
2. Select Subroutine > Save.
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To use a subroutine in a strategy, first add the subroutine to the strategy. Then, you can use it just like a
command in the logic within the strategy’s flowcharts, or within another subroutine that has also been added
to the strategy.

Adding a Subroutine to a Strategy

Since subroutines are independent of strategies, you must add the subroutine to the strategy before you can
use it.

1. With the strategy open in Configure mode, double-click the Subroutines Included folder on the Strategy
Tree (or in the menu bar, click Configure > Subroutine Included).
The Subroutine Files dialog box appears, listing all subroutines currently included in the strategy. The
example below shows no subroutines currently included.
& Subroutine Files: Cookies x
Subroutine Filename Ref Count Add...
Remove
Change Folder...,
Cancel Help
2. (lick Add.
3. Inthe Select Subroutine File dialog box, navigate to the folder containing the subroutine you want to

add.

_& Select Subroutine File s
Look in: | Subroutines ~ | e F e mr
Mame . Date modified Type
-=5‘u’ariable_lncrease_Notification.isb 41972016 11:41 AM  ISB File
£ >
File name: | | I Open I
Files of type: | PAC Control Subroutine Files (*isb) ~ Cancel
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Click a subroutine to select it, and then click Open.

5. The new subroutine’s name appears in the Subroutine Files dialog box. Click OK to save the change and
close the dialog box.

The new subroutine appears in the Strategy Tree in the Subroutines Included folder.

Removing a Subroutine

If the Remove button is grayed out when you select a subroutine in the Subroutine File dialog box, it means
the subroutine is used in the strategy. Before you can remove the subroutine, you must first delete any
references to it in the strategy.

1. Open the Subroutine Files dialog box, and then click the subroutine to remove.

ﬁ Subroutine Files: Cookies >
Subroutine Filename | Add...
C:\MyStrategies\Subroutines \Wariable_Increase_Motification.isb S
| Change Folder...|
< >
oK. [ Cancel Help

2. (lickRemove, and then click OK to save your changes and close the dialog box.

Changing a Subroutine’s Folder

The Change Folder button helps when:

«  Asubroutine is saved in a read-only folder (which can cause errors when you attempt to compile the
strategy)

«  Yousimply want to change the location of a subroutine that is being used by a strategy.

To change a subroutine’s folder:
1. Open the Subroutine Files dialog box. The subroutine’s original folder and filename appear.

ﬁ Subroutine Files: Cookies >
Subroutine Filename | Add...
C:\MyStrategies\Subroutines \Wariable_Increase_Motification.isb S
| Change Folder...|
£ >
0K, [ Cancel Help

2. (lickthe subroutine to select it, and then click Change Folder.
3. Inthe "Choose a new location for” dialog box, navigate to the folder containing the subroutine.
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ﬁ Choose a new location for Variable_|ncrease_Notification

410

Files of type:

4. C(lick the subroutine to select it, and then click Open.

5. The subroutine’s name appears in the Subroutine Files dialog box. Click OK to save the change and close

the dialog box.

Using a Subroutine in Strategy Logic

You use a subroutine just like a PAC Control command: by adding the subroutine as a command to a blockin a

chart or subroutine.

NOTE: Subroutines are located in the Subroutine group by default. If you want subroutines in a different group, you
must change the group when you configure the subroutine's parameters. See “Configuring Subroutine Parameters”

on page 404.

1. With the strategy open in Configure mode, open the chart or subroutine that will call the subroutine.

2. Double-click the block that will call the subroutine.

If it is an OptoScript block, list parameters (@arguments) in order within parentheses, the same way you
enter parameters for PAC Control commands (see “OptoScript Syntax”on page 383). Be sure to use the
subroutine's OptoScript name, using underscores instead of spaces. The Put Status In return value can be
consumed by a variable (as shown below), a mathematical expression, or a control structure.

nStatus

For more information on entering a command (instruction) in OptoScript, see “Using the OptoScript

Editor” on page 394.

3. Inthe Instructions dialog box, click where you want the instruction to be placed, and then click Add.

The Add Instruction dialog box appears.
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Loaok in: | MewsubroutinesFolder Vl (€} 5 el b
MName - Date modified Type
w Variable_